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Introduction

Visualization, both in the form of traditional business intelligence (Bl) and as
infographics (such as those of The New York Times) has become a vital part of
communication in business, in the media, and in government.

Much work has been done on the art and science of visualization, and just as
much has been done on specific technology implementations. However, less
work has been done on the intersection between these, making it difficult to
choose the best tool to implement a specific visualization. Visual Intelligence:
Microsoft Tools and Techniques for Visualizing Data bridges this gap, helping you
to choose the right visualization and the right tool to implement the visualiza-
tion, and then to guide you in the best way to implement that visualization.

OVERVIEW OF THE BOOK
AND TECHNOLOGY

This book focuses on the Microsoft platform. With the ubiquity of Microsoft
products such as Excel, and to a smaller extent SQL Server and SharePoint,
almost everyone has access to a Microsoft tool. Indeed, anyone working on
a Windows PC can freely download SQL Server Express and gain access to
Reporting Services.

The biggest challenge in the Microsoft Bl platform is the spread of the capa-
bilities across the platform. With products from the SQL team and the Office
team often overlapping, it can be challenging to know when to use one tool
as opposed to another, and there is often a tendency to try to make just one
tool (most commonly Excel!) fit all use cases. In this book, you find out how
to avoid this pitfall and choose the correct tool for the task at hand.

HOW THIS BOOK IS ORGANIZED

In order to visualize data, you need to understand why visualization is a good
representation of the data. This involves a good understanding of the data you
are analyzing, a good understanding of which visualizations are appropriate,
and an in-depth knowledge of what your toolset is capable of representing
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XXiv

INTRODUCTION

visually. Part 1 of this book starts with a review of the history and science of
visualization, explaining what research has discovered about human percep-
tion, and how this science can be applied to building a visualization.

Part 2 explains how to bring data into the platform to do visualizations. Building
on the basics covered in Part 1, we give you an overview of the capabilities
of the Microsoft platform and dive into the shortcomings that can be solved
using custom code. We take some time to explain the place of Silverlight
and how it is being changed with the advent of HTML5, and we show you an
approach that enables you to build for either platform. We also discuss the
future of Microsoft user interface (Ul) technologies using XAML.

The real value of the book is in Part 3. Each chapter in the part explains a
particular family of visualizations, starting with the science behind the visual-
ization and what types of data it is appropriate for. This section of the book is
appropriate for any person regardless of the technology he is using. The part
continues by helping you choose the best technology on the Microsoft stack;
we provide practical real-world implementations along with code samples.

PART 1: INTRODUCTION TO DATA VISUALIZATION

Chapter 1 introduces the concept of visualization, and differentiates between
data-driven visualization and infographics. It also discusses the place of 3D.

Chapter 2 talks about designing a visualization, and what techniques need
to be applied as you decide what effects to use.

PART 2: MICROSOFT'S TOOLSET FOR VISUALIZING DATA

Chapter 3 discusses the Microsoft toolset and introduces you to the various
tools.

Chapter 4 explains the basics of building a data set to support your visualization.

Chapter 5 discusses the tool everyone loves (or loves to hate)—Excel. It also
covers the data-processing tool embedded in Excel 2013: PowerPivot,

Chapter 6 introduces the new data exploration tool called Power View.

Chapter 7 covers the dashboarding and performance management tool called
PerformancePoint.
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In Chapter 8 you get an introduction to Reporting Services.

Chapter 9 covers the custom code development tools—the future of Silverlight
(or lack thereof) is covered, followed by HTMLS5, and building web services
to supply datasets.

PART 3: VISUAL ANALYTICS IN PRACTICE

Chapter 10 focuses on scorecards and indicators; it explains how you can use
them to monitor your business.

In Chapter 11, you find out how to analyze data that changes over time.

Comparing data points is one of the fundamentals of visualization, and in
Chapter 12 you work through the different ways of doing so.

Chapter 13 covers a subject that has been at the core of many Bl tools—slice
and dice, also called ad hoc analytics.

Chapter 14 covers a visualization that has become much more important in
the modern world of social media: relationship analysis.

In Chapter 15, we cover the art of embedding visualizations in tables.

Chapter 16 talks about visualizations that are not covered in depth in this
book. Many of the visualizations are very useful, but they are not built into
the Microsoft toolset.

Appendix A is a cheat-sheet to help you choose a visualization tool based on
the visual you want to achieve.

Appendix B is a DAX (Data Analysis Expressions) function reference. DAX is
used by both PowerPivot and the Tabular mode of Analysis Services, and you
will find it is greatly useful for data analysis.

WHO SHOULD READ THIS BOOK

The target reader for this book is a data professional who needs to present
data. By data professional we mean anyone who works with data—from sales
managers and accountants to Bl professionals.
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INTRODUCTION

The primary audience is people with a moderately technical inclination who
are comfortable learning new technologies and/or adding to the understand-
ing they already have of the technologies. A basic knowledge of Excel will
suffice for many of the implementation examples, and this book starts by
introducing you to new tools.

The secondary audience is those people who, despite not implementing any
visualizations themselves, need to understand how to choose a visualization,
such as journalists who need to present data to their readers. This audience
includes business analysts who need to know what visualizations to choose
for development, and anybody who reads modern publications, consumes
infographics, and needs to know how to interpret them.

INDUSTRY AND TECHNOLOGY TRENDS

Bl, and its front-facing discipline visualization, is changing from a back-office
activity of mega-corporates to a mainstream activity conducted by small com-
panies, bloggers, journalists, and departments in a company. This has been
partly driven by a change in the world to a data-driven culture and is driven
partly by an improvement in the tools—both in capabilities and in affordability.

There are two major changes in the technology space that inspired this book:
One is Microsoft specific, and the other is a general sea change. The release
of Microsoft SQL Server 2012 is a driving force for end-user adoption. Data
integration visualization tools, in the form of PowerPivot and Power View, are
coming to the less technical end user for the first time. In the world as a whole,
the adoption of a standard web-based technology, HTMLS5, for the presenta-
tion of highly interactive user interfaces, has led to the wholesale adoption
of more interactive data graphics, which are automatically cross-platform.

Both of these changes allow more people to implement data visualization,
but they also require some re-education on the part of existing implementers.

TOOLS YOU NEED

This book covers the entire Microsoft stack, and different tools are shown
throughout. You don’t need any of the tools listed in the following sections to
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understand the material that's presented in the book, but the implementation
examples do require them.

VERSIONS

Excel is the most important tool, and the examples shown are all built in Excel
2013. Most of the implementation samples work with Excel 2010, and a good
portion also work with Excel 2007.

The PowerPivot add-in is required for Excel 2010. Excel 2007 requires an
Analysis Services instance from SQL 2012 because PowerPivot is not available
for that version of Excel. Excel 2013 requires the Professional Plus Edition to
use PowerPivot.

SQL Server 2012 is used for the Reporting Services component, as well as for
the databases that contain the data—both SQL databases and Analysis Services.
SQL Server 2008 R2 Reporting Services can do most of the visualizations listed,
but 2012 is required to install any of the samples.

The PerformancePoint examples require SharePoint 2010 Enterprise Edition,
but they work without modification in SharePoint 2013.

EXCEL AND POWERPIVOT

Excel has always been the world’s foremost data-analysis tool for the end user,
and with the advent of the PowerPivot add-in it has become even stronger. We
work primarily on Excel 2013 (with and without PowerPivot), but we highlight
when a particular visualization also works on earlier versions. Most of the work
in PowerPivot will be possible in Excel 2010 as well.

POWER VIEW

Power View is part of the SQL Server 2012 release, and it's also embedded
in Excel 2013. PowerView's greatest attraction is its integration of animation
components to show changes over time.

REPORTING SERVICES

Reporting Services is the reporting tool provided with SQL Server. It focuses
primarily on the developer market. With rich customization abilities, in some
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INTRODUCTION

ways it's the most powerful of the Microsoft visualization tools, but it comes
with a commensurately steep learning curve.

SQL SERVER ANALYSIS SERVICES (MULTIDIMENSIONAL AND
TABULAR MODELS)

Writing SQL queries to access data is not something the average person
wants to do. Analysis Services provides a user-friendly layer as well as query
acceleration that makes developing visualizations a quick and easy process.

SQL Server Analysis Services (SSAS) comes in two flavors: multi-dimensional
(MDM) and tabular (BISM or Business Intelligence Semantic Model). The multi-
dimensional model has not changed significantly from SQL 2008 to 2008R2
and 2012, so all code samples provided work in SQL 2008. Tabular is a new
version released with 2012, and so SQL 2012 is required for those examples.

SHAREPOINT TECHNOLOGIES: PERFORMANCEPOINT AND EXCEL
SERVICES

Excel Services is the web-based version of Excel, and as such all Excel Services
discussions are the same as Excel.

PerformancePoint is the dedicated monitoring and analysis tool provided in
SharePoint, and forms a large component of this book.

CUSTOM CODE: C#, SILVERLIGHT, XAML, AND HTML5

There are some places where the Microsoft toolset falls short. In those cases,
you have to write some code. The book covers the use of non-Microsoft HTML5
libraries such as InfoVis. These sections are explicitly highlighted, and you can
skip them if you're part of the non-developer audience.

The custom code samples used in the book cover several different tech-
nologies, and we include a discussion of the strengths and weaknesses of
each technology. A chapter on the future of Silverlight (@and the presentation
language called XAML that is used both for Silverlight and other Microsoft
presentation technologies) with the advent of HTMLS5 is included in the book,
along with guidance to help you future-proof against the changeover from
Silverlight to HTML5.
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C# is covered as a way of providing a data provider to front end-only technolo-
gies such as Silverlight/HTMLS5, and for a code sample we provide a generic
version that you can use for any of the visualizations in this book.

WHAT'S ON THE WEBSITE

Data for the implementation examples that you will work through have all
been obtained from the Organization for Economic Development (OECD)
at http://stats.oecd.org/. The data samples have been provided in SQL
database form, as Analysis Services backups, and PowerPivot workbooks.

We have provided finished versions of all implementation examples.

In addition, code samples for the C# web service and the HTML5 visualizations
are included in more detail than covered in the book.

The data sets, implementation examples, and code samples are available from
this book's page at www.wiley.com/go/visualintelligence.
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PART |

INTRODUCTION
TO DATA
VISUALIZATION

In this part

B CHAPTER 1: Fundamentals of Visualization

B CHAPTER2: Choosing a Visualization

www.it-ebooks.info


http://www.it-ebooks.info/

www.it-ebooks.info


http://www.it-ebooks.info/

CHAPTER 1

Fundamentals of
Visualization

When we talk about visualizing data, it is important to understand that any
representation of data other than simple text is visualization. The very first
visualization was a tabular representation of numbers, and tables are still
a very powerful visualization—indeed the most common. Tables, however,
are not the most appropriate visualization for every type of data—visualiza-
tions such as bar, column, and line charts; scorecards and key performance
indicators; network maps; and custom graphics drawn by an illustrator are all
visualization techniques that, when used appropriately, convey the meaning
of data better than a simple table.

This book explores the different visualization types and, more importantly,
how to choose a visualization based on the data you have.

These explanations apply to any business intelligence application, but we
perform implementation examples using the Microsoft stack—starting with
Excel, the world’s most widely used Business Intelligence (Bl) tool and then
covering the entire toolset. We also explore the new world of custom visual-
ization techniques using HTMLS5.

This book is divided into three parts: this first part introduces you to the subject
of visualization; the second part introduces you to the tools you will use; and in
the third part, you dive deeply into the individual visualizations, learning when to
use them, which tool to use, and how to build them using the appropriate tools.

In this first chapter, you learn how to differentiate between data visualization
and artistic visualization. Each has its place, but it is important when present-
ing data to focus on data presentation and not just make the visualization
presentation pretty. Typically, three-dimensional (3D) rendering is an example
of choosing form over function, but it can be done right, with form properly
serving function, and you will learn how.
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INTRODUCTION TO DATA VISUALIZATION

THE FIRST VISUALIZATIONS

The very first visualizations (other than tables) were the time series and bar
charts you are probably very familiar with. Although earlier versions exist,
the art of line and bar charts was created in the form we are now familiar
with by William Playfair in the late 1700s. Other related developments, such
as the development of graph paper, also occurred in this time period. The
invention of lithography aided the widespread adoption of visualizations,
and new forms of visualization such as the pie chart soon followed. All these
developments were paralleled by the huge strides taken in cartography,
and the graphic techniques required to render these maps were used in
the visualization space. William Playfair's first bar chart is shown in Figure 1-1.

Exports and lmports of SCOTLAND & and from different parts for one Year fom Clrifbuas 1780 to Chriftranas 1pé1

: .30 % 40 S0 80 yo_bo go o o _e0o l‘.Jn‘Em

The Flmright divgfions are Tene Thavpind Foureds cach . The Hlark Lines are Lxporir the FaBbod b lmporte.

ke e dhe ot dvew farst 34 g0 po W Nkt Hock e * IS8 Sirand . £ araddots

FIGURE 1-1 The very earliest bar chart from William Playfair

DATA VISUALIZATION VERSUS ARTISTIC
VISUALIZATION

The goal of data visualization is to present data to either provide a more intui-
tive understanding of the data or show it in a way to view a large amount of
data in a smaller area. Artistic visualization is designed to present a piece
of data in a way that appeals to people and hence engenders interest in the
data being presented.
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FUNDAMENTALS OF VISUALIZATION
Data Visualization versus Artistic Visualization

There is obviously an overlap between these goals, but it is important when
developing data visualizations to remember that the goal is to present data
more meaningfully, not just to make it prettier.

Figure 1-2 shows an artistic visualization—it is exceptionally pretty, but it
contains a minimal amount of data.

folls.
potdod 15%
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FIGURE 1-2 Aninfographic where the pictures don’t add value

Figure 1-3 follows the same theme, but has been enhanced to be data rich. It
shows how graphics can be used to enhance data presentation:
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FIGURE 1-3 The same infographic crafted as a data driven graphic

Of course, as pretty as these graphics might be, they are very space-consuming.
Figure 1-4 is a traditional Bl chart showing the same data.
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FIGURE 1-4 A stacked bar chart

INTRODUCTION TO DATA VISUALIZATION

Sales in Thousands

Greens; R 1500

Mince; R 3 200 Chicken: R 9 000

Butchery Cosmetics Electronics Greengrocers

Although not as flashy, this chart shows it’s utility quite quickly: the different
categories can be compared to each other at a glance, while still allowing for
comparisons of the components of the categories. In addition, comparing cakes
and pork in this graph, it is apparent that pork is a much bigger sale amount,
although they are the same percentage of their category. Labels for the actual
amounts have been added in lieu of percentages; either could be used, but
comparing values is more meaningful for cross-category comparisons here.

Now that you have looked at these graphics, you should keep the following
questions in your mind each time you develop a visualization:
Does this visualization contain more data than an equivalently sized table?

Is the data presented in this visualization easier to comprehend than an
equivalent table?

Do the artistic elements add meaning?

Have | added any gratuitous elements that don’t add meaning or distract
from the meaning, such as 3D effects, animated transitions, or gratuitous
images?
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FUNDAMENTALS OF VISUALIZATION

At the point of answering these questions, consider then whether you are
producing an infographic or a data visualization.

THE PLACE OF INFOGRAPHICS

The distinction between an infographic and a visualization is a narrow one,
but can be put simply as follows:

An infographic is a graphic used to convey a message that is known before
the creation of the infographic.

A data visualization is a graphical aid used to discover a message buried
in data.

It is clear from these definitions that a data visualization can be published as
an infographic. But data visualizations are often interactive and dynamic, so if
the message changes (for instance, the sales figures that are being reported on
show a decrease from June to July), the data visualization updates automati-
cally and shows the new figures. Whereas an infographic designed specifically
around showing how well the sales team performed in June still shows the
same figures because an infographic is typically simply a flat graphic.

The reason for flat and non-interactive infographics typically being the case
is rather simple: infographics are often handcrafted one-offs, and the level
of effort involved in creating a data visualization that performs image trans-
forms similar to those done in a tool such as Photoshop can be challenging.
However, this work is valuable because it means that an infographic does not
become stale and out of date; it stays up to date as the data changes. (You
read more about how to do this using HTML5 in Chapter 9 and throughout
Part 3 of this book.)

To reiterate the questions mentioned previously: When you create a data
visualization, you enable the discovery of answers through the data presented,
and as such the data presentation should be as rich as possible.

USING 3D EFFECTIVELY

The use of three dimensions in visualization is a controversial topic. 3D effects
are used in many ways: to add flash by creating an illusion of depth; as an
additional dimension to represent another data point; and for representation
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INTRODUCTION TO DATA VISUALIZATION

of true 3D objects, such as machinery or topography. In this chapter, you learn
how 3D can distort the meaning of your visualization. This applies to other
types of visualization as well, so take care in any visualization that you do not
create an equivalent distortion!

This section delves into the pitfalls of the various approaches used in charts
and graphs, and goes through one of the approaches to solve the problem
of parallax.

THE ILLUSION OF DEPTH

Figure 1-5 shows a typical Excel chart—and as you see, the default chart for-
matting leaves much to be desired. (You learn how to address many of Excel’s
formatting issues in later chapters.) The main issue with the 3D representation
here is the distortion of the values: Compare June 2011 to October 2011, and
work out whether they're the same. You need to look between September 2011
and November 2011, and May 2011 and July 2011. We deal with this particular
flaw in the chart in later chapters.

MonthMNameYear

1200000 +————

Sum of Murder tweets in SA Sum of Murder tweets worldwide

Values

B Sum of Murder tweets worldwide

m 5um of Murder tweets in SA

FIGURE 1-5 A default Excel chart showing a misuse of 3D, distortion of figures by stacking values, and poor axis label

choice
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FUNDAMENTALS

Reading the values off this chart can be done by following the lines and think-
ing about them: they look fairly similar. But the top of the October column is
slightly below on the image, so you could be forgiven for thinking October
is about the same or a little more. It turns out that October is 2.64% less than
June: 553849 versus 539566. You see this by carefully following the lines drawn

above it, but it is not as intuitive as showing the columns starting from the
same baseline.

An additional issue is that the height of the columns is also distorted. January
2010, with a value of 101586, has a height of 22 px; whereas December 2012,
with a value of 618987, has a height of 132 px. The ratio of the values is 6.077,
and the ratio of the heights is a ratio of exactly 6—a distortion of almost 8%!

It is clear that adding perspective in this manner must be approached with

caution, if done at all.

ADDITIONAL DIMENSIONS

A better use of 3D is to show an additional dimension, as shown in the Excel
graph displayed in Figure 1-6.

=

OF VISUALIZATION
Using 3D Effectively

Sum of Murder tweets in SA  Sum of Murder tweets worldwide

1000000 [T

500000 N

e —

Sum of Murdertweetsin 5A

March 2010}

January 2010
May 2010
July 2010
September 2010
Movember 2010 |
January 2011
March 2011
May 2011
July 2011
September 2011
Movember 2011
January 2012
March 2012
July 2012

September 2012
Movember 2012

MonthNameYear
L

FIGURE 1-6 A better use of the third dimension
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In this chart, the third dimension is being used to break up the numbers by
the country dimension. Although it is better because the third dimension is no
longer simply stacked and indeed carries data, this representation still carries
all the flaws of the previous chart.

The solution in both of these cases is truly that three dimensions are not
required to adequately represent the data points. A stacked bar chart in 2D
is a better representation and is more efficient in terms of space. The third
dimension would be great if it could be used in addition to stacking and add
a dimension otherwise not present, but unfortunately, basic tools such as
Excel do not allow for this functionality. In Excel, the one solution is to choose
“Right angle axes” in the Rotation menu to get the chart shown in Figure 1-7.

Sum of Murder tweets in SA  Sum of Murder tweets worldwide

MonthMNameYear

FIGURE 1-7 Flattening out the chart
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A DESCRIPTION OF THE PROBLEM AND A PROPOSED SOLUTION

The reason why these distortions occur is that although an object is created in
three-dimensional space, a further transform is applied to represent it on the
two-dimensional screen on which we view it. This transform projects the edges
of the 3D dimensional object against your screen, applying a shrinking factor
to the height (as in the first example) and width to give a sense of perspective.
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The solution in these examples is to provide a faux 3D transform—keeping
the relationships of the heights to one another identical and distorting the
shape to present a 3D view.

Figure 1-8 is an example of such a graphic on a country map. Note that the
countries are extended vertically rather than in three-dimensional space.

The way the extension of the countries is achieved is through a transform—
essentially each country is the base of a column graph, and as such the height
of the country can be read as the height of a column.

FIGURE 1-8 A prism map illustrating a false 3D projection

If you are using a tool with predefined three-dimensional transforms, | urge
you to hesitate and think through the utility of using them before you apply
them. They often add no value and also easily distort the values presented.

SUMMARY

In this chapter you learned to distinguish by their intended purposes between
a data-driven graphic (a true visualization) and an infographic: visualizations
enable you to discover facts in your data, whereas infographics are designed
to communicate a message.
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You also learned about one of the ways visualizations can misrepresent data,
with the hope that you will apply this thinking to the visualizations you learn
throughout this book. In Chapter 2 you learn the principles of choosing a spe-
cific visualization to match the type of data you are working with, to prepare
you for the details that come the chapters that make up Part 3 of this book.
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CHAPTER 2

Designing a Visualization

Designing visualization is not a simple case of picking one from the list that a
tool supports. The right visualization conveys the right message, whereas the
wrong visualization might confuse the message you are trying to send, or even
convey the wrong message. An example of this is a 3D pie chart in which the
3D distortion shows one slice of a pie as the largest even though it isn't the
biggest piece. Another example is a line chart that shows discrete values, such
as murder rates, across countries but the interpolation between the countries
makes no sense. Each visualization is covered in later chapters; this chapter
shares the background of why you should choose different visualizations.

GOALS OF VISUALIZATION

The goal of a visualization is to make it possible to answer questions—even
questions you didn’t know you should be asking until you saw the pattern of
the data in the visualization.

Example questions include:

How are my sales figures trending over time?

What is my most profitable product line?

Who is the best sales person in the company?

How does seasonality affect my stock levels?
Temporal analysis is the place where the advantages of visualization first
become easily apparent. Someone reading two lines on a graph can predict

where the lines will cross or diverge by glancing at the graph. (Read more in
Chapter 11.)
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Visualizations answer questions by highlighting patterns and outliers. For
example, changing the color of an element that is significantly different from
its neighbors, tracking the relationship of two lines over time, comparing two
columns that are side by side are ways to graphically illustrate a pattern that
may not be immediately apparent.

In Figure 2-1, an early chart of the “radar” or “polar” type, comparisons of
causes of mortality are compared in the Crimean war. The red areas are used
for war wounds, blue areas are for preventable diseases, with black for all
other causes. It is immediately apparent that disease significantly outweighs
any other cause of death on average. Indeed, barring September, war wounds
are still outweighed as a cause of death by all other types.

The chart in Figure 2-1 easily illustrates, at a glance, a weighty amount of infor-
mation. The chart visually describes how the deaths from war wounds grew and
how quickly they grew, but it also shows how the increase in disease-related
death outweighed the war deaths. Both causes of mortality grew earlier and
carried on growing after the war wound deaths started decreasing.

) DIAGRAM ortve CAUSES of MORTALITY )
APRIL 1855 ro MARCH 1856 INTHE ARMY 1N THE EAST APRIL 1854 to MARCH 1853

%r Pesy

T

The Areas of the blus, red, & black wedges are each measured from
the centre as the commeon verter
The blue wedges measured from the centre of the circle represent area
Jor area the deaths from Preveniible or Mitigable Zymotic Diseases, the
red wedges measured from the centre the deaths from wounds, @ the
black wedges measured from the centre the deaths from all other causes
The black fine across the red triangle in Noo ™ 1854 marks the boundary
of the deaths from all other causes during the month
iIn October 1834, d April 1853, the biack area coincides with the red,
in Janwary & February 1856, the blue coincides with the Slack
The entire areas may be compared by following the bive, the red & the
black fines enclosing them.

FIGURE 2-1 One of Florence Nightingale’s early charts
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DESIGNING A VISUALIZATION
Human Perceptual Abilities

However, as with many of the chart types developed prior to this, there are
failings. Although the pattern of growth and decline is easy to see, the abso-
lute values of the deaths are not easily discernible. Being able to quickly get
to an absolute value that can be compared to other charts and data sources
is a key goal of data visualization.

To summarize, the possible goals of visualization are

To present more data than otherwise possible

To illustrate patterns that are not immediately apparent
To answer questions posed by a viewer

To compare values

To show changes over time

To easily extract the underlying data points used

To draw a viewer toward a visualization

To create a quick mechanism to view a value

HUMAN PERCEPTUAL ABILITIES

Human visual perception is not as clear-cut as you might think. The percep-
tual difference in the size of a full moon just above the horizon versus the full
moon directly overhead is the most commonly known instance of how an
optical illusion can trick you. The moon is in fact the exact same size in terms
of angular diameter, or what fraction of your visual field it takes up. Knowing
and taking into account perceptual differences are key to creating visualiza-
tions that communicate the intended message.

You have already discovered how the use of 3D imagery in visualizations can
be misleading—partly due to the technologies used to represent it and partly
due to our perceptual abilities—but there are additional pitfalls you need to
be aware of.

The most important pitfall is context—the shapes around a visualization may
distort the message of the visualization. An extreme example is shown in
Figure 2-2.
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The two lines in Figure 2-2 are, in fact, the same length. Of course, you are
unlikely to end up with such an extreme example in your visualization, but
the use of a gradient background or a watermark could lead to more subtle,

but just as misleading, misinterpretation. Using grid lines, as in Figure 2-3, aids
the viewers’ comprehension.

VY \/

/\
/N

/\

/N

FIGURE 2-2 Which lineis

longer? The one on the bottom, FIGURE 2-3 Using grid
or the one on the top? lines to aid perception

Another key to human perception is choosing an unambiguous dimension
upon which you show values. On the left in Figure 2-4, it is immediately appar-
ent that we are measuring the difference in height. In the middle pair and on
the right, it is immediately apparent that we are using angle. But which of these
changes in the angles is equivalent to the left-hand change in the height?

FIGURE 2-4 Changes in angles versus changes
in height
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DESIGNING A VISUALIZATION
Human Perceptual Abilities

Technically, either of them could be deemed equivalent. The right side is angled
at 14.4 degrees from vertical, or 4 percent of 360 degrees, and the middle is
angled 3.6 degrees, or 4 percent of 90 degrees. As it turns out, most people,
whether due to training in school or a natural proclivity, tend to perceive the
middle figure—represented as a percentage of the difference between vertical
and horizontal—as closer in difference to the change in height.

A change in area in a column, as shown in these
figures, is harder to read. The area in each of the
three columns in Figure 2-5 are equivalent, and can
be perceived as such after a little mental ninjitsu.
At first glance, though, your eye rebels at seeing
them as the same.

This difficulty comes in trying to equate change in

two different dimensions with each other. A rect- FIGURE 2-5 Doubling and
angular shape is by far the easiest to do this with. halving widths and heights
Attempt to determine the relationships between to keep the areas the same
the circular shapes in Figure 2-6 using area and

not radius.

FIGURE 2-6 Evaluating the area of circles

The answer may be surprising: the radii are 20, 28, 34, and 40. The areas, based
on © * (radius squared) are 1256.63, 2463, 3631.38, and 5026.55.

Not an even stepping, but that is hard to pick up.

This problem is compounded with pie charts. Attempting to dissect a circle
and determine the constituent percentages is even more difficult. You might
be saying, “But we can use the angles to tell the difference!” Alas, although the
human eye is skilled at judging the angle from vertical or horizontal, judging
intermediate angles is something at which humans are not so skilled, as you
can see from the examples in the figures. Read more on this issue in Chapter
12 about comparison visuals.
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STRATEGIC, TACTICAL, AND
OPERATIONAL VIEWS

Strategic, tactical, and operational views have been around since the early days
of military action. They reflect a real need for different levels of an organization
to have a different type of view of the data flowing within that organization.

In any intelligence application—from the military uses in which the techniques
evolved to the business intelligence (Bl) applications you are more likely to
be familiar with—the reason for having a view of data is to make a decision
and/or take an action. The key difference among strategic, tactical, and opera-
tional views is the level of detail required in the view and the magnitude or
importance of the decision being made.

In the retail world, an example strategic decision is the decision to open a
new store. A decision like this is typically collaborative, with many people
contributing to making the decision. A market research firm may be engaged
to discover and compare the demographics of the possible areas in which the
store could open; the Finance Department evaluates the cost of doing business
in those areas and does profitability projections; and product managers supply
their knowledge of what products would work well in each store. All of these
data are collated and discussed. It takes some time, and—most likely—many
meetings to make a decision to open a new store, but an organization does
not usually have to make very many strategic decisions.

The other aspect of strategic views of data is monitoring. While the new store
project is being evaluated, the CEO and other executives need to know, at a
glance, that the business is still performing optimally, or at least adequately.
The executives need to know which of the existing regions, and which stores
within those regions, are doing poorly so that an intervention can occur imme-
diately. The strategic view is at an aggregated level, and it offers the ability to
drill into more details. See Figure 2-7 for an example.

An operational view, such as what’s shown in Figure 2-8 on the other hand,
is at a detailed level. For example, in the same retail organization, a credit
controller at a store may be considering a request from a customer to get a
credit extension for a specific purchase, and will run a report showing the
customer’s payment history and credit rating. The presentation style of this
type of detailed data is typically very different from the high level view used
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Strategic, Tactical, and Operational Views

in the strategic level. In direct contrast to strategic decisions, operational
decisions are made frequently. Individually, they have very little effect on
the organization, but in aggregate they spell the difference between success
and bankruptcy.

Rating by Metric overti.. . -

Rating by Store -C
January February  March apri May June July August September
Rating Target Rating Rating Rating Rating Rating Rating Rating Rating Rating Rating
o weighted Score 208 (O Al 2300 £ zie0 & 2500 5 2060 () 2060 O 1e0 @ vew @ 2157 O 227 O
=i Parent Organisation  2.086 () = CUSTOMER 0200 @ 0207 @ 0247 ® 0133 @ o017 @ 0193 ¥ o017 @ 0207 @ 0167 @
= Gauteng 2023 (O Pending applications 0107 @ 0003 @ 0120 @ o067 @ 0003 @ 0003 F 0053 @ 0107 S 00s0 @
Store 1 2112 Upgrade/tew applications ~ 0.047 @ 0.067 @ 0073 @ 0033 @ 0037 ® 0057 & 0027 @ 0037 @ o053 @
Store 2 193¢ i Value Added Services 0,047 ® 0047 @ 0053 # 0033 @ o7 @ 0053 @ 0027 $ 0053 @ 0 @
EL=0) 221 & FINANCIAL 0917 @ o643 @ o870 @ o050 @ oo00 @ 033 @ 0w @ 0733 @ s @
Store 3 2211 (& INTERNAL PROCESSES o0 @ 1070 @ 1030 @ 1257 @ o070 @ 1030 @ 0820 W 097 @ o090 @
[ PEOPLE 0283 @ 0290 @ 0353 ® o0 @ o023 @ 0233 ® o030 @ 02w @ 0220 @
Store Trends -
035
030
025
020
0.15
0.10
0.05
0.00
August Octaber December February april June August
September November January March May July September

FIGURE 2-7 An example of a strategic view with drill down
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FIGURE 2-8 An example of an operational report
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Tactical decisions are the middleground between strategic and operational
decisions. For the most part, in the preceding example scenarios, the decisions
being taken into account and the data being monitored are known ahead of
time; tactical decisions are often about data exploration more than just pure
monitoring or evaluating a detail view. For instance, a product manager may
need to decide which products need to be held in extra stock over the fes-
tive season. The product manager examines the product’s sales data and its
seasonality, and might also examine data from fashion labels that highlights
which products will have strong marketing campaigns. The key here is more
interactivity and flexibility than in the other views. Decisions and actions aris-
ing from tactical business intelligence (BI) typically sit between strategic and
operational in terms of both their business impact and the quantity of them.
An example of a tactical report is shown in Figure 2-9. This report provides an
interactive view of sales and profit, broken down by month and by brand, and
with a slicer for region. The view allows for additional analysis by changing each
chart element according to the other chart elements that are clicked on—for
instance, when clicking a particular brand, each column for the months will
be split up by that brand. This is covered in more depth in Chapter 6.

The Microsoft business intelligence toolset loosely follows this model:
PerformancePoint dashboards match to the strategic level; Excel, PowerPivot,
and now Power View match to the data exploration of the tactical level; and
Reporting Services is often used for operational-level reports. This correlation
is not very strong and is explored further in Chapter 3.

Brand, and MonthName Region
LENTHERIC MAYBELLINE Bastern Cape
Free state
¥ Gauteng
1imnonn
YL
I Mpumalanga 1
Natal
100K
SALLY YARDLEY Bl PercyoY

80K [ ProfitMargin

60K

40K

(Thousands)

FIGURE 2-9 An example of a tactical report being used for data exploration. Clicking on one chart or slicer will filter the other charts.
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GLANCE AND GO VERSUS DATA
EXPLORATION

We've explored the use of monitoring (which can also be called glance and
go), specifically for strategic views, and exploration specifically for tactical BI,
but of course there is a large overlap. Strategic views can include exploration,
and tactical views can include monitoring.

It's time to explore the different use cases. “Glance-and-go” Bl, which is often
called monitoring and is epitomized by colorful indicator icons, has for many
years been the poster child of Bl applications. Figure 2-10 shows an example
with colorful indicators that are presented on a scorecard with drill-down and
drill-across capabilities.

GDP per hour Value Added by Activity
GDP Per hour Target 800
3 Asia + Pacific 40.43 48.60 (@ -17%
= Europe 44.88 8150 (7 45% . _ _
@ Latin America + Carbbean 19,13 20.90 @ 8% 0 m
 North America 45.59 46.20 @ 1% 500

200 I I i
0 I

2000 2002 2004 2006 2008 2010
2001 2003 2005 2007 2009 2011

2012

Bl "Valueaddedin agricutture

Wl "Valueadded infinancial intermed
[l "Valueaddedinindustry

[ "Value added inwholesale and ret
Il Value sdded in construction

[l Value sddedinother services act...

FIGURE 2-10 An interactive scorecard, with indicators. Clicking on an indicator will filter the chart on the right.

For a long time the use of vehicle-type gauges and dials, such as those shown
in Figure 2-11, were immensely popular for a long time, but they're luckily
fading into oblivion now. This format that resembled a vehicular dashboard
seemed like an ideal way of showing business information in a manner that
people were familiar with. However, a key failing of these types of dashboards
were that they showed little information. A gauge is designed to show a con-
tinually changing figure, and it is ideal for continual monitoring; information
such as speed, engine revolutions, and oil temperature are measured up to
thousands of times per minute, and keeping an eye on a gauge is a good
mechanism for viewing this velocity of data. However, business rarely changes
this frequently; Indeed, much financial data is only relevant as of the last month
end, and the gauge is a poor representation of this data.
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Stare Metrics

Title Sales Amount Sales Quota
}g{ BN
European Sales Manager $98,323 $117.000 y ;,
e N
North American Sales Manager $249,400 $271 ,OOO i L;,
Pacific Sales Manager $26,580 $33,000 p ¥
~% ;i

FIGURE 2-11 An early example of a “gauge” in a dashboard. Note how only one number is
communicated.

Glance-and-go visualizations thus need to be at once “information dense”
(or, to use another term, data rich) such that enough data are presented to
enable a viewer to know whether more investigation is required, but sparse
enough that the data do not overwhelm. A guided maximum of seven data
points is suggested, with the extension that multiple axes of seven points can
be used. For instance, you might have seven indicators each for Month-To-
Date, Year-To-Date, and Year-over-Year. This would be viable in a scorecard,
but depends on the visualization. Figure 2-12 shows a good example of a
monitoring scorecard, including drill-down information.

W Vesterday Vesterday (LV) Company Rank (YD) District Rank (VD) Wk ToDate Wk To Date (L) Month ToDate  Month ToDate (LY} Vear TaDate Vear Ta Date (L¥)
@ 5ales Amount §7,162 47,985 @ -10% ® 53 ® 5 f24,567 | eeavs @ -15% 101,685 115,066 @ -12% 2,884,050 $2,926,156 @ -1%
DSW! Sales §l,450  foos o 0% ® 147 ® ] 2,863 §1,859 @ 54% $10,251 $11,643 @ -12% $294,367  jaoe0ze @ -1%
@IFab Finds Sales Amourt  $585 2z @ -19% » 47 ® 5 1,824 §1,116 @ 64% 47,550 §3.217 @ 135% §156,203 452,363 @ 199%
I Clearance Sales Amount  $708 275 @ 155% Y 3 ® 4 2,098 $2,992 @ -15% $3,123 $11,083 @ -18% $385,85¢  $200,289 W 93%

FIGURE 2-12 A scorecard with key performance indicators (KPIs) and time-based measures

Glance-and-go visualizations are often accompanied by interactive elements.
Drilling down on the KPIs to see what figures make up the number that is
not meeting target and drilling across to a second element, such as a line
chart, to give detail about how the KPI has trended over time are two of the
most common. In addition, capabilities such as interactive slice and dice are
often incorporated to aid discovery of the data behind the KPI. For instance,
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Using Color in Visualizations

a retail organization analyzing poor sales in a region may want to drill down
to a store that’s performing particularly poorly, check the store’s performance
trend over the last year, and bring in a list of any marketing campaigns run in
that store for that period.

NUMBER OF DATA POINTS IN A VISUALIZATION

The suggested number of data points in a visualization is four to seven. Of
course, this doesn't mean that you should only have seven dates in a line
chart; instead the limit is suggested so that you only have a maximum of
seven series plotted over time. This limit applies to any kind of visualiza-
tion and is based upon the human ability to keep only a certain number
of items in focus at any given time.

Be careful not to confuse this data discovery portion of glance and go with
data exploration!

The key difference between the data discovery based on glance-and-go visu-
alizations is the intent. In glance and go, you know what question to ask—for
instance, “Have sales targets been reached?”—and typically which follow-up
questions need to be asked, such as the following:

Which stores missed their sales targets?

Which product categories are performing poorly?

What marketing campaigns were run in that period?
In data exploration, the questions are unknown, and the visualization is
explored until a pattern is discovered. The patterns to be discovered may be

correlations such as similar products being bought together or seasonality
of purchasing patterns.

USING COLOR IN VISUALIZATIONS

Preparatory to discussing the use of color in visualization, it's important to
understand the way color is perceived in the human brain. Despite the popu-
lar education of red/green/yellow as primary colors, the three primary colors
in the human eye, and not coincidentally, in the computer monitor are red/
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green/blue, or RGB. Several things are important about the RGB encoding
scheme for colors on computers:

RGB does not adequately cover the spectrum of visible light. To test this,
simply compare a photo of a sunset to the real sunset, and the differences
between the two will be very apparent.

Human perception of color is skewed. Red, green, and blue are the most
readily perceived colors because they match to the cones in the eye, but
not in direct proportion. Reds and greens are much stronger than blue,
and the cones are more centered in the eye, whereas blue is more in the
surrounding areas of the eye. This has led to the use of red and green in
most indicators, mostly notably traffic lights.

The differences between rods and cones in the eye are beyond the scope
of this book, but a nice explanation is available at www.cis.rit.edu/
people/faculty/montag/vandplite/pages/chap_9/ch9pl.html.

The default color schemes implemented by the Microsoft toolset can be
problematic. Both Excel and Reporting Services allow for a great deal of
control over the colors used, but PerformancePoint and Power View do
not. The website http://colorbrewer2.org/ (shown in Figure 2-13), gives
great recommendations for different color scenarios.

number of data classes on your map. how to use | updates | credits
4 » | leam more >

diverging v | Jocn more >
pick a color scheme: RdBu

Hik il

) colorblind safe || printfriendly
[ photocopyable  Jeam 1o >

Jecirn more >

FIGURE 2-13 Colorbrewer
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What should you use color for? Color can be used to highlight and separate
different series, to show a value along an axis, or as a quick visual cue to show
crossing a threshold.

Looking at Figure 2-14, you can see that differentiating between the series is
relatively easy based on the use of colors.

SANZAR Reserves

$35,000 — Australis
— g Zealand

South Africa
e /’\A/
T W

$20,000

il ons of Dollars

$15,000

/\—'——-——_____ —

10,000
5,000

50
208+ Nowarmbser 2011 : Saptambar 2012 Fabruary 2012+ July 2012 March
11t Decambar 201t Detober 0z: nprd 2 sanvary. 2021 June FoTT)

Country Name

A o’

FIGURE 2-14 Chart contrasting the 3 SANZAR countries’ reserves over time

Showing a value along an axis can take many forms, with shapes in forms
such as heat maps, bubble charts, and geo-spatial maps. In all these cases,
the color is used to indicate a value along a range, with the most common
ranges being green > yellow > red, or blue > orange > red. Figures 2-15,
2-16, and 2-17 show these different charts.

It is important when choosing these color ranges to make sure that the num-
ber of colors chosen and the values being displayed are congruent. Choosing
a four-color range when there are five different possible values easily leads
to confusion when two disparate values are displayed using the same color.

In the same way, choosing the intervals between the colors is important. Having
one value widely divergent while using an even interval, as in Figure 2-18,
bunches up colors toward one end of the spectrum and possibly hides vari-
ances in the values. Figure 2-18 shows the five European countries with the
highest national reserves, and Switzerland is much higher than the rest, which
can't be distinguished by color.
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FIGURE 2-15 Heat map example
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FIGURE 2-16 Bubble chart example—color is based on profit margin, banded into ten percentiles
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FIGURE 2-17 Geo-spatial example

77,000 171,000 265000

30,000 124,000 218,000

FIGURE 2-18 Divergent values

The solution in these cases is to choose intervals carefully and, knowing your
data, apply a wider range to the first color. Figure 2-19 shows this approach
with the same data. The variances are much clearer, and color has been used
to rank the countries.

You can think of indicators as a subset of the display of colors along an axis,
with predetermined shapes in a predetermined grid rather than colors on a
map. The convention of red is bad; yellow is a warning; and green is good.
Just red and green is very typical and should only be diverged from with
much thought. One example of a divergence may be to show red for values
less than last year, and black for values greater, which is a system that more
closely matches accounting conventions. Figure 2-20 shows an example of a
scorecard using red/yellow/green for figures against targets and red and black
for values against the previous year.
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Using shape and
color, asin the
example to the right
for quota, is impor-
tant for those who
are color-blind. If the
shape is set, another
approach is to ensure
that either the shad-
ing pattern or the
brightness of the
color is differentiated
even when converted
to gray scale.
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FIGURE 2-19 A better spread
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Canada $833 406 O 105%  $527 @ 58% $513 @ 62%
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Parific 600 O $460 @ 3% o0 @ 191%

FIGURE 2-20 A scorecard using colored shapes to indicate performance

USE OF PERSPECTIVE AND SHAPE

Perspective and shape may appear different, but in the two-dimensional world
of visualization, shape is the only way to show perspective, and thus we treat
them as the same.

There are many ways to use shape in visualizations. The one you will be most
familiar with is to use the shape of an object as it appears in the physical world
as a representation. Examples of this are the use of shapes of countries as
used in maps, representing real objects in infographics as well as the 3D rep-
resentation of objects, or using an object as a metaphor for a size. Figure 2-21
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shows an example of using the height of buildings to represent a measure. An
interactive version of this is available at www.pwinfographics.net.
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FIGURE 2-21 A column chart implemented using buildings instead of columns

Other ways of using shapes in visualizations are similar to the ways you can
use color: as ways to differentiate between series; as ways to illustrate a point
along an axis; or as a quick way to differentiate crossing a threshold. Figures
2-22, 2-23, and 2-24 show an example of each of these.

Although this seems similar to the use of color, it's important to note that
the number of discrete values, often called the set of domain values, which
is available to us when using shapes is much less than when using colors.
For instance, the human eye struggles to differentiate between a septagon
(seven sides) and a nonagon (nine sides), whereas nine different shades of
green are easy to differentiate. The number of different shapes that allow for
ranges—such as equilateral polygons, stars, and crosses—is also much smaller
than the number of colors.
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Employment rates
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FIGURE 2-22 A scatterplot using different shapes for each set of values. The use of both color and shape is useful.
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FIGURE 2-23 A bubble chart using the size of the bubbles to show the magnitude of the visualized values
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Summary

Activity Progress Table
Actons» @ M A1 oft b Pl & Findliext [100% = B
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Target Date

Achieved Millestone:

Past Completion Date ]
.

STP8.1.1 : Upgrading households in informal settlements with access to secure tenure and basic services
ACTS8.1.1.1 : Activity 8.1.1.1

201011 201112
Milestone Hame Target Date o
and 1 of informal settlements in all provinces 2011/03/31 ! I750% [7S0% [T50% [B0%
9 confirmed provincial project lists 2011/03/31 ! |1W, '0%
Assess existing projects for compliance against delivery agreement target 2011/03/31 0% |5“
Confirm pipeline of new and existing projects 2011/03/31 p‘m
Planning, land acquisition and service provision to 20000 households 2011/03/31 |1W’
Planning, land acquisition and senvice provision to 100000 households 2012/03/31 BiE%
Planning, land acquisition and service provision to 140000 households 2013/03/31 0%
Planning, 1and acquisition and sernvice provision to 140000 households 2013/06/01 0%

FIGURE 2-24 Ticks and exclamation points used to show crossing a threshold

Sizes, on the other hand, are much easier to comprehend, but you must S~ (_/-"“"\\

take care in how the sizes are represented. The use of area versus diameter ( ) ]

to represent sizes could be challenging to read. Look at Figure 2-26 for two N

values that are 25 percent apart, using diameter and area. Which looks most

like a 25 percent increase? 7\

It is a good idea to indicate what differentiator you have used when it is N

ambiguous. If you have bars increasing in one dimension only—for example, FIGURE 2-25: Doubling

the lengths are changing—it is not necessary to state what differentiating acircle by diameter versus
doubling by area

characteristic you are using, but when a circle’s size is increasing, visually
indicating which dimension is being used is helpful to a user.

SUMMARY

In this chapter you learned about the elements to consider when choosing
and designing your visualization, balancing illustrating data by using color and
shape. This knowledge will be used as the basis of the chapters in Part 3 of
this book, guiding you to choosing a specific visualization.
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PART Il

MICROSOFT'S
TOOLSET FOR
VISUALIZING DATA

In this part

CHAPTER 3: The Microsoft Toolset

CHAPTER 4: Building Data Sets to Support
Visualization

CHAPTER 5: Excel and PowerPivot
CHAPTER 6: Power View
CHAPTER 7: PerformancePoint

CHAPTER 8: Reporting Services

CHAPTER 9: Custom Code
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CHAPTER 3

The Microsoft Toolset

Microsoft was a late entry to the visualization market. Although it had a strong
and early entry to the online analytical processing (OLAP) market, for the most
part it relied on third-party vendors to do the front-end work and focused in
the early days on the database work, allowing vendors such as Panorama and
Proclarity to take the lead. More recently, as Microsoft wanted to take more
control of the market, it started to develop and buy more of the front-end
toolset. Microsoft’s purchase of Proclarity and later Report Builder marked
a strong entry into the front-end market, but it was paralleled by a strong
independent entry in the form of both strengthening the Excel visualization
tools and developing a tool called Business Scorecard Manager (BSM), which
evolved into PerformancePoint and was eventually subsumed into SharePoint
as PerformancePoint services. Reporting Services, originally aimed squarely
at the technical user from a developers' point of view, has evolved into a self-
service tool aimed at the business user. In this chapter, you find out about the
history of the Microsoft toolset and discover how each tool fits in the tool bag.

A BRIEF HISTORY

The history of Microsoft’s business intelligence (Bl) toolset is in two parts: the
history of the analytic tools is first and begins with Microsoft’s purchase of
the OLAP engine from Panorama, which happened in 1996. In the initial days,
Microsoft focused on building SQL Server, and allowing third-party vendors
such as Panorama and Proclarity to build the front-end tools. The chart in
Figure 3-1 shows the release versions for each analytic database. It's impor-
tant to note that even the analytic databases embedded in SharePoint and in
Office are in fact developed by the SQL team and, more importantly, require
a separate installation. Read more about the evolution of these products in
the “Database Tools” section.
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OLAP Cubes —|

Report Models —

Unified Dimensional Model —
PowerPivot Services —
PowerPivol —

Tabular Model —|

|r||||

Column-store index —

1995 1996 1987 1998 1999 2000 2001 2002 2003 2004 2009 2006 2007 2008 2009 2010 2011 2012 2013 20M

FIGURE 3-1 Atimeline of the Microsoft backend tools

Development of the front-end toolset started much later, and it has a much
more diverse path. Figure 3-2 shows the introduction timelines and evolution
of each tool currently available from Microsoft.

SSRS QL 2012

PerformancePoint — BSM 2006

Fxcel —

180801/01 19930101 200001101 20000101 200210101 20030101 20040101 20050101  20068/0101 20070101 20080101 20090101 20160101 2011011 201210101 201301UD1 201401101

FIGURE 3-2 Atimeline of the Microsoft front-end toolsets currently in use.

CRYSTAL REPORTS

Although you might be thinking that Crystal Reports has been omitted, it is
not truly a Microsoft Bl product. It did come bundled with Visual Studio for
several versions, but Crystal Reports was always a non-Microsoft reporting
solution. It is currently owned by SAP/Business Objects.

Excel introduced pivot charts in Office 2000. Pivot charts are hardly true B,
yet they are quite likely the single most prevalent subset of Bl. With the ability
to connect to cubes in Analysis Services, this combination of tools was truly
the first Microsoft Bl stack.

The next entrant to the Bl field was Reporting Services. Released as an add-on
to SQL 2000 in 2004, Reporting Services was aimed squarely at the developer
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demographic; it required that you have Visual Studio and a fair degree of
technical expertise. Reporting Services served as replacement for the vener-
able Crystal Reports.

Both Excel and Reporting Services have kept their names but, as discussed
in the following paragraphs, the dashboard toolkit has had a much more
checkered history. One caveat: Reporting Services now includes Power View,
a break from the earlier naming.

Business Scorecard Manager (BSM) was the first iteration of this tool. It provided
the ability to connect to multiple types of data sources, and incorporated Key
Performance Indicator tools (read Chapter 10 for more details), as well as some
graphing capabilities. Much like PerformancePoint today, much of the power of
BSM 2005 was only provided when connecting to Analysis Services as a backend.

PerformancePoint 2007 was Microsoft’s foray in the world of Enterprise plan-
ning. With three different products (each with its own installation) sold as a
single product at a fairly hefty price point (by Microsoft standards—it was
well priced compared to the competition), Microsoft struggled to sell mas-
sive volumes of this product. The three products were PerformancePoint
Monitoring (the predecessor to PerformancePoint services that is discussed
heavily throughout this book), PerformancePoint Planning, and Proclarity.

PROCLARITY

Proclarity, a major third-party solution provider, was bought by Microsoft
in April 2006 and sold as part of PerformancePoint 2007. The product line
was discontinued along with PerformancePoint planning.

The planning product was deemed too complex for most organizations because
it required multiple skills across various Microsoft technologies, and the prod-
uct was deemed too expensive to obtain solely to have PerformancePoint.
Consequently, Microsoft started bundling PerformancePoint with the SharePoint
2007 Enterprise license from April 2009. This move, although derided by those
who had implemented the planning product, was a good one for the moni-
toring toolset.

The SharePoint 2010 release incorporated PerformancePoint Services as a
baked-in service application, making administration and installation much
easier.
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SharePoint 2013 adds theming and makes administering security simpler.

The tool history in Table 3-1 gives some highlights the released feature set.
With Excel especially, this is a small subset of the changes.

TABLE 3-1 Tool history

TOoOL VERSION  FEATURES ADDED
PerformancePoint BSM Initial release
PerformancePoint 2007 Dashboard Designer with Office Ribbon

Click-once client install
Drag-and-drop design
Multiply connected filters
Analytic charts and grids
Scorecard aggregation formulae
PerformancePoint 2010 Pie charts
Multimetric (multiple column) KPIs
Decomposition tree
Content integration into SharePoint
Connect to SharePoint filters
Dynamic hierarchies with drill down/up
Dynamic selections
Time intelligence
Calculation engine
Value filtering
Reusable filters
PerformancePoint 2013 SharePoint theming

Kerberos not required for role-based security

Excel 2000 Pivot charts
Excel XP Task panes
Excel 2003 Lists

Auto filter

SharePoint integration
New statistical functions
Excel 2007 Ribbon Ul
1 million-row workbooks
XML format
Lists upgraded to tables
Conditional formatting limits raised from three
Unlimited color pallet

www.it-ebooks.info


http://www.it-ebooks.info/

TOOL

Excel

Excel

SSRS
SSRS

SSRS

SSRS

SSRS

VERSION
2010

2013

2000
2005

2008

2008 R2

2012

THE MICROSOFT TOOLSET
A Brief History

FEATURES ADDED

Slicers
PowerPivot available as an add-in
Sparklines

64-bit Excel (essential for big PowerPivot
workbooks)

Faster conditional formatting
PowerPivot built in
Power View built in
Recommended charts
FlashFill

Initial release
DatePicker

Multi-value parameters
Report sorting of data
XML Data provider

64 bit

Report Builder 1 and Report Models
(Note: RB1 and RB2 are actually different
products, not versions of one product)

Report Builder 2 for self-service reporting
Performance improvements

Tablix

Gauge

Text formatting

Shared data sets

Report parts

Integrated GIS capabilities

Azure, PDW, and SharePoint List data sources
Sparklines

Indicators

Atom rendering extension

Aggregation expression enhancements
Alerts

Power View
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DATABASE TOOLS

Many people working in the SQL Server world don’t understand the need for
analytic databases. Especially in organizations with either small databases or
really good SQL developers, some of the benefits are not immediately apparent.

The first benefit of analytic databases is related to performance, and this ben-
efit is typically the one that blinds some SQL developers to the other benefits.
SQL databases are really good at row-by-row work, but not as good at doing
aggregations. Summary tables have often been used to solve the issue of
aggregation, and OLAP was one approach to this.

OLAP

OLAP stands for Online Analytic Processing, coined in a 1993 white paper
by Edgar F. Codd. The generic term for working with Multi-Dimensional
Analysis (MDA) is cubes, but this has been mostly used to apply to OLAP
cubes. There are subsets of OLAP: MOLAP is Multi-dimensional OLAP; and
ROLAP is Relational OLAP, in which the queries are passed through to SQL;
and Hybrid OLAP (or HOLAP) is a hybrid of the first two.

OLAP (and hence Microsoft’s OLAP product, Analysis Services) provides per-
formance benefits by aggregating data according to user defined hierarchies.
For instance, the designer of the cube defines a date hierarchy as rolling up
from Day to Month to Year (YMD), and the OLAP engine creates aggregations
at each level—for example, summarizing sales for the day, for the month, and
for the year. Other hierarchies across multiple dimensions such as the organiza-
tion or location dimensions are also created and aggregated. This can lead to
a problem called database explosion (where the size of the database increases
exponentially), and thus needs a fair degree of skill to optimize.

Partitioning is another performance enhancement technique in Analysis
Services. This works by splitting the data into partitions (for instance by region
or by month), and then queries are optimized, either by reducing the size of
the data to be queried when it exists within a single partition, or by allowing
parallelization when the data is split across multiple partitions.

An alternative method for accelerating queries is to use a column store data-
base. Whereas SQL is a row store and stores data in rows, pages, and extents,
column stores instead store each column independently. This has benefits in
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terms of not having to scan over all the attributes of a row when scanning
for large aggregations. It's a big benefit when a lot of attributes are present,
as in a typical data warehouse scenario.

Figures 3-3 and 3-4 show the differences between a column store and a row
store.

Account
Customer|D CustomerName Account

Balance Customer|D

Balance

1000000005 Sigmund von Graat

1000000006 Michael Adrian 354
1000000007 Leigh Roberts 245
1000000008 Zain Abraham 991

1000000009 Wikus van de Merwe 520

FIGURE 3-3 How a row store selects data

Adrian Smith Fano Ndlovu Jane-Ann Battalieu

CustomerlD

CustomerName n Wu

AccountBalance

Account
Balance

FIGURE 3-4 How a column store selects data

An additional benefit of column store databases is the compression that'’s
achievable. As similar data is stored contiguously, both dictionary compres-
sion and run length encoding are successful techniques. Read more on this
at Daniel Abadi’s excellent paper, which you can find at http://db.csail
.mit.edu/projects/cstore/abadi-sigmod08.pdf.

Another key benefit of column store databases (as proven in the Abadi’s paper,
as well as in much other research) is that denormalization is not as necessary
for performance reasons in a column store. This is the reason the latest ver-
sion of Analysis Services has a “tabular” mode (or at least that it is called that).
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The final reason for the Microsoft column store being so fast is that it is stored
in memory.

With the advent of much better performance on SQL Server, including the
introduction of a column store index that has all the benefits of the engine
spoken that was previously described, the other benefits of using an analytic
database become much more important.

The second benefit of analytic databases is the creation of what Microsoft
once called a Unified Dimension Model, and now calls a Business Intelligence
Semantic Layer. This layer abstracts the naming conventions of the underly-
ing database and allows for meaningful, business-friendly naming, as well as
abstracting the structures, aggregations, and calculations. The main benefit
of this is that a single maintenance point is created. If the calculation of Net
profit changes, it can be maintained in a single place and not have every
single report require changes.

The third benefit of analytic databases rolls on from the second: Report writers
and self-service users do not need to know the underlying structures or how
to write SQL queries against them, nor do they need to know the calculations
used. Instead, if they are working in a tool such as Excel, they can simply drag
the Net profit measure onto a pivot table and then drag the location hierarchy
onto the rows and have a basic report with drill-down capabilities.

In today’s world, with the hardware capabilities available, the second and
third benefits are often greater than the first—at least in the enterprise space
that has a Bl team.

In the organizations that don’t have Bl teams, an organization’s ability to
build its own “analytic databases” or cubes is important. This is where the
tool PowerPivot comes in.

PowerPivot was first introduced as a downloadable add-in for Excel 2010
and an installable add-in for SharePoint (run from the SQL 2008 R2 install)
called PowerPivot Services. The engine running underneath both of these is
the Microsoft column store implementation then called VertiPag—the same
column-store you have just read about.

In the SQL 2012 release, these options were expanded to include an Analysis
Services instance that doesn’t require SharePoint. The engine was renamed
xVelocity (@ naming choice this particular author doesn’t like—Vertipaq was
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a better name in my opinion). One of the biggest advantages of this shared
engine across the tools is that a model can be designed in PowerPivot, shared
across a team by saving to a SharePoint library, and then imported and opti-

mized by importing into Visual Studio.

Table 3-2 summarizes the toolsets available for databases with SQL 2012.

TABLE 3-2 Toolset for databases as of SQL 2012

QUERY
TOOL ENGINE LANGUAGE
Analysis Services—  OLAP MDX
Multi-dimensions (DAX now
supported)
Analysis xVelocity DAX, MDX
Services—Tabular
PowerPivot xVelocity DAX, MDX
Services
PowerPivot xVelocity DAX, MDX

Column Store
Indexes

xVelocity  SQL

NOTES

Still has capabilities such

as writeback, actions, and
parent-child hierarchies that
have yet to make it into tab-
ular mode. In addition, the
memory requirements are
much lower.

Standalone xVelocity engine.
Performance is great as long
as workload fits in RAM, but
massive degradation when
paging starts to happen

Distinct counts are much
improved over SSAS-MD

Quicker development time

A tabular Analysis Services
instance that is also con-
nected to SharePoint

An instance of the xVeloc-
ity engine inside Excel, with
a backup of the database
stored inside Excel. This
backup can be extracted and
restored to an SSAS tabular
instance

An instance of the xVeloc-
ity engine running as a
non-clustered index on SQL
Server. As of SQL 2012 SP1,
these are non-updateable
(they need to be rebuilt for
any changes) and can’t be
clustered.
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THE PLACE OF EACH FRONT-END TOOL

Chapter 2 introduced the concept of strategic, tactical, and operational views,
with a statement that the tools loosely match to the following concepts:

PerformancePoint is the strategic tool, allowing for monitoring of business
metrics and some analysis when the values are out of band.

Excel is the tactical tool for data exploration. It is split into two pieces,
with PowerPivot being the data integration tool, and Power View being
the visualization tool.

Reporting Services fits in as the operational tool, showing detailed data.
In reality, this view is off-kilter, with quite a lot of overlap.

Historically, these tools were developed by different teams within Microsoft,
which is why there’s some overlap. Table 3-3 shows the differences in the tools.

TABLE 3.3 Front-end tools

TOOL

PerformancePoint

SSRS

Excel/Excel
Services

Power View

PROS

Scorecards: High-level
overview, drill down
Analytics : Interactive
High fidelity

Advanced visualizations

Drill down/drill through—
can be dynamic, requires
more work

Fully customizsable
High fidelity

Very interactive—data
exploration

Animations
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Not totally customizable

Interactivity requires work
and even then is limited

Loses fidelity in Excel
Services

Not as interactive
with other SharePoint
components

Not a great deal of control
over visualizations

Requires a model for
visualizations

Gimmicky GUI
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It is very important to keep in mind that each tool has its place. It is not the
case that an organization will only choose a single tool and implement every-
thing on it. This is commonly the case with either Excel or Reporting Services
as they have been aimed at different users. Instead, it is vital to choose the
appropriate tool for each task.

PerformancePoint is really strong at the monitoring and guided analysis tasks.
The designer of the report knows what needs to be monitored—for instance,
sales per store—and also knows that when an out-of-band value occurs, the
person looking at the value is likely to analyze the cause through a finite set
of choices. For instance, the person is likely to take the sales figure and break
it up by date, salesperson, or product to determine exactly where the problem
is coming from.

Reporting Services is used for reports and visualizations that are likely to
remain mostly static—for example, a monthly management report, an engi-
neer'’s report, or a spatial visualization. The data that feeds these reports are
dynamic, but the interactivity is limited.

Excel (and this author includes PowerPivot and Power View in this description) is
an interactive experience for users who might not know up front how they will
combine and analyze the data and instead want to discover meaning in data.

These roles map to the retail example in Chapter 2.

When to use PerformancePoint:
An analysis services cube (multidimensional or tabular) is available.
Glance-and-go dashboards are required.
Users are likely to need to change the view displayed.

Integrating Reporting Services or Excel within a report is required.

When not to use PerformancePoint:
Control over aspects such as color is required.

Dashboards need to be printed.
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When to use Reporting Services:

Specific visualizations, such as ranges and maps, are required.
High visual fidelity is required.

Reports need to be printed.

When not to use Reporting Services:
Dynamic measures are required.
Slice and dice capabilities.

Anonymous access is required.

When to use Excel:
Interactivity is required.
No cube is available (build one through PowerPivot).

A higher level of control over individual chart elements is required (for
example, drag-and-drop positioning of chart labels).

Possibly the fastest development using pivot tables and charts.

When not to use Excel:

Guided interactivity is necessary—it's better in PerformancePoint.

When to use Power View:
Animation is required.

Cross-filtering between charts.

When not to use Power View:

When any control over chart formatting is required—it is even more lim-
ited than PerformancePoint.

INSTALLING THE SAMPLE DATABASES

The two samples are in SQL server database format and in Analysis Services
tabular mode. You need SQL 2012 for both.
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To restore the SQL database, open Management Studio, right-click Databases,

and choose Restore. Select the Device radio button, and click the ellipsis to
see the screen in Figure 3-5.

Click Add, browse to the VvI_UNData.bak backup file, and click OK. Type
VI_UNData in the Database Name field and restore the database.

For restoring the Analysis Services database, ensure that you have Analysis
Services running in tabular mode (you may well need to run the SQL install
again if you chose all the defaults because multi-dimensional is installed by
default), and connect to it in Management Studio.

.. Restore Database - ",\1‘ (=] 3]
@ Mo backupset selected to be restored.
Select a page f Saeript - | IByHeip
5 General
1% Files
2 options £ A0
" Database: | =l
= Devics: I E
Database: I |
Destination
- I ﬂ
m= select backup devices =] ) S
Timeline, .
Specify the backup media and its location fior waur restore operation,
Backup media type: =
Fibi Checkpaint LW | Full L
Add
Hemoye
Cantents

Connection 1

A MGS-MEE00|SQL2012
[MGS-2012BThadministrakor]

0K I Cancel | Help |

Yiew connertion properties 4
9 3
Ready I I _I
Yerify Bachup Media
oK | Caneel | Help |

4

FIGURE 3-5 Restoring a SQL database

You need to copy the backup to a folder that Analysis Services can access.
You can check what these are by right-clicking the instance and then click-
ing Properties. The information tab has a line item called BackupDir as in
Figure 3-6. Copy OECD_Data.ABF to this folder.
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-loix|
Seeclapage 5 seript - 17 Help
7 Information
% General
(% Language/Callation M arne [ Valug | CunentValue =
2 Secuiy BackupDir C:\Program Files\Microsoft SOL ServertM5A511.50L2012TABULARAD LAP B ackup C:“Pragram File.
CommiTimeout 0 0
CoordinatorE xe. . -4 -4
DataDir C:\Program FilesiMicrosoft SOL Server\MSAS11.50L2012TABULARNVOLAPAD ata C:\Pragrarm File..
DataMining & &ll...  false false
Dratabining S Al false false
Daatabdining % M 1} 1}
Feature % Coml) false: false
Feature S LinkFr..  false false
Feature % Linkln...  true tue
Feature % LinkT...  false false
ForceCommitTi 30000 30000
Log % FlightRec. true true o
Log % Querplog. false: false
. Log* QuenlLog..
Logh Quenleog.. 10 10
Server. Log % Querplog..  OlapQuerlog OlapQueryLog
MGS-MEGIMSAL20T2TABLILAR LoaDir CAProgram FllestMicrosoft SOL ServertMSAS11.50L201 2TABULARMILAP Log £ \Program Fie.
Connection bemaony b Hard 1} 1}
MES-201 2B1%administrator Memar \ LowM... | 85 o
37 View connection propetties Memoy \ Total.. | 80 e hd
4| | _’l—l
™ ShowAdvanced (A1l Propetties
Fieady

¥ Save Only Modified Properties Reset default
Y

%

FIGURE 3-6 Analysis Services backup directory location

= ]') MGES-MEEODYSQLEOL2TAEULAR (Micrasoft Analysis Server 11,0,3000,0 - MG5-20 Right-C“Ck Databases and choose Restore. Browse to
= [[3 Databases . .
[ BiaTransactionistary OECD_Data.abf in the backup folder, and then type in
bJ irol‘:?pfr‘iasbol:scube the name of the Database (OECD_Data), and restore it.
|| InsightCube_Exclusions
| 1] MixTel Agaregator - UAT 3 A
= [ oEco_pata Your final step is to connect this cube to the SQL data-

base you restored previously. Right-click Databases and
[ Tables i
3 Rles choose Refresh to show the database you just restored.
| pECOPopulationstats .
[ PowerPivotTimesheetsimport Open OECD_Data.abf, expand the connections, and
lj m;ﬁfﬁ:ﬁfm'?m then double-click the connection as shown in Figure 3-7.

|| sPanairobi
| 1| TabularbigProduct

In the Connection Properties dialog box, click the
Connection String property and then click the ellipsis
next to it to see the connection string builder shown
in Figure 3-8.

FIGURE 3-7 Changing an Analysis Services
Connection

Set the connection to your SQL database and test the connection. If you get an
error, you may need to edit the security settings on your SQL Database. Start
by going Start > All Programs > Microsoft SQL Server 2012 > Configuration
tools > SQL Server Configuration Manager. Click SQL Server Services and
check what account Analysis Services is running under, as shown in Figure 3-9.
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g =1

27 General

=

=
Server
MGS-MEE00NS QL2012TABULAR
Conrection:
MGS-201 281N administrator
3 View connection properties
G
5

Ready

E General
Connection Sting

Provider=SQLNCLI11.Data Source=. \sqIZIJ‘

Connection Manager ]

Pravider: I Mative OLE DEVSGL Server Mative Client 11.0

Server name:

y

I.lsql2012

j Refresh |

Connection
Log on ko the server
@2 % Use Windows Authentication
h III T Use SQL Server Authentication
A

User mamme: I

Password: I

I | save my password

[~ Connect ko a database

% Select or enter a database name:

[¥1_nData

 pttach a database file:

Logical name;

QK

Cancel

Help

Tesk Connection

FIGURE 3-8 Analysis Services connection string builder
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4
=10l

Ll AR ERER 7 JICRORONC

8 SQL server Configuration Manager (Local)

E] SQL Server Services

SQL Server Nstwork Configuration [32bit)

. S0L Native Client 11.0 Configuration (32bit)
. 5QL Server Network Canfiguration

. 50L Native Client 11,0 Configuration

[3)39L Server Analysis Services (3QLEKERZ) Running
Twywindows Internal Database (MICROSOFT# #55EE) Stopped
EhsaL server (so12012) Running
EhsaL server (soL2KERZ) RUMning
$HI5aL Fulktext Fiker Daemon Launcher (SQL2012) Running
AD959L Fulktext Fiker Daemon Launcher (SQLZKERZ) Running
[Eh5aL Server Reporting Services (SQL2012) Running
Haysal server Agent (SQL2012) Stopped
Fm5aL Server Agent (SQLEKSRZ) Stopped
5L server Browser RURRing

Automatic
Manual
Automatic
Automatic
Manual
Manual
Automatic
Automatic
Manual
Automatic

harme: [ state Stark Modz [Logonas [ Process Ip [ service Type |
[ F50L server Inteqration Services 10.0 Running Automatic MGS-Z01ZENsveQL 2635
FR50L Server Inteqration Services 11.0 Running Automatic NT Service|MsDtsSer... 2720
(3150 Server Analysis Services (POWERPIYOT) Running Automatic MGS-Z01ZBNisveSQL 2896 Analysis Server
(150 Server Analysis Services (5012012) Rurring Automatic MGS-2012BIsvCS0L 2352 finalysis Server

An

MGS-2012BTisveacL Analysis Server
NT AUTHORITYiNEL. . O QL Server
mos-201 2biladminist... 16285 SOL Server
MGS-2012BIisveSGL 3108 SQL server

NT Servics\MSSQLFD... 12316

NT AUTHORITVILOC... 6240

MGS-Z01ZETisveIGL 3663 Reeport Server

mgs-2012bi\administ... 0
MGS-201ZBTisveSqL o
NT AUTHORITYILOC...

0L Agent
SOl Agent

FIGURE 3-9 Analysis Services Service account
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Now, go to your SQL database

= [3 MES-MEE00LSOLZ012 (S0L Server 11.0.3000 - ME5-2012BTadrinistrator)

"1 Databases

and expand Security and then = [ Securiy

. _— = o
Logins, as in Figure 3-10. If the g. #[ Mewlogn.. |

#i "

login exists, double-click it; oth- Y _rr

. . . & # hel ¢
erwise, right-click and choose ¢ ——

. A, Reparts b onE#
New Login. B ———
A me Refresh

A MES-2012B0Administrataor
'g MGES-2012BIMDS_ServiceAccounts

If you created a new login, first
A MGS-2012BIsvcSPS

search for the Iogin you identi- A MGE-2012BT|sve50L
. B A NT AUTHORITHSYSTEM
fied in the configuration screen, A NT ServicelMS50LES0LED1Z
. (5 MT SERVICE\SQLAgent$SQLZ01Z
and choose it. A NT SERVICE|SCLuriter
A NT SERVICE|Winmarat
. ﬁ: ]
Next, go to the User Mapping (3 Server Rokes
. . [ Credentials
tab and, as shown in Figure 3-11, 3 Cryptographic Providers
3 Audits
Select the VI_UNda ta data' £ server Audit Specifications
Server Objects
base. Ensure that the database S ronleaton
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FIGURE 3-11 SQL Server username mapping
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This process allows Analysis Services to access the database, so go back and
change the connection appropriately.

SUMMARY

This chapter discussed the background of the Microsoft tools that you work
with throughout this book. The remainder of the chapters in this part of the
book take you through the tools themselves in detail, laying the foundation
for creating visualizations as well as guiding you in choosing a tool to create
your visualizations.
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CHAPTER 4

Building Data Sets to
Support Visualization

This chapter focuses on the building of data sets and storing them in formats
conducive to data access and creating great visualizations. We will cover a
number of common and more unique data sets and discuss specifically the
uses, types of data, creators and consumers, and benefits or drawbacks to
each data source.

WHAT DATA SETS ARE

Data sets are groups of information that may be stored in a number of formats
in today’s digital age. These formats can include lists of customers, products,
sales records, or even logs from a server or computer system. These sets are
then combined in a number of different ways to produce information that
businesses can use to drive decisions.

WHY WE NEED THEM

We need these data sets to help us answer questions such as these:
What are our customers buying?
What products are the most profitable?
What kinds of trends do we see in our sales over time?

How do these trends affect the buying behavior or volume of sales?
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“Itis a capital mistake
to theorize before
one has data”

SiIR ARTHUR CONAN DoYLE

These and other questions are important to any organization that is looking
to get more insight into how it does business. Your business is often faced
with these kinds of questions (and their more complex versions), and having
data sets available to work with will enable folks (soon to be you) to gain the
know-how to use them to provide answers.

HOW DATA SETS ARE CREATED

Data sets get created in a number of ways: automatically by some systems,
by teams of people, and by organizations for publishing. In this chapter you
learn to use a couple of the most common methods, including the following:

Cut\copy and paste
Import or export from a computer system

Manually entering data that comes from offline sources

Any one of these methods might be easier for your particular situation, as you
learn later in the chapter where each of these methods is discussed, but they
are all focused on bringing different pieces of data (customer names, products
purchased, registrations, and/or other important data points) together to paint
a picture of activities and conditions that you want to analyze.

WHY DATA SETS ARE IMPORTANT

The data sets mentioned in the previous section are important since you
need good source data to ultimately create great visualizations, and they
are the reasons this book was written. These data sets, and the systems or
processes that create them, become the basis for all the analysis you will
do. Their capability to provide clean and accurate information, a consistent
approach to organization of the data, and completeness of the included fields
is directly proportional to the quality and quantity of analysis that those sets
of data will support.

COMMON DATA SET ELEMENTS

Data sets share a number of elements or qualities that help you work with
them and navigate their contents to reach the information you're looking
for. This section dives deeper into those to help you understand what to pay
attention to.
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DATA QUALITY

You should spot check or, if possible, do a more in-depth analysis of the data
you've accumulated to make sure it is accurate and free of miscellaneous
characters and punctuation that might cause you a problem when writing
expressions or formulas in your visualization platform. Being able to count
on clean data is a great advantage for the visualization techniques you are
learning in this book. This means if you are pulling this data from different
sources or locations that may have been manually updated or altered, you
need to pay special attention or go through a cleansing process where the
data is reviewed for accuracy.

DATA RATINGS

When possible, it is good to triangulate between data sources. For instance,
when working with data such as the national GDP, you may pull data from
the Organisation for Economic Co-operation and Development as well
as the CIA fact book. Internally, you may cross-reference data from your
ERP, financial, and CRM systems. When doing so, it is often good to give
your data a rating that can be surfaced in your reports—for instance, if all
three systems agree, that's gold or 100%; if two systems agree, that's silver
or 67%, etc. The percentages are useful when you look at many of these
data points in aggregate. If you have only one or two data points with low
confidence, you can trust your aggregated data.

METADATA

Hand in hand with clean data go descriptive column headers. If you do not
have these in place, you will have to adjust them later in the data consump-
tion cycle, which might impact the performance and methods you can take
to visualize your data. See a good before and after example of descriptive
column headers in Figure 4-1.

Metadata is important because many visualization tools will pull this informa-
tion in to allow you to reference your data by its descriptive properties so you
can navigate the data sets more easily.
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AW00011602 Larry Gill 4/13/197712... S M larryl6@advent...
AW00011603 Geoffrey Gonzalez 2/6f197712:... S M geoffreyls@adv...
AWO00011610 Blake Collins 4{23/197512... S M blaked7@advent...
AW00012517 Alexa Watson 8/25/197712... § F alexa0@adventu...
AW00012518 Jacquelyn Dominguez 9/27/197712... S F jacquelyn13@ad...
AW00012519 Casey Gutierrez 12/17/19771... S M casey34@advent...
AW00012714 Colleen Lu 7/17/197312... S F colleenll@adve...
AW00012728 Jeremiah Stewart 6/26/197912... S M jeremiah4a@ad...
AW00012871 Leah Li 10/6/1976 12... S F leah2@adventur...
AWO00013671 Frank Ramos 2/7/197412:... S M frank25@advent...
AW00013826 Candice He 11/25/19771... S F candice2@adve...
AW00013830 Andrea Cox 8/3/197712:... S F andreall@adve...
AW00013838 Jill Rubio 6/27/197612... § [F jill29@adventur..
AW00014838 Darren Alvarez 7/26/197712... § M darren26@adve...
AW00014839 Natasha Sanz 5/18/197712... S F natasha20@adv...
AW00014840 Autumn Zhu 10/23/19771... S F autumnl3@adv...
AW00014848 George Louverdis 9/10/197512... S M georges@adven...
AW00014849 Dwayne Martin 10/12/19751... S M dwayne0@adve...
S M

AW00014991 Edwin Zhao 2/26/1976 12... edwinll@adven...

FIGURE 4-1 Before and after descriptive column names

FORMATTING

Data formatting is also important. If you have currency values, make sure they
reflect the correct currency. If you have international data, make sure any
nuances for handling other languages are in place, such as support for inter-
national font types, and so on. Problems with language-specific characters or
alphabets is often not an issue if the data is coming from a modern computer
system, but can be the case if it is manually entered. Other concerns for inter-
national data include special accents or punctuation formatting. Spreadsheets
can shine here because data enhancement can be easily done by a business
user or administrative professional and does not require IT interaction to
change the data. See a good example of proper data formatting in Figure 4-2.

DATA VOLUME

The volume of data you're working with needs to be in the manageable range
for the tools you're using. There are technologies better suited for greater
volumes of data such as SQL tables; tabular models; and, of course, Hadoop
for very large volumes. Excel will handle up to 100,000 to 200,000 rows and
then will begin to experience some performance problems with scaling that
many rows. There is also a hard limit at 1 million rows. Make sure you are aware
of the types of problems you might run into. These types of sources will be
covered more in depth in this and future chapters, but it's important to make
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sure you know that you can start with a smaller set of data and then begin
working with larger sets once you're comfortable with the types of analysis
that you're performing.

v

larryl6@advent...

a

4

. Partial College Estudios universitari... Baccalauréat Clerical Administrativo
geoffreyl6o@adv... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
blake47@advent... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
alexad@adventu... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
jacquelynl3@ad... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
casey34@advent... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
colleenll@adve... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
jeremiah44@ad... Partial College Estudios universitari... Baccalauréat Clerical Administrative
leah2@adventur... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
frank25@advent... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
candice2@adve... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
andreall@adve... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
jill2s@adventur.. Partial College Estudios universitari... Baccalauréat Clerical Administrative
darren26@adve... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
natasha20@adv...  Partial College Estudios universitari... Baccalauréat Clerical Administrativo
autumnl3@adv... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
george5@adven... Partial College Estudios universitari... Baccalauréat Clerical Administrativo
dwayne0@adve... Partial College Estudios universitari... Baccalauréat Clerical Administrative

Estudios universitari... Administrativo

edwinll@adven...

Partial College

FIGURE 4-2 Proper data formatting

Baccalauréat

Clerical

AUTOMATED DATA

If you have calculated values in your data, you need to make sure those are
identified. Spreadsheets and other data analysis tools can create powerful
calculations, but they may have some limitations as you begin to use them
for sourcing. For example, in some cases, drill-through functionality is limited
based on the type of calculation and where it is in your data source. If it is
coming from an OLAP cube, there will be limited functionality if it is being
calculated in the OLAP layer and not in the spreadsheet. In addition, data that
is autogenerated may have lots of repeated information that you don’t need,
and importing it would only make your analysis tasks more cumbersome.

TYPES OF DATA SETS AND SOURCES

There are many different types of data, from lists of people and products to
financial documents and more. This section reviews some of the important
sources you will see most often in projects like those in this book.
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DATA IN THE INTERNET AGE

It's no secret that in today’s enterprises many organizations are finding data
in all sorts of new places. Departments are doing more of their own IT and
analysis, and the concept of self-service reporting is no longer a myth; it is
rapidly becoming the norm. Folks are using data from wherever they can
access it to give them a leg up on doing better analysis and finding more
insight from data they already have. This section covers some common data
sources you will run into in an enterprise and when you may want to leverage
them for storing your data as you collect it.

SPREADSHEETS

Spreadsheets, which are one of the most common data sources, are popular
because they are so easily created and very accessible. Spreadsheets can
store many different types of data, but typically store financial information
and extracts from other systems, and function as a collection point for data
consolidated from many other sources. A recent Gartner report said that more
than 90% of all the reports in the world wind up in Excel to be manipulated.
With that being the case, it is easy to see why Excel and spreadsheets became
such a critical source for our data.

WHEN TO STORE DATA IN A SPREADSHEET

Spreadsheets are typically created by analysts and then consumed by analysts,
sales professionals, and executives. Professionals in many departments are
consumers of this data, and in many cases it is reviewed in a meeting either
on a shared screen over the Internet or on a projection in a conference room.
Spreadsheets are consumed in many ways, but the most important thing to
remember about the simple spreadsheet is that it's not really simple at all.
Spreadsheets can have complicated formulas and macros built into them.

These complications can cause challenges when using spreadsheets as a
source and should be mitigated as part of your data processing or loading,
depending on how the visualizations are being sourced. Some of these con-
cerns can be mitigated by converting your spreadsheets to use PowerPivot or
a tabular model (more on this later). These options give you more powerful
capability to embed calculations that will perform better on larger volumes of
data. Spreadsheets are an incredible, powerful source and will likely be used
extensively in any visualization exercise, but remember that data may not need
to be sourced directly from spreadsheets and to use the most appropriate
source for the type of visualization desired.
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Spreadsheets can provide an easy-to-use and easy to source (i.e., many tools
connect to it directly) platform for data visualizations if your data size is rela-
tively small and you have a need to easily combine data from multiple sources.
If you can leverage the power of Excel’s functions and features to help ensure
that your data is high quality and formatted appropriately for consumption,
this might be a great option for you. Next, let’s talk about using data stored
in a database for our source.

HOW DID WE GET TO EXCEL?

Spreadsheets (which are covered later in this chapter) form the foundation
for organizing data in the digital age. In 1978, Harvard Business School
students Daniel Bricklin and Bob Frankston came up with the idea to cre-
ate an interactive calculating program called VisiCalc. This was one of the
first programs that led to the functionality that we know as a spreadsheet
program.

Spreadsheets are wide, flat pages with columns and rows that organize
data about particular transactions for a business purpose. It spreads the
information across a sheet for the business person to analyze, hence the
name. VisiCalc came out of the original spreadsheet world developed by
Professor Richard Mattessich in 1961. He used mainframe computers and
a new programming language called LANPAR.

Lotus 1-2-3 came along in 1980 and was the first “modern” spreadsheet.
Microsoft then countered with Excel (written originally for the 512K Apple
Macintosh) in 1985. Microsoft acquired Lotus in 1995 and with the advent
of DOS and then the Windows operating system, Excel has grown to be
the most widely used spreadsheet application in personal use and by
businesses around the world.

SQL TABLES

SQL tables are another common source, although they are typically accessed
and leveraged differently. When the term SQL table is used, many times we are
specifically speaking about a table that is in a relational database. This can be
a data warehouse or data mart, CRM system, ERP solution, or simply a table
in a Microsoft Access database that a user has created to do an individual
analysis. This is a pretty common solution for many organizations that do not
have a cohesive strategy for data management and reporting. Many users are
taking the “I'll-find-it-myself” strategy and managing the extraction of data
from a number of different places in the organization.
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The types of data stored in tables are usually more organized physically than
in spreadsheets or other locations, but this can be deceiving. Just because
the data is organized well physically, stored in tables with relationships, and
labeled in detail, doesn’t mean that the application or user process that is
populating them has the right amount of governance or access rights built in.
That governance is critically important because when you are building data
sources for visualization, data quality is so important. A key part of creating
data visualizations is knowing the data well enough to help others understand
and interpret it more effectively. Storing data in tables is normally a byproduct
of that data coming from another source where it was worked with previously,
then put in a table, and is now persisted that way. If you're going to keep the
data, add to it, and continue to improve it, a table is often a better long-term
location than a spreadsheet that could be easily deleted from the file system.

OLAP AND TABULAR MODELS

OLAP and tabular models are terms for systems that store data in a special
format called multidimensional, or in the case of tabular, as a column store
with a multidimensional interface. This means the data is designed and stored
in a way that allows the end user to connect data across different business
segments more easily. These models are usually set up by developers or
power users and deployed to a server in your environment. This provides
a trove of data for end users to navigate through and begin to explore and
build visualizations. These are very common data sources and are made up
of data from tables and other sources to consolidate the information in one
place that other tools can connect to and analyze.

PowerPivot is an instance of a tabular model embedded inside Excel and can
be published from PowerPivot to Analysis Services.

REPORTS AND DATA FEEDS

Reports and data feeds are also good sources of data. May tools these days can
connect directly to reports and data “feeds,” or online streams of data. These
tools can pull this data in as if it were a spreadsheet or table and enable users
to work with it in more creative ways. These sources are advantageous because
many times the security and integrity of the data was already addressed
upstream in the process. The risk is that using reports as data sources for other
reports can lead to a long chain of reports pulling data from reports and lead
to a scenario where the data has gotten polluted—that is, the figures coming
through are wrong.
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HADOOP AND OTHER NONRELATIONAL SOURCES

You may have heard the term Big Data around your organization or in the
industry; it often means someone is referring to unstructured or loosely
organized data that comes in large volumes. These sources come with their
own tools to analyze the data and powerful results can be generated. Caution
should be taken, however, because this data has not been cleansed or orga-
nized, is often quite raw, and should be used for exploratory purposes only
before moving it to a more stable and organized framework for specific or
in-depth analysis. This analysis can be done in Hadoop, but is not typically
for beginners who are more familiar with visual tools.

Map-reduce, the algorithm underlying technologies such as Hadoop, is at its
heart a mechanism to split a processing problem into parts (the map part of
the name), distribute the data among nodes, do the processing (the reduce
part of the name), and then recombine the data. A diagram of this process
sourced from http://code.google.com/p/mapreduce-framework/wiki/
MapReduce is shown in Figure 4-3.

compu-
tation

FIGURE 4-3 Map-reduce
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CREATING DATA SETS FOR
VISUALIZATION

When you create data sets specifically for visualization there are tasks and
priorities you need to pay close attention to that make the process much
smoother. Now is the time to learn them! Let’s get started.

COPY AND PASTE

Many data sets are composed of data from other locations around the orga-
nization. Although this is part of the power of the spreadsheet, it is also dan-
gerous. This data has now become portable and static in its current form, but
being able to combine a text file containing customer and marketing mailing
list data with geographic information can significantly enhance our ability to
create great visual effects with our data while keeping its preparation time
and effort manageable.

EXPORTING DATA FROM SYSTEMS

Users, developers, and administrators can export data from systems. The user
can also get data from an automated feed or e-mail delivery. Although export-
ing data is a good way to get data in some cases because the format will be
predictable, it may not be the most intuitive or flexible method. Review your
options to see whether this is the best fit for a first data set. An example of
this is a SAP user with the appropriate rights exporting data to a format such
as CSV, which can be opened in Excel or imported into a database for analysis.

IMPORT TECHNIQUES AND TOOLS

Through Excel’s built-in functionality, much of this data is imported from
enterprise or departmental systems and then combined to create a unique,
business-oriented view of a product, service, or internal data focus point. This
importing is done easily by most end users and provides a quick and easy
way to get data in while maintaining connections to those sources so data
can be reimported at some point, if necessary. Tools such as Microsoft Access
or SQL tables may be used as sources, so Excel can do some additional data
preparation not easily performed in the source.
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GETTING STARTED

In this chapter you create a representative data set like those you use through-
out the book. So make sure you have all the sample files downloaded for the
book to follow along as we move forward.

YOUR FIRST DATA SET

When creating your first data set, it is important to get advice from others in
your organizations about an easy data set to begin working with. Alternatively,
you can start with some of the samples included in this book or with other free
data from sites such as Data.gov, infochimps.com, and others where free data
is available for download. Working with data that is familiar is often a good
exercise because it helps reduce confusion for folks new to these techniques.

Check with your developers, analysts, and administrators for data that you're
allowed to access, or pair up with someone working on a data project and
offer some “free” help to get some exposure to the processes used in your
organization for this type of work. This exposure can be invaluable when learn-
ing how to better visualize data because you'll have additional perspective
on what folks like and dislike when it comes to reviewing their information.

YOUR FIRST DATA SET

In this chapter you work with a simple and freely available database from
Microsoft called AdventureWorks. You can download this database at http://
msftdbprodsamples.codeplex.com/. The file you want is the SQL Server
2012 DW database. When it downloads you will need to attach the files to a
SQL Server instance. If you have trouble with this please see your database
administrator. This will work with all editions of SQL Server 2012.

Other chapters use data sets provided by the authors with the book, and
obtained from the Organisation for Economic Co-operation, so be sure to
review the sections in each chapter that cover installing and configuring those
data sets along with the instructions provided in Chapter 3 for installing all
the data sets at one time. Installing them all at once will provide the best
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overall experience as you move through the chapters’ walkthroughs. The
data sets were carefully crafted to support the walkthroughs and demos, and
some chapters have data sets to make them more approachable while others
have very specific sources of data to be able to showcase specific features in
a product or approach.

GETTING DATA

The first step is getting some data, so open Excel and connect to your data-
base, as explained in the following steps.

With Excel open, go to the Data tab and select Get External Data > From
Other Sources > From SQL Server, as shown in Figure 4-4.

H s Book! - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW POWERPIVOT
[=] Connections H 1 A H Clear Y — —
rn e 2 Em y =
@ ® El '¢. =~ Properties - Reapply =0
From From From [From Other Existing Refresh o Hive ZAl Sort Filter Textto Flash Rernove Data Consolida
Access Web Text | Sources~ | Connections  All~ Edit Links Pane Yo Advanced  Columns  Fill Duplicates Validation ~
Get Exl From SQL Server t & Filter Data Tools
D Create a connection to a SOL Server table, Import data into Excel as a
H5 - Table or PivotTable report,

From Analysis Services
P Create a connection to a SOL Server Analysis Services cube, Import data
into Excel as a Table or PivotTable report.

A E D From Windows Azure Marketplace ] K L M N o
1 .\=/ Create a connection to a Microsoft Windows Azure DataMarket Feed.

! **  Import data into Excel as a Table or PivotTable report.

2 From OData Data Feed

3 [% Create a connection to an OData Data Feed. Import data into Excel asa
4 Table or PivotTable report.

5 From XML Data Import

5 [% Open or map a XML file inte Excel.

7 From Data Connection Wizard

é Import data for an unlisted format by using the Data Connection Wizard
g and OLEDE.

10 From Microsoft Query

1 Import data for an unli:te.d f.orr.nat by using the Micrp:oﬂ Query \"."iz.ard
12 and ODBEC, Functienality is limited for compatibility in previous versions,
13

14

15

16

17

FIGURE 4-4 Connecting to your data source
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Select the tables you want to import, as shown in Figure 4-5, and

click Next.

Data Connection Wizard

Select Database and Table
Select the Database and Table/Cube which contains the data you want.

Select the database that contains the data you want:
v
Connect to a specific table:

|:| Enable selection of multiple tables

Mame Owner Description  Modified Created

vEmp\oyee HumanResources 3/14/2012 1:14:55 PM
vEmp\oyeaDepartment HumanResources 3/14/2012 1:14:55 PM
vEmp\oyeaDepartmentHistory HumanResources 3/14/2012 1:14:55 PM
vJobCandidate HumanResources 3/14/2012 1:14:56 PM
vJobCandidateEducation HumanResources 3/14/2012 1:14:56 PM
vJobCandidateEmployment HumanResources 3/14/2012 1:14:56 PM
vAdditiona\Contact\nfo Person 3/14/2012 1:14:55 PM
vstatePm\rinceCouﬂtryRegion Person 3/14/2012 1:14:56 PM
vProductAﬂdDescription Production 3/14/2012 1:14:56 PM
vProductModalCatangDescnptiun Production 3/14/2012 1:14:56 PM
vProductModaHnstructiuns Production 3/14/2012 1:14:56 PM
v\-’eﬂdorWithAddresses Purchasing 3/14/2012 1:14:56 PM
vVeﬂdorWithCoﬂta:ts Purchasing 3/14/2012 1:14:56 PM
v\nd\vidualcustomar Sales 3/14/2012 1:14:55 PM
vPersonDamograpnics Sales 3/14/2012 1:14:55 PM
vSaIesPersun Sales 3/14/2012 1:14:56 PM
vSaIesPersunsa\esByFiscaWears Sales 3/14/2012 1:14:56 PM
vStoreWithAddrasses Sales 3/14/2012 1:14:56 PM
vStoreWithContacts Sales 3/14/2012 1:14:56 PM
vStoreWithDamograpnics Sales 3/14/2012 1:14:56 PM
B8 awsuildversion dbo 3/14/2012 1:14:19 PM
Databaselog dbo 3/14/2012 1:14:19 PM

Import relationships between selected tables

Cancel < Back

FIGURE 4-5 Selecting tables to import

Choose the Table option, as shown in Figure 4-6.

CLEANING YOUR DATA

You can clean this data up by removing some columns you do
not need. Then you are ready to begin analyzing the data using
many of Excel’s tools (more on this in future chapters).

Next you make some formatting changes to allow for better
visualization.
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» I

Select how you want to view this data in your workbook.

[ @ Table
PivotTable Report
7 PivotChart
Power View Report
E ) only Create Connection
‘Where do you want to put the data?
Existing worksheet:

=5Hss|
(O) New worksheet

|:| Add this data to the Data Model

=

Z:3

Cancel

FIGURE 4-6 Create a new table in Excel
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DATA CLEANSING

The process of data cleansing can often be messier than this: when pull-
ing from sources such as those used for the book, data will often need to
be pivoted (the rows and columns swapped) and headings repeated, and
this will often be a manual process when working in tools such as Excel.
Integration tools such as SQL Server Integration Services are commonly
used when this needs to be automated.

MOVING YOUR DATAINTO A GOOD FORMAT FOR VISUALIZATION

Now that you have your data in a good clean layout, you can format it as a
pivot table, which is a basic type of visualization but is very powerful within
Excel. After you've formatted your data as a pivot table (as shown in Figure 4-7),
you can begin to do some nice drag-and-drop analysis on the data, as shown
in Figure 4-8.

= TABLE TOOLS
HOME  INSERT ~ PAGELAYOUT ~ FORMULAS ~ DATA  REVIEW  VIEW  POWERPIVOT DESIGN

Table Name: Summarize with PivotTable Properties Header Row First Column Filter Button =
T Adventy Remove Duplicates Open in Browser Total Row =
Export Refresh =
Resize Table Convert to Range Slicer Unlink Banded Rows Banded Columns
Properties Tools External Table Data Table Style Options
Table__. .. ~ fe

TransactionlD |« | ProductiD | ~ | ReferenceQrderlD |~ | ReferenceOrderlLinelD |~ |TransactionDate |~ | TransactionType |+ |Quantity |~ |Actu

2 100000 784 41590 0 9/1/2007 0:00 W 2
3 100001 794 41591 0 9/1/2007 0:00 W 1
4 100002 797 41592 0 9/1/2007 0:00 W 1
5 100003 7938 41593 0 9/1/2007 0:00 W 1
e 100004 799 Create PivotTable ? 1
7 100005 800 1
P 100006 801 Cn_oosetne data that you want to analyze 1
P 100007 954 (®) Select a table or range 1
10 100008 955 Table/Range: |Table_._AdventureWorks2012 Transactionl |7 1
1 100009 966 (_) Use an external data source 1
12 100010 968 Choose Conned 1
13 100011 972 Connection name: 1
14 100012 973 Choose where you want the PivotTable report to be placed 1
15 100013 974 (®) New Worksheet 1
16 100014 977 () Existing Worksheet 1
17 100015 981 Location: 555 1
18 100016 989 Choose whether you want to analyze multiple tables 1
;i iﬁg 2;; [] Add this data to the Data Model ;
21 100019 514 L 3
22 100020 516 e u 21 2y evur vaws v 2
23 100021 517 41611 0 9/1/2007 0:00 W 4
24 100022 518 41612 0 9/1/2007 0:00 W 7
25 100023 519 41613 0 9/1/2007 0:00 W 1

FIGURE 4-7 Create a pivot table
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BUILDING DATA SETS TO SUPPORT VISUALIZATION
Your First Data Set

First things first: Highlight your entire table, go to the design tab, and select
Summarize with pivot table (see Figure 4-7). This will convert your regular table
into something you can use for the drag-and-drop (or slice and dice) type of
analysis mentioned earlier.

Next, drag the column names you'd like to filter or sort to the field box in the
PivotTable Fields list. You must click somewhere in the table for this to work.
You will begin to see results like those shown in Figure 4-8.

PIVOTIABLE 100LS

@O 5 o -

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW POWERPIVOT ANALYZE DESIGN Adam Jorgensen -

(fy|  AciveField: 5 Finsensicer
7 Incert Timels
PivatTable 0 Group | SV et Timaiine
Active Fleld Filter

A3 - fe

fields from the PivotTable

B
2

s

6 | Tobuildareport, choose
7

8 Field List
]

0

™ s | 3 Fields, Items, & Sers~
L& [PT B A'xle.s.:ni 3 Ii i [

PivolChart Recommended  Show

Refresh Change Data Actions
v Seurces N clatensh Pivotables

Data Calculations Tools ~

PivotTable Fields -
Choose fields to add Lo report: -

TransactioniD
ProductiD
ReferenceOrderD
ReferenceQrderl inelD
TransactionDate
TransactionType
Quantity

ActualCost
ModifiedDate

MORE TABLES...

Drag fields between areas below:

T FILTERS 1l COLUMNS

23

2

25

26

27

8 ROWS T VALUES
29

0

31

R

33

34

Sheet2 | Sheet! ® : - Defer Layout Update
s iii - 100%

FIGURE 4-8 Sorted and organized pivot table

VERIFYING YOUR DATA BY PROTOTYPING

The best way to tell if your data process is working is to do some basic visual-
izing or “playing around” to see whether the data is lining up as expected. In
this instance, we'll build a simple report, as shown in Figure 4-9.

www.it-ebooks.info

67


http://www.it-ebooks.info/

68 MICROSOFT’S TOOLSET FOR VISUALIZING DATA

B e e ® PIVOTTABLE TOOLS
HOME  INSERT ~ PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  POWERPINOT  ANALYZE  DESIGN Adam Jorgensen =
[y ActiveField: += 3 [ insen Sticer [H E‘\-. 2 £ ] =
B Ao 3 : 2 L 2l Ny ? 8
ModifiedDate B 7 Insert Timeline . .
Pivotiable Diill Dill - Greup X Refresh Change Data Actions Calculations PivotChart Recommended — Show
- [ Field Settings pr - Filter Connectio - Source- - - PivolTables -
Active Field Filter Data Toals -~
AB v fe || 1/4/2008 12:00:00 AM ~
A B c D E F G HE )
1 PivotTable Fields e
2
- Chi fields to add t it -
3 Rowlabels |-T Sum of Quantity osthecsioaddio mpo
4 |9/4/2007 0:00 209219 TransactionlD
5 |10/4/2007 0:00 125750 BroductiD
6 |11/4/2007 0:00 167039 ReferenceOrderiD
7 |12/4/2007 0:00 170256 ReferenceQrderlinell
8 |1/4/2008 0:00 82657 TransactionDate
S |2/4/2008 0:00 140161 TransactionType
10 |3/4/2008 0:00 135481 ] Quantity
11 |4/a/2008 0:00 117329 ActualCost
12 |5/4/2008 0:00 165987 ] ModificdDate T
13 | 6/4/2008 0:00 163928 MORE TABLES..
14 | Grand Total 1477867
] Drag fields between areas below:
16
7 T FILTERS 1l COLUMNS
18
12
20
21
2 = rows T VALUES
23 ModifiedDate _~ | || Sum of Quant... ~
24
25
E
P ® 5 ; Defer Layaut Update

READY i M ——— 00

FIGURE 4-9 Simple pivot table report

Since the previous section got you comfortable with dragging and dropping,
let’s drag Modified Date into the Rows box and Quantity into the Values box
in the PivotTable Fields list. This will create a simple report you can use to
test your process.

This is the simplest possible Excel pivot—in Part 3 of this book you learn how
to format your pivot tables.

SUMMARY

Many visualization techniques and technologies can make the most of differ-
ent sources of data. In many cases, the sources described in this chapter are
used together to align information for easier consumption and understand-
ing by the users. This chapter provided an introduction to your first data set.
Going forward, the next chapters will all be focused on how to imagine and
build next-generation data visualizations on the next generation of tools. So
buckle up and turn the page.
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CHAPTER 5

Excel and PowerPivot

This chapter is about the two most frequently used tools in a power users’
arsenal for working with and visualizing data. It will review Excel and PowerPivot
and discuss important use cases for leveraging them in your quest to for
visualizing your data. They are the best tools to gather data and then begin
visualizing and analyzing data quickly. This is the foundation for many of the
types of visualizations you'll be doing in the rest of the book, so it’s important
to be familiar with them.

WHAT ARE EXCEL AND POWERPIVOT?

Excel and PowerPivot are easy-to-use, very intuitive programs that work
together to create a powerful set of tools and capabilities for the end user.
Excel came first in the 1990s, with PowerPivot following as part of SQL Server
2008 R2’s release cycle to deliver powerful data volume enhancements through
a column store engine.

Calling Excel a spreadsheet application seems so 1990s because it has grown
so much, but its foundation is still the top data analysis tool in the world.
More on this in the “What Does Excel Do for Me?” section later in this chapter.
PowerPivot is a free add-in for Excel that provides capabilities far beyond what
traditional Excel could even deliver, including more Analysis Services-style
functionality (online analytical processing (OLAP)) tools directly in Excel and
accessible by the end user.

POWERPIVOT VERSUS BISM VERSUS ANALYSIS SERVICES

When you work with PowerPivot, you will notice that there are several
names for this technology as new editions of the software it is part of with
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are released. In addition to PowerPivot, you will hear names such as the
following:

Bl Semantic Model (BISM): new in SQL Server 2012

BISM tabular: new server version of PowerPivot

Each of these is accurate in its own way. So let’s explore them before we
move forward.

PowerPivot

PowerPivot is the correct name for the client-side tools. This functionality is
installed from a free add-in that you can find at http: //www.powerpivot . com.
Choose your add-in version (32- or 64-bit) and install. The installation is very
simple with no options, and the functionality is then added to Excel. You will
know you succeeded when you see the POWERPIVOT tab and its options shown
in Figure 5.1.

=] .
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW POWERPIVOT

@ UE @ S Align Vertically \: E D& Q?

EIEIAlign Harizantally

Manage Calculated KPls Addto  Update Detect Settings
Fields - - Data Model Al
Data Model Calculations Slicer Alignment Tables Relationships

FIGURE 5-1 The POWERPIVOT tab in the Ribbon

Bl Semantic Model (BISM)

Bl Semantic Model (BISM) is the name Microsoft gave to its OLAP suite in the
new SQL Server 2012 release. The tools, features, and applications were all
enhanced to align them with modeling the way a business needs to see data,
adding flexibility and functionality to support it. PowerPivot is a part of this
new feature set, but it is not all of it. BISM tabular is another feature, and so
are other enhancements such as Power View, which you learn more about in
Chapter 6. Figure 5-2 shows the BISM architecture.

BISM Tabular

BISM tabular is the new server version of Analysis Services that supports models
created in PowerPivot. Now that PowerPivot has been available for a while, we
can upload these models to a production Analysis Services Server and share
them across the company, taking advantage of the extra memory on a server
to process and collaborate on larger, more intensive models. Figure 5-3 shows
some of what this new interface looks like.
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Third-party Reporting . SharePoint
Excel PowerPivot Insights

-

appli@ations Services

Bl Semantic Model

Multi
Data model dimensional Tabular

Business logic
and queries

Direct

Data access ROLAF  MOLAP VertiPaq ey

[ 1 l
| =

o

Databases LOB Applications Files OData Feeds Cloud Services

FIGURE 5-2 BISM architecture view
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FIGURE 5-3 SQL Server Data Tools
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Use Cases

Excel is often used by a variety of professionals to collect, sift through, and
analyze data in an organized and predictable fashion. The users’ activities
include pivoting data to be able to see how numbers or information look
when different filters, parameters, and criteria are applied. The functionality
and design of Excel makes this process very straightforward and painless.

PowerPivot is often used by the same folks who want to work with a much
larger amount of data and need to persist the model. In other words, they want
to keep their creations around and continually enhance then with features
like partitioned data, automated data refresh, hierarchies for easier browsing,
and course, much more data than Excel can handle natively. Analysis of tens
of millions of rows of data is possible in PowerPivot, while Excel struggles
above 60K rows in a native Excel table. This is because of the new column
store features in PowerPivot that deliver significantly increased compression
and performance when iterating over the data.

These persisted models are then shared and made available for collaboration
by publishing them to SharePoint either through Excel Services or BISM tabular
integrated with SharePoint to enable browsing and collaboration across the
organizations. A typical workflow looks like this:

Create Workbook > Enhance in PowerPivot > Publish to SharePoint > Collaborate

This workflow is illustrated in Figure 5-4.

Information workers and decision makers
use corporate Bl solutions and
published self-service Bl applications.

IW Consumers
- _H

|2 € #2

B2 52

| o ® 5

&3 ‘ T8

|8 53
Corporate Bl g £

- Y Suggestions -

Bl Solution =4 = W Producer
Developer i‘g S5 (Power User}
B BE |
g8 2=
£2 52
[ o
7 IT deploys and maintains S
the managed Bl environment. "\‘ y

Managed BI Collaboration Environment

FIGURE 5-4 A self-service Bl model
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How Do These Models Fit into Your Organization?

EXCEL AND POWERPIVOT 73
What are Excel and PowerPivot?

Think through your organization and the types of people and roles who are
always working with data, asking for more data, and needing more memory
on their machines or access to data sources. Some examples include:

Accounting and finance teams

Marketing analysts

Retail, manufacturing, and logistics analysts
Executives

Reporting analysts

Many of these people will already be familiar with these tools but will love
the additional assistance professionals can give them with all the new things

you're learning in this text.

COLUMN STORES

The term column store has been mentioned
several times in this chapter already with only
a basic explanation. This section highlights the
importance and building blocks of this powerful
technology. The technology is not new, although
it's very new to client tools such as PowerPivot.

SQL Server's traditional index structure is based
on a B-Tree model. B-Tree models are great for
finding data that match a particular condition in a
query. They are also pretty fast when you need to
scan all the data in a table. There are a couple of
main reasons we need the column store, however.

Compression is critical to getting increased per-
formance out of the same data on the same disks.
Most of the time, data is stored in rows as shown
in Figure 5-5.

With a column store, the data is reorganized into
a column-wise fashion similar to Figure 5-6.

Row store for B-Tree or Heap

Row 1 ‘CIICEIC.S‘C“#‘CSI(BIC?‘CS‘CQ‘CIDI
Row 2 Gl | E2]C3 ] c4 | csi|'ce | €F | CB I c8 | c10
Row 4 €l |€2 | C3 | Cd | CS | C6 | €7 | €8 | €9 | C10
Row 5 1 2| C3 |4 | C5C6|CT |CB|CO|C10

Page 1

Row &

Row 7 €l |[C2|C3|C4|C5)|C6|C7[C8|CY |C10

Row 8 Cl |c2 |63 | |'cs|cee |xcr|ca| o |co

.......... Cl|Cc2|C3|Cq|C5| |06 |C7|C8|CO |cC10

Row n Cl|Cc2|C3|C4|C5|C6|C7|cCa|ce|co

Page 2

FIGURE 5-5 Row store versus column store
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Column Store Index
Row1| C1 c2 ca c8 C9 || €10
rRowz2| €1 || €2 c4 c8 || c9 || c10
Row 3 Cl c2 c4 C8 ce C10
Row4| C1 || C2 c4 cs || co || c10
rows| €1 || c2 c4 cs || co || clo
rows| €1 |[HE2 ca c8 || co || cio
row7l €1 |[E2 ca c8 || co || cro
rowsl €1 | ca c8 || co || cio
.......... E1 C2 c4 fot:] co Cl10
Rown | C1 2 c4 c8 c9 || €10
o ™~ L] b 4 o« (-] (=]
@ @ @ @ @ @ b
& 7 5 5 7 7 §
o o o o o o =

FIGURE 5-6 Column store index

When you put that together it looks something like Figure 5-7.

rows <]

H-
g B

3
v

pages

|

row store
(heap or B-tree)

——>» non-column store

C4 C5 Cé6

ii

pages

——> column store index

pages

I I I I I e

FIGURE 5-7 Selecting from a column-store index
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Creating Your First PowerPivot Model

If this seems complicated, that’s okay. You don’t need to know all the internal
details, but if you'd like to know more, use your favorite search engine to search
for “Columnstore Indexes” and go to the page for “Columnstore Indexes: A

New Feature in SQL Server known as Project ‘Apollo™ on blogs. technet . com.

MULTIDIMENSIONAL VERSUS IN MEMORY MODELS

PowerPivot represents a new shift in enhancing the capabilities around in-
memory models. This differs from the traditional multidimensional model in
that now we don't need to build out a traditional OLAP cube to be able to do
much of the OLAP-type analysis. Not that we might not want to build it out,
but sometimes that is more work than we have time for. Typically, you would
want to use a multidimensional model when size or complexity overruns the
PowerPivot or BISM tabular toolset.

For size, this would be data that would be too much for a server memory foot-
print or perhaps require complicated MDX scripting. PowerPivot can do much of
this scripting as well, however, so don't discount the power of its DAX language.

CREATING YOUR FIRST POWERPIVOT MODEL

Let’s move forward by creating our first PowerPivot model. This model will be
based on a sample data set in the Chapter05. zip from this book’s download
files. First, you want to have the PowerPivot add-in installed; or if you are
already running Office 2013, you just need to enable it.

To enable the add-in in Excel 2013, go to File > Options > Add-ins > Com
Add-ins > GO. After the add-in is enabled, you should see a dialog like the
one shown in Figure 5-8.

COM Add-Ins

Add-Ins available: K

Hive for Excel -
|:| Inquire ‘_

Cancel
[ Load Test Report Addin

[¥] Load Test Report Addin

Microsoft Office PowerPivot for Excel 2013
PowerView e
I:‘Team Foundation Add-in Remove
Team Foundation Add-in 57

m

= =
g o
i b

Location: Ch\Program Files\Microsoft\HiveODBC\HiveExcel.vsto|vstolocal
Load Behavior: Load at Startup

" W

FIGURE 5-8 Add-ins in Excel
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Make sure the “Microsoft Office PowerPivot for Excel 2013” check box is
selected. Now you'll see the PowerPivot tab in the top of the Ribbon and
you can get to work!

STEP 1: UNDERSTAND YOUR DATA

The VI_UNData.bak database contains tables based on United Nations data
collected for a number of countries around the globe. It contains a number
of statistics and facts by country that we'll be using throughout the book.
For this first example, we'll take a couple of tables and build a simple model.

Open a new workbook in Excel, go to the PowerPivot tab, and click the Manage
icon, as shown to the left in Figure 5-9.

=] .
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW POWERPIVOT

@ v"ﬂ @ 5[ Align Vertically \: E D& a?

EIEIAlign Harizantally i
Manage  Calculated KPls Addto  Update Detect Settings

Fields - - Data Model Al

Data Model Calculations Slicer Alignment Tables Relationships

FIGURE 5-9 The PowerPivot Ribbon in Excel 2010

STEP 2: CREATE YOUR FIRST MODEL

Now that we have the right add-in configured, let’s create our model. There
are a number of ways to do this, but the primary way is to import data from
one or many data sources. For this example, we are going to use the United
Nations data sample from the book’s downloadable files.

Make sure you have the database restored to an accessible server and then
select your PowerPivot tab and click the Manage icon. Then click “Get External
Data” and choose SQL Server database. In this case, the database is the data-
base backup file you downloaded for this chapter that you should have restored
and made accessible somewhere in your environment. The next several sec-
tions will highlight the steps to load data into your model.

Step 2a: Select Your Data Source and Data to Load into Your Model

The UN data sample is a SQL database, but remember that the “power” in
PowerPivot comes from the ability to use virtually any source of data and
then combine it with data from other sources. See the following figures for
the process to get your data.
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First, you connect to your data source. Click the manage icon in the Ribbon to
open the PowerPivot window. This window is where you do most of your work
with PowerPivot. Next, locate the section in the Home tab for getting data. Click
the From Database button, then select From SQL Server, as shown in Figure 5-10.

= | PowerPivot for Excel - Bookl

Al gs d

Design Advanced

Paste Append

Paste Replace

2k

Copy
Clipboard

i &7

3 &

From From Data From Other  Existing Refresh | PivotTable

Database | Service

Sources  Connections

| |: From 5QL Server

gz From Access

From SQL Server
|:°‘ From Analysis Services
Create a connection to a SQL
Server database and import data
into PowerPivot.

FIGURE 5-10 Creating a SQL data source

Enter the server and connection credentials for the data source you're con-
necting too, then choose the VI_UNData database as shown in Figure 5-11.

Table Import Wizard M
Connectto a Microsoft SQL Server Database
Enter the information required to to the Mi ft SQL Server datab
Friendly connection name: ISqISenrer localhost VI_UNData
Server name: . -
Log on to the server
@ Use Windows Authentication
() Use SQL Server Authentication
User name: I
Password: I
Database name: |_LUNData -
pdvanced | [Test
< Back Nesdt Finish Cancel

FIGURE 5-11 Table import wizard
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Figure 5-12 shows the check boxes next to each table. You can also give the
tables friendlier names, which you use in this model. This is important to
make the model more readable and usable down the road. You could filter
your data here as well, but you don't need to do that in this case. Click finish
to complete the import.

;
Table Import Wizard -2 [t

Select Tables and Views
Select the tables and views that you want to import data from

Server:  localhost
Database: VI_UNData

Tables and Views:

Source Table Schema  Friendly Name Fitter Details o

A | DimCountry dbo DimCourtry

[ | DimOECDStatistic dbo

|E DimTime dbo

[ | FactOECDPopulation dbo FactOECDPopulation £

[ | FactUNData dbo FactUNData

|E GEO_Data_Portal__biths__ 1343117343 dbo

|E GEO_Data_Portal__electricity_exports__ 1345118423 dba

|E GEO_Data_Portal__electricity_imports__1345118681 dbo

|E GEOQ_Data_Portal__expors_goods__ 1345118343 dbo

|E GEO_Data_Portal__imports_goods__1345118945 dba

|E GEO_Data_Portal__intemet_users_tot__1345115445 dbo

|E GEOQ_Data_Portal__migration_rate__ 1343119578 dbo

|E GEO_Data_Portal__mobile_phones__1345115352 dba

| il = T NS Dmr=l e, 3 12401100R0 Ak T
Select Related Tables | | Preview & Filer

2 related tables were selected. it

<Back | [ MNet> |[ Fmsh ][ Cance

L 4

FIGURE 5-12 Using relationship detection
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Figure 5-13 shows the import running suc- (Tabie Import Wizard (=)
cessfully! Great work! Imporing
The import operation might take several minutes to complete. To stop the import
operation, click the Stop Import button.
Step 2b: Build and Check Relationships e Totol 4 Cancelled: D
. . . Success Success: 4 Error: 0
If there are existing physical keys or rela- o
s
tionships in the underlying data, they will ok o o Mossage
be imported into PowerPivot if you clicked ©  DmCeurty Suscess. 237 rows transfend.
" ” Q DimDate Success. 36,850 rows transfemed
Import RE|ated Tables‘ HOWeVer, the goal I_g FactOECDPopulation Success. 31,620 rows transfemed.
is to combine data and begin visualizing it, FactUNDats Suscess. 263307 rows transfemed
.. . . . o Diata preparation Completed Details
so you can create additional relationships in
your model based on how the data lines up.
You just drag and drop the column names
onto each other and the relationship is cre-
ated! Simple! See the before and after in the
figures that follow.
To build your relationships, switch to the I
_ your PS, SWITER 1 Sepineon)
diagram view in your PowerPivot window

using the icon at the lower right, as shown

in Fi FIGURE 5-13 | t
in Figure 5-14. mport screen

B3| g8l - ¢ - v | PowerPivot for Excel - Bookl b=b @
Home  Design  Advanced L]
|72 Paste Append L& l—] D L\a LH ) Data Type PlootAtez W T H 7. AutoSum
= o o .
D) 2 onse memice g L4 & g o Zlsonzan  PC I e
Paste From  From Data From Otner _Budsting  Refresn | FwvotTabie At ClearAll Somoy | Find | - Data
2 Copy Database - Service Sources  Connectians §-% » W3 ClearSort  Fiiters Column View

Cupboara Get External Data Formatting oMt and Fiter Fina | Calcuiations View

Display: 7 Columns i Calculated Helds = Hierarchies = KPis

[ CountrylD 0
[Z] CountrySourceKey
[ LoadDate
[T Createpate [ OECDPopulationID
1 Active = [ LoadDate
™ CreateDate
M Active

™ | nadDateln [ Datesk.
™ patein
M Date

™ UNDatalD
™ LoadDate
[ CreateDate
[ Active

1 1 padnatain

=] ]

FIGURE 5-14 The diagram view
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Find the columns in your tables that relate to each other and drag them from
one table and drop them on the column name that matches in the related
table. For this example, FACTOECDPopulation.CountrylD was dropped on
DimCountry.CountryID. Continue this for the remainder of your tables. Often
you'll drag the column from the fact table and drop it on your dimension table.
Step 2c: Clean-Up Work
The last thing to do before verifying your model is clean it up. Inevitably,
you will bring in columns you thought you needed but wind up not using,
or columns whose names don’t really match or mean anything semantically
valuable to you or your end users. See how in the following figures.
Highlight the columns that you're not using (you can pick columns with little
or no data or that don’t seem to be as useful). Right-click in the header of the
column and select Delete. The columns with empty rows near the top right
in this Figure 5-15 are the columns we chose to delete.
Bl = | PowerPivot for Excel - Bookl = | @ ]
E Home Design  Advanced )
Bimes| B & 0 B |3 B[ e [fio oAby = o] il =
Paste From From Data From Other  Existing Refresn  PiwotTable Fina Data Ciagram | Show |Calculation
ER Copy Datahase - Service - Sources  Connectlans g ] Clear Sort Miew | View |[Hidden| Area
Ciipboara Get Bemal Data Formatting oMt ana Fier Fina Calcutations view
|[sDumachang_. - v\
nt... " B| Countrysourcekey B3| 10adpare B3| createnate B acn = e - | B = [ sourcechangenate [+] previousesourcechangeDate || SourceChangaDatestaging [ |-
1 Afghanistan 10/2/20128... 10/2/2012 8:5... 1 Afghanistan Afghanistan 201,
2 Albania 10/2/20128... 10/2/20128:5... 1 Albania Albania 200
3 Algeria 10/2/20128... 10/2/2012B:5... 1 Algeria Algeria 201
4 American Samoa 10/2/20128... 10/2/20128:5... 1 Americansamoa American Samoa 201
5 Andorra 10/2/20128... 10/2/20128:5... 1 Andorra Andorra 201
& Angola 10/2/20128... 10/2f20128:5... 1 Angola Angola 201
7 Anguilla 10/2/20128... 10/2/2012 8:5... 1 Anguilla Anguilla 201:
8 Amarcuc 10/2/20128... 10/2/20128:5... 1 Amarenc Antarcuc 201
9 AntiguaandBarbuda  10/2/20128... 10/2/20128:5... 1 AntiguaandBar.. Antiguaand Bar.. 201
10 Argentina 10/2/20128... 10/2f20128:5... 1 Argentina Argentina 0L
11 Armenia 10/2/20128... 10/2/20128:5... 1 Armenia Armenia 201
12 Aruba 10/2/20128... 10/2/2012 8:5... 1 Aruba Aruba 200
15 Azerbaijan 10/2/20128... 10/2/2012 8:5.. 1 Azerhaijan Arerbaijan 201
16 Bahamas 10/2/20128... 10/2/2012 8:5... 1 Bahamas Bahamas 201
17 Bahrain 10/2/20128... 10/2/2012 &:5... 1 Bahrain Bahrain 201:
18 Bangladesh 10/2/20128... 10/2/2012 8:5... 1 Bangladesh Bangladesh 201
19 Barbados 10/2/20128... 10/2/2012 8:5.. 1 Barbados Rarhadns 201
20 Belarus 10/2/20128... 10/2/2012 8:5... 1 Belarus Belarus 201
22 Belize 10/2/20128... 10/2/20128:5... 1 Belize Belize 2001
23 Benin 10/2/20128... 10/2/20128:5... 1 Benin Benin 201
24 Bermuda 10/2/20128... 10/2/20128:5.. 1 Bermuda Bermuda 201
25 Bhutan 10/2/20128... 10/2{2012 8:5... 1 Bhutan Bhutan 201
26 Bolivia 10/2/20128... 10/2/20128:5... 1 Bolivia Bolivia 201
27 Bosnia and Herzegov... 10/2/20128... 10/2/20128:5... 1 Bosniaand Herz... Bosnia and Her... 201 - |
|| <
||
g .
DimCountry .DumDnis FactOLCDPopulation | FactUNData
.F’n.uld_ H 4 1207 ¥ Eﬂa

FIGURE 5-15 Cleaning up columns
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Creating Your First PowerPivot Model
Figure 5-16 shows the second clean-up step where you rename your columns
to something more usable. You can right click on the column header and select
Rename. This will then edit the model right there and persist the change. You
can see this renaming in Figure 5-16.
BB | @ fd % - ¢ - = | PowerPivot for Excel - Bookl E@W
- Home  Design  Advanced L]
Paste Append 5 Y e Data Type: *lsotAtoz y AutoSum 2 [§
| 8 & 2 B |5 s W T EE B me RAER
Paste From  From Data From Other  Existing Refresn  PivotTable = 9 Clear Al Sort by Fina iagram | Show iculation
ER Copy Database - Sendce - Sources  Connectians $- % » W 4B ClearSot Fiters Column View |Hidden|  area
Cuppoara Get Extemal Data Formatting Sort ana Firter #ina | Calcutations View
| ILoadpatein) - \znumnz ¥
1 Aﬁd’mmslal\ 10,'2[20118 1 Afghanistan lafghanistan 20121002 Aﬁ(hamsm" AslalPuclﬁc ..uuﬂ'lAslu
2 Albania 10/2/20128... 1 Albania A lbania 20121002 | 1 [ |... Albania Europe Central Europe AL
3 Algeria 10/2/2012B... 1 Algeria Algeria 20121002| GEO_Data_Porta Algeria Africa Northem Africa  DZ
4 american Samoa 10/2/20128... 1 AmericanSamoa jamerican Samoa 20121002 | GEO_Data_portal United State... Asia+ Pacific south pacific as
5 Andorra 10/2/20128... 1 Andorra landorra 20121002| GEO_Data_Porta Andorra Europe Western Europe  AD
& Angola 10/2/20128... 1 Angola langola 20121002 | GEO_Data_Portal_... Angola Africa Southern Africa AQ
7 Anguilla 10/2/20128... 1 Anguilla fanguilla 20121002| GEO_Data_Portal_... UnitedKing... Latin America... Caribbean Al
8 Antarcnc 10/2/2012 8... 1 Antarenc Jntarcnc 20121002 | GEO_Data_Portal Antarcnc polar Antarcuc Ala
9 AntiguaandBarbuda  10/2/20128... 3 1 AntiguaandBar.. fAntiguaand Bar.. 20121002| GEO_Data_Portal_... Antiguaand... Latin America... Caribbean AG
10 Argenuna 10/2/20128... 10/2f20128:5... 1 Argentna jargentna 20121002 | GEO_Data_Portal_... Argentina Latin America... South America AR
11 Armenia 10/2/20128... 10/2/20128:5... 1 Armenia barmenia 20121002| GEO_Data_Porta Armenia Europe EaslernEurope  AM
12 Aruba 10/2/20128... 10/2/20128:5... 1 Aruba laruba 20121002| GEO_Data_Portal_... Netherlands  Latin America... Caribbean AW
15 Azerbaijan 10/2/2012 8... 10/2/2012 &:5... 1 Azerhaijan s erbiaijan 20121002 | GEO_Data_Portal_... Azerbaijan Europe Eastern Furope A7
16 Bahamas 10/2/20128... 10/2/20128:5... 1 Bahamas [Bahamas 20121002| GEO Data_Porta Bahamas Latin America... Caribbean BS
17 Bahrain 10/2/20128... 10/2/20128:5... 1 Bahrain Bahrain 20121002 | GFO_Data_Portal_..  Bahrain Weest Asia Arabian Peninsula BH
18 Bangladesh 10/2/20128... 1 Bangladesh [Bangladesh 20121002| GEO Data Portal ... Bangladesh  Asia+Pacific  South Asia BD
19 Barbados 10/2/20128... 1 Barbados [Rarhados 20121002| GFO_Data_Porta Rarbados Latin America... Carlbbean BB
20 Delarus 10/2/20128... 1 Belarus Delarus 20121002| GEO_Data_Portal_... Delarus Europe EasternCurope DY
22 gelize 10/2/20128... 1 Belize Belize 20121002 GEI:I_Blﬂ_PMll_,,, Belize Latin america... Meso america BZ
23 Benin 10/2/20128... 1 Benin Benin 20121002 Benin Africa Western Africa B
24 Bermuda 10/2/20128... 1 Bermuda Bermuda 20121002 United King... Latin America... Caribbean BM
25 Bhutan 10/2/20128... 1 Bhutan Bhutan 20121002 Bhutan Asia+Pacific  South Asia BT
26 Bolivia 10/2/2012 8... 1 Bolivia Bolivia 20121002 | Bolvia Latin America... South America BO
27 Bosnia and Herz . 10/2/20128... 1 Bosnia and Herz... ia and Her.. 20121002 Bosnia . Euroj Central Europe ___ BA

DimCountry | GimDate | FactOECOPopulation | FactunData |

Recond. H 4 1of 227 ro

FIGURE 5-16 Renaming columns

STEP 3: DOES YOUR MODEL WORK?

To test your model, let’s explore it in Excel. Click the PivotTable button on the
Home tab in the Ribbon, as shown in Figure 5-17.

Now that we know we can use our model, let’s take a look at some things that
Excel can do for us. The next section will build some tables and visualization
on top of this foundation.
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&1 @ d - s | PowerPivot for Excel - Bookl Lo | @ sl
Home Design Advanced Ll
o " Paste Append B, B, [a Dota Type: Whale Number - %] Sort Smallest to Largest )“Aum;um 3 |
D | L & [ B | (3 Wi Hammrsnns o O | i oo B oS REER
Paste From  From Dala From Other _ Existing  Refresh " Clear 4l Sortby | Find Data |Dlagram | Shaw.
B2 Cor A I o D o O 3 EcEing i T % Cler St oo o
Clipboard Get Extemal Data [0} BivotTable ot and Filter Fing | Couustions view
| lacivel - ‘ vz Pwvotgnar |*‘
L 1 Amhammn 10/2/20128... m,'z!zmzs.s... B cnar anaTable ernq _Create a PivotTable ia Excel. 121002 GEO Data Portal .. Aﬁ(hamsmn Asia + Pacific  South Asia |:|
(] 2 albania 10/2/20128... 10/2/20128:5.. G Two Charts {Horizontal) Ibania 20121002 s:n_nm_pmal_, albania Europe Central Europe AL 1
[ 3 Algeria 10/2/20126... 10/2/20128:5... & Twacnamsvemen Igeria 20121002 GEO_Data_Portal_... Algeria Africa Northern Africa  DZ
. 4 American Samoa 10/2/20128... 10/2/20128:5... $ EourCharts }nenmn Samoa 20121002 GEO_Data_Portal ... United State... Asla+ Pacific South Pacific AS
L 5 Andorra 10/2/20128... 10/2/20128:5... il Fattenea Puotlable ndorra 20121002 GEO_Data_Portal ... Andorra Curope \Western Curope  AD
. & Angola 10/2/20128... 10/2f20128:5. 1 angola ;ngnla 20121002 GEO_Data_Portal_.. Angola Aafrica Southern africa a0
] 7 Anguilla 10/2/20128... 10/2/20128:5... 1 Anguilla Anguilla 20121002 GEO_Data_Portal_... UnitedKing... LatinAmerica... Caribbean Al
. 8 Antarctic 10/2/20128... 10/2f20128:5... 1 Antarctic Antarctic 20121002 GEO_Data_Portal_... Antarctic Polar Antarctic ATA
. 9 AntiguaandBarbuda  10/2/20128... 10/2/20128:5... 1 AntiguaandBar.. Antiguaand Bar.. 20121002 GEO_Data_Portal ... Antiguaand... Latin America... Caribbean AG
. 10 Argenuna 10/2/20128... 10/2f20128:5... 1 Argentna Argentina 20121002 GEO_Data_Portal_... Argentina Latin America... South America AR
[ 11 Armenia 10/2/20128... 10/2/20128:5... Emmenia Armenia 20121002 GEO_Dala_Porlal_... Armenia Europe Eastern Europe AM
N 12 Aruba 10/2/20128... 10/2/2012 8:5... 1 Aruba Aruba 20121002 GEO_Data_Portal_... Netherlands  Latin America... Caribbean AW
. 15 Azerbaijan 10/2/2012 8... 10/2/2012 8:5... 1 Azerhaijan Azerbaijan 20121002 GEO_Data_Portal_... Azerbaijan Europe Eastern Furope A7
] 16 Bahamas 10/2/20128... 10/2/20128:5... 1 Bahamas Bahamas 20121002 GEO_Data Portal ... Bahamas Latin America... Caribbean B
17 Bahrain 10/2/20128... 10/2/20128:5... 1 Bahrain Bahrain 20121002 GFO_Data_Portal_..  Bahrain Wiest Asia Arabian Peninsula  BH
I 18 Bangladesh 10/2/20128... 10/2/20128:5... 1 Bangladesh Bangladesh 20121002 GEO Data Portal ... Bangladesh  Asia+Pacific  South Asia BD
19 Barbados 10/2/2012 8... 10/2/2012 &5... 1 Barbados Rarbados 20121002 GFO_Data_Portal_... Barbados Latin America... Caribhean BR
20 Belarus 10/2/20128... 10/2/20128:5... 1 Belarus Belsrus. 20121002 GEO_Data_Portal ... Delarus Europe Castern Curope BY
. 22 Belize 10/2/20128... 10/2/20128:5... 1 Belize Belize 20121002 GEO_Data_Portal_.. Belize Latin America... Meso america BZ
] 23 Benin 10/2/20128... 10/2/20128:5... 1 Benin Benin 20121002 GEO_Data_Portal_... Benin Africa Western Africa B
. 24 Bermuda 10/2/20128... 10/2/20128:5... 1 Bermuda Bermuda 20121002 GEO_Data_Portal_... United King... Latin America... Caribbean BM
L 25 Bhutan 10/2/20128... 10/2/20128:5... 1 Bhutan Bhutan 20121002 GEO_Data_Portal_... Bhutan Asia+Pacific  South Asia BT
. 26 Bolivia 10/2/20128... 10/2/20128:5... 1 Bolivia Bolivia 20121002 GEO_Data_Portal_... Bolivia Latin America... South America BO
27 Bosnia and Herzegov... 10/2/20128... 10/2/2012 8:5... 1 Bosnia and Herz... Bosnia and Het.. 20121002 GEO_Data_Portal_... Bosniaand... Euro) Central Europe BA =
m L
u
- . 2
DimCountry | DimDate | FactOECDPopulation | FoctUNData |
Recad. M+ o207 » n =5

FIGURE 5-17 Creating a pivot table

WHAT DOES EXCEL DO FOR ME?

If you're still asking this question, you haven’t been paying attention! Kidding,
but only a little. Excel is very powerful. Even without PowerPivot, Excel gives
us some great functionality for analyzing our data. In fact, without Excel’s
pivoting, charting, and analysis tools, PowerPivot would not be as functional
either because we often explore our models right in Excel.

PIVOT CHARTS AND TABLES

Using pivot charts and tables is an incredibly powerful and easy way to begin
simple visualizations that provide some great self-service capabilities for
end users. They allow for dynamic work on charts and tables by using drag-
and-drop functionality and easy-to-learn formulas and techniques for more
advanced users.
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What Does Excel Do for Me?

Intro to Pivots in Excel

Let’s explore our model and see some examples of pivots. Pivots enable us to
change the axis alignment of our data to show, or “pivot,” it differently. This
is a big key to a lot of Excel’s power. See examples of us building and using
pivots in Excel. We do this by changing where we drag the columns in the
grid on the right. See the difference in where the columns are placed in the
grid and how that affects the pivot report’s axes.

In your model in PowerPivot, click the Explore in Excel icon to get an empty
Excel pivot table. Then you drag some of the values into the boxes in the Field
Well on the bottom right to begin to see the report take shape. Notice that
we've put the year as the column, the country in the rows, and population as
a simple value. Figure 5-18 shows how this looks.

= s Bookl - Excel FIVOTTABLE T00LS ? 8 - 8 X
HOME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  POWERPNOT  AMALVZE  DESIGN Signin

@ [ﬁ\:l |:| [ Align Vertically @ ’@ Ca d:

B8 Align Horizontally

Manage  Calculoted  KPIs Addto Update  Detect  Settings
Fielde = i Data Model  All
UataModel  Calculations Siicer Alignment Tables Relationships A
AL - f || Population v
A ] [ D € F G H 1 J K L M N =

1 [Poputation ! bels | - PivotTable Fields T
2 |Row Labels - 2000 2005 2008 2009 2010 2011 Grand Total ACTME AL

3 |Australia 809566.4871 658512.5578 1416716.887 1601876.274 1054624.313 26375.02454 5567671572

4 |Austria 172029.44 1561654060 4856157566 492302.7776 471022.0666 53403.88677 1830539.335 Chosseficklatoaddtonpor | 8 -
5 |Belgium 624493.8431 340175.6796 2260847.33 1956650.379 1630G14.83 53865.28846 G8GG647.351 47 DimCountry =
6 |Brazil 183754.7313  226056.5545 717154.1849 845614 7821 9292415349 195606.7613 3097428.549 CountrylD

7 |canada 1479581836 11285/8.081 2198009.172 2273176746 1319629.342 79126.21205 8488101389 CountrySourcekey

2 |chile 91117.4068 58691.74629 201517.0161 272903.0991 250897.5956 38508.4759 9136353398 LesdDste

9 |China 1327042.077 1693767.245 3087154.416 4161939.562 3395736.605 1351987.668 15037629.57 Creene

10 |Czech Republic 193606.9915 210039.0705 304282.8954 3G0101.8171 3428024675 39484.78504 1510318.031

11 |Denmark 278546 635 1694569604 524527.7496 522547.4363 506106.0593 49302.05026 2050481.891 Active

12 |Estonia 35336.63632 19789.30251 7E198.80794 JIBILIVIVE 6IA0AAZIAY 259457605 325507.6485 | CountryName

2 |Finland 228031.624 184042.5261 400565.5544 392745.5828 401912.8820 45840.75385 1654139.034 CountryCode

14 |France 1902318.119 1441705.047 3792693484 3911862953 3812667.12 104505.4734 149657522 LoadDatelD

15 |Germany 2537106.663 1825671.481 4031932869 4253528.664 3170437.011 129821.5094 15543498.2 SourceFileNeme -
16 |Greece 112119.2569 115084.2422 189553.2589 1694850934 138308.2189 4137466289 765934.7332

17 |Hungary 158322.6743 1826149671 313/90.5/38 3I18/UL13/3 2/3383.696 349713656 1281797411 Drog fickds between orcas below:

18 leeland 41229.44671 56853.39263 75867.22936 73140.30212 60016.90058 35064.66443 2461715358

19 India 1910749.044 7438916.695 1454437.559 1540815396 1564735.418 1242694.546 15212348.66 ¥ FALTERS W coLumns

20 |Indonesia 236356.7597 264644.5217 353399.3616 394561.6835 777231.4374 751490.1648 1777683.423 Yesrlome =
21 \reland 234484 0429 82638.1593 4669151762 656448 7772 6701584013 7177.148482 2117821.705

22 |1srael JU856.78353 A6425.11529 1S0723.9422 1877782518 193/29.1193 1047776676 699990.9802

3 |1taly 1453257.788 1213250.562 1977396.212 2091506.368 1979783.882 97697.87658 8812892.689

24 Japan 2234341.042 2032173.64 3014951363 1772049.155 1627443.447 136367.4113 10877526.06 — + vaLEs

25 |luxembourg 60306.77298 90822.02623 372433.9045 466203.369 440643.3239 93355.14504 1524364.547

26 |Mexico 872708.9992 905807.6307 1303636.406 1386906.757 1291788696 114335062 S830183.601 Cousintame ¥ | || Populstion =
27 |Netherlands 894907.1281 551966.227 2023992.573 1899762477 1722492.985 62682.42553 7168805.825

20 |New Zealand 8231108595 57005.22512 1403567713 129167.562 122320.7062 6B35.474159 537996.8247

29 |Norway 175651.5256 183617.3604 485027.3575 542569.3473 180729.7993 69746.27287 1637361663

30 |Paland 447379.9284 520519.7406 857461.8032 918801.8819 951328.916 41785.64053 3732277.911 B

Sheetl ® 1 : Defer Layout Update

FIGURE 5-18 The layout of a pivot table
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Filters versus Slicers

We can add extra functionality by going to the Ribbon, as shown in Figure 5-19,
and inserting a slicer (a visual filter), or we can use the built-in Excel filters (see
Figure 5-20). Inserting a filter is as easy as dragging the column you want to
filter by into the filter area in the Field well (where you just dragged the other
columns).

mAE S = Buokl - Excel PIVOTTABLE TOOLS ?E - & X
[Tl oME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  POWERPIVOT  ANALYZE  DESIGN Signin
’_—‘EI j I3 Shapes = a l‘b =24 ,t’- II.Z 7 e §| rv 4 xl:lunmn-- T Equation ~
- = =5 BSmantan . R o i B R N v [ Signature Line = €2 Symbol
sble  Pictures Online Appsfor Recommended . PivotChart Power  Line Column Win/  Slicer Timeline Hyperiink  Tott  Header
Pictures ma Screenshot = Office v Charts k- - View Loss Box & Footer [ Obicet
Tablas Uustrations apps chan: | Reports Sparkiines Fiters Links Ten sympot PN
F18 - £ | 60016.900581 Sleer v
Use a sicerto filter data visually.
A 8 < 0 & E L H 1 ! Slicers make it faster and easier to u = s H
1 Pupulation Calumn Labels | - fitor Tables, PivotTables PivotTable Fields %
2 |Row Labels ~| 2000 2005 2008 2000 2010 2011 Grand Total PiuotCharts, and cube functions ACTME AL
3 |Australia 809566.4871 6585125578 1416716.887 1601876.274 1054621.313 26375.02454 S56767L572
4 |Austria 172029.44 156165.4069 485615.7566 4923027776 471022.0668 53403.08677 1830539.335 ChosieRiddstoaddtorpen | 4 -
5 624493.8431 340175.6796 2260847.33 1956650.373 1630614.83 53865.26846 6866647.351 4 7% DimCountry B
& |Brazil 183754.7313 226056.5545 717154149 BAS614.7821 929741.5349 195606.7613 3097428.549 CountryID
7 |canada 1479581836 1138578.081 2198009.172 2273176.7a6 1319629.342 7912671205 B488101 389 CountrySourceKey
3 |chile 91117.4068 5869174629 201517.0161 272903.0991 250897.5956 38508.4759 913635.3398 LoadOate
9 |china 1327042.077 1693767.245 3067154.416 4161939.562 3395730.605 1351967.668 15037629.57 P
10 | Czech Republic 193606.9915 210039.0705 364282.8954 360101.8171 342802.4675 39484.76904 1510318.031 ctve
11 |nenmark 27R546.635 169456.9604 524522.7496 5225474363 S06106.0593 49302.05076 2050481.891
12 |estonia 35336.63632 19789.30251 /S198.80790 283270978 630442719  25945.7645 3255016485 ] CountryName
13 |Finland 228031.624 1840425361 400565.6544 393745.5828 401912.8829 45840.75385 1654129.034 CountryCode
14 |France 1902318119 1441705.047 3792693404 3911662.953 3812667.12 104505.4734 149657522 LoadDateld
15 | Germany 2537106.663 1825671.481 4031932.869 4253528.664 3170437.011 129821.5094 15948498.2 SourceFileNome =
15 | Greece 112119.2569 115034.2422 189553.2589 169485.0934 138308.2189 41374.65289 765934.7332
17 |Hungary 158333.6713 182611.9671 313790.5/38 3187021373  2/3383.686 34972.36546 1281797411 Drag fields between areas below:
18 iceland 41229.44671 56853.39263 75867.22936 73140.30212] 60016.90058] 39064.66043 2461719358
19 India 1910745.044 7498916695 1454437.559 1540815.396 1564735418 1242094.506 15212348.66 T FLTERS W COLUMNS
20 |Indonesia 236356.2597 2764644 5212 353399.3616 3945616835 2772314324 251490.1648 1777683.423 YearName -
21 |ireland 234484.0429 52638.1593 466915.1762 656448.7772 670158.4013 7177148482 2117821705
22 |1srael JU856.783%93 46125.11529 190/23.9422 18///8.2528 193729.1193 1047/7.766/6 699990.9802
23 | taly 1453257.768 1213250.562 1977396.212 2091506.368 1979783.882 97697.67658 8812892.689
24 |1apan 2234341042 2032173.64 3014951.3G3 1772049.155 1627443.447 136567.4113 10877526.06 [E— v
25 |IIIE‘II\|IIIIJIB 60906.77298 90822.02623 372433.9045 46G203.369 440643 3239 9335514504 1524364 542
25 |Mexico 872708.9992 905807.6807 1308636.406 1386306.757 1291786.696 114335.062 5880183.601 CountryName ¥ | || Population ¥
27 | Netherlands 894907.1281 554966.227 2023993.573 1899762.477 1732493.985 62682.43553 7163805.825
28 |New Zealand 82311.08595 57005.22512 140356.7713 129167.562 122320.7062 6635474150 S37996.8247
29 |Norway 1756515256 183617.3604 485027.3575 542589.3473 180729.7993 69746.27287 1637361663
30 | Poland 4423799284 520519.7406 857461.8032 918801.8819 951328916 41785.64053 3732277.911 =
Sheetl ® a - Defer Layout Update

FIGURE 5-19 Inserting a slicer from the Ribbon

Inserting a slicer is one extra step. You need to click on your pivot table some-
where and select Insert > Slicer. Then you can choose the fields you'd like to
slice by. These function as live filters on the canvas as opposed to in a drop-
down list, so they are better for common filters that users would combine.
They are also sometimes more visually preferable to regular filters. The slicers
we chose are shown in Figure 5-20.

See how easy that was? Now we can format and sort our report using some
of the cool functionality in Excel.
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EXCEL AND POWERPIVOT
What Does Excel Do for Me?

FILE HOME ~ INSERT ~ PAGELAVOUT ~ FORMULAS ~ DATA  REVIEW  VIEW  POWERPIVOT  OPTIONS
Slicer Caption: @E i, 2 Eb E ‘?’[n\umnt: 1 | 2 Ieight: [276"
CountryName - € ¥l Height: [o26"  *

- Report Bing  Send  Selection Align Group Rotate oo 1 w27

Slicer Settings  Connections Forward - Backward = Pane - oy Width: 1,58 -

Slicer Slicer Styles Arrange Euttons Size

CountryN... ~ £

A B c D E F G H 1 ) K L M N
1 |Population Column Labels | ~ GEO Region
2 |Row Labels ~ 2000 2005 2008 2009 2010 2011 GrandTotal | —
3 |Australia 809566.4871 658512.5578 1416716.887 1601876.274 1054624.343 26375.02454 5567671.572
4 |Austria 172029.44 156165.4069 435615.7566 4923027776 471022.0668 53403.88677 1830539.335
5 |Belgium 624493.8431 340175.6796 2260847.33 1956650.379 1630614.83 53865.28846 6866647.351
6 |Brazil 183754.7313 226056.5545 717154.1849 845614.7821 9292415349 195606.7613 3097428.549
7 |canada 1479581.836 1138578.081 2198009.172 2273176.746 1319629.342 79126.21205 2438101.389 | | Latin America + Caribb...
8 |chile 91117.4068 SBE91.74629 201517.0161 272303.0991 250897.5956 38508.4759 913635.3398 [ o
9 |China 1327042.077 1693767.245 3087154.416 4181939.562 3395738.605 1351987.668 15037629.57
10 |Czech Republic 193606.9915 210039.0705 364282.8954 360101.8171 3428024675 39484.78904 1510318.031 Folar
11 |Denmark 278546.635 169456.9604 5245227496 522547.4363 506106.0593 49302.05026 2050481891 | | \yect pcin
12 |Estonia 35336.63632 49789.30251 78198.80794 72832.70978 63404.42749 25945.7645 325507.6485
13 |Finland 228031624 1840425361 400565.6544 393745.5828 401912.8829 45840.75385 1654139.034
14 |France 1902318.119 1441705.047 3792693.484 3911862.953 3812667.12 104505.4734 14965752.2
15 |Germany 2537106.663 1825671.481 4031932869 4253528.664 3170437.011 129821.5094 15948498.2 | GEO Subregion CountryName
16 |Greece 112119.2569 115094.2422 189553.2589 169485.0934 138308.2189 41374.66289 765934.7332 [Auma““,\,ewze_" l; [ Austratia I
17 |Hungary 158333.6743 182614.9671 313790.5738 318702.1373 273383.696 34972.36546 1281797.414 =
18 |Iceland 41229.44671 56853.39263 75867.22936 73140.30212 60016.90058 39064.66443 346171.9358 lce"t’a'E“mpe l = IAUSt"E l
19 India 1510743.044 7498916.695 1454437.559 1540815.396 1564735418 1242634546 15212348.66 | | Eastern Europe | [Be|gium l
20 |Indonesia 236356.2597 264644.5212 353399.3616 394561.6835 2772314324 251490.1648 1777683.423 , B

[ Meso America l [ Brazil l

21 |Ireland 2344840429 82638.1593 466915.1762 656448.7772 670158.4013 7177.148482 2117821.705
22 |Israel 70856.78393 46425.11529 190723.9422 15777.2528 193729.1193 10477.76676 699990.9802 | | North America | | canada |
23 [italy 1452257.788 1213250.562 1977396.212 2091506.368 1979783.852 9769787658 8312892689 | orth East Asia | [ chite |
24 |Japan 2294341.042 2032173.64 3014951.363 1772049.155 1627443.447 136567.4113 10877526.06 =
25 |Luxembourg 60906.77298 90822.02623 372433.9045 466203.369 440642.3239 93355.14504 1524364.542 IS"“thAme"c" l IC'"“" l
26 |Mexico 872708.3952 905807.6807 1303636.406 1386906.757 1291788.696 114335.062 5830183.601 | | South Asia 15 [ caech Republic 1=
27 |Netherlands 894907.1281 554966.227 2023993.573 1899762.477 1732493.985 62682.43553 7168805.825
28 |New Zealand 8231108595 57005.22512 1403567713 129167.562 122320.7062 6835.474150 537996.8247

FIGURE 5-20 Slicers on a worksheet

Formatting and Sorting Pivots

All the formatting is right at your fingertips. We have so many options to play
with here to dial in how we want this to work. Let’s see the following few
figures, in which we can choose options and see the results of our formatting
capabilities in Excel.

The best way to experiment with formatting is to right click on columns in
your pivot table and select Format Cells. This will allow you to choose all
kinds of formatting options including currency, date formatting and other
customer formats like phone numbers, internal codes, etc. These options
will be covered throughout Part lll of this book in the Excel implementation
examples in each chapter.

You also have the option to do custom filtering on a pivot. Figure 5-21 shows
an option to filter by value.
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A B C D E F G H I J K L M N
1 |Population Column Labels IZ‘
2 |Row Labels 2000 2005 2008 2009 2010 2011 Grand Total

GEO Region .

SOV ST 001624.343 26375.02454 5567671.572
SortZto A 156165.4069 485615.7566 492302.7776 22.0668 53403.83677 1830539.335
More Sort Opions.. 340175.6796 2260847.33 1956650.379 0614.83 53865.28846 6866647.351
226056.5545 717154.1849 B845614.7821 41.5349 195606.7613 3097428.549
1138578.081 2198009.172 2273176.746 629.342 7912621205 8433101.333
Label Filters 5869174629 201517.0161 272903.0991 7.5956  33503.4759 9136353398
Value Filters x 1939.562 38.605 1351987.668 15037629.57
101.8171 D2.4675 35484.78904 1510318.031 | FPolar
Search CountryName Equals... l
147.4363 06.0593 4930205026 2050421891  \yioinois
P S 12.70978 4.42749 25945.7645 325507.6485
Greater Than... 745.5828 [12.8829 45840.75385 1654139.034
Grester Than Or Equal To..  1862.953 2667.12 104505.4734  14965752.2 - =
R 1528.664 437.011 129821.5034 159434932 GEO Subregion CountryName T
Lol o e wamaseots 1osrnate | NS o | (SR =
Between.. . .50058] 3906466443 3461719358 [ central Eurape ] | Austria |
v Net Between... 1815.296 35.418 1242694.546 15212348.66 [Eastem Europe ] [Be|gium ]
361.6835 1.4324 251490.1648 1777683.423 B
St e ) 55.4013 7177.143482 2117821705  Meso Americs ] Braai ]
. 46425.11529 190723.9422 187778.2528 29.1193 10477.76676 699990.9802 [North America ] [(‘anada ]
1453257.788 1213250.562 1977396.212 2091506.368 83.882 97697.87658 8812892.689 [th East Asia ] [Chile ]
2 a43al oa o 54 niao & a & 1443.447 136567.4113 10877526.06
25 | Luxembaurg 60906.77298 90822.02623 372433.9045 466203.369 440643.3239 93355.14504 1524364.542 [5"““' e ] [Chi"a ]
26 |Mexico 872708.9992 905807.6807 1308626.406 1386906.757 1291783.696 114335.062 5380183.601 [South Asia ] . [czech Republic ] 4
27 |Netherlands 894907.1281 554966.227 2023993.573 1899762.477 1732493.985 62682.43553 7168805.825
28 |New Zealand 82311.08595 57005.22512 140356.7713 129167.562 122320.7062 6835.474150 537996.8247
29 |Norway 175651.5256 183617.3604 485027.3575 542589.3473 180729.7993 69746.27287 1637361.663
30 |Poland 442379.9284 520519.7406 857461.8032 918801.8819 951328.916 41785.64053 3732277.911

Sheetl @ [ [

FIGURE 5-21 Avalue filter

SUMMARY

This chapter covered some great ways to begin assembling data for analysis.
We covered the different ways we can use Excel and PowerPivot to build simple
models and tables to begin using them as baselines for visualizing our data
on top of them. You can now build a model, improve it and clean it up, and
begin visualizing it in Excel. In Chapter 6 you learn about bigger and better
models and visualizations using Power View.
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CHAPTER 6

Power View

This chapter focuses on building a solution in Power View so you can con-
tinue your data visualization efforts. It covers what Power View is, what the
requirements are to create Power View reports, how to create a report, data
modeling tips, and also how to deploy and share the reports.

WHAT IS POWER VIEW?

Power View is a new reporting feature that was added in Reporting Services 2012.
Power View was created to provide web-based self-service reporting capabilities
to end users. It is designed for rapid data exploration and mash-ups of data from
a tabular Bl Semantic Model (BISM). The tabular data model can either be cre-
ated using PowerPivot or Tabular Analysis Services. Users can very quickly create
highly visual and interactive reports with Power View and the experience is greatly
simplified. Report developers no longer have to deal with setting properties
on objects included in the design, worry about relationships in the data, how a
particular visualization will look, or how to connect items together for filtering.

With Power View the property settings are not present like they are with the
other Reporting Services development tools such as Report Builder and Report
Designer. The modeler of the data has already taken care of the relationships in
the data. Power View provides you a WYSIWYG (What-You-See-Is-What-You-Get)
experience, so there’s no flipping back and forth between design and preview
anymore to see what your report will look like. Items within Power View reports
are also connected to each other based on how the data is related, so clicking
on an item in a chart legend can automatically filter related data in a table.

Power View is also a new feature in Excel 2013, so now this new functional-
ity is available either as an add-in that you can easily enable in Excel 2013 or
through Reporting Services in SharePoint integration mode. Figures 6-1, 6-2,
and 6-3 show some of the types of visualizations you can do with Power View.
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Sales Dashboard

DATA
Calendarvear SalesAmount  TotalProductCost
2005  $3,266,373.66 $1,954,767.79
2006  $6,530,343.53 $3,883,493.37

2007 $9,791,060.30
2008  $9,770,899.74

$5,718,327.17
$5,721,205.24

Total $29,358,677.22  §17,277,793.58

EnglishPromotionMame  SalesAmount = OrderQuantity

Category

No Discount $27,307 607 58,247
Wolume Discount 11 to 14 52,005,230 2118
Touring-1000 Promotion £30,993 13
Touring-3000 Promotion $14,347 20
Total §20,358,677 60,398
OrderQuantit ount, and Count of ProductKey by EnglishProduct
o nglish uctCats
@ Accassories
a @ Sikes
@ Clothing
2008
M Clothing Accessories 2006
o [ [}
oK 5K 20 25K
2008
CalendarYeal » = am
2005 2008 2007 2008

FIGURE 6-1 Sales Dashboard Power View report

Promotion

salesamount by Calendaryear, and EnglishPron

EnglishPromotionCategory 005 2006 2007 2005 Total
Mo Discount 1,013 2,507 23454 31,273 58,247
Reseller 170 9E3 592 2,151
Total 1,013 2,677 24,441 32,265 60,398
EnglishPromotiontame StartDa_  EndDate  Orderuanti_  Salesdmount
He Discount. 67172005 12/31/20... 58,247 $27,307 407
Touring-1000 Promotion TH1/2007 9/30/2007 13 $30,993
Touring-3000 Pramation 74142007 973042007 0 $14,647
Volume Discount 11 to 14 7#1/2005 &/20/2008 2,118 42,005,230
Total 60,398 $19,358,677
SalesTerritoryGro..  EnglishPromotionType  OrderQuanti._
Europe Hew Product 14
Ho Discount 17,423
Velume Discount 652
Total 18,089
Horth America Mew Product 7
Mo Discount 27,985
Volume Discount P62 s
Total 8,964 50K
Pacific Hew Product 2
Ho Discount 12,639
Velume Discount 504
Total 13,345
Total 60,398 o
oK

— Haw Product

Ho Discount

FIGURE 6-2 Promotion Evaluation Power View report
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POWER VIEW
What Is Power View?

Geo-Analysis
GO
2005
g
SslesAmount  OrderQuantity A
Bl =
R 29388577 60398
esAmoun StateProvince e, and Engli i §
Englis| pation m
@ Clerical |
@ Management &
@ Manual L
@ Professional
@ skilled Manusl S
werca S €™
R CT
(% N \ SalesAmount by SalesTerritoryCountry
\\
FRICA
Canada - 198M
\ SOUTH
- AMERICA France - 2640
Germany - 289M
United .
Yingdom 333M

on Y] 100

20 HAUTEG, © 250 Sreenag, D 2013 Misrasn Cagontn

FIGURE 6-3 Geo-Analysis Power View report

POWER VIEW MULTIDIMENSIONAL MODEL SUPPORT

As of this writing, only tabular models are supported with Power View. In
November 2012 Microsoft released a CTP of SQL Server 2012 that provides
support for Analysis Services multidimensional models to work with Power
View. This new capability could very well be released by the time this book

is released. For exercises in this chapter, just the tabular data models were
used.

Table 6-1 outlines the different visualizations that are available in Power View.

TABLE 6-1 Power View Visualization Options

VISUALIZATION ADDITIONAL INFORMATION

Table Regular table or matrix style, which can include row and
column groups. Tables can also include totals for the val-
ues, which can be turned on or off.

Bar chart Bar charts also include options for clustered, stacked, and
100% stacked. Data labels can be included as well.
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VISUALIZATION

Column chart

Line chart

Pie chart

Small multiples

Scatter chart

Map

Card

ADDITIONAL INFORMATION

Similar to the bar charts, they include options for clus-
tered, stacked, and 100% stacked. Data labels can be
included as well.

Line charts can support multiple values or can be broken
out by a particular dimension attribute. Data labels can
be included as well.

Pie charts can be broken out by a particular dimension
attribute. Data labels cannot be included.

Also known as trellis charts; can turn a single chart into
smaller repeating charts based on groupings and can be
organized either horizontally or vertically. This option is
available in the Field Well when a chart is selected.

Also known as a bubble chart. Provides ability to analyze
three metrics simultaneously and also provides a play
button feature to enable viewing how data changes over
time. You can view the history of a particular bubble by
clicking it to see the trail over time (assuming time was
set up in the chart).

The map uses the Bing map service to provide geo-
coding to plot the data elements using geographical data
elements such as text or latitude and longitude.

The card provides an index style layout for dimension
members, which can include images as well as text and
data values.

BISM: THE FIRST REQUIREMENT FOR POWER VIEW

As mentioned previously, a BISM tabular model is the foundation for the
Power View reports in Reporting Services. If you are using Excel 2013, which
now has native support for data models, you will be able to create a Power
View report from any data formatted as a table in addition to using tabular
data models. The native data model capabilities in Excel 2013 are limited, and
an advanced BISM tabular model will provide you much more functionality.
Also, it is a good idea to build a BISM tabular model with Analysis Services to
centralize your data and enhancements (such as calculated values or images,
etc.). That is functionality you can’t get if you just import data into Excel and
then create a Power View report.
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Creating a Power View Report

CREATING A POWER VIEW REPORT

In this section you create a Power View report from scratch. This process
involves connecting to a deployed BISM tabular model and using that data
and functionality to drive the Power View experience.

CREATING A DATA SOURCE

Be sure to install the data samples for this chapter before beginning this
section. For more information, see the “Installing the Power View Samples”
section later in this chapter. The data sample files will be used to perform the

exercises in this chapter.

First, you need to create the data source. You can do this in one of several
ways. You can connect to your data model through Excel 2013 and import
the data into an Excel worksheet. Although this process will limit the amount
of data and functionality you can leverage, it is great for simple tasks. You
can use PowerPivot to import the data and then create tables in Excel to
analyze or you can connect to a PowerPivot data model that is published in
SharePoint. Right now, your data model is published to an Analysis Services
server somewhere, and that is the type of solution we're focusing on. For now,
let’s jump into Excel.

CREATING A NEW POWER VIEW REPORT IN EXCEL

To create your new report, open Excel 2013 and select the Data tab. Then
select From Other Sources in the top-left third of the Ribbon. See Figure 6-4.

[: = :
HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
2] Connections 4 H &

H = [b's 2l
n' & E -¢- ’—'V Praperties
From From From From Other Existing Refresh . 7l Sort Filter
Access Web Text Sourcesw Connections  All» = EditLinks o
Get External Data Connections Sort & Filter
a3 - Get Data From Other Sources

Import data from other sources,
A E = U E F G H 1

FIGURE 6-4 Getting external data from other sources
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2lx| Next, select From Analysis Services, enter your connection informa-
5*"5"";:”;:;":’““"‘"*“"" B213,0 YU IOk o ok tion, and click Next. Now select the Chapter 6 - BISM Model from
i € EiotTable Report the database dropdown and click Finish.
IG5 © PivotChart
21 ower View Report] . .
® o T T From the Import Data dialog box choose Power View Report, as
s shown in Figure 6-5, and click OK. If you do not see the Power
¥isting worksheet:
[Fsast = View Report option, that means that the add-in has not been

= New worksheet

enabled yet, so click Cancel and follow the steps in the “Enabling
the Power View Add-in” sidebar—then you will be able to complete
these steps.

I Add this data to the Data Model

Properties... | oK I Cancel |

FIGURE 6-5 Choosing to view datain a
Power View report

ENABLING THE POWER VIEW ADD-IN

In order to enable the Power View add-in click on File in the Ribbon, and
then Options > Add-Ins, and then select COM Add-ins from the Manage
drop-down list and click Go. Now check the box next to Power View and
click OK.

After the Import Data dialog box closes you should see a screen like that
shown in Figure 6-6.

@ d J BeckL - Microsoft Excel Previes ? B - 8%
HOME  INSERT 3 ATA  REVIEW  VIEW  POWERVIEW | POWERPNOT  INQURE - @

i

Fitto  Field Fillers
Window Lut  Ares
Cipbosry ungo/Redo Themes Backgrouna Imsge st iew insert arrange

Power View Fields »
acmve | A
¢ x || *ECutomer

viEew

Drag fields between areas below:
FIELDS

Sheetl | Power Viewl @

FIGURE 6-6 Clean Power View report canvas
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Creating a Power View Report

When you see the Power View interface for the first time, you'll notice how
uncluttered it looks. Let’s review the sections of this interface and see where
to go for certain types of actions.

Canvas: The center section dominated by the watermark is called the
canvas, which is where your different visualizations will show up. You can
build tables, slicers, charts, and other elements to create an interactive
experience.

Field List: The upper right of the screen should look familiar if you've used
Excel’s pivot table functionality in the past. It is where the tables from the
data model show up for you to work with.

Field Well: The Field Well, found in the bottom right, is where you drag
and drop fields to enable them in different elements on the canvas. We
can change some settings here as well to help them show up the way
we want.

Filters Area: The Filters Area restricts the amount of data displayed in
your canvas elements. We could, for example, restrict to showing just a
particular year or a city/state combination for more detailed viewing of
our data. If it gets in the way, you can toggle it using the “<” icon at the
top of the Filters Area or remove it completely with the Filters Area option
in the Ribbon.

View area: The View Area is available when using the SharePoint Power
View option and allows for tracking different states and/or views of the
data in the same report file to provide capabilities to analyze data at dif-
ferent points in time and/or in different ways.

Ribbon: This is the familiar interface introduced with Office 2007 in which
many of your other common tasks such as saving, design, and data con-
nectivity are grouped together.

Now we can begin creating our first report, but before we do let’s review the
steps at a high level and then we'll complete an exercise:

First, you can give your report a title such as Reseller Performance by
clicking on the item on the Power View canvas labeled Click here to add
a title.

Next, you select the data you want to analyze and explore by dragging
it onto the canvas. You can rearrange the fields in the Field Well to make
the report look more appealing. Remember that you don’t need to do
any relationship building here. If the relationships exist in the model,
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they will be surfaced here. As you see here, the fields have created a
table on the canvas, which is the starting point for any item added.

Now you can change the initial table into a different visualization such
as a column chart by switching over to the Design tab in the Ribbon.

You can then drag other fields into the Filter pane to the right of the can-
vas, as shown in Figure 6-6, which provides additional context-sensitive
filters on the report.

Additional fields you add to the canvas that you want as slicers can be
enabled by selecting them and then clicking slicer in the Ribbon. Simple!

Creating Your First Simple Power View Report

Now you dive deeper and build a financial-style report step by step. Because
financials are not always eye-grabbing, you can add some visualizations to it
to spice it up.

Open Excel 2013, if it isn't open already, and go to the Data tab. Make
sure you are in a worksheet in the Excel workbook, because if you are
in a Power View report the items will be greyed out. Select Existing
Connections, and then select the connection file that you created previ-
ously in this chapter in the section “Creating a Data Source,” and refer to
that section if you still need to create the data source connection. This
will display the Data Import dialog box where you will then want to select
the Power View Report option, and click OK, as shown in Figure 6-5.

Now you create your first table in Power View. In the Power View Fields
list, select InternetSales > OrderQuantity and SalesAmount. In the
Field Well click on the drop-down arrow next to OrderQuantity and
select Sum. Also select Geography > EnglishCountryRegionName and
StateProvinceName. This process creates your first table on the canvas.
Figure 6-7 shows an example.

Using filters is easy in this new interface. Between the main part of the
canvas and the field list is the Filters Area. Drag fields from the list into
the Filters pane such as SalesTerritory > SalesTerritoryGroup and Date >
CalendarYear. Make selections from these two fields in the Filters pane
and watch as the data changes in the table. Experiment with dates,
numeric values, and regular text columns to see the different types of
sliding filters and check box lists you can get.
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2303 $1988415.03 Aususia
867 S618I55.56 Ausvialia
393 523335750 Ausvalia
3343 5227930000 Auswala

33 52244750 Canacs
7584 $195534010 Canacs
3 33036 Canads
7S 53444173 France
505 527325718 France
109 55404172 France
543 520341813 France
0 52147374 France
193 59150231 France
156 53404623 France
844 533140020 France
4 51134292 France

174 $53372580 France

FIGURE 6-7 Your first table in a Power View report

5833 $393449573 Ausraia

Péew South Wales
Quesatand
St Aususia
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Vicwrta

Aera

Beitsh Columbia
Orario
Chareme-ariime
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Hiauts de Seine
Loir ev Cher
Loire
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Fas o8 Canats
Seing (Pars)
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Creating a Power View Report

Click in the corners of the table and drag them to make the table more
readable. Get used to resizing these visualizations because you'll be
moving things around a lot to fit everything on the canvas.

Now we can make this report even better by changing it to use tiles.
Click in the table and then go to the Design tab in the Ribbon. Click the
Tiles button and select Convert to use tiles. Now the report is tiled by the
region name, and you can click through the tiles in a visually appealing
manner. Your final report should look similar to that shown in Figure 6-8.

AT §118A 74438 Aveeraliz
1643 SE73IE492 Austalia
08 §16595179 Australia
167 5224258 Australia
1704 61279067 Australia
6757 $256188429

FIGURE 6-8 A Power View report with filters and tiles

Mave Sousth Wialas
Quesniland
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Drag fields between areas below:
TILE BY

=ICategonyimage -
FIELDS

StateProvinceName -

¥ OrderQuantity -

X 5alesAmount -

FIGURE 6-9 The Field Well
showing Tile By Categorylmage

Enhancing Your Power View Reports

Now that you've created your first simple report, let’s add some pizazz to your
reports by adding images.

Create a new Power View Report in Excel connecting to the data model
provided with this chapter. If you need any help refer to the first step in
the previous exercise.

Let's add some images to a new version of the report we created in the
previous exercise. In the next couple of steps, you build a report with
even more interaction.

Create a table on the report using Geography > StateProvinceName
and InternetSales > OrderQuantity and SalesAmount from the field
list. Make sure to select Sum from the drop-down arrow next to
OrderQuantity in the Field Well just like in the previous exercise. Then
Select ProductCategory > Categorylmage and drag it into the Tile
By section in the Field Well, as shown in Figure 6-9. When you add
Categorylmage to the Field Well you will probably receive a Security
Warning message above the worksheet. You will need to click the
Enable Content button to allow for the images to be displayed. The
images are referencing URL locations on the Internet, so you will also
need an Internet connection for these to display properly.

Next, drag the following fields onto the canvas to use as slicers:
Geography > EnglishCountryRegionName
Date > CalendarYear
SalesTerritory > SalesTerritoryRegion
Customer > EnglishEducation
Customer > EnglishOccupation

For the CalendarYear table you may need to change the setting in the
Field Well to Do Not Summarize (if it is set to Sum) so that you will be able
to change this to a slicer.

Click each one of the fields you just added on the report, select the
Design tab in the Ribbon, and then click Slicer. This will turn each of
these fields (tables) into a live filter with no additional work on your part
to hook them up or build relationships to the other items on the report.
Figure 6-10 shows the finished example after the items have been rear-
ranged, sized, and with selections made in the slicers.
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FIGURE 6-10 Power View report with images and slicers
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ENHANCING DATA MODELS FOR
POWER VIEW

Before you make your data model available to end users to create reports
against, there are a few enhancements that should be done to improve the
usability and adoption of the model. These enhancements include cleaning up
the data model as well as setting some additional settings within the model
that Power View can then leverage when you're creating reports. Now let’s

take a look at what is involved with these enhancements.

CLEANING UP YOUR DATA MODEL

There are a number of things you can do to clean up your data model and
make it more valuable for your efforts or for your end users’ needs. Let’s

explore some of them here:

Remove unnecessary columns. Many times we import a lot more col-
umns than we need into our data models. Now is the time to go about
cleaning them out. Just remove them; or if you feel they must be there,
you can right-click the column header and select Hide From Client Tools.
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Make sure column names are clear and understandable. Go through
your data model and make sure the names are clear and legible. Now is
the time to make this easily understandable for your end users. These
names can be edited by either changing the properties of a column in the
properties pane of SQL Server Data Tools, or by right-clicking the column
header and selecting Rename.

Review formatting of data and ensure the data is clean. You should
always spend some time reviewing the data in your model to make sure
it fits the profile you believe to be correct. Sometimes you won't know
and that’s okay, but check for simple things such as ensuring that the
Description column does not contain Prices and other things like that.

Add any images you might need for building cards or more-advanced
visualizations. Review the previous section on Enhancing Your Power
View Report to see how to add images and other impressive interactivity
to your model so you can consume them in Power View.

ADDING METADATA FOR POWER VIEW

After the data model has been cleaned up, there are some additional items
that can be looked at to further enhance it when used with Power View. These
items include the default field set, table behavior settings, and categorizing
the data in your columns within your tables accordingly. This section discusses
these and provides an example from a Tabular Analysis Services project. In
a PowerPivot data model, these items are found in the Reporting Properties
section of the Advanced tab in the PowerPivot window.

Default Field Set

First there is the default field set. This setting on a table in your data model
provides you the ability to select one or more columns from your table (includ-
ing measures) and allows you to order them as you see fit. Now when a user
clicks on the table in the Power View Fields, all of the columns that were
defined in the default field set will be added to the canvas. This provides a
quick way to add multiple columns that are typically used for a particular
table in a report. Figure 6-11 shows an example of what the Default Field Set
dialog boxes looks like.
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Default Field Set x|
Default Field Set for Table Customer
Specify the columns, measures, and field ordering that define the default field set when visualizing this table in certain dient tools.
Click here for more information on Default Field Set.

Fields in the table: Default fields, in order:
CustomerAlternatekey LastName
Customerkey Firsthame
EnglishOccupation EnglishEducation
GeographyKey Gender
Suffix MaritalStatus

CommuteDistance

Add -> | Move Up
<-Remove | Mave Down
cncd_|

FIGURE 6-11 Default Field Set dialog box

Table Behavior

The table behavior properties can be used to set the following properties
for a particular table: Row Identifier, Keep Unique Rows, Default Label, and
Default Image. The Row Identifier allows you to designate the column in the
table that is the unique identifier (primary key) for that table. The Keep Unique
Rows setting allows you to establish which column(s) in the table will be used
to determine unique rows when reporting. So, for instance, in the Chapter 6 -
BISM Model, if the Row Identifier is set to CustomerKey, the Keep Unique Rows
could be set to CustomerAlternateKey or possibly FirstName and LastName.
That way if a customer is in the table multiple times you can report on them
as a single customer instead of multiple customers and avoid sending them
multiple offerings.

The Default Label and Default Image do exactly what you would think—they
allow you to define the label and image for each unique row in the table. So
for the ProductCategory table you would select EnglishProductCategoryName
for the Default Label and Categorylmage for the Default Image. The Default
Image can reference either binary data-type columns or text columns that are
designated as URL references to image files. See Figure 6-12 for an example
of the table behavior dialog box.
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Properties
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FIGURE 6-13 Data Cat-
egory column property

Table Behavior for Table ProductCategory

The properties on this dialog allow you to change the default behavior of different visuslization types and default grouping behavior in
dient tools for this table.

Click here for more information on Table Behavior.

2x

Row Identifier:

Keep Unigue Rows: [w| CategoryImage
[] EnglishProductCategoryName
[] ProductCategoryAlternatekey

[] ProductCategorykey

Default Label: I EnglishProductCategaryMame

Default Image: I CategoryImage

L]

cancel_|

FIGURE 6-12 Table Behavior dialog box

Data Category

Data category is a property setting that is available on a column within your
data model. Some of the values for this property are address, city, continent,
image, imageURL, place, etc. Once this property is set on the column, Power
View can interpret that information and use it so that it knows that the text is
a URL reference to an image or that the text represents a country name. This
can then be used to display images and map the data depending on the type
of visualization used in the report. Figure 6-13 shows an example of this prop-
erty setting in a Tabular Analysis Services project for the StateProvinceName
column in the Geography table.

SHARING POWER VIEW REPORTS

Now that you have learned how to create these highly interactive Power View
reports, the next step is to share them with others. There are a few options
for this—one is that you can publish them to a SharePoint portal and another
option is to use the export to PowerPoint capability. Let’s look at these two
options a little further.
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PUBLISH IN SHAREPOINT

It is especially useful to be able to share not only your Power View creations,
but also your PowerPivot data models. This section explores doing that and
shows some of the value it provides.

Deploying Your Data Model to SharePoint

When you want to share your data model with co-workers or a team, you
can save it to a SharePoint library, enabling them to create new Power View
reports right from the SharePoint interface. Here are the steps that you can
use to deploy the PowerPivot Excel file to SharePoint.

Open the PowerPivot Excel file (in this example this is an Excel 2013 file).

Select the File tab in the Ribbon.

Now click Save As and then Browse, enter the location, as shown in
Figure 6-14, and click Save (in Excel 2010 this is done as Save & Send,
then Save to SharePoint, and Browse).

% + Libraries » Documents + - @II Search Documents 2]

S/@)

Organize | Mew folder = @

@3 vicosoftexedl  —|  Documents library

Indudes: 2 locations

Arrange by: Folder «

W Favorites

B Desktop MName * Date modified | Type
@ Downloads My Data Sources 9/28/2012 4:25FM File folder
] Recent Places SQL Server Management Studio 9/29/2012 1:52PM  File folder
; Visual Studio 2010 8/1/2012 3:47 PM File folder
i Lbraries 0% Chapters PowerPivot 8/1/20123:47PM  Microsoft Excel
j Documents
J‘J Music
[ Pictures
B videos LI | | LI
File name: I http: fflocalhost/documents/Chapters PowerPivat] j
Save as type: IExce\ Workbook j

Authors: Windows User Tags: Add a tag

™ save Thumbnai

s HIdeFoIdersl Tools - Save I Cancel

FIGURE 6-14 Saving an Excel file to SharePoint

Now the file will be uploaded to SharePoint in the document library that
you specified.
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Alternatively, you can share your own reports and people can view them
if given the right access. These Power View reports could have potentially
been included in the Excel file with the PowerPivot data model already, they
could be in a separate Excel file like the one we created in the exercises in this
chapter against the Tabular Analysis Services model, or they could be created
and saved directly in SharePoint. If they are included in the Excel file, you can
follow the steps just listed to save them to SharePoint.

Now that the file is in SharePoint, users have the ability to connect to that file
from their desktops in a new Excel file and create reports from it. In addition,
users could also create connection files in SharePoint that could in turn be
used to develop Power View reports from directly in SharePoint, or even use
them as sources for PerformancePoint dashboards.

Saving Your Power View Reports in SharePoint

If you are creating the Power View reports directly in SharePoint instead of Excel,
you can quickly save and share the reports directly in a document library. Once
the files are in the document library or possibly a PowerPivot Gallery, then you can
provide access to these reports for others to reference and explore. The following
are the steps that you can use to save a Power View report directly in SharePoint.

After you have created your Power View report in SharePoint, select the
File tab in the Ribbon.

Then click Save (or Save As; since this is your first time saving the report
those options will act the same) and enter a file name for the report file,
which has a file extension of RDLX, as shown in Figure 6-15.

Save As 3

http://win-dogtev6dajd/Documents - [ 4
P q J L

This folder is empty.

File name: |Chapter & Examples |.rd|x

[+ Include an image of each view in its current state as a preview for other users (in
PowerPivot Gallery and other applications)

Save Cancel

FIGURE 6-15 Save a Power View report in SharePoint
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You see in Figure 6-15 that there is an option to have images of the views
with the report file as well. These images can then be used to display in,
say, the PowerPivot Gallery if you choose to save your reports in that type
of a library. If you do then you will get to see a preview of the views that

are included in your report file.

Now you can browse to a new location if the current location is not
where you want to store the report file. When you are ready, you can

click Save.

EXPORTING TO POWERPOINT

Power View reports created in SharePoint (not the ones created by using
Excel) have another great feature: they can be exported to PowerPoint. This
makes these reports more mobile, and full interactivity is possible as long as
the person has connectivity to the data source. To export your Power View

reports to PowerPoint, simply press the button
shown in Figure 6-16 while you are viewing the
report in SharePoint.

In addition to being able to make these reports
more mobile and being able to incorporate them
into a presentation, this also provides a nice way
to be able to print all of the reports at the same
time. If you tried to print them from SharePoint
you would only be able to print one view within
a report file at a time, so if you have multiple
pages, using the Export to PowerPoint option
works nicely. In addition to that, you are also
able to save them to a PDF format once they
are exported.

H2g

E Save
B’ Save As
Eﬂ Print
[P4]
=L.
I:.:a- Optians
9 Help

Export to PowerPoint

Export c

Power View

Micresoft SQL Server Reporting Services
Version 11.0.2845.0

Diagnostics

Sync diagnostic information with the serve
urrent report to PowerPoint. bn.

FIGURE 6-16 Power View Export to PowerPoint option

INSTALLING THE POWER VIEW SAMPLES

The samples are simple to install. You need an instance of SQL Server 2012
SP1, SQL Server Data Tools, a tabular instance of Analysis Services running in
your environment, and a SharePoint installation with PowerPivot and Reporting

Services integration. Follow these steps:

Restore the CH6db . bak file to your SQL Server 2012 SP1 database instance.
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Open the project file in the Chapter 6 - BISM Model directory.

Check the Model .bim Workspace Server property. Make sure that this
points to the right server for your environment. The server setting will
default to localhost.

Check the model’s existing connection server setting. Open the Model
.bim file and, from the File menu under Model, you can open the exist-
ing connections and edit the SQL Server data source with the project
so that it points to the right server for your environment. The server
setting will default to localhost.

Check the properties for the project and make sure it points to the right
server for your environment. The server setting will default to localhost.

Deploy the model to your tabular instance of Analysis Services.

You're now ready to connect to it with Excel 2013 and start building reports!

SUMMARY

In this chapter, you created models to explore your data and then created some
simple visualizations using Microsoft Power View. Power View, like many of
the tools in this book, is bigger than we can cover completely in one chapter.
We hope this introduction has inspired you to test it out more thoroughly in
your environment!
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CHAPTER 7

PerformancePoint

PerformancePoint provides a very powerful toolset dedicated to designing
scorecards and dashboards. PerformancePoint, being introduced in 2007, is
one of the newest Microsoft business intelligence (Bl) tools.

Compared with other Microsoft Bl tools, PerformancePoint offers the designer
the most useful functionality. As a key benefit for rapidly designing content,
most of the useful functionality need not require planning and specific imple-
mentation because the features are common options associated with the
various scorecard elements. Balancing this functionality is less control over
visual elements, and rather limited print and export options. This chapter
will provide an introduction to key PerformancePoint functionality used to
develop visualizations.

TABULAR VERSUS MULTIDIMENSIONAL
SOURCES

The key foundational element used with a PerformancePoint solution is a data
source. The data source supplies data for use by key performance indicators
(KPIs), analytic charts, grids, dashboard filters, and other PerformancePoint
objects. The types of data sources supported for use with PerformancePoint
include tabular and multidimensional sources. It is important to note that
PerformancePoint will treat both tabular and multidimensional sources the
same way for the purpose of design activities.

Tabular data sources include Excel spreadsheets, Excel Services spread-
sheets, SharePoint lists, and relational database tables. These tabular-type
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data sources work best with PerformancePoint when organized in a way that
distinguishes columns as either dimension data or fact (measure) data by the
PerformancePoint Dashboard Designer during data import. One example of
this organization is that a column within a spreadsheet that should contain
fact (measure) data must contain only numeric values in order to be classified
as a fact source by the Dashboard Designer.

Multidimensional data sources are those that include dimensions, measures
(facts), and support—either the MDX or DMX language. PerformancePoint mul-
tidimensional data sources presently include Analysis Services and PowerPivot
workbooks.

Key usage differences exist among the tabular and multidimensional data
source capabilities within PerformancePoint. A key limitation found when using
a tabular data source is that data is flattened, so it cannot represent parent/
child relationships nor can it model hierarchies between dimensional values.
Additionally, tabular sources cannot be used by analytic charts and grids.
The data exploration feature, Decomposition Trees, is also not supported for
tabular data sources.

REQUIREMENTS FOR RUNNING
PERFORMANCEPOINT

This section discusses the various hardware and software requirements for
running PerformancePoint and the Dashboard Designer.

The Dashboard Designer, used to create and organize PerformancePoint objects
into dashboards, requires a computer having a dual core, 32-bit processor with
2GB of memory and 2GB of disk space. Additionally, a SharePoint-supported
browser is required (details are provided in the “SharePoint Requirements”
section that follows.

Analysis Services 2000 is no longer being supported as a data source and,
along with SharePoint, PerformancePoint requires 64-bit server architecture.

SHAREPOINT REQUIREMENTS

To install, configure, and run SharePoint web servers and application servers,
the host server must have a 4 core 64-bit processor with 8GB of memory and
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80GB of disk space. Additionally, the database server that stores the SharePoint
data requires a 4-8 core 64-bit processor with 8-16GB of memory and 80GB
of disk space. This database server requires a 64-bit edition of Microsoft SQL
Server from the following versions:

Microsoft SQL Server 2012 (requires SharePoint Server 2010 SP1 or later)

Microsoft SQL Server 2008 R2

Microsoft SQL Server 2008 SP1 with Cumulative Update 2 for SP1

Microsoft SQL Server 2005 SP3 with Cumulative Update 3 for SP3
A 64-bit version of Window Server 2008 with SP2 or Windows Server 2008 R2
or later is required for SharePoint installation, and the SharePoint preparation
tool will install any of the following if they are missing from the server:

Web Server (lIS) role

Application Server role

Microsoft .NET Framework version 3.5 SP1

Microsoft Sync Framework Runtime v1.0 (x64)

Microsoft Filter Pack 2.0

Microsoft Chart Controls for the Microsoft .NET Framework 3.5

Windows PowerShell 2.0

SQL Server 2008 Native Client

Microsoft SQL Server 2008 Analysis Services ADOMD.NET

ADO.NET Data Services Update for .NET Framework 3.5 SP1

A hotfix for the .NET Framework 3.5 SP1 that provides a method to sup-
port token authentication without transport security or message encryp-
tion in Windows Communication Foundation (WCF)

Windows Identity Foundation (WIF)

SharePoint requires a supported Internet browser in order to successfully
view and interact with content. Support for Internet browsers is categorized
into supported, supported with limitations, and not supported (as follows):
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TABLE 7-1 SharePoint 2010 Supported Browsers

SUPPORT WITH

BROWSER SUPPORTED LIMITATIONS NOT SUPPORTED
Internet Explorer 10 32-bit 64-bit
Internet Explorer 9 32-bit 64-bit
Internet Explorer 8 32-bit 64-bit
Internet Explorer 32-bit 64-bit

7 (no longer sup-
ported in 2013)

Internet Explorer 6 X
Google Chrome X

Mozilla Firefox X

Apple Safari X

The first step in installing PerformancePoint Services is ensuring that the
Enterprise Features are installed. To do this, go to Upgrade and Migration in
the Central Administration site, and click Enable Enterprise Features. This is only
necessary once for any Enterprise Feature. After you have done this, enable
these features by clicking Enable features on existing sites. This will enable
the Enterprise Features across all existing sites—you can do this manually if
you want to enable the features on only some sites. The next step is to run
the configuration wizard—make sure to choose PerformancePoint and the
Secure Store service!

AUTHENTICATION ISSUES WHEN USING
SECURE STORE SERVICE

To successfully use PerformancePoint a Secure Store Service (SSS) is required
to be configured. When an SSS is not properly configured, the Dashboard
Designer will have errors when trying to create new data sources that are
resolved by ensuring that the SSS is running, it has a correctly generated
encryption key, and an unattended service account is set for PerformancePoint.

SSS may already have been configured for another application, but if it has
not, it will need to be set up. The steps to be taken are:

Install SSS

Create a key for encryption

www.it-ebooks.info


http://www.it-ebooks.info/

PERFORMANCEPOINT 109
Authentication Issues when Using Secure Store Service

Create a new Secure Store Application

Assign credentials to the new application

KERBEROS

SSS is not required when Kerberos is being used—Kerberos is required for
role-based security in SharePoint 2013, and is outside the scope of this book.

Kerberos allows users to connect to an Analysis Services data source under
their own credentials, whereas SSS will store a single credential for access-
ing the data source.

Configure a Secure Store by registering a managed (domain) account in
SharePoint (via Central Administration > Security > General Security) to run the
Secure Store application pool, start the SSS (via Central Admin > Application
Management > Service Applications > Manage Services on Server) on the
application server in the SharePoint farm, and create an SSS application (also
via Central Admin > Application Management > Service Applications >
Manage service applications).

From Central Admin, choose the Manage Service Applications option under
Application Management, then click the Secure Store Service and you will see
a screen like Figure 7-1.

Site Actions - @Y  Browse Edit

X & ¥ G B

Mew Delete Edit Generate New Refresh Set Set
Key Key

Manage Target Applications Key Management Credentials Permissions

Central

Administration r Target Application 1Dt Type Target Application Name
Application Management - 7fagdcoe7-fech-4734-9ade- Group PerformancePoint Service Application

. c23b048521c9-

System Settings PPSUnattendedAccount

Sl Il ESA Group ESA

Backup and Restore

Security - Excel Services Application Group Ticket Excel Services Application
Upgrade and Migration - Excel Services Sales Group Excel Services Sales

General Application
Settings

Configuration Wizards

FIGURE 7-1 Secure Store Service
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If there are no applications listed, you will need to start by generating a new
key—this is the key that will be used to encrypt the credentials stored in the
Secure Store Service, so ensure that you save the passphrase in a secure location.

Now that you have created a key to encrypt the usernames, you will set up
the account that PerformancePoint will use.

Set an unattended service account using SharePoint Central Administration by
selecting Manage Service Applications and then clicking the PerformancePoint
Service Application. Select PerformancePoint Service Application Settings and
set the username and password for the Unattended Service Account.

KPIS, SCORECARDS, FILTERS, REPORTS,
AND DASHBOARDS

This section gives you a tour of the various component objects within
PerformancePoint along with an overview of how each contributes to the
design of a data presentation solution. In order to create any of these compo-
nents, a site collection using the Bl Center template is required. You create a
new site collection in Central Admin > Manage Applications > Create site col-
lection and choosing the Business Intelligence Center under the Enterprise tab.

CREATING A DATA SOURCE

To connect PerformancePoint to the data, a data source is required. SharePoint
further requires that all data connections be stored in a trusted data connec-
tion library. When PerformancePoint Services is configured, it automatically
trusts all SharePoint libraries—this can be overridden to allow only certain
libraries to contain PPS data sources.

All PerformancePoint design occurs within a tool named Dashboard Designer.
There are several ways to start the Dashboard Designer. If not previously
installed, from web browser, open the Business Intelligence Center, select a
section from Monitor Key Performance, Build and Share Reports, or Create
Dashboards, and click the Start using PerformancePoint Services link. On the
PerformancePoint site, click the Run Dashboard Designer button. You can also
open the Dashboard Designer by opening the Business Intelligence Center or
the PerformancePoint site, right clicking on any PerformancePoint content listed
and selecting the Edit in Dashboard Designer. After Dashboard Designer has
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been opened previously, you can launch it from the Start menu (via Start >
All Programs > SharePoint > PerformancePoint Dashboard Designer).Within
PerformancePoint, as shown in Figure 7-2, the data source can be created
by selecting the Data Source menu option located on the Create Menu of
Dashboard Designer or from within a SharePoint Data Connections library
by selecting New Document from the Documents view. The server name will
need to be inserted next. Often, “.” can be used if you are working from a local
machine, else the server name will be required. Sometimes an instance name
in the format “servername\instancename” will be needed. Then you should be
able to choose the appropriate database from the drop-down, and then the

cube from the drop-down.

Edit | Create ]
3 7 1 :
e =4 = LS . =] i fir]
I e = 4 3 T} [ |5 Jr_l _%oﬂl il
Dashboard Scorecard KPI Filter Indicator | Data Analytic  Analytic  Strategy KPI Reporting  Cther
Source Chart Grid Map Details  Services Reports
Dashboard Items Reports
Workspace Browser <« | [ SharePaint| Source
= . Create a connection to a database,
Llﬂ UntitledWorkspace file, SharePoint list, or other source.
E= Data Connections Data Cormiccuors
[ PerformancePoint Content Name Type
U AWCube Analysis Services

If_\l
=

|:| http://kiwi:81/sites/bi/Data%20Connections%20forit 20PerformancePoin

{-?p |:| EI Center - SharePoint |:| PowerPivot - SharePoint

Library Tools
Site Actions ~ @B Browse Documents
::j] ﬁ.j] y _{y Check Out
< 5 checkIn 7
Mew Upload Mew Edit View Ed
Document ~| Document ~ Folder Document &l Discard Check Qut ~ Properties Prope
| PerformancePoint Data Source n & Check Out
Add a new Data Source to the L .
document library using the % Description Modified
Dashboard Designer

: PerformancePoint Data Source |
Create a new Office Data Connection

File 5/22/2012 11:37 AM
j Universal Data Connection File

j Office Data Connection File

Provide a standard place for
applications, such as Microsoft
InfoPath, to store data connection
information.

[y Al site Content

FIGURE 7-2 Methods of creating new PerformancePoint data sources
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MAPPING THE TIME DIMENSION

PerformancePoint has a Time Intelligence feature to support a rich variety
of common time selections such as Last Quarter, Current Financial Year, or
Last 3 Quarters. This Time Intelligence feature associates a common time
label with a specific filter period that is defined using the Simple Time Period
Specification (STPS) language.

Configuration of Time Intelligence is performed on the data source using the
Time tab. This is covered in the “Installing the PerformancePoint Samples” sec-
tion at the end of the chapter, specifically for the samples used in the book.
After starting by selecting a dimension in the data source that stores calendar
dates, a reference date to begin a year for the dimension is provided.

Next, the hierarchy level of the date provided is selected. In the case of a date
of January 1, 2005, the hierarchy level may be set to Day. A reference date
that is equal to the period specified by the hierarchy level is entered and then

each member level has its appropriate

e | — | . | time aggregation set to the dimension
level corresponding with a given mem-
i«) AWCube

5 ber level (e.g., Calendar Year member
Reference Data Mappi % . .
st St i i level is mapped to Year time aggrega-
Time Dimension: . . .

tion level). A sample Time Intelligence

[Date.Date.CaIendar '] . )

Reference Data Mapping is demonstrated
Reference Member: in Figure 7-3

Member:

Choose a date to begin the year for the selected time dimension: With the Time Intelligence pro perly

January 1, 2005 configured for a PerformancePoint

Hierarchy level: ; ;

Erarey Eve data source, the Time Intelligence for-

Day '] L

mulas can be used within a filter cre-
MAPS TO... ated by selecting the Time Intelligence
Reference Date: template when creating a new filter.
Enter & date that is equal to the period spedified by the reference member above: Flg ure 7-4 shows the selection of a
1 1/2005 @~ . .
Time Intelligence filter from the Select
Time MemberAssocations & a Filter Template dialog box that appears
Member Level Time Aggregation when creating a new filter within
Calendar Year ’Year - PerformancePoint.
Calendar Semester [Semester i
Calendar Quarter [Quarw = The resulting Time Intelligence filter can
Month IMonth - be added to PerformancePoint dash-
Date |Day - boards in order to permit users selecting
FIGURE 7-3 Configuring PerformancePoint data sources with Time these common Time Intelligence date
Intelligence values.
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Select a Filter Template
T
P ¥F ¥ ¥ ¥ ¥

Custom Table  MDX Query

Member Named Set Time: Time
Selection Inteligence Intelligen...

Time Intelligence

Create a filter that allows the user to select Time Intelligence members.

FIGURE 7-4 Creating a PerformancePoint filter that uses Time Intelligence

Quick Samples

Formula structure: [ (1<Period>[0Offset>[)]]

TABLE 7-2 Example Formulas

TO DISPLAY

Yesterday

Tomorrow

The current quar-
ter and today

Last 10 days

Last 10 days
(excluding today)

Same day last year

FORMULA

day-1

day+1

quarter, day

day:day-9

day-1:day-10

(year-1) .day

RESULT

The previous day relative to the
current date.

The next day relative to the cur-
rent date.

A set of time periods consisting
of the current day and current
quarter.

A 10-day range including today.

A 10-day range NOT including
today.

Current date (month and day)
for last year. For example, if the
current date were December 10,
2010, then (year-1) .day would
show information for December
10, 2009.
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TO DISPLAY

Same month last
year

Same range of
a period of six
months last year

Same range of
months to date for
last year

Year to date

Year to date
(by month)

Year to date
(by day)

Parallel year to
date

Parallel year to
date (by month)

MICROSOFT’S TOOLSET FOR VISUALIZING DATA

FORMULA

(year-1) .month

(year-1)
. (month-5) :
(year-1) . (month)

(year-1)
.firstmonth:
(year-1) .month

yeartodate

yeartodate
.fullmonth

yeartodate
.fullday

yeartodate-1

(yeartodate-1)
.fullMonth

www.it-ebooks.info

RESULT

Current month for last year. For
example, if the current month
were December, 2010, then
(year-1) .month would show
information for December, 2009.

From 18 months ago to one year
ago. For example, if the current
month were December 2010,
then (year-1). (month-5) :
(year-1) .month would show
information for the time period
ranging from June, 2009 to
December, 2009.

From the first month of last year
up to and including the month
parallel to the current month this
year.

A single time period representing
the aggregation of values from
the beginning of the year up to
and including the last completed
period. The period corresponds
to the most specific time period
defined for the data source.

A single time period representing
the aggregation of values from
the beginning of the year up to
and including the last completed
month.

A single time period representing
the aggregation of values from
the beginning of the year up to
and including the last completed
day.

The aggregation of the same set
of default time periods completed
in the current year except for the
prior year.

The aggregation of time peri-
ods last year that is equal to year
to date periods for the current
year.
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General conventions

When no offset is specified, the current period is assumed.

Using a time period with an offset along with a function requires the use
of parentheses.

Casing of formulas does not impact formula evaluation or meaning.

White-space does not impact formula evaluation or meaning.

Time period including “to date” permits the use of offsets.

Formulas should use singular nouns rather than plural nouns (e.g., year

not years)

Syntax Elements

Operators (Table 7-3), time periods (Table 7-4), and functions (Table 7-5) are
used to create Tl formulas.

TABLE 7-3 Operators

OPERATOR

+ Oor -

USE

The period or “dot” operator delimits time periods from func-
tions. The string in front of the dot always corresponds to the
time period. The string following the dot always corresponds
to the time period function.

Example: year.firstMonth

The plus (+) and minus (-) operators are used to determine
the offset relative to the current date. Use the minus sign (-)
to specify time periods in the past. Use the plus sign (+) to
specify time periods in the future.

Example: day-1

Parentheses are used to group a time period and its offset
when you use them together with a function. Required.

Example: (year-1) .firstMonth: (year-1) .month

Commas are used to delimit multiple time periods in the same
formula.

Example: year, Quarter, Month, day
The colon operator (:) specifies a range of time periods.
Example: day:day-4
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Standard Time Periods

Table 7-4 shows standard time periods used within Tl formulas.

TABLE 7-4 Standard Time Periods

PERIOD EXAMPLE

Year Year-1, year+2
Quarter quarter, Quarter-4
Month Month-2

Week Week-51

Day Day-9, day+2

Hour Hour-12

Minute minute-30

Second second+5

Standard Time Period Functions

Tl formulas can use the time period functions provided in Table 7-5 to modify
any standard time period via usage of the dot operator (.).

TABLE 7-5 Standard Time Period Functions

FUNCTION USE

FirstQuarter Specifies the first quarter in a year.

LastQuarter Specifies the last quarter in a year.

FirstMonth Specifies the first month in a year or quarter.

LastMonth Specifies the last month in a year or quarter.

FirstWeek Specifies the first week in a year, quarter, or month.

LastWeek Specifies the last week in a year, quarter, or month.

FirstDay Specifies the first day in a week, month, or larger time
period.

LastDay Specifies the last day in a week, month, or larger time
period.

FirstHour Specifies the first hour in a day, week, or larger time
period.

LastHour Specifies the last hour in a day, week, or larger time
period.
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FUNCTION

FirstMinute

LastMinute

FirstSecond

LastSecond
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USE

Specifies the first minute in an hour, day, or larger time
period.

Specifies the last minute in an hour, day, or larger time
period.

Specifies the first minute in a minute, hour, or larger time
period.

Specifies the last minute in a minute, hour, or larger time
period.

Period-to-Date Formulas

PerformancePoint 2010 introduced period-to-date formulas in order to provide
a way to aggregate data up to the last completed period requested. These
formulas will exclude incomplete time periods and use the lowest time pre-
cision supported by the underlying data source. The period-to-date periods
shown in Table 7-6 may be used within Tl formulas.

TABLE 7-6 Period-to-Date Formulas

PERIOD

YearToDate

QuarterToDate

MonthToDate

WeekToDate

DayToDate

HourToDate

MinuteToDate

USE

Specifies a time period from the beginning of the year to
the current period.

Specifies a time period from the beginning of the quarter
to the current period.

Specifies a time period from the beginning of the month
to the current period.

Specifies a time period from the beginning of the week to
the current period.

Specifies a time period from the beginning of the day to
the current period.

Specifies a time period from the beginning of the hour to
the current period.

Specifies a time period from the beginning of the minute
to the current period.

Period-to-Date Functions

Formulas needing to specify periods may use the period-to-date functions
including those provided in Table 7-7.
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TABLE 7-7 Period-to-Date Functions

FUNCTION EFFECT

FullQuarter Specifies that the period to date should include up to the
last full quarter.

FullMonth Specifies that the period to date should include up to the
last full month.

FullWeek Specifies that the period to date should include up to the
last full week.

FullDay Specifies that the period to date should include up to the
last full day.

FullHour Specifies that the period to date should include up to the

last full hour.

FullMinute Specifies that the period to date should include up to the
last full minute.

FullSecond Specifies that the period to date should include up to the
last full second.

Parallel Period-to-Date

Formulas often require the ability to compare and contrast values across similar
periods during the current and prior years. Time Intelligence formulas support
including an offset value to the to-date period needed as shown.

YearToDate-1

The formulas support any to-date time period including those using a full
period function.

(YearToDate-1) .FullMonth

KPlIs

A critical component used to measure and track performance is a key perfor-
mance indicator (KPI). Within PerformancePoint, a KPI represents a measurement
of a particular business process, including the actual value from a data source,
a desired target achievement level, the visual indicators used when reporting
the result of comparing the target with actual values, and a scoring pattern
that represents the method used when scoring the resulting comparison value.

To create a KPI, open the Dashboard Designer and select the KPI dashboard
item from the Create menu. On the KPI Template dialog box, the Blank KPI
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option is selected, and the KPI editor is then used to map the KPI to data
sources. Figure 7-5 illustrates a sample KPI being created by the KPI editor.

Editor Properties ‘
(€ ProfitkPI
Actual and Targets F
\J) New Actual J% New Target | X Delete Selected Metrics % Compare

Mame Compare To Mumber Format ~ Indicators Data Mappings Calculation
Actual (Default) Gross Profit Margin (AWCube)  Default

Thresholds E3

Set Scoring Pattern and Indicator... ]

Best 120%

Threshold 2 100% @

Threshold 1 50% Li’l 100.00% to >50.00% |\=J

Worst 0% 3 im i

FIGURE 7-5 Creating a PerformancePoint KPI using the KPI editor

Configure the data sources for both actual and target rows within the KPI
editor by clicking the 1 (Fixed Values) link that is located within the Data
Mappings column. Note that the actual and target data mappings are con-
figured separately, so support is mapped to different sources. Multiple actual
and target values per KPI is available. This supports, as an example, the ability
to provide multiple period, actual and target evaluation of the KPI (e.g., Now,
This Month, This Year).

Selecting the proper scoring pattern and indicators involves editing a target
row within the KPI editor and setting the scoring pattern, banding method,
desired indicators, and worst value expected. Figure 7-6 demonstrates infor-
mation provided by the Edit Banding Settings editor within PerformancePoint.

The scoring patterns define whether a resulting value is considered a good
or bad score and include the following options:

Increasing Is Better: No upper limit on what is considered good and larger
values are desired

Decreasing Is Better: No lower limit on what is considered good and
smaller values are desired

Closer To Target Is Better
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Edit Banding Settings ==
4 Select the Scoring Pattern
_:Iﬁ\ Select the scoring pattern and banding method.

e Scoring pattern: [Increasing is Better V]
Select an indicatol
slectan indcator Banding method: [Band by normalized value of Actual/Target v]
Spedfy the worst value
o~
3 (2 1 Band by Normalized Values (I g is Better) [

The values are determined by dividing the
distance of Actual from Worst by the
4 distance of Target from Worst.

>
. Target value

Actual value
Worst value
Distance of Target from Worst
Distance of Actual from Worst

l:': Band by = Distance of Actual from Worst / Distance of

Target from Worst

m

l

Band by value shown as percentage.

FIGURE 7-6 Editing banding setting for a KPI target

The banding method defines how values are compared in order to generate
a status value and includes the following options:

Band By Normalized Value Of Actual/Target: Enables comparison of
scores that would otherwise be incompatible (e.g., percentages and dol-
lar amount values) by converting the raw KPI values to a common scale
and then averaging the converted scores

Band By Numeric Value Of Actual: Uses exact values for thresholds that
divide the status levels

Band By Stated Score (Advanced): Specifically ignores the calculation of
a score and uses a defined value from the data source

SCORECARDS

Some of the most useful and powerful objects within PerformancePoint, score-
cards are used to display snapshots of business’ performance by displaying key
performance indicators (KPIs). The scorecard is organized into groupings of
related goals referred to as objectives and their component metrics. Figure 7-7
shows an example of a PerformancePoint scorecard with a Profit KPI being
measured across Sales Territories.
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A scorecard, ultimately, is a special PerformancePoint report that can Actual  Target
include the following features: el L 4
= All Sales Territories 0.58% 1 @ -99%
Status indicators showing a summary of the current actual per- Australia 8% lg 107
Canada 1.24% 1 -99%
formance versus a targeted value France a1 14y -101%
Trend indicators showing how values have performed versus a Germany 561% | 14p -106%
. . . MA 1
prior time period %
United Kingdom 0.15% 1 0 -100%
KPIs that measure performance comparing actual values with United States L01% | 14 -39%
desired target values FIGURE 7-7 PerformancePoint
scorecard

Drill-down/drill-up navigation in order to see different levels of
detail by expanding or collapsing rows or columns

Time Intelligence for displaying dynamic time period values (e.g., Last
Two Quarters)

Analysis of individual member contributions via a Decomposition Tree

Filtering of other reports on the dashboard based upon the current selec-
tion within the scorecard

Special filtering of top/bottom values
Export to PowerPoint or Excel

View information about a given KPI using a KPI details report

FILTERS

Enabling end users to target the data in which they want to analyze within
a dashboard is accomplish by designing PerformancePoint filters. Filters can
be classified as one of two types: dashboard filters and object filters. The
dashboard filters are separate PerformancePoint objects designed for use in a
single dashboard or across multiple dashboards. Object filters are found within
analytic reports and scorecards. It is important to note that a scorecard can
also be used as a filter for other dashboard objects on the scorecard.

Several types of dashboard filters are available, as follows:

Member Selection: Uses Analysis Services or tabular dimension members
MDX Query: Uses Analysis Services to form an expression
Named Set: Uses Analysis Services items defined as a named set

Time Intelligence: Enables specific preconfigured time filters specified
using Simple Time Period Specification (STPS) syntax
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Time Intelligence Connection Formula: Similar to the Time Intelligence
filter, but uses a calendar to permit date selection

Custom Table: Enables using a data table created within an application
such as Excel

Connecting filters to various other PerformancePoint objects is described later
in this chapter. Note that depending on the type of dashboard filter, different
items should be selected to configure the source value sent from the filter as
shown in Table 7-8.

TABLE 7-8 Filter Connections Table

CONNECT TO OBJECT SOURCE VALUE NOTES
Dimension Values Member Unique Replaces rows or columns with
Name the selections made within the

filter

Axis, Page, Row, Display Value Captions from object’s data

Column Hierarchies source displayed when matching
filter selections

Time Intelligence Formula Filters scorecards to the period of

Formula time selected

Current Date-Time Current date-time  Filters scorecards to the current
date

Time Dimension Data source Filters analytic charts and grids

with the specified period sup-
plied by the Time Intelligence
formula

ANALYTIC REPORTS

Reporting on data with PerformancePoint often involves the creation of analytic
reports that include analytic grids and analytic charts. The Analytic compo-
nents require Analysis Services. Both are designed by dragging and dropping
available objects from the Details pane on the right side of the Dashboard
Designer into the Rows/Series, Columns/Bottom Axis, or Background designer
panes located below the report design. The analytic report requires that the
Rows/Series and Columns/Bottom Axis contain items while placing items
in the Background is optional. An example analytic report in design within
Dashboard Designer is shown in Figure 7-8.
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sign Query | Properties ‘

Details

i€} SalesbyCountryGrid

Sales Territory Coun... CY 2005 CY 2006 CY 2007 CY 2008 CY 2009 CY 2010

Australia 3,000 1,933

Canada 2,404 12,727 18,801 7,829

France 2,680 7,715 3,953

Germany 4,480 2,900

NA

United Kingdom 2,443 7,060 3,650

United States 8,431 40,391 59,107 24,319

Rows Columns Background

22 EIERCIIEN R ¥ X | 8% Date Calendar Year

FIGURE 7-8 Adding PerformancePoint Objects to an analytic report

o Reseller Order Quantity

x

Reseller Sales

= Measures

=] Lé Dimensions

1 Date

Lé Delivery Date

E Destination Currency

E Employee

Z Geography

TZ‘ Product

1 Promation

1 Reseller

Z Reseller Sales Order Details

E Sales Territory
b Sales Territory
E% Country

BB E

BHEHEE

o®E

§§ Group
§§ Region
14 ship Date
E Source Currency
jé Mamed Sets

The analytic reports are highly interactive; supporting many powerful capabili-

ties, including the following:

Pivoting the data displayed

Using Analysis Services actions

Sorting values

Sorting chart legend values

Filtering: Removing empty values, selecting particular value, removing

avalue

Drilling up/drilling down to view different levels of detail

Exporting to PowerPoint or Excel

Applying top or bottom filtering

Viewing contributions of members using a Decomposition Tree

Changing to a chart

DASHBOARDS

PerformancePoint combines various different objects represented as web
parts into a dashboard or web part page. As a result, the dashboard is the
central visual organizing component, responsible for determining what content
appears and where it is located on the web page. Dashboards are divided into
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zones that can host the various forms of PerformancePoint content, including
the following:

Scorecards

Reports (analytic charts and analytic grids)

Filters

Non-PerformancePoint content (e.g., Excel Services, Reporting Services
reports)

The dashboard is designed by dragging and dropping available objects (e.g.,
scorecards, reports encompassing analytic charts and analytic grids, and fil-
ters) from the Details pane on the right side of the Dashboard Designer into
a dashboard zone located in the Dashboard Content section of the Editor
window. Figure 7-9 shows the design of a new dashboard having a header
zone spanning the width of the dashboard with left and right column zones
directly beneath the header.

Tmr' Properties ‘
(«) A New Dashboard

Pages

Dashboard Content

Header

Add a dashboard item to this zone by dropping ithere

Left Column Right Calumn

Add a dashboard itemto this zone by dropping it here Add adashboard itemto this zone by dropping it here

FIGURE 7-9 Dashboard content zones

Once the dashboard design is completed, it is published to a desig-
nated SharePoint site that has been previously configured to work with
PerformancePoint.

COMBINING VISUALIZATIONS IN
PERFORMANCEPOINT

This section introduces some of the non-PerformancePoint content that may be
included within the PerformancePoint dashboard. Examples include Reporting
Services reports and Excel spreadsheet reports.

www.it-ebooks.info


http://www.it-ebooks.info/

PERFORMANCEPOINT

Combining Visualizations in PerformancePoint

EMBEDDING AN SSRS REPORT

Reporting Services offers a great deal of flexibility in how it renders data while
also offering additional chart types that are not found within PerformancePoint.
Furthermore, many existing reports contain key information desired for inclu-
sion within a PerformancePoint dashboard. Lastly, scorecards that are used
within the dashboard can filter the reports.

Adding Reporting Services reports to PerformancePoint is done by navigating
to the PerformancePoint content library within SharePoint, selecting a new
report, and then selecting the Reporting Services report template. Next, specific
reporting settings are configured as needed, including these:

Server mode (SharePoint Integrated or Native)

Report Server URL

Report URL

Display Options (show toolbar, parameters, and docmap)

Zoom (percent of actual rendered report size to display in a web part)

Format (e.g., HTML 4.0)

Section (to limit just part of a report to be included)

Report parameters
Once the report has been added to the PerformancePoint content library, it can
then be added to a dashboard as other PerformancePoint objects. Additionally,

the report can be configured to work with PerformancePoint connections
permitting, for example, filtering by passing values to report parameters.

EMBEDDING EXCEL REPORTS

Excel files often contain very useful and important business information that is
desired for inclusion in a PerformancePoint dashboard. SharePoint allows Excel
files to be used directly on SharePoint sites when Excel Services is configured.
Once Excel Services is enabled and Excel workbooks are stored within the
SharePoint site, support for these files is provided within PerformancePoint
by the Excel Services type of report.

To create an Excel Services report, open Dashboard Designer, and from the
Create menu and Reports menu group, select Other Reports. Figure 7-10
shows the selection of Other Reports from within the Report Ribbon group
within Dashboard Designer.
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‘Create |

LT g F- = T P

flter Indicator Data Analytic  Analytic Strategy Reporting | Other
Source Chart Grid Map Details  Services Reports
‘ms Reports

:| SharePoint | Workspace | Other Reports

Create an Excel Services, ProClarity, [~
web page, or other report.

PerformancePoint Content

FIGURE 7-10 Creating other reports in Dashboard Designer

Within the Report Template dialog box, select an Excel Services report. Finally,
configure the Editor properties with the following:

SharePoint site: The SharePoint site hosting the Excel file
Document library: The specific SharePoint library hosting the Excel file
Excel workbook: The name of the Excel file

Item name: The specific named item to display from the Excel file

Once the Excel Services report has been added to the PerformancePoint content
library it can then be added to a dashboard as other PerformancePoint objects.
Additionally, the report can be configured to work with PerformancePoint
connections—permitting, for example, filtering by passing values to report
parameters.

CREATING WEB PART PAGES IN
SHAREPOINT

SharePoint uses web part pages that contain web parts displaying various types
of content. Site owners, site members, and others having the necessary permis-
sions can create and modify web part pages, adding or removing web parts
to arrange the content of the pages. Likewise, PerformancePoint dashboards
are created by selecting a template that has zones, putting PerformancePoint
objects together in the zones and establishing connections between the
objects so they can pass values for filtering or other actions. Figure 7-11 shows
the templates available for designing the dashboard zones, columns, and rows.
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Select a Dashboard Page Template

Column, Split Header, 2
Column Columns

1 Zone 2 Columns 2 Rows 3 Columns 3 Rows

Header, 2 Columns Dashboard

zone and two vertical zones.

Create a new dashboard that has three zones - one horizontal header

FIGURE 7-11 Selecting a Dashboard page template

ADDING WEB PARTS

Within Dashboard Designer, adding content to the page is accomplished by
dragging PerformancePoint content (e.g., scorecards, reports, and filters) from
the Details pane to the Dashboard Content section. The content is then placed
into the desired zone (e.g., Left Column, Right Column, or Header—when using
the Header, 2 Columns dashboard page template). Figure 7-12 shows what
Dashboard Designer displays while dragging a scorecard into the dashboard’s

Left Column zone.

—Eﬁr" Properties ‘

Details £

(«) A New Dashboard

[ PerformancePoint Content

Pages

P = E Reparts

| % New Page 3! Delete Page |

Name Qwner
» Page 1

=} _m PerformancePoint Content
Tl salesChart
Tl SalesGrid
=[5 Filters
¥ Apply Filters Button
[ PerformancePoint Content

Date Modified
12/26/2012 11:55:46 AM

Dashboard Content

Header

B

Add a dashboard itemto this zone by dropping it here

Left Column Right Column
o
Add adashboard itemto thiszone by dropping | | Add adashboard itemto thiszone by dropping Add To Zone 2
it here it here
el [Header = Add

FIGURE 7-12 Dragging Items onto Dashboard Zones
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PERFORMANCEPOINT CONNECTIONS

A key advantage of using PerformancePoint is the ease in which dashboard
connections and filters can be designed and configured. PerformancePoint
objects that support providing or receiving connections use the Connections
dialog box to configure the connection. Complex filtering can be performed
by refining connections by using connection formulas (e.g., a Dimension value
filter can show just those values selected while the connection formula could
further refine the selection to include the top five).

In order to connect a filter to an existing PerformancePoint object, open the
Dashboard Designer. Within the Details pane located on the right side, expand
the Filters section and the PerformancePoint Content section. Simply drag the
desired filter to a dashboard zone in the middle pane. Once the filter is located
in the dashboard zone, click the down arrow on the right side of the filter
name and select Create Connection. Figure 7-13 demonstrates the option of
using a PerformancePoint object’s action option menu to create a connection.

Dashboard Content

Header

LY YearFilter d X‘ H ‘
Type: Filter: List Qﬁ Edit ltem...

| Drop fields to create connections Igb Create Connection
4 AvailableFields =
gﬁ Display Condition
4 YearFilter
47 Display Value
47 Member Unigue Name

FIGURE 7-13 Using the Create Connection menu option

The Connection dialog box will display; on the Items tab set the Send Values
To drop-down list to the PerformancePoint object that will receive the values
from the filter. On the Values tab of the Connection dialog, set the Connect To
value to the target field that will get filtered, and set the Source Value to the
appropriate value based upon the source being used (e.g., Member Unique
Name is commonly used with Analysis Services filter sources). Figures 7-14
and 7-15 illustrate the connection dialog steps to connect a filter to another
dashboard object and also what the target object looks like after the connec-
tion has been successfully implemented.
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Connection [==4 | connection ==
Connection Connection
v
== Create and modify a connection between dashboard tems. == Create and modify a connection between dashboard items.
Ttems ‘ Values Ttems | Values
Choose the items you wart te connect. Connect ta-
[Date Calendar Year -

Select the field to receive the source values.

Get values from

Header - (1) YearFilter 2
Source value:

Send values to [Member Unigue Name -
Left Column - (1) SalesChart -

Connection Formula.. I

FIGURE 7-14 Connection dialog items and values tabs

The result is a fully functional filtering of a e

PerformancePoint object using a PerformancePoint Header
filter. Other comparable connections are con- ‘|\, vearflter
figured in a similar fashion, and all support the Left Column

capability to pass values to and from different
dashboard objects in order to support advanced
capabilities.

|_j] SalesChart
Type: Report: Analytic Chart

BT YearFilter

F¥ Connections ‘

Time Intelligence expressions and MDX queries
can be used as expressions within connection
formulas. When using Time Intelligence expres-
sions, the Simple Time Period Specification (STPS)
syntax is required for defining the expression. STPS syntax and examples were
provided earlier within this chapter’s “Mapping the Time Dimension” section.
MDX queries used as expression will include monikers included within double
angled brackets. The following MDX expression example uses the MDX non-
empty values function combined with the Sourcevalue moniker to map to the
value being passed by a source using the connection:

FIGURE 7-15 Analytic chart with year filter connection

NONEMPTY (EXISTS ( [Dimension] . [Hierarchy - Dimension].[Level number].
members, <<SourceValue>>, 'Measure Group'))
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INSTALLING THE PERFORMANCEPOINT
SAMPLES

Each chapter with a PerformancePoint sample has a ZIP file with the
PerformancePoint files, which have an .DDWX extension. Start by unzipping
this file. To use the samples, open Dashboard Designer, then click Import
items on the home screen and browse to the .DDWX file, then click OK. That
will bring up a screen like Figure 7-16.

| — T § :
Import Items to SharePoint x|

! Select locations

Choose destinations For the items. For non empty destinations, the imported items will overvwrite existing ibems in the destination that
have the same name.

B Cata Conn
| Roks 1] PerformancePoint Cont,,| % | (1] PerformancePoint Content

™ Import data sources that already exist in the destination.
| I Import items with missing dependencies.

e.-.'wc--\-;-:--_u-jl Next = I Finiigh Cancel

FIGURE 7-16 Importing PerformancePoint components

Click Next to import, then click Finish to finalize the import.

You will need to modify the data source to point to your local Analysis Services
instance—do this by clicking on dsOECD, and editing the server name to your
server, and then choosing the appropriate database and cube. This should
be OECD_Data and Model, as shown in Figure 7-17, but your server name will
likely be “".

Next, you need to map the time source. The first step is to choose the hierarchy
with the dates from the model—in this case it is Dimbate.YMD. Next, choose a
date to map. The date is important, as year calculations are all based on that
day being the first day of the year, so you'll choose the 1st of January. You do
this clicking browse, then choosing the date. You'll choose “Day” as the date
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to map, and then you will choose what date this entry in the dimension maps
to in live dates. You can use this to map “Today” to an equivalent date in the
past, and with the Adventure Works data you will almost always do this: in
production data you will always choose the same date. Finally, you need to
set the Time Member Associations: YearName to Year, MonthName to Month,
and Date to Day. You should then see a screen like Figure 7-18. Finish by sav-
ing your data source.
Wworkspace Browser « itor Properties | Time: |
LB Untitled Warkspace —
= 3] Data Connections "-(:'I dSOECD
| dsaDw Connection Settings 2
| | dscECD pu
= _j PerformancePoint Content * Use Standard Connection
il ACW_Grid Server: | isalz01Ztabular
fﬂ 2‘:‘mpanson Drababase: IOECDiData j
ﬂ Comparison Repork Roles; I
:' Enmlparisn;sl_withFilter 7 Use the Follawing connection
“ai| Employes Sales
| Product Details X X ﬂ
; Sales Zonnection String: ;I
W ear
Cube: IMUdEl j

FIGURE 7-17 Setting up a data source

i«) dsOECD
Reference Data Mapping =
DimDate. YMD |
Juijzo1z Brawse... |
o 5]
MAPS TO...
| 1y 1jz01z =l
Time MemberAssociations *
Member Level Time Aggregation
‘earhame ‘ear ﬂ
MonthMarme Month hd
Date

FIGURE 7-18 Setting up a data source

h
|
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SUMMARY

This chapter introduced PerformancePoint and its key features. First, a com-
parison and contrast of tabular and multidimensional data sources was pro-
vided, followed by a review of requirements for running SharePoint and
PerformancePoint. Next, some considerations for authenticating with data
sources using the Secure Store Service (SSS) were outlined. A tour of the key
PerformancePoint components, including data sources, Time Intelligence map-
ping, key performance indicators (KPIs), scorecards, filters, analytic reports, and
dashboards was provided. Finally, combining visualizations in dashboards as
well as constructing PerformancePoint dashboard pages was detailed.
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CHAPTER 8

Reporting Services

Reporting Services has an engine dedicated to the marrying of data to a
predeveloped visual design, which makes it a very useful tool for displaying
information. Reporting in general has seen a great deal of expansion in its
capabilities, and in many instances it now has overlapping use cases with
other tools. For example, in the past, other tools such as PerformancePoint
would have been considered a much more appropriate choice for producing
scorecards, but Reporting Services has expanded its capabilities and is able
to generate scorecard-type content depicting very graphical summarized
information.

Compared with all the other Microsoft business intelligence tools, Reporting
Services offers the designer the most control over visual elements, format-
ting within the reports, and rendering options such as PDF or Excel output.
Although this control is very useful, the trade-off is that every piece of layout
and interactivity must be planned and implemented while you're design-
ing reports. Offsetting this effort are the greater visualization capabilities in
Reporting Services, such as charts, gauges, indicators, trendlines, and mapping.
This chapter is an introduction to developing visualizations using Reporting
Services.

NATIVE VERSUS INTEGRATED MODE

Reporting Services offers two supported modes of installation and operation:
Reporting Services Native mode and SharePoint Integrated mode. No one
operating mode is best suited to all the various reporting and use scenarios
that the consumer may require. Therefore, it's important to understand just
what each mode can offer a reporting architecture.
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REPORTING SERVICES SERVER SUPPORTS MULTIPLE INSTANCES

[t is important to understand that a given Reporting Services report server,
like the database engine, can support multiple instances. You can configure
each instance of Reporting Services in either native or SharePoint Integrated
Mode, but after you select the mode it is very difficult to change it (for
details on how to switch server modes, please see the Microsoft MSDN
article “Switch Server Modes” at http://msdn.microsoft.com/en-us/
library/bb326407 .aspx).

To support multiple Reporting Services instances you need to create a new
database, and only one instance can be associated with SharePoint. In the
SQL Server 2012 release, more than one Reporting Services instance can
be associated with SharePoint.

NATIVE MODE

Reporting Services has a Native mode that enables both users and adminis-
trators to access reports using a Report Manager web application. The Native
mode provides a report server that is a standalone application providing
report viewing, management, administration, processing, and delivery. The
Native mode provides a complete self-service approach to report browsing
and access, but it's not without its limitations.

The original Report Manager web application was intended to be used as
a sample application to aid in the design and development of custom web
applications that would use the Reporting Services application programming
interfaces (APIs) demonstrated within Report Manger. Many people feel that
Report Manager provides a quick solution for handling basic reporting needs,
but that it offers very little opportunity to customize the management and
delivery of reporting.

When configured in Native mode, you can view reports on SharePoint websites
using SharePoint web parts, but there are no management capabilities pro-
vided via these web parts and they cannot be connected to other SharePoint
web parts.

SHAREPOINT INTEGRATED MODE

SharePoint Integrated Mode enables users and administrators to access the
Reporting Service report server using the SharePoint server. This mode offers
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three levels of integration within SharePoint, including sharing storage, security,
and site access of other business applications and data. SharePoint centrally
stores all application and user content data in SQL Server databases while also
providing a robust web application security system that is responsible for man-
aging access to content and data hosted on SharePoint sites. Additionally, the
SharePoint web application platform hosts business applications that permit
user collaboration and centralized document management for reports and
other types of content such as Word documents and Excel spreadsheets. As a
result, one of the primary benefits of selecting SharePoint Integrated Mode is
that it provides a unified portal presenting, managing, and securing business
documents and information in one place. Because reports can be managed as
just another form of content, applying the same security and administration
model as other SharePoint content, this integration is very attractive to most
IT departments as SharePoint administrators may assume reporting adminis-
tration duties, thereby reducing administrative overhead.

Figure 8-1 illustrates the connectivity between Reporting Services, configured
in SharePoint Integrated Mode, and the SharePoint farm via the Reporting
Services Add-in.

d 2

Windows SharePoint Services Report Server

Reporting Services Add-in Report Server Web Service

HTML Pages T - :
Vle::t?web Man:gp:|:1ent Security Catalog
* Part Pages Extension | | synehronization
HTTP Requests

Web front end ‘ Web Front end

G

FIGURE 8-1 SharePoint Integrated Mode using the Reporting Services Add-in

Configuration, Content Databases | Report Server Database

The SharePoint Integrated Mode of deploying Reporting Services includes
some loss of the functionality found with Native mode. Notably, the following
features are not supported with SharePoint Integrated Mode:

Linked Reports

Custom Security
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SharePoint backup
and restore does not
back up the Reporting
Services encryp-

tion keys. Use the
SharePoint Central
Administration
Manage Reporting
Services Application
Key Management
page to perform a
backup of Reporting
Services encryption
keys prior to perform-
ing a SharePoint
backup.

Report Scripting Host (rss. exe)

Report Manager (website replaced by SharePoint sites)

Some of the key strategic advantages of the SharePoint Integrated Mode of
deploying Services include the following:

Reports and the libraries in which they are deployed use SharePoint cen-
tralized security (permissions and authentication providers).

SharePoint libraries may be used for subscription delivery (using a SQL
Server 2012 SharePoint delivery extension).

Reports and the libraries in which they are deployed use SharePoint docu-
ment administration, security, and collaboration (for example, alerts).

Report Server File Sync permitting report files stored within SharePoint
document libraries are synchronized with the report server when changes
are made via the document library.

SharePoint scale-out applies to Reporting Services applications.

SharePoint Shared Service Application pool host the Reporting Services
shared service.

SharePoint cross-farm support may be used for viewing reports.
SharePoint backup and recovery also covers reporting applications.

SharePoint claims-based authentication may be used by Reporting
Services applications.

SHARED AND EMBEDDED DATA SOURCES

Another point of consideration for report design using Reporting Services
involves determining whether data sources will be shared among many other
reports or embedded within a given report. Data sources are used within
Reporting Services to provide a connection to external data; as such they
contain connection strings and credentials for authorizing access to the data.
You can also configure the connection itself to be a dynamic connection
string that is provided through the use of an expression that enables a user
to specify which source is to be used when the report is run.
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The primary difference between a shared and an embedded data source is that
the shared data source is stored and managed on the report server, whereas
the embedded data source is stored and managed within the report. The net
result of this difference is that embedded data sources are independent of
one another and require separate maintenance. More specifically, they require
modification of a report in order to apply changes. The shared data source
is stored as a separate object on a report server, which allows this type of
source to be used by many reports, models, and subscriptions. By central-
izing the data source within one object, the maintenance and administration
is also greatly simplified, permitting modifications without having to edit and
redeploy many reports.

FREQUENTLY CHANGING DATA SOURCE:
CONSIDER SHARED DATA SOURCES

You should strongly consider shared rather than embedded data sources
when the data source might frequently change, especially when the par-
ticular connection that is part of the data source is used by many reports.
This has an impact on maintainability, and also aids in deployments between
environments, as only a single data source needs to be updated.

AUTHENTICATION: A BETTER SOLUTION

Managing access to reports and the data that reports display is a key to plan-
ning a successful Reporting Services architecture. To deliver well-targeted
report content, often user credentials need to be sent to the data source in
order to permit appropriate filtering of information. Reporting Services offers
many different ways to address authentication and authorization of users as
well as permitting passing user credentials to the data sources.

Authentication is used by Reporting Services to determine the identity of the
entity (person, computer, service account) requesting access. With authentica-
tion the report server simply identifies who is accessing Reporting Services
and does not determine if permissions are granted to the entity accessing
the report server. The determination as to whether an entity has permission
to access the report server is handled by authorization.
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THE DOUBLE HOP PROBLEM

The network environment in which Reporting Services is deployed deter-
mines the supported types of connections used when supporting access to
data sources. With Kerberos enabled, delegation and impersonation features
available in Windows Authentication to support connections across multiple
servers may be used to pass user credentials to remote data sources. Without
having Kerberos enabled, Windows connections are only able to pass user
credentials to one server prior to expiration. In this case, users are only able
to connect and pass their user credentials from their computer to the report
server. After this first connection, the user credentials are not subsequently
permitted to be passed from the report server to a remote server containing
the data source for the reporting.

To successfully pass user credentials from the user’s computer through the
report server to the data source servers, Reporting Services has the follow-
ing options:

Set reports to use stored or prompted credentials when querying data
sources

Configure Kerberos authentication protocol and enable impersonation
and delegation in order to permit credentials to be delegated to other
computers without limits

Configuration of Kerberos authentication is outside of the scope of this book.
The next section discusses the option to use stored or prompted credentials
allowing the end user’s credentials to be passed without having Kerberos
configured.

SET EXECUTION CONTEXT: REQUIREMENTS AND SETUP

To permit the end user’s credentials to be successfully passed to the data source
without configuring Kerberos, the data source must be set to use stored cre-
dentials and use both the Use as Windows Credentials When Connecting to the
Data Source and Impersonate the Authenticated User After a Connection Has
Been Made to the Data Source options. Figures 8-2 and 8-3 show the specific
configuration of the data source during report design and server configuration.
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Name: [ our Dam Srce tame

Description: ‘ =]

|
™ Hide in list view
W Enable this data source

Data Source Type: [Microsoft SQL Server Analysis Services |

Connection string:  [pata Source=SSAS; Initial =l
(Catalog=YourDB _|
-

Connect using:
 Credentials supplied by the user running the report

Display the following text to prompt user for a user name and password:

|1~,fpe— or enter a user name and password to access the data sou
¥ Use as Windows credentials when connecting to the data source

@ Credentials stored securely in the report server

User name: |domain\,SSA5Adminuser

Password: [esessess

¥ use as windows credentials when connecting to the data source

REPORTING SERVICES
Authentication: A Better Solution

¥ Impersonate the authenticated user after a connection has been made to the data source

© Windows integrated security

FIGURE 8-2 Reporting Services Data Source configuration on the Report Server without Kerberos

.

-
Data Source Properties ol -‘“

[ N = = ey s

General

“Credentials™ "

Change the credentials used to connect to the data source.

A This information is only stored when you save the report to a report server.

Use this user name and password

User name: domain\SSASAdminUser

Password:  esessess|

Use as Windows credentials

Impersonate the authenticated user after connecting
() Prompt for credentials

Enter prompt text:

() Use current Windows user. Kerberos delegation might be required.

|:| Use as Windows credentials

() Do not use credentials

ok || cance ]

L = =

FIGURE 8-3 Reporting Services Data Source configuration during data source design without

Kerberos
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For Analysis Services data sources, setting these options causes Reporting
Services to add the Ef fectiveUserName property into the connection string
and populate it with the user that is running the report. The key requirement
for using the EffectiveUserName property with an Analysis Services con-
nection is that the stored credential account must be an Analysis Services
administrator.

In some cases when SharePoint uses a distributed architecture separating the
front-end web server from an application server hosting Reporting Services,
additional configuration of the Analysis Services server to support this capabil-
ity including creating an SPN (Service Principal Name) for the Analysis Services
service account as well as enabling the account’s delegation setting within
Active Directory may be required.

For SQL Server data sources, setting these options sets the SETUSER function
to be used to impersonate the user to run the data source query. The key
requirement for using SETUSER to impersonate another user within SQL Server
with a SQL Server connection is that the stored credential account must be
a member of the SQL Server sysadmin fixed server role or be a db_owner
fixed database role. Additionally, when using SQL Server authentication and
the username and password are database credentials, do not select Use as
Windows credentials when connecting to the data source.

EXPRESSIONS IN REPORTING SERVICES

Reporting Services supports the use of expressions (Visual Basic code) to
control aspects of report content, design, and interactivity. These expressions
include constants, operators, and references to report values (fields, functions,
and collections) or external (custom) code.

You can achieve advanced report designs primarily by successfully using
expressions to control the report content and appearance of report objects.
You may also use expressions to create formulas that evaluate data values
in order to determine what type or format of indicator should be displayed.
This use of report expressions is very useful when creating key performance
indicators (KPIs) within a Reporting Services report. Displaying the current
status of a KPI value an expression can determine if a value was in a desired
range and, if so, to render a stoplight graphic with a green light illuminated.
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Another common reporting design involves highlighting information by con-
ditionally appending graphics beside the data values. The following example
expression, implemented in a column of a report, returns the name of an
indicator graphic to display when the current account balance is less than 75
percent of the prior period’s balance:

=IIF (Sum(Fields!AccountBalance.Value) /
Sum(Fields!AccountBalancelLastPeriod.Value) <
.75, "indicator_small", "nothing")

Similarly, you can use report expressions to alter the color or other text box
appearance attributes in order to draw attention to the values under given
conditions. The following example expression changes the color of the
AccountBalance field when the value is a negative amount:

=IIF (Fields!AccountBalance.Value < 0, "Red", "Black")

Ultimately, Reporting Services expressions enable many dynamic and interac-
tive report design features that can aid in effectively communicating the data
stories found within the data.

BUSINESS INTELLIGENCE DEVELOPMENT
STUDIO AND VISUAL STUDIO VERSUS
REPORT BUILDER

Understanding what tools are available to design and publish reports is an
essential part of working with Reporting Services. In this section two primary
tools are contrasted, Report Builder and Business Intelligence Development
Studio (BIDS).

BIDS has been the defacto report design and publishing tool of Reporting
Services since the product’s inception. The base of Business Intelligence
Development Studio (BIDS) is a core subset of Microsoft’s Visual Studio devel-
opment environment which is successfully used to develop other forms of
software and as a result has significant investments in usability and key devel-
opment tools such as source code control.

Report Builder has been, at best, a confusing product that was originally
introduced as a tool to provide end users with a report design experience.
The confusion surrounding this product centers on the abandonment of the

www.it-ebooks.info

141


http://www.it-ebooks.info/

142 MICROSOFT’S TOOLSET FOR VISUALIZING DATA

The report code
developed when
using either Report
Builder or Business
Intelligence Developer
Studio (BIDS) is identi-
cal, and as a result,
reports authored in
either tool are fully
compatible with both
report design tools.

original Report Builder (version 1.0) in favor of a completely different tool in
the SQL Server 2008 release. Ultimately, Report Builder in the current version
is a solid tool for report design, and, in many cases, it offers additional value-
added features not found within BIDS.

Report Builder offers a more guided path for developing certain reporting
features through the use of wizards. For example, when starting a new report
in Report Builder, a sophisticated getting started wizard, shown in Figure 8-4,
immediately assists in getting the report design started.

1] Getting Started [ o - P Y
Create a report from a wizard or from a blank report.
. Mew Report
\ . Display data from various . N
\ i.' data sources in tables, < 'ﬁ Table or Matrix Wizard
———F charts, and other formats. $4%! Guides you through choosing the data source connection, layout, and style for a
table or matrix report.
New Dataset Chart Wizard

Share queried data among $4\ Guides you through creating column, line, pie, bar, and area charts.
multiple reports.

= A

Map Wizard
Displays report data against a geographical background.
Open

Open a saved report.

rilﬂ‘ | j Blank Report

. Recent
J Open a recently used report.

[] Don't show this dialog box at startup.

FIGURE 8-4 Report Builder Getting Started Wizard

One of the key differences is that Report Builder creates report datasets
through the use of a query designer (wizard), as shown in Figure 8-5, that is
reminiscent of those in Microsoft Access, thus affording the report designer a
much more managed path to complete this common report design activity.

Of the more frustrating differences, Report Builder does not offer intelligence
built into the expression editor. As a result Report Builder does not offer assis-
tance in completing the expressions by showing prompts indicating the parts
of the expression required for completion.
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New Table or Matrix S BB [ o |

Design a query

Build a query to specify the data you want from the data source,

o3 Edit as Text [ import.. | [ Run Query
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o-CallE || Field Aggregate
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=] Databaselog AccountDescription

=[] DimAccount AccountType
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i e
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v|E] AccountDescription
v| ] AccountType

3 operator | Relationships Auto Detect r ¥
] customMembers .

1 valueype Applied filters - r & 2
=| CustomMemberOptions Field name Operator  Value Parameter

= pimCurrency

1 DimCustomer

= DimDate

=] DimDepartmentGroup
= DimEmployee

=1 DimGeography

& DimOrganization
= on
< il »

1-E-8-E-E-f-B-E

Query results ¥

[ <pack ][ met> ] [ cance

&

FIGURE 8-5 Report Builder Design a Query

Another common report designer productivity feature missing from Report
Builder is the ability to quickly switch report items by changing the properties
windows drop-down. While Report Builder does have a properties window
that can be activated in the Ribbon, items can only be selected by clicking
on them. Figure 8-6 shows the properties windows drop-down expanded to
permit navigation to other report objects.

Some of the key innovations found within Report Builder do not exist within
BIDS. Most significantly absent is the ability to jump start a report design by
using Report Parts. Report Parts encapsulate report objects such as the con-
nection, datasets, and visual elements (for example, a chart or matrix) for use
in many reports and may only be used via Report Builder.

Working with subreport parameters is a bit more difficult using BIDS because
it does not have a drop-down list prepopulated with the parameters found
within the subreport, which is a feature offered within Report Builder.
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(5] PWFinancialDallasReports
[ Shared Data Sources
[ Shared Datasets

4 [y Reports

1] Reportl.rdl

-~

Body

Branch_City Text Box
Branch_Name Text Box

matrix1 Tablix
Month Text Box

[Sgoort
-

Year Text Box

textbox2 Text Box
textbox3 Text Box

FIGURE 8-6 BIDS report properties navigation

Report building is shown in Figure 8-7.

BulletGraph.rdl- Microsoft SQL Server Report Builder

4 Interactive Sort
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FIGURE 8-7 Report Builder
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SERVICES SAMPLES

The chapters that include Reporting Services samples include
files with an .RDL extension in the ZIP. Despite the guidance
given in this chapter for the general best practice of using shared
data sources, these .RDL files will all contain an embedded data
source, which you will need to edit to point to your restored
databases.

To do that, open Report Builder 3 (available for download at www
.microsoft.com/en-us/download/details.aspx?id=6116),
and then select File > Open, browse to the .RDL file you
extracted. Next, right click on the data source and click Data
Source Properties as shown in Figure 8-8.

Finish by changing the server name to the machine you are
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\ :
\“/ Home | Insert Wigw
ENIER El e
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Wigs Clipboard Font
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-1 Images - SEO_
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working on—often, if you have a default instance, you can sim-

un

ply use “.
shown in Figure 8-9.

to access your local server. The data source screen is

Data Source Properties ‘

Change name, type, and connection options,

Credentials

Mame:

IrsdsOECD

" Use a shared connection or repart model

' Use a connection embedded in my report

FIGURE 8-8 Changing a data source

Select connection type:

Microsoft SQL Server Analysis Services j
Connection string:

Data Source=Msgl20i2tabularInitial Catalog=OECD_Data|

™ use single transaction when processing the queries

Build... |

£

Test Connection |

Help |

[ o ]

Cancel |

FIGURE 8-9 Changing a data source

www.it-ebooks.info


http://www.it-ebooks.info/

146 MICROSOFT’S TOOLSET FOR VISUALIZING DATA

SUMMARY

This chapter introduced Reporting Services and its key features. First, a brief
overview of both native and integrated modes for configuring Reporting
Services was provided. Next, shared and embedded data sources were
reviewed. Special attention was given to accessing reports including provid-
ing a method often does not require the complex configuration of Kerberos.
A discussion of the value of report expressions followed. Lastly, this chapter
contrasted the two report design tools, Report Builder and Business Intelligence
Developer Studio.
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CHAPTER 9

Custom Code

Most of the visualizations used in this book are based upon the standard
Microsoft toolset, but for some types of visualization, those tools just don't
have enough capabilities. Missing visualizations include column charts that
are both clustered and stacked (allowing for another dimension of data), color
wheels, as covered in Chapter 14, heatmaps (although you can build them in
Excel by using cells), network graphs of various types, and tree graphs (although
the Decomposition Tree is available in PerformancePoint).

When a tool doesn’t have the visualization you need, it's time to write your
own in a language such as C#. There are various ways of using code to create
a visualization, and this chapter explains the different methods.

AUDIENCE

This chapter sets the groundwork for the HTML5 examples covered in
Chapters 11, 12, and 15: each chapter contains only one HTML5 example.
While this chapter and the examples can theoretically be done by someone
with no HTMLS5, Javascript, or C# background, experience in some form of
coding (such as VBA) will be advantageous. The rest of the book can be
read without this chapter.

SILVERLIGHT, WPF, XAML, AND HTML5

Prior to the release of Windows 8, and indeed prior to the broad success of the
non-Microsoft computer in the form of the iPad and the Android tablet, the
toolset choice for visually rich applications was simple: Windows Presentation
Foundation (WPF) on the desktop and Silverlight (a web-based subset of
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App is a shortening
of the word applica-
tion and is typically
used in the context of
smartphones where
apps are available
from “app stores.”
This use has spread to
Windows and Office
with the launch of
app stores for the
Microsoft platform.

WPF) for the web. The tool of choice for developing these applications was
Expression Blend, and the world was a happy place for developers. The key for
development was creating markup for the design of the application using a
language called XAML (eXtensible Application Markup Language), separating
the design from the functional code.

WORLDWIDE TELESCOPE (WWT) BUILT IN SILVERLIGHT

As seen in Figure 9-1, Silverlight (@and to an even greater extent WPF) allows
for full customization of the graphics within an application. This kind of
visualization extends far beyond the traditional Bl visualizations.

FIGURE 9-1 A Silverlight astronomy visual tool

The broad success of the iPhone and the iPad changed everything. Suddenly,
cross-platform support became a much bigger issue than it had been, and
the myriad of business intelligence (Bl) apps released for the iPad became
competition for the Microsoft tools, although some worked with the Microsoft
platform as a whole (RoamBI is one example; you can find it at www. roambi .
com/). The challenges of developing for the Apple iTunes store are mostly politi-
cal in nature, as evidenced by the dispute between Amazon.com and Apple
around the Kindle app. Amazon.com had to remove a link to its online store
in the app, and users had to buy content through Apple—with 30 percent of
the purchase price going to Apple.

Amazon.com'’s response was to build an HTML5 application that didn’t go
through the Apple store. This approach is simpler when you consider the wider
(and growing) world of non-iOS tablets—Android as well as WinRT.
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In the visualization world, HTMLS5 is thus the best approach to creating a
visualization. Visualizations that you create using HTMLS5 can easily work on
multiple platforms. In addition, as you create a visualization, it's essential that
you consider the tablet form factor and the user’s ability to consume and
interact with a visualization on the go, such as in a board meeting. One of the
limitations is that tablets are not useful for authoring content, and advanced BI
customizations, including self-service BI, simply don’t work as well on a tablet.

HTML5 AND ASSOCIATED TECHNOLOGIES

When you read "HTMLS," it is not just HTML5 that is being discussed. The
term is used broadly to include a number of technologies, such as CSS 3
(Cascading Style Sheets) and JavaScript.

What is so special about HTML5 over HTML 4 that makes it so much better for
visualization? Aside from anything else that it provides, the canvas element is
the key: The canvas element allows for the direct manipulation of graphical
elements such as arcs and lines. However, just using the canvas, you would
still need to write an extensive amount of code to generate stunning visualiza-
tions, so you will want to use some of the existing libraries. There are several
libraries that are worth looking at:

Flotr2: http://www.humblesoftware.com/flotr2/index

Raphael: http://raphaeljs.com/ (technically SVG rather than HTMLS5)
D3 (used to be Protovis): http://d3js.org/ and http://nvd3.org/
JavaScript InfoVis Toolkit: http: //philogb.github.com/jit/

You can find more examples at http://socialcompare.com/en/comparison/
javascript-graphs-and-charts-libraries.

These libraries each have different capabilities and intents. Flotr2 is a generic
HTMLS5 charting library; Raphael and D3 are aimed at aiding graphical manipu-
lation on a webpage; and InfoVis provides a diverse set of visualizations. As
the goal is to create visualizations that are not present in the Microsoft toolkit,
rather than design interactive websites, this book uses InfoVis for most custom
visualizations. A selection of the visualizations available is shown in Figure 9-2.

The other great aspect of using HTML5/JavaScript is that Excel 2013 can natively
embed this code to run in the client. You can read more on doing this at
http://msdn.microsoft.com/en-us/library/office/apps/jj220038.
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Area, Bar and Pie Charts Sunburst Icicle

Stacked AreaChart File System Visualization Static Idde Animation
Vertical Stacked BarChart Custom Modes and Edges File System Visualization
Horizontal Stacked BarChart
Stacked PieChart

ForceDirected TreeMap SpaceTree

Graph Manipulation Squarified Animated Treemap Tree Animation
Graph Manipulation and Editing On-Demand Modes On-Demand Modes
Cushion Treemap Add/Remove Subtrees

Custom Style Animations

RGraph HyperTree Advanced/Other

Tree Animation Tree Animation Implementing NodeTypes
Weighted Graph Animation Weighted Graph Animation Composing RGraphs
Graph Qperations Graph Operations Combinig SpaceTrees and RGraphs

Drag and Drop Modes

copyright @ 2012 Senchalabs - Author: Nicolas Garcia Belmonte

FIGURE 9-2 A selection of charts from the InfoVis library

THE FUTURE OF SILVERLIGHT

Silverlight itself is a dying product. The latest release—Silverlight 5—will most
likely be the last release. However, the fundamental development paradigm
of both Silverlight and WPF is declarative development using XAML, and this
approach is deeply embedded into Windows 8.

PERFORMANCEPOINT AND POWERVIEW

Both PerformancePoint’s Decomposition Tree and PowerView use Silverlight—
the intent to move PowerView from Silverlight has been expressed by
Microsoft, but no roadmap was available at the time of writing. Nothing
is known about the future of Silverlight for the Decomposition Tree either.
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The concept is that a combination of XAML and a language of your choice
(C#, Visual Basic, C++, and even JavaScript) are used to develop Windows Store
applications (these were originally called Metro apps, but this name was
changed) that are aimed at being touch-enabled and using a different user
interface (Ul) experience. A key feature of Windows Store application is the
tile Ul, in which applications update their “live tiles.” The technology stack is
shown in Figure 9-3.

FIGURE 9-3 The Windows 8 development stack (note that Metro style has been
replaced with Windows Store)

ACCESSING DATA FROM HTML5

You can access data from HTML/JavaScript in many ways. The simplest, of
course, is to have server-side code generate the page with the data embed-
ded. This requires a page refresh for any data changes, but it can often be a
good method.

Alternative methods involve having a web service called from JavaScript, which
returns the data required. The earliest approaches used a technique called
AJAX, for Asynchronous JavaScript and XML. More recently, this has been
mostly replaced by using JSON (JavaScript Object Notation) instead of XML to
reduce the amount of data flowing from the server to the browser. Libraries
such as jQuery make this approach easy, with an object call: jQuery.getJSON.
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A code sample of using jQuery (from the jQuery API page at http://api
.jquery.com/jQuery.getJISON/) is included here:

<html>

<head>

<style>img{ height: 100px; float: left; }</style>

<script src="http://code.jquery.com/jquery-latest.js"></script>
</head>

<body>

<div id="images">

</div>

<script>

$.getJSON("http://api.flickr.com/services/feeds/
photos_public.gne?jsoncallback=2",

{

tags: "mount rainier",

tagmode: "any",

format: "json"

}

function(data) {

$.each(data.items, function(i,item){

S("<img/>") .attr("src", item.media.m).appendTo ("#images");

if (1 == 3 ) return false;

1)

});</script>

</body>
</html>

The getJSON function takes three parameters: The first parameter is the URL
to be accessed, the second parameter is the list of parameters to be passed
to the URL, and the third parameter is the function that will process the data
when it is received.

INSTALLING THE HTMLS5 SAMPLES

Running most of the HTML5 samples is as easy as double-clicking the .HTML
file and accepting the security warning. However, when working with web
service calls, for security reasons the JavaScript calling the web service and
the web service itself should be on the same website.

All the samples are available in the download files for this book at www.wiley
.com/go/visualintelligence.

Start by opening IIS from Administrative tools > IIS Manager in the Windows
menu.
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SUPPORTED OPERATING SYSTEMS

You need Windows Server or Windows 7, or 8 Enterprise or Premium to
do this. The home editions do not support IIS. You may need to install the
IIS role as well; check here to install it: www.iis.net/learn/install/

installing-iis-7/installing-iis-on-windows-vista-and-

windows-7.

You will do this from Turn Windows features on or off in Windows 7 and 8,

and Add roles to server in Server Manager for Windows Server.

You should see a screen like Figure 9-4 on opening IIS Manager.

g Internet Information Services (II5) Manager i

@_@ [% b StartPage

File

View  Help

& =

@- |2 @ Internet Information S
-5 Start Page
=] ‘a MGS-MBENN (MGS-201281}admin)
1) Application Pools
8] Sites

Recent connections

Connect to localhost
Connect to a server...
Connect to a site..
Connect ta an appication..

115 News and Information
115 Downloads

115 Forums

Techhzt

MSDN

ASPLNET News

Name.
fMGs-tissn0

Server
Incalhost

1IS News

IS News is disabled, click the Enable TIS News link ko get the mast recent anling news,

4] | 3

Ready

FIGURE 9-4 IIS Manager

Expand the web server, right-click Application Pools, and add a new appli-
cation pool. Make sure to set it to .NET 4 as shown in Figure 9-5. Click OK.

Right-click Sites and choose Add Web Site. Set up the site as shown in
Figure 9-6. Make sure to select the application pool you just created.
You will need to click on the ellipsis next to the Physical Path to create
your new folder. Also set your port to 5555. The Host name of “localhost”
means that this website will be hosted on the local machine.
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Add Web Site i 2x]
- L |
a‘ U'"_‘ l - lﬁ‘ Site name: Application pool:
W Start Page IOECD |OECD T

B “j ME5-MEE00 (MGS-201 28T administrator)
[ 2 Application Paols
El-[&] Sites

-4 December Training Take 2

Default Web Site
MDS

— Content Directory

Physical path:

IC:'{inetpuh'(OECD

Pass-through authentication

B “ eldy Connect as... | Test Settings...
S bin
g September Training
€ sharePoint - 80 ~ Binding
9 SharePoint Central Administration w4 Type: IP address: Part:
-4 SharePoint Web Services [Fie =] [pi tnassigned =] [rsss

Hast name:

IIDca\hast

Example: www,contosa,com o marketing.conkoso.com

[V Start Web site immediately

Concel

FIGURE 9-6 Anew IS site

Now, browse to the C:\inetpub\OECD folder that you created in the previous
screen and copy the samples in treemap.zip to this folder. Make sure to remove
the files from the zip into the root of this folder. At this point, you can open the
samples by going to http://localhost:5555/treemap.html. Depending on
your security settings, you may need to click Allow blocked content to see it.

A WEB SERVICE SAMPLE IN C#

As you learned earlier, visualizations are nothing without the data to feed them,
and JSON is the format of data typically used in HTML5 applications. JSON stands
for JavaScript Object Notation. In order to create JSON with data in it, you will
need to write server-side code that creates it, and that is where C# comes in.

EARLIER VERSIONS OF .NET

If you are using .NET 2.0, you are not able to use the built-in JSON serial-
izer. Instead, you can download one from http://json.codeplex.com/.
You also need to create a basic web service rather than use a WCF service.

This web service has one objective: retrieve data from SQL Server, Analysis
Services or any other data source, and publish it as JSON that the JavaScript
can consume. .NET 4 provides a convenient JSON serialization method that
converts a C# class to JSON. Of course, to do that, you need a C# class, and
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there is a wonderful utility at http://json2csharp.com/ that enables you to
paste in JSON to generate a C# class. More details on how you will accomplish
this after you have created the solution.

In this section you will be creating a new C# web service, enabling it for use
by JavaScript, using the converter to create a C# class that generates JSON,
and adding code to put data in that new class.

Open up Visual Studio and create a new project. Go to File and select New pro-
ject>Visual C#, then WCF in the left-hand panel, and WCF Service Application
on the main screen.

WINDOWS COMMUNICATION FOUNDATION (WCF)

Windows Communication Foundation (WCF) is Microsoft's programming
model for using managed code to build unified web services and other
distributed systems that can talk to each other. It replaces the earlier "ASMX”
web services that were provided in .NET.

You can see the new project screen in Figure 9-7.

New Project

You will need Visual
Studio to do this
work. The content
in this book was
developed using
Visual Studio 2010
Professional, but
both Visual Studio
2012 Professional
and the free version
(Visual Studio Express
for Web, available
athttp://msdn
.microsoft.com/
en-us/library/
dd537667 .aspx)
should also work.

2l

A

I‘NET Framework ¢ j Sort by: IDEfault ﬂ | Search Installed Templates
Installed Templates
?‘ WCF Service Librar Wisual C# Typer veual G
Business Intelligence _&ﬁ ¥ 15Ul
[ wisual C# T ) ! that is hosted in 115/WAS and managed by
windows E& WCF Service Application Wisual Ca# Windows Server AppFabric, To download
Web == ‘Windows Server AppFabric, please o to
Office % WCF WworkFlow Service application wisual C# Pitpijmsein.microsoft.comjappfabric/
Claud
Reporting @ Syndication Service Library Wisual C#
SharePoint
Silverlight
Test
WCF
Workflow

Other Languages
Other Project Types
Database

Modeling Projects
Test Projects

Orline Templates

Mame: | CECDWehSve

Locatian: |D:\Dropbox\|

LI Browse. ..

Solution name: |0ECDWebSvc

A project For creating WCF Service Application

¥ Create directory Far salution
I add to source contral

FIGURE 9-7 New Project screen
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Rename your project from the default to OECDWebSvc, then click OK.

In Solution Explorer, Right-click the IServicel.cs file and delete it; then
right-click Servicel.svc and rename it to OECD. svc.

You can see what the project should look like in Figure 9-8.

OECD.sve.cs X Solution Explorer 3 x

% CECOWebSve Servicel [ % GetDataint vae) 3 Feleal il
Slusing System; =l [ solution 'OECDwwebsve (1 project)
using System.Collections.Generic; <[l = 3 oEcDwWebsve
using System.Ling; B [l Praperties
using System.Runtime.Serialization; i1 References
using System.ServiceModel; 3 App_Data
using System.ServiceModel.Web; 2 3
using System.Text; %] CECD.sve.cs

[ wieb.config
Sinamespace OECDWebSve

// NOTE: You can use the "Rename” command on the "Refactor” menu to change the class name "Servicel” in cod
5 public class Servicel : ISerwicel
!

FIGURE 9-8 Solution overview

Replace the content of OECD. svc with the following code:

using System;

using System.Collections.Generic;
using System.Ling;

using System.Runtime.Serialization;
using System.ServiceModel;

using System.ServiceModel.Web;

using System.Text;

using System.ServiceModel.Activation;

namespace OECDWebSvc
{

[ServiceContract (Namespace = "OECDSvc") ]
[AspNetCompatibilityRequirements (RequirementsMode =
AspNetCompatibilityRequirementsMode.Allowed) ]
public class OECD
{
[DataContract (Namespace = "OECDSvc") ]
public class Response
{
[DataMember]
public string tmString { get; set; }

}

[OperationContract]

[WebInvoke (BodyStyle = WebMessageBodyStyle.Wrapped,
RequestFormat = WebMessageFormat.Json, ResponseFormat =
WebMessageFormat .Json) ]

public Response POSTTreemapByRegions (String sRegions)

{
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return (new Response() { tmString = "basic Response" });

The class attributes ServiceContract on line 13 and AspNetCompatibility
Requirements on line 14 define what this class can do. The DataContract
attribute on the response class on line 17 defines what this web service is going
to return—in this case, just a string. The reason you have to return a string and
not a pure JSON object is the naming convention of $area and $color, which
you have to fix. C# does not support $ or a space in a name in class, whereas
the InfoVis library requires them. You'll get to that a little later in this section.
Finally, the method attributes OperationContract on line 24 and WebInvoke
on line 25 tell the web service that this is a POST service—this is the method
that the web page will use to communicate to the web service, as opposed to
the other type of service, the GET service.

Next, open the web.config file—it is located in your solution explorer in
Visual Studio directly underneath the OECD. svc file you have been working
on. Replace the contents with the following:

<?xml version="1.0"?>
<configuration>

<system.web>
<compilation debug="true" targetFramework="4.0" />
</system.web>
<system.serviceModel>
<behaviors>
<endpointBehaviors>
<behavior name="OECDSvc.OECD">
<webHttp />
<enableWebScript />
</behavior>
</endpointBehaviors>
<serviceBehaviors>
<behavior>
<!-- To avoid disclosing metadata information, set the
value below to false and remove the metadata endpoint
above before deployment -->
<serviceMetadata httpGetEnabled="true"/>
<!-- To receive exception details in faults for debugging
purposes, set the value below to true. Set to false
before deployment to avoid disclosing exception
information -->
<serviceDebug includeExceptionDetailInFaults="true"/>
</behavior>
</serviceBehaviors>
</behaviors>
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<serviceHostingEnvironment multipleSiteBindingsEnabled="true" />

<services>
<service name="OECDSvc">
<endpoint address="http://localhost:5555/0ECD, svc"
behaviorConfiguration="0ECDSvc.OECD"
binding="webHttpBinding" contract="OECDSvc.OECD" />
</service>
</services>
</system.serviceModel>
<gsystem.webServer>
<modules runAllManagedModulesForAllRequests="true"/>
</system.webServer>
</configuration>

The default example has used port 5555. Note that you need to replace
http://localhost:5555/ with the website you're using on your machine if
you changed this—this is located in the endpoint tag eight lines from the end.
Go ahead and create a new empty website in Internet Information Services
(11S) now if you don’t have one (this was covered in “Installing the HTML5
Samples” earlier in the chapter, and if you followed that section you should
have a website setup—you should use that one.)

The final piece of the basic website setup is changing the service markup. Go
to OECD. svc, right-click, choose View Markup, and then replace the content
with the following code:

<%@ ServiceHost Language="C#" Debug="true" Service="OECDWebSvc.OECD"
CodeBehind="0ECD.svc.cs" Factory="System.ServiceModel.
Activation.WebServiceHostFactory"%$>

This can be seen in Figure 9-9.

Next, you need to return some data. In this example, the data is hardcoded.
In the download samples for the chapter (available at www.wiley.com/go/
visualintelligence), it is pulled from a database. This data needs to be
returned in JSON, based on the format that InfoVis requires.

JSONTO C# TO JSON

You may be wondering why you are going through this process. You need
to deliver JSON (which will be dynamically generated) in a very particular
structure to our visualization, and you will be using C# to generate that
JSON. While you could code this yourself, instead you are going to use a
converter tool that looks at a sample of the correctly structured JSON and
outputs an appropriate C# class.
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OELOWebSve - Micrusoll Visual Studio (Administrator E =1oix|
Fio Edt Vew Propct Buld Debig Tean Data Tods Archbectws Test fnabyos Window Help
P gt g g™ I A . Y i < A= Al =1 3 [servcer A RErRHED-" .

L Pie| =2 ) 2§ ubkshy |prfiot - i 2§ nstel Wb Components =

PO | %0 servicetost Languakes"Ch™ Debuga™true™ Services"0ECONebSve. 0ECD™ CodeBehind="0ECD. sve.cs™ Factory="System. ServiceMode] Activation, WebsServicetostFactory %

FIGURE 9-9 The new markup for OECD.svc

So take the JSON from Treemap.js (Treemap. js is part of the code down-
loads for this chapter, available at www.wiley.com/go/visualintelligence),
where it says var json = {xxxxx}; and take everything including the two
braces but excluding the equal sign and semi-colon, and paste it into the
converter. You can see what to copy in Figure 9-10. Make sure to copy all
the JSON before the line that has ends with //, but excluding the semi-colon.
Note that Figure 9-10 has been edited, and you need all the content from
the brace on line 31 to the brace on line 290.

TEXT EDITORS

While Notepad or Wordpad that are included with Windows could be
used for this, a free editor such as Notepad++ (available from http://
notepad-plus-plus.org/) will be much easier to use, as it includes syntax
highlighting and line numbers. You will set the syntax highlight by going
to Language > J > Javascript in the menu.

Create a new class called Treemap.cs by right-clicking on your solution file
and clicking Add > Class, as in Figure 9-11.
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28 [Clfwnction init{){
30 Ffinic data

31 H var json = {
32 = “children”: [ {
33 = "children™: [{
34 "children™: [1.,
35 = Tdata™: {
36 "GDP Per Capita™: "567,
37 "goolor”
35 "image: "7,
39 "farea”: 56
4an r 3.
41 "id": "Austria™,
a2 "neme”: "Austria”
43 ¥oA
44 children™: [1.
a5 [+ Tdata™: {
a6 "GDP Per Capita™: "8G87,
a7 "gocolor™: "HFDAEGLT,
a5 "image™: "7,
49 "garea”: 88
0 r 1
51 Tid": "Belgium”,
52 "name’: "Belgium”
53 ¥oA
54 "children™: [1.,
55 [H Tdata™: {
56 "GDP Per Capita™: "195"7,
57 "gocolor”
55 "image™: "7,
59 "garea': 195
60 - Y.
&6l "id": "Czech Republic”,
EEEN N EEEEESSEEESEEESEENEENEEEEEEEEN
The JS library we're 2:: ,,d;t]a.’,: o,
using has a challenge 288 Tid™: Troot”,
When WOI’king With 289 "ame": "Regions by National Reserwe and GDF per capita™
290 | B
C#,in that it uses $ 201 .
symbols in the names 292 //end
of variables in the = frmE Trestian
JSON definition, and FIGURE 9-10 The JSON that is the data for the visualization
in C#, $ isreserved.
The JSON library

generator cleans this

up for us by replacing Paste the code that you got for the JSON class over the class (make sure to

$with __invalid leave the lines starting with USING at the top, as well as the line starting with
name__$. For your namespace, and the final brace that closes the namespace. The class contents
purposes, your end . L . .
R e are contained within the braces following the name of the class). You will
these exactly the need to make some amendments to make this code work correctly however.

same, so for now
you will replace that
invalid name with

a placeholder, and

Replace __invalid_name__$ with DOLLAR (you do a reverse replace later).

immediately prior to Spaces are also illegal, so do a replace for __invalid_name_ GDP Per Capita
returning the JSON, with GDP_Per_Capita.
replace the place-
holder with $.

You can see the class in Figure 9-12.
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FIGURE 9-11 Adding a class

% OECDWebService, Data

P2 MewItem,.. Chrl+Shift+a
[ Existing Ttem... shift+Al-+4
[y Mew Folder
&dd ASPMET Falder 3
#2  Class.., Shift+alt+C
»
s
Chrl+Y
Del
Alt+Enker
Treemap.cs
«| 4 playcount

Husing System;

using System.Collections.Generic;

using System.Web:

Cinamespace OECDWebService
1
public class Treemap
{
public
public Data3 data { ge

t<child> children { get; set; }

t; }

public string id { get: set: }
public string name { get; set; }

}
= public class Data

{
public string playcount { get; set; }
public string DOLLARcolor { get; set; )
public string image { get; set; }
public inl DOLLARarea { get; set; }

}

public class Child2

tcobject> children { get; set; }
a data { get; set; }

public string id { get; set; }

nuhlic strine name § set: <et: }

W0% < 4

FIGURE 9-12 C# code
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Custom Tool
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You now need to finish changing the class to work with the rest of your code.
Change the namespace to OECD.JSONSerialization. Change the class name that
says “RootObject” to Treemap. It should appear as in Figure 9-13 below. You
can test if the code is correct by building the project—pressing Ctrl-Shift-B
will do so.

Treemap.cs X

VfgoECD.JSONSer\aIlzatlon.Treemap vlﬁchlldren
—lusing System;
using System.Collections.Generic;
using System.Lling;
using System.Web;

—Inamespace 0ECD.JSONSerialization

i
= public class Data
{
public string GDP_Per_Capita { get; set; }
public string DOLLARcolor { get; set; }
public string image { get; set; }
public int DOLLARarea { get; set; }
}
= public class Child2
{
public List<object> children { get; set; }
public Data data { get; set; }
public string id { get; set; }
public string name { get; set; }
}
= public class Data2
{
public double GDP_Per_Capita { get; set; }
public double DOLLARarea { get; set; }
}
= public class Child
{
public List<Child2» children { get; set; }
public Data2 data { get; set; }
public string id { get; set; }
public string name { get; set; }
b
= public class Data3
{
b
= public clas -~
{
public List<Child» children { get; set; }
public Data3 data { get; set; }
public string id { get; set; }
public string name { get; set; }
¥
h

FIGURE 9-13 Treemap class
Next, create a new class—Serial.cs—in the same manner you created the new

Treemap.cs and paste the following code (overwrite everything on the page
in this instance, as all the requirements are included in the following code.)
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using System;

using System.Collections.Generic;
using System.Ling;

using System.Text;

using System.Web.Script.Serialization;

namespace OECD.JSONSerialization
{
public class Serial
{
public Treemap tmJSON;
public Serial ()
{
tmJSON = new Treemap () ;
tmJSON.1d = "root";
tmJSON.name = "root";
Child allChild = new Child();

allChild.id = "region_Europe";
allChild.name = "Europe";
allChild.data = new Data2();

allChild.children = new List<Child2>();

Child2 grandChild = new Child2();
grandChild.children = new List<object>();
grandChild.id = "country-France";
grandChild.name = "France";
grandChild.data = new Data();
grandChild.data.DOLLARarea = 35133;
grandChild.data.GDP_Per_Capita = "35133";
grandChild.data.DOLLARcolor = "#E66101";
grandChild.data.image = "";

Child2 grandChild2 = new Child2();
grandChild2.children = new List<object>();
grandChild2.id = "country-Greece";
grandChild2.name = "Greece";
grandChild2.data = new Data();
grandChild2.data.DOLLARarea = 26934;
grandChild2.data.GDP_Per_Capita = "26934";
grandChild2.data.DOLLARcolor = "#FDB863";
grandChild2.data.image = "";

Child2 grandChild3 = new Child2();
grandChild3.children = new List<object>();
grandChild3.id = "country-Germany";
grandChild3.name = "Germany";
grandChild3.data = new Data();
grandChild3.data.DOLLARarea = 39518;
grandChild3.data.GDP_Per_Capita = "39518";
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grandChild3.data.DOLLARcolor = "#B2ABD2";
grandChild3.data.image = "";

allChild.children.Add (grandChild) ;
allChild.children.Add(grandChild2)
allChild.children.Add (grandChild3)
tmJSON.children = new List<Child>(
tmJSON.children.Add (allChild) ;
tmJSON.data = new Data3 () ;

7

);

}
public string serialize()

{
JavaScriptSerializer js = new JavaScriptSerializer();
return js.Serialize (tmJSON) ;

This code hard codes the values for the treemap—in the samples for this
chapter, a data-driven layer that returns the same data is provided. Finally,
go back to OECD. svc (you created this at the beginning of the example; just
double-click to open it). Add the following using statement at the top:

using OECD.JSONSerialization;

then replace:

return (new Response() { tmString = "basic Response" 1});
with:

Serial s = new Serial();
string sTM = s.serialize().Replace("DOLLAR", "S");
return (new Response() { tmString = sTM });

This will call the class you just created to retrieve the data, and replace the
placeholders with the $ symbols. Press Ctrl-Shift-B to rebuild.

Finally, right-click the project OECDWebSvc and choose Publish. You see the
screen shown in Figure 9-14. You may need to create a new profile if Profile
1 does not appear in your drop-down—do this simply by entering a name in
the text box, and then entering the settings

Set the URL to the website you created earlier, set the Site/Application to
OECD, tick the Mark as IS application on destination check box and click the
publish button.
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Publish Web 2=l
e

Publish profile: @ x H
IProF\Ial =l Rensme [ Delete | 5=

Publish uses settings from "Package/Publish Web" and "PackagefPublish SCQL" tabs in
Project Properties,

Find Weh hosting provider that supports one-click publish.
~Publish
Build configuration: Debug

Use Build Configuration Manager ko change configuration

Publish methad: IWeb Deploy j

Service LRL: |http:;’ﬂocalhost:5555 @
.0, localhost or https: ffRermateServer 8172 MsDeploy aed

Sitefapplication: |0ECD 7]
2.3, Default Wieh Site/MyApp or MyDomain.comMyapp

[V Mark as 115 application on destination

[ Leave extra files on destination (do nat delete)

- Credentials
™ allows untrusted certificate

Use this option only for trusted servers

User name: I

Passward: I

™ save passward

Publish I Close

FIGURE 9-14 Publishing your web service

CUSTOM CODE
A Web Service Sample in C#

All of the changes thus far have been done in Visual Studio as part of the
web service. The next set of changes will be done in Notepad++ once more.

Next, you need to make the JavaScript changes. Open Treemap.js in
Notepad++. You need to change the init function to look like the following:

function init(){
var json;
$.ajax
(
{
type: 'POST',

url: 'http://localhost:5555/Servicel.svc/POSTTreemapByRegions',

dataType: 'json',
contentType: 'application/json; charset=utf-8',

data: '{ "sRegions": "All" }',
success: function (response, type, xhr)
{

json = response.POSTTreemapByRegionsResult.tmString;
CreateVisual (json) ;

},

error: function (xhr)

{
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window.alert ('error: ' + xhr.statusText);

Note that this replaces the same code that you copied for conversion, but this
time it is all the content from line 29 to the end of the file

This is an asynchronous call to the C# web service (which is specified in the
line beginning with URL), and replaces the hardcoded data that was in this
file originally. As an asynchronous call, you have to have another function
that creates the visualization to allow it to only execute after data is returned.
This function is called CreateVisual and is specified in the success result of
the AJAX call.

Then, place the code below code directly below the code you have pasted
above.

function CreateVisual (jsontext) {

var json = eval('(' + jsontext + ')');

var tm = new $jit.TM.Squarified({
//where to inject the visualization
injectInto: 'infovis',
//parent box title heights
titleHeight: 15,
//enable animations
animate: animate,
//box offsets

offset: 1,
//Attach left and right click events
Events: {

enable: true,
onClick: function(node) {
if (node) tm.enter (node);
I
onRightClick: function() {
tm.out () ;
}
},
duration: 1000,
//Enable tips
Tips: {
enable: true,
//add positioning offsets
offsetX: 20,
offsetY: 20,
//implement the onShow method to
//add content to the tooltip when a node
//is hovered

www.it-ebooks.info


http://www.it-ebooks.info/

onShow: function(tip, node, isLeaf, domElement) {
var html = "<div class=\"tip-title\">" + node.name
+ "</div><div class=\"tip-text\">";
var data = node.data;
if (data.GDP_Per_Capita) {
html += " GDP_Per_Capita: " + data. GDP_Per_Capita;
}
if (data.image) {
html += "<img src=\""+ data.image +"\" class=\"album\" />";
}
tip.innerHTML = html;
}
I
//Add the name of the node in the correponding label
//This method is called once, on label creation.
onCreateLabel: function(domElement, node) {
domElement.innerHTML = node.name;
var style = domElement.style;
style.display = '';
style.border = 'lpx solid transparent';
domElement .onmouseover = function() {
style.border = 'lpx solid #9FDAFF';
Y
domElement .onmouseout = function() {
style.border = 'lpx solid transparent';
Y
}
1)
tm.loadJSON (json) ;
tm.refresh();

That's really it. The rest of the sample’s layout stays the same. Now open your
browser and go to http://localhost:5555/treemap.html

SUMMARY

In this chapter you learned the basics of using C# and HTML5/Javascript to
create your own visualizations. These make using libraries such as InfoVis and
others for the front end and writing your own web service to supply data to
extend the visualization capabilities available from Microsoft much easier.
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PART Il

VISUAL ANALYTICS
IN PRACTICE

In this part

CHAPTER 10: Scorecards and Indicators
CHAPTER 11: Timelines

CHAPTER 12: Comparison Visuals

CHAPTER 13: Slice and Dice: Ad-hoc Analytics
CHAPTER 14: Relationship Analysis

CHAPTER 15: Embedded Visualizations

CHAPTER 16: Other Visualizations
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CHAPTER 10

Scorecards and Indicators

A scorecard can be thought of as the business version of a school report card:
it's a summary of how the business has performed over the last period, shown
as numbers for key performance areas (KPAs), which are aggregated from
key performance indicators (KPls). A KPI is loosely similar to the subjects on a
school report card, but generally a scorecard’s KPIs have graphical indicators
and interactive capabilities (unlike a school report card).

Scorecards have been popularized in recent years through the widespread
adoption of Performance Management. Starting in the management con-
sultancy McKinsey & Company in the 1930s, Performance Management as a
discipline advocates building a measurable strategy to grow a business and
identifying key performance indicators to measure various aspects of the
business. Key performance indicators, roll up into key performance areas, and
these are put together in a visual way in a scorecard, typically using “robot”
indicators of red, yellow, and green to indicate whether targets are being
met. On the Microsoft platform, Business Scorecard Manager evolved into
PerformancePoint as the tool of choice for displaying these scorecards and
other visualizations together in dashboards.

This chapter discusses how these tools can be used both for Performance
Management and for business intelligence (Bl) in general.

ACRONYM SOUP

Business Performance Management, Corporate Performance Management
and Enterprise Performance Management really are all the same thing,
leading to a confusion of acronyms—BPM, CPM, and EPM.

Differentiating from Business Process Management (BPM) and Enterprise
Project Management (EPM) is important, leaving CPM as the easiest acronym.
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A QUICK UNDERSTANDING:
GLANCE AND GO

The main reason for implementing a scorecard system is to enable quick
analysis of key metrics—the ability to view a metric (be it a KPI, an operational
metric, or indeed any metric in your business) and either move on when values
are within predefined bands, or start an investigation when the values are
out of band. This definition often sits outside the traditional scorecard and
dashboards arena, but is a very important and growing area for these tools.

Some key design features to enable this are vital—the details vary from tool
to tool, but the basics are the same:

A filter area to change the data displayed

A scorecard area, with drill-down capabilities and indicators, to highlight
where investigation is needed

A further details area—either drill across or drill through

KPIs

KPIs are the heart and soul of scorecards. In its simplest form, a KPI is an actual
value, measured against a target, and assigned to a band by the distance from
the target. The reality of choosing KPIs for an organization’s strategy is that
the process is long, complicated and fraught with difficulties—for instance,
measuring customer service representatives by how long they spend on the
phone with customers (what appears to be an easy way to drive down costs)
can have grave effects.

In this book, it's assumed that you've gotten all of that perfect, and you need
to master using the technology.

The other piece of this puzzle is that technologies allow you to do much
more than simply assign an actual, a target, and bands to a KPI. For instance,
in PerformancePoint you can add both dimension and time filters, and have
multiple actuals and targets—for example, actuals of Today, Month-to-Date,
Year-to-Date, with targets of This-Day-Last-Year, Last-Month-to-Date, and
Last-Year-to-Date. The bands are the range of values that are considered
good, acceptable and poor. For instance, 120 percent and above against the
previous year would be good, anything above 100 percent of the previous
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A Quick Understanding: Glance and Go

year would be acceptable, and anything lower than the previous year would
be poor. In addition, the drilling functionality that comes out of the box adds

a lot of depth to the scorecards.

Ease of Development

REPORTING TOOL

Excel
PerformancePoint
Power View
Reporting Services

Silverlight/HTML5

DRILL DOWN

PREDEFINED CHART TYPE

Yes

Yes

Yes

Yes

N/A

EASE OF DEVELOPMENT

Drill down is the process of starting analysis at a high level, with aggregated
data, and narrowing the focus to show detail data. This is typically done using
a list of higher-level dimension items with a drill-down plus sign next to each
and inserting the more detailed items between the drilled member and the
next member. Lower levels are indented to distinguish them. A minus sign
allowing you to drill up is usually included as well. For instance, in a retail

environment, the aggregated levels may be states or regions, showing sales

figures, and drilling down allows you to view individual stores.

Ease of Development

REPORTING TOOL

Excel
PerformancePoint
Power View
Reporting Services

Silverlight/HTML5

PREDEFINED CHART TYPE

Yes

Yes

Yes

Yes

N/A
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DRILL THROUGH

Drill through, although it has a similar function to drill down, is usually imple-
mented as a double-click, or a click on a link, that takes you to a different report
or worksheet to get more details about the KPI. Drill through is very often used
to go to view the individual transactions that make up the values on a scorecard.

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes .
Power View No .
Reporting Services Yes .
Silverlight/HTML5 N/A .
DRILL ACROSS

Drill across is aimed at obtaining additional information about the dimension
member. For example, when viewing the sales figures in a scorecard that has
a store drill-down hierarchy, you may want to see the breakdown by product
category and include a profit margin.

You accomplish this by linking the scorecard to another item on the same
page—a chart or a table of values—and filtering this item by the dimension
value that’s been clicked in the scorecard.

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel No

PerformancePoint Yes .

Power View Yes .

Reporting Services No .

Silverlight/HTML5 N/A
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TOOL CHOICES, WITH EXAMPLES

Scorecards can be built with all of the Microsoft tools. PerformancePoint is
designed around scorecards, but with SQL Server 2008 R2, scorecard func-
tionality was added to Reporting Services. Excel has always been able to
build scorecards and indicators, but has had this functionality natively since
Excel 2010. In the following sections you learn in detail about the capabilities
of each tool.

PERFORMANCEPOINT

PerformancePoint excels at scorecards, as it is aimed squarely at this segment
of Bl. A key point, however, is that PerformancePoint works immensely better
when combined with Analysis Services or PowerPivot Services—the functional-
ity around analytic charts, hierarchies for drill down in scorecards—which are
all based upon having the semantic layer already built.

PerformancePoint dashboards can scale from the Stare Metrics
simplest—a single traffic light visualization (red/ ® ettt 8 ke e B [k R
. # Sales Amount 43,072 44,002 @ -25% [ ] 245 &
yellow/green) used on an operational page, as v~ Y P s e
shown in Figure 10-1—to a completely interactive HFeb Finds Seles Amourt  $249 90 @ 170% . e @
dashboard that has multiple pages, several filters, ACeRniany v 157 @ 5w ® = | ®
a scorecard driving an analytic chart and another FIGURE 10-1 A scorecard showing rollups of store scores
scorecard, as shown in Figures 10-2, 10-3, and 10-4.
Rating by Store B Rating by Metric over ti... . ~[C]
January February  March April May 1une July August September
Rating TargetRating Rating Rating Rating Rating Rating Rating Rating Rating Rating
= Weighted Score 2086 Al 2300 ¢ 2160 (% 250 (O 2060 (5 2060 (5 180 @ 1847 @ 2157 (O 2227 O
SParentOrganisation  2.086 () ©CUSTOMER 0200 @ 027 @ o027 @ o033 @ 0wy ® o3 & ow S 0w # owr @
=i Gauteng 2023 EFINANCIAL 0917 @ 0643 @ o080 @ o050 @ 000 @ 033 @ ocw $ 0733 $ s @
Store 1 212 & HINTERNALPROCESSES 0900 @ 1070 @ 1030 @ 1257 @ o070 @ 1030 @ osn # 09w # oom @
Store 2 1934 @ [HIPEOPLE 023 @ o020 @ o033 @ o0 @ 023 @ 023 ® o030 @ om0 @ 02w @
KN 2211
Store 3 2211 (O

Store Trends

5.0
4.0

3.0
— Gauten
2.0 <
— KZN
10

0.0
August October December February April June

September November January March May

FIGURE 10-2 The same dashboard but with the righthand scorecard switched for a chart
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Store Comparison -

Rating by Store - a5
Rating TargetRating
= Weighted Score 208 (7 2.0
[ZParent Organisation  2.085 ()
= Gauteng 203 O 15 [ PEOPLE
Store 1 2112 (& [l INTERNAL PROCESSES
Store 2 193¢ @ I [l FINANCIAL
j— 2 Il CUSTOMER
Store 3 2211 (O s
0.0 i
Gaute] = | Dril Down N
Drill Down To H| & pimDate »
Store Trends =1 prill Up V| oimMetricHierarchy  * .
o Show Only £ DimStores »
q'ﬂ Remove 12 FactkPvalues 4 ar
3.5 Select Measures... Reg
20 N i b T v Storeshiame _— — Gauteng
10 Pivot — — k2N
00 (4] | Report Type »
: August October December = pril June August
Format Report D
September November January (i | Format Repor May July September
@ | show Information Bar

FIGURE 10-3 Drilling down on an analytic chart

. Store Comparison .l
Rating by Store -E 12 o o
Rating Target Rating
[ Weighted Score 2.086 L0 -
(JParent Organisation  2.085 /) Llsane of O
v 205 & 08 Filter:
=i Gauteng - DimMetricHierarchy KPL Top 7 by Store 1, Weighted
5
Store 1 2112 Oy 06 core
Store 2 1933 @ ] out of Box Failures
=L 2211 Oy 04 M stock
Banking
Store 3 2211 &y u
0z Il StockAging
0.0
Store Trends -[
5.0
40
3.0
— Gauts
2 auteng
1.0 -k
0.0
August October December February April June August
September November January March May July September

FIGURE 10-4 Drilling down in an analytic chart

The true power of PerformancePoint is that the connections between these
components are completely developer driven—having some filters only affect
a selection of components on the page is a great tool to have in your arsenal.
Another useful advantage is that the filters remember the selection of each
user—allowing them to seamlessly move from page to page and continue
analyzing the same selections.
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The following is a list of some key design guidelines to work with in
PerformancePoint:

Keep filters along the top of the page.

Keep a scorecard that controls other components on the left.

Add additional items on the right side and at the bottom linked to the
scorecard.

Figure 10-5 shows an

vear: |This Year W

example of these.

£460,562.40
§1,675.50
$397,587.65
$5,439.22
55,860.02

Comparison -0 Product Details
Sales This Menth | Quota This Month Sales Last Month Sales LY This Menth Product Categeries Freight Cest Standard Pro...
= Sales [} @ @ = All Products $33,004.25
& Europe 51,258 51,009 @ 25% | $653 @ 93% | $433 @ 190% + Accessories §295.96
S North America | §2,424 2,448 () 1% | $1,895 @ 28% | $2,233 @ 9%  Bikes $28,453.75
= Clothin $787.38
@ Canada 8411 5296 @ 38% | $397 @ 18% | s3I @ 1% g
®C $3,557.66
= United States | $2,013 $2,189 ) 8% | $1,547 @ 30% | s1,862 QP 8%
Central s254 §207 ) 15% | 114 @ 123% | 5234 @ 9%
Northeast s141 $352 i 60% | S140 @ 1% 278 @ 49%
Northwest 5612 607 @ 1% 472 @ 0% | M0 @ 39%
Southeast $191 240 (0 -20% | 115 @ 66% | 5213 o -10%
Southwest 5815 713 @ 14% | §707 @ 15% | S697 @ 17%
= Padific 8482 O 455 @ 6% 5208 @ 132%
Employee Sales
300K
600K
400K
200K
Jillian Carsan Linda C. Mitchell Michael G. Blythe

FIGURE 10-5 Key design considerations in PerformancePoint

EXCEL

Tax Amount
£105,901.52
£945.45
£91,051.97
62,519.61
$11,384.49

-

Shu K. Tto

Excel in Office 2013 has become a very powerful dashboard tool. Although it has
some limitations compared to the power of PerformancePoint in terms of the
control over the connections, Excel still has a very simple and intuitive interface.

Excel includes KPIs, with the sole limitation that you must use the built-in icons.
PerformancePoint enables you to import your own indicators.

Excel is much more customizable than PerformancePoint when it comes to
appearance. You can fairly extensively customize a basic pivot table, as you
can see in Figure 10-6. When further customization is required, you can use
cube functions, which allow for total control, as you can see in Figure 10-7.
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Period FY - 2011 October | ¥
Row Labels -T|Amount

=Income Statement R 38 651 314.63

= 5ales R 3119477726

 Cost of Sales R 2468042476

Gross Profit R 650535250

Gross Margin % 20.85%

# Other Income R 263066023

Gross Profit After OtherIncome R 813601273

® Cartage and rallage R -356 154,59

HWarehouse & Distribution Cost | R -422 D67, 40

H Deprecigtion R -74 760,66

® Staff Expenses R -1 770 754,01

® Administration expenses R -548 734,47

#5qles & Marketing expenses R -105 755,13

Total Expenses R -3 370 135.09

# Finance Charges R -7

Profit before Tax R S 765877.48

HTax R -240 000,00

Net Profit R 4825877.48

Net Margin % 15.47%

= 15% Improved M2K
= 15% Worse M2k
Notes

The marketing effort really paid of !

FIGURE 10-6 A pivot table showing an Income statement, with conditional formatting

sale Coordinator Name %

-

Ange Baatjies
Candice Chester
Cape Town
Chadwin alburn
Cheryl Mitchell
Durban
Johanneshurg
Karen De &llende
Lindiwe Mbhokow,.,.
Mandy September
Narie Wilkinson
Melissa Henry
Nichielle Wenter
Sandra Boyce
Thabile Chaka
unknown

Zodwa Nelebele

Unknowin

‘Warehouse Name

l Bond ” Cape Town H Consignment ... ” Consignment ... ” Consignment ... H Consignment ... ” Consignment(... H Cruz Freight (... ” Drumpal Unpa... ” Palatinit Sam... l

[ Port Elizabeth ” REMMIES/FLA, .. H Savannah ” ST TRF from C... ][ ST TRF from D... H ST TRF from PE ” ST TRF to Cap... H ST TRF to Durh... ” Unknown ][ Unknown l
Date 2011 October T

Headline
Sales
Met Profit

Gross Margin %

4577595.658

20,85%

2259 174,66

sales
Met Profit
Gross Margin %

151%
212%
236%

YoY Growth

Top 10 Clients -Sales Amuunt-('ustumer Notes hd

-

Agrana Fruit South Africa (Pty) Ltd R 36 548
A slow month due
ta the plant
Arnka Products (Pty) Ltd R 23111 shutdown
Colgate Palmalive (Pty) Ltd R 78307
Ekharmanzi Springs (Pty) Ltol R BRI 344
Givaudan $outh &frica (Pty) Ltd R 508 329
GlaxoSmithkline S& (Pty) Ltd (2) R 233670
GlaxoSmithkling S& (Pty) Ltd ( PH ) R 56 317
A key strategic
Le-5el Research (Pty) Ltd R 374687 client
Mestle (South africa) (Pty) Ltd R 146 336
Unilever South Africa (Pty)Ltd R 829378 i

Top Products in Stock
Ceto Stearyl Alc Ginol 1618 25kg R
Citric Acid Anhyd FE000 25kg R

Cocoa Pwd "Cordoba 10-12%" 25Kg R
Cocoa Pwid "alencia 10-12%"

25KG R
Fructose Reg Gran 23Kg R
| & G Mucleatide 10kg R
Orafti GR 25kg R
Propylene Glycal USP/EP (1) 215kg R
Skimmed Milk Pwel Code 01 25Kg R
Titanium Dioxide Pharma 25kg R

- Valuation

2051942,21
2120518.23

121 489,65

9927384.39
10332 867.32
5975 396,95
5462853.98
2612117.86

307 345,65
1627 863,30

-Sturk notes  §d

Top 10 Products -Sales Amuunl- Product Notes id

Propylene Glycol USP/EP (1) 215kg R

Cetyl Alcohol C16 25Kg
Fructose 25kg
Fructose Reg Gran 25Kg
Glycerine BP Natl 230kg
Orafti GR 25kg
Orafti P95 25kg

E-REE RN O]

Fara dichlorohenzene ® R
Zeodent 113 20kg R
Zeodent 153 (Zeofree) 10kg R

1316432

257931
465 A66
389183
285859
683033
119512

1305631
153475
213642

Massive growth in
this product

FIGURE 10-7 An excel sheet customized to include notes fields
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The design principles for Excel are a little different, due to the limitation on
filters that a standard filter can only be along the top of the screen, and the
fact that slicers are inherently larger than the filters. The guidelines are the
following:

Keep filters along the top of the page.
Keep data on one sheet visible to the user without scrolling when possible.
Use slicers below the data on the sheet that are linked to all data points.

Use slicers to the right of the sheet that are only linked to data on that
sheet.

IMPLEMENTATION EXAMPLES

In this section you learn how to implement a scorecard in Excel (using
PowerPivot) and in PerformancePoint. You also learn how to implement indica-
tors in PerformancePoint using your own images in place of the standard ones.

To follow along with the samples, you will need to install the samples, which
are available on this book’s web site on Wrox.com. (See Chapter 4 for guidance
with installing the database samples.)

IMPLEMENTING A SCORECARD IN EXCEL

After you have set up a data model for Excel, it is remarkably easy to create
something quite good looking in a fairly short amount of time. Luckily, set-
ting up this model is also fairly easy in the latest version of Excel. To do so,
open a new Excel workbook, and, on the PowerPivot tab, click the Manage
button. (See Chapter 5 for enabling PowerPivot if the tab is not visible). Click
the From Database button, choose SQL Server, and enter the location of
your SQL Server. Choose the VI_UNData database from the drop-down and
click Next. Choose Select from a List of Tables and then select the DimDate,
DimCountry, DimOECDStatistic, FactOECDPopulation, and FactUNData tables,
and click Finish. Your screen should look like Figure 10-8.

In order to use indicators, you first need to have a target, and you also need
to have a calculated measure on both the actual and the target.

www.it-ebooks.info

Slicers were intro-
duced in Excel 2010,
and give visual feed-
back about which of
the available entries
in the slicer have
data in the associ-
ated pivot tables or
charts. In addition,
a slicer can be con-
nected to multiple
tables and charts,
unlike the older
filters. Figure 10-6
shows a slicer next
to the tablesit is
connected to.
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Cedo e N o

Home Design Advanced Q,
"'D G [5‘ Data Type : Date Y i 5 i
L Format : *2001/03/14 01:30:55 PM
Clipboard Get External Refresh | PivotTable = 20 .00 Sortand Find Calculations  View
Data %o » T 41 Filter
Formatting
[SDurcEChang v| ‘ |
_ e e Ll CEerrs s i Tl -
i Afghanlstan 2012!10,’02... 2012/10/02 08... 1 Afghanistan
2 Albania 2012/10/02 ... 2012/10/0208... 1 Albania
3 Algeria 2012/10/02 ... 2012/10/02 08... 1 Algeria
. 4 American Samoa 2012/10/02 ... 2012/10/02 08... 1 American Samoa
. 5 Andorra 2012/10/02 ... 2012/10/02 08... 1 Andorra
. 6 Angola 2012/10/02 ... 2012/10/02 08... 1 Angola
. 7 Anguilla 2012/10/02 ... 2012/10/02 08... 1 Anguilla
8 Antarctic 2012/10/02 ... 2012/10/02 08... 1 Antarctic -
] i
]
4- m v
| DimCountry |DimDatE |Dim0ECDStari5tic FactOECDPopulation | FactUNData
Record: M 4 20f 237 YoM (== [

FIGURE 10-8 A PowerPivot data set

For the target, you are going to compare each country against the best of its
peers. To do that, you are going to create a Data Analysis Expression (DAX)
calculation as a calculated column on FactOECDPopulation. The DAX code to
put into the column is:

=CALCULATE (

MAX (FactOECDPopulation[Value])

, FILTER (ALL(FactOECDPopulation), FactOECDPopulation
[DimOECDStatisticID] = EARLIER (FactOECDPopulation
[DimOECDStatisticID])

)

)

After this, create a SUM rollup on both the new column and on the actual,
which you will do by clicking the Sigma (sideways M) symbol on the Ribbon
while you have those columns highlighted.

Then click the measure you just created on the actual column, and click Create
KPI on the Home tab of the Ribbon. The pop-up box in Figure 10-9 appears.
Configure it to use your new measure as a target by selecting your new mea-
sure from the drop-down and set the red band to 40%, set yellow from 40%
to 80%, and set green above 120%.
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,
T T

KP base field (value): | Sum of Value

KPI Status
Define target value:
@ Calculsted Field:
(@ Absolute value: - e - e ——
Define status thresholds:
x g
%

— T—

Select icon style:
®@ v © @ x| e
@ v @ a Y a ¥
® Y © @ |¢v| ® ¢
& Descriptions

FIGURE 10-9 Setting KPI values in Excel

When you're done, create a new pivot table. Add the Sum of Value and Status
measures to the pivot table, and drag the country column of the DimCountry
table from the list of fields to the rows. You need to add a filter and choose a
single metric to get a meaningful number. See Figure 10-10 for an example.

Metric Partner countries and regions of African merchandise imports Iz‘
Row Labels IE‘ Value Status
Belgium 2.80 @
Brazil 2.10 @]
Canada 0.80 O
China 8.81 @
France 11.57 .
Germany 7.75 @
India 2.85 @
Italy 6.59 €]
Japan 347 O
Netherlands 3.13 o
Portugal 1.01 €]
Russian Federation 1.20 @]
South Africa 3.20 Q
Turkey 1.91 @
Grand Total 4.08 @

FIGURE 10-10 A pivot table with indicators
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Of course, the ability to accidentally leave off a filter and get meaningless
values is quite dangerous. With a slight tweak to your calculated measures,
you can fix that up. Change your two measures (Sum of Value and Status) to
the following DAX to show a value only when the DIimOECDStatistics table
has only one value:

Sum of Value:=IF(

HASONEVALUE (DimOECDStatistic[Metric]),
SUM ( [Valuel),

Blank ()

)

BestOfPeers:=IF (HASONEFILTER (DimOECDStatistic[Metric]),
SUM ( [MaxOfPeers]),

Blank ()

)

PERFORMANCEPOINT SERVICES (PPS) SCORECARD:
TRAFFIC LIGHTS

In this section, you are going to create a scorecard using the standard
PerformancePoint indicator images for the KPIs. The data source you will be
using is from the Organization for Economic Development.

Start by setting up the data connection and mapping the date dimension as
described in Chapter 7. You are connecting to the OECD_Data tabular mode
cube.

To make the connection, right-click the PerformancePoint content list and
choose New > KPI. Select Blank KPI in the screen that follows. You will see a
screen like the one shown in Figure 10-11.

You need to map the KPI metrics to data points because they default to a fixed
value. Click 1 (Fixed Values) under Data Mappings on the same line with the
title Actual to start editing. In the screen that displays, click Change Source
and then double-click the data connection you created. In Figure 10-12, the
data connection is called dsOECD.
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"f\ Untitled - Dashboard Designer = ox
2 Haome Edit Create @
=5 ¥ ocut | dpy TdAddlsts | 5F Properties X Delete | [ Compare ltem I
4
| g
23 Co Remove Permissions 7 validate Ttem
paste = P g W ® & Tnport
Eems (2 Refresh | = pename {3 Mark Differences | Ttems
Cliphoard workspace Item Changes Import
Workspare Browser « itor Praperties ‘ Details »
Untitled Workspace Related Scorecards 2
a ; New KPI 2
= 3] Data Connections ~ Name 4 PersonR...
|| dsoECD Actual and Targets F3
= E’fﬂ’ma"“EFﬂ'”t Content 133 New Actusl (3 Hew Target | X Delete Selected Metrics £ Compare
2| Mewkp1z
Niarme, | compareTo | Mumber | indicstors | Data Mappings | Calculation Iﬁ
Actual (Defaul) 1 (Fixed valu...  Defalk
> Actual =] ©efauty @ @ 1 (Fixed valu..  Default =
Reelated Data Sources S
Thresholds 2 | | Name 4 PersonR..,
Set Scoring Pattern and Indicator.
Bect L20%
Threshold 2 100% @ [ w0
Threshold 1 50 [f[100.00% ko >
[ = Related Ingicators P
Warst 0% & [ =0.00 [
Name “ PersonF.,
Connected to: httpifmas-me&00]

FIGURE 10-11 Editing KPIs in Dashboard Designer

Select a Data Source [

SharePoirt Site  Workspace |Ca|cu|ated Metric |

E;, Toggle View | Expand &l 1= Collapse Al

Person
Responsible

Mame | Type | Description

| Modified

‘ Modified By |

U Fixed Yalues

-] =3l Data Connection: Libirar

=T et BT Foer

L_] Actual

U Target

Ok Cancel

FIGURE 10-12 The Select a Data Source dialog

Choose MetricValueAvg in the Select a Measure drop-down

field, as shown

in Figure 10-13, then click OK to close the window. Click the (Default) link

underneath Number Format and then choose Number. Click

www.it-ebooks.info
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To finish setting up the Actual, click
the Default link under Calculation,
choose Average of Children, and
then click OK.

Be careful using the
Average of Children
rollup. It may lead

to a miscalculation
when you're doing
averages of averages. Now, map the Target metric in
exactly the same manner, but use
MetricValueMax for the measure and
Max of Children for the calculation.
Your screen should look like the one

shown in Figure 10-14.

Dimensional Data Source Mapping | 5[
Select a measure:
IMetri:Va\ueAvg j
Select a dmension:
Laf” Mew Dimension Fiker G Mew Time Intelligencs Fiter | <
[ ] mame | Defaul
Aggregate members by:
IDaFau\t j

r Use MD¥ tuple Formula

Change Source... | O I

Cancel |

4

Finish by naming your KPI Metric
Value and then saving it by right-
clicking on the KPI and clicking save.

| | Mame 4 | Eomnare ‘ Mumber Farmat | Indicators | [rata Mappings

FIGURE 10-13 Selecting a data source

| Calculation

1,234,568

actual v | B

Actual
P | Target

FIGURE 10-14 A fully setup indicator

Metricvaluafyg (dsOECD)
" (\) @ MetricvalueMax (dsOECD)

fverage of children

Max: of children

It's now time to create a scorecard: Right-click the PerformancePoint content
list and choose New > Scorecard. Choose a Blank Scorecard from the Standard
Scorecards category. Drag the KPI from the Details tab onto the left-hand
column labeled Drag KPI Items Here. Click the Update button on the Edit tab
of the Ribbon, and the scorecard displays as shown in Figure 10-15.

In the example in Figure 10-15, no values show because of the rollup up we
chose; as there are no children, and neither average nor max will work. Drag
the Regions hierarchy onto the Metric Value KPI so that the tooltip shows Last
Child, as shown in Figure 10-16. Release the mouse button.

Right-click the All member select Autoselect Members > Select Children, and
then click OK. Click the Update button in the Edit tab to see the result.

The current result showing on the scorecard is meaningless because it is a
rollup of all the indicators for all time. You are going to fix this by adding
two filters for year and statistic. Begin by renaming the scorecard as Metric

Scorecard and then saving it.
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|H @9~ 3 t) Unkitied - Dashboard Designer = X

4 Home Edit Create 7]

5 cut = i Addlists | [SF Properties X Delete 1) compare Item

o
o 5
-3 Copy i Remove Permissions [Z walidate Item
Paste Add @ Import
Trems L5 Refresh [=]i Rename @ Mark Differences | Ttems
Clipboard ‘Workspace Ttem Changes Impart
WWarkspace Brawser « itor Properties | Dietails »

@ Unkitled Workspace = = EE KPIs
(€]
= 53] Data Connections e NEW Scorecard B .E PerformancePoint Content
u dsOECD |:| Metric Yalug

= _j] PerformancePaint Content actual T Il E Metrics
|j Metric Yalue .iél Aggregations
= Metric Yalue -
ﬂ [ew Scorecard Ta.@] Dimensions
ﬁﬂ Propetties

jﬁl Marned Sets
aﬂ Set Formulas

Data Source

|dsoEcD |

»

Connected to: http:fimgs-m&s00)

FIGURE 10-15 Adding a metric to a scorecard

itar Propetties ‘ Details »

=] E DimCountry ;I

5 Active

(«) New Scorecard

CountryCode
CountryMame

. CountrySourcekey
Metric Yalue CreateDate
Developed
GEC IO

GEQ Reqgion
GEO Subregion
150 2 Code

Actual Target
150 3 Code
LoadDate

Regions
o
2 Soversign
UN Code 2
< | »
Diaka Source *
[dsceco =l

FIGURE 10-16 Adding a dimension to a scorecard

i 095 B90 000 020 00O OO DIO OO0 05O 00 D8O O30
845 565 545 9aC 569 Ba7 940 SaS 845 55° 54T %A

B
525 B B,
232 232 B

Right-click the PerformancePoint content list and choose New > Filter >
Member Selection. Select the dsOECD data connection you created earlier
by double-clicking it, and then click Select Dimension on screen that dis-
plays. Select the DimOECDStatistic.Statistics dimension hierarchy. Click Select
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Members right-click All, and then choose Autoselect Members > Select All
Descendants, as shown in Figure 10-17.

i

Select Members
Right click any member to view additional selection options.

E DimOECDStatistic, Statistics

[0 @ Default Member (all
H ) m

Set as Default Selection
- Aukoselect Members 3 | gg Select Children
L, select visible L Select Leaves
3 =]
33{ Zalact Childran |gxg Select Al Descendants
1 s
L3 Clear Vishls Select "Subject”
o2 Clear all Select "Category”
T SCIETICE S TECTnoig
Select "Area”
Select "Metric”

Selected items: 0 Cancel |

4

FIGURE 10-17 Using auto-select to allow for data changes

Leave the Default member selection blank and click Next. Choose Tree on the
next screen. Name the filter Statistic and save it.

Repeat this process for DimDate.Year, using the member selection filter again,
but only select the years 2000, 2005, 2008, 2009, 2010, and 2011 (which are
the years we have data for). Name the filter Year and save it.

Finish by creating a new dashboard (right-click the PerformancePoint content
list and select New > Dashboard). Select 2 Rows and click OK.

Statitic: Total primary energy supply per capita ~ vear: 2010 ~ Drag the filters to the top row and then drag the score-
Metric Scorecard card to the bottom row. Connect them as described in
Actel] e mTarger Chapter 7 in the “Filters” section.
= Metric Value 3 17 0 -84%
 Africa (@]

Rename your dashboard as OECD Statistics, right-click

& Asia + Pacific 5 6 (0 -19% . . .

it, and deploy it to SharePoint. You should have a dash-
i Europe 4 17 @ -73%
Lot Amerca + Carbbean 2 2 () 7% board similar to the one shown in Figure 10-18. Not all
i North America s 8 @o% data points have data for all years in this data set, so
k Polar <& you may need to work through a few.
[ West Asia O

FIGURE 10-18 A basic scorecard with filters
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MDX FUNCTIONS FOR COMPARING AN ITEM WITH ITS PEERS

Note that this method of comparing the average of children to the maxi-
mum of children is a particular method of banding generally used to indi-
cate inequality in a region. It is typically used in conjunction with a custom
MDX formula to pull the average from the current level to compare an item
with its peers. In MDX (Multidimensional Expressions), the formula to put
in the target would look like the following:

MAX( [DimCountry].[Regions].CurrentMember.Parent.Children ,
[Measures] . [MetricValue] )

As this would show a Target even for those members without data, you
may want to wrap it in a statement like so:

IIF( [Measures].[MetricValue] = NULL, NULL,

MAX( [DimCountry].[Regions] .CurrentMember.Parent.Children |,

[Measures] . [Metricvalue] )

)
The equivalent function to do a rank would be like the following:

IIF( [Measures].[MetricValue] = NULL, NULL,

RANK ( [DimCountry] . [Regions] .CurrentMember,

ORDER ( [DimCountry].[Regions].CurrentMember.Parent.Children ,
[Measures]. [MetricValue] ) )

)

CUSTOM INDICATORS IN PERFORMANCEPOINT

Custom indicators are relatively easy in PerformancePoint. For this example,
you are going to use them to create conditional formatting, but you could as
easily add your own images.

Working on the workspace created in the previous example, right-click the
PerformancePoint content list and choose New > Indicator. Choose Blank
Indicator and then click OK. Leave the defaults of Standard and 3 levels, and

click Finish.
\'(ou change the image by double-clicking the red- 7 [ Trefaior
Ilned bOX, or Change the baCkground COIOr by dOUble Lewvel | pisplay Mame | Image | Text Color | Backaround Color |
clicking. For Level 1 (Worst) click background color, || Mo Data to Data

. Level 1 (waorst)  OFf Target IZ Z .
choose Red from the standard colors, and then click = Levelz Sightly OFF Target ] 7z O
OK. Set Level 2 as Yellow, and set Level 3 (Best) as ¥ [Level3(Best) On Target U U s
Green. Your indicator setup screen should look like FIGURE 10-19 Conditional formatting on an indicator
Figure 10-19.
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The other banding
methods are used
less often. You use
Band by Numeric
Value of Actual
when your actuals
can only be certain
values, and you use
Band by Stated Score
when using Analysis
Services KPIs. The
Worst Value setting
is also used very sel-
domly; for most use

Name your indicator ConditionalFormatting and save it. Now, go back to
your KPI, click the Target, and click Set Scoring Pattern and Indicator. Leave
the defaults as they are and click Next.

Click the Workspace tab and choose the indicator you just created, as shown
in Figure 10-20. Click Next and then click Finish.

Edit Banding Settings x|
Select an Indicator
L2 Select the indicator bo use for the target,

Select the scaring pattern ShareFrint St Workspacs: | avaiable Indicators |

[ sdedtanindiator = =

cases With inCI’eaSing Spechy the warst valie ke, Toggle View |E Expand Al += Collapse Al |

indicators' 0 iS the | Mame | Images | Description
optimal value fOI' thiS =] j PerformancePoint Content
setting.
< Previous | Mext > I Finish Cancel
FIGURE 10-20 Selecting an indicator
x| Save your KPI and go to your scorecard. By default

% Indicator

the scorecard doesn’t use KPIs’ conditional formatting

Scaring Show

Variance R mage

I Text color

[T Status display name
I Backaround color

settings, so right-click any cell below the Target and
choose Metric Settings. Click the Indicator tab and
select the background color check box, as shown in
Figure 10-21.

Position
& Center
0 Left

£ Right

Click OK to see your scorecard. Notice that most values
are red. The empty values are black because you didn't
choose a color.

You are going to hide those values, so right-click again
and choose View Settings. Select to the Filter tab select

Preview

the Filter Empty Rows check box, and then click OK.

= - The rows that are hidden still show on the scorecard in

design mode, but they are highlighted in red to show

FIGURE 10-21 Formatting a scorecard
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that they will be hidden when the scorecard is deployed on a dashboard. Save

your scorecard, go back to your deployed dashboard, and refresh it to see a s e

similar dashboard to the one in Figure 10-22. using conditional
formatting, you will

remove the actual
Statistic:  Total primary energy supply per capita ™ Year: 2010 7 column and replace

the variance with the

Metric S rd N
stric Scorecal actual value. This is

Actual  Target a good way to save
= Metric Value R alot of space—by
@ Asia + Pacfic 56 9% showing only a single
1+ Europe 4 - column, removing
@ Latin America + Caribbean 2 | 2 7% the variance, and
(2 North America 8 8 % using color instead of
an indicator.

FIGURE 10-22 A scorecard with conditional formatting

SUMMARY

In this chapter you learned the basic principles of using scorecards, and you
worked through the practical implementations in both PerformancePoint
and Excel. Scorecards are one of the most prevalent forms of business intel-
ligence deployed today, and knowing how to build them is an essential part
of your toolbox.
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CHAPTER 11

Timelines

Providing an understanding how values change over time is one of the most
fundamental functions of visualization, and the presentation of this type of
information has evolved significantly since it was invented. Timeline visual-
izations serve as an aid to comprehension, allowing you to extrapolate and
predict a trend. For example, if sales are consistently increasing by $100,000
per month over the last three monthes, it is easy for the human eye to imagine
an increase over the upcoming months. Similarly, seasonality, such as the sales
increases in the retail sector for the Christmas shopping season, becomes easy
to see as a chart line rises and falls. Trends can be built into the charts as well
as trendlines. Care must be taken when using trendlines to ensure that the
user of the chart is kept aware of the fact that trends are derivations based
on the data rather than actual measured values. Statistical predictions are
another way of creating trendlines.

HISTORICAL USE OF TEMPORAL ANALYSIS

The earliest examples of timeline visualizations were in the mid-17th century,
when Joseph Priestly created a timeline to compare the lifespan of various
people, as illustrated in the “Timelines” section later in this chapter, and the
convention of time being shown as running left to right, used to match
the direction in which the names on the timeline have been read is one
that we continue to use for visualizations. William Playfair, who you read
about in Chapter 2, extended this usage by creating bar, column, and line
charts to show changes over time. Although both bar and column charts
are often used purely for comparison, their original use was to allow com-
parisons over time, or to show a progression over time.
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Similarly, visualizing multiple trends over time creates a visual cue to related
trends or contra-related trends. Seeing a correlation between an increase in
profits related to a decrease in customer satisfaction might indicate a cost-
saving measure that has affected product quality, and visualizations showing
these changes over time aid in sparking that intuitive leap.

Traditionally, temporal analysis has been used by historians and in the medical
field to track the progress of diseases both in individuals and in the popula-
tion at large. In business, the biggest users of timelines have been in sales and
finance departments where they track sales and profitability against costs.

TYPES OF TEMPORAL ANALYSIS
VISUALIZATION

How you illustrate a change over time is primarily dependent on whether you
have to do so in a static manner or whether you can create an animated visu-
alization. Many early examples of showing a time change in the film industry
used an animation of calendar pages being torn off a calendar, which is a great
example of illustrating the passage of time, but it doesn’t show any other data
points. To show data points against the passage of time on a static medium
(such as a printed chart, or indeed in a chart on a computer screen), one of
the dimensions of the chart needs to be chosen to represent the passage of
time. The convention is that this is done left to right. There are certain types
of visualizations that use top to bottom (or even bottom to top); if you use
one of these formats then include an indicator that helps the reader of the
chart know that you have used an unconventional format.

Charts that use the horizontal axis to show position in time use the vertical
axis to show the value of a data point. A data point can be represented as a
point, a column, a line, or a bar.

The other ways of showing changes over time are animation and tiling—i.e.,
repeating a chart over a time axis. The following list introduces each of the
chart types described later in this chapter:

A timeline is the earliest form of temporal chart. It shows a change over
time, generally from left to right, but sometimes also from top to bottom.
The length of the line indicates the amount of time, as well as the start
and end dates.
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Types of Temporal Analysis Visualization

A line chart traces a value continuously over time, but unlike a timeline, it
varies its position vertically. Choosing between a line chart and the other
charts is easy; if the values can be interpolated over time, such as arise in
temperature throughout a day, then a line chart is appropriate. If values
cannot be interpolated—for example the chart is showing the seven days
of the week, and the data has sales for only three of those days—connect-
ing those points is inappropriate and misleading.

A bar chart, with bars positioned vertically above each other, is a useful
tool for showing discrete values that start and end at different dates. In
the case of a bar chart, positioning on the vertical axis is a point in a series
rather than an additive value. Graphically, a bar chart resembles a timeline
in that it has a graphical element stretching between two points. If these
points are on an axis of dates, the bar chart is a timeline.

A column chart, in which columns are positioned horizontally next to each
other, is useful for showing values where the addition of the individual
values would be meaningful. An example is a chart for sales value, with
each column representing the value of sales for a given time period, such
as a financial month.

A combined chart combines column and line charts, typically for showing
percentages or trends.

A pointor scatter plot is useful for discrete values in which the addition, or
“summing,” of the individual values would make little sense. This type of
chartis often used in scientific research or for the results of opinion polls.
Additional data can be added to a chart of this type by changing the size
of the point; this is called a bubble chart. (Bubble charts are the most com-
monly animated chart type, as showing a bubble growing and shrinking
over time illustrates the changes over time very effectively—temporal
analysis is one of the places where animation works well).

Tiling—repeating the same chart, either horizontally or vertically, with
each repetition showing a different point in time—is a way of increasing
the available dimensions to show other values. Because both x- and y-axes
are now available for non-time dimensions, the information available in
a single chart increases at the expense of screen space and the size of
each individual chart.

Animations are the latest addition to temporal analysis. Showing changes
in time by animating is an easy way to add an extra dimension to analy-
sis without consuming additional space. Most typically combined with
scatter plots, other ways of showing changes over time are also possible.
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The following sections examine these visualizations in more depth and also
describe how you can combine the different visualizations to better present

your data.

TIMELINES

Joseph Priestly’s timeline of lifespan shown in Figure 11-1, is the earliest example
of this form of chart, and it shows many of the key features that we still use
today. Note the labeled timeline—running from 600 BC to 0 AD. The length
of the line between the birthdate and the date of death of each man shown
on the chart offers an easy way to see the lifespan of each.
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FIGURE 11-1 An early timeline chart created by Joseph Priestly

A timeline has a graphic—a bar or a line—to show the start and end dates of
an event or series of events. Timelines are useful in instances where you do not
need to show a metric but rather a sequence of events, using the length of the
line to delineate the length of time that has passed and showing qualitative
metrics. Sometimes the qualitative metrics can include great detail, especially
in an interactive version of the timeline is available where detailed write-ups
of the event can be expanded.

Timelines are visually very similar to both bar charts and Gantt charts. Which
chart is used depends on the context. Timelines are used primarily where no
other data points are being shown, and qualitative data, such as the names of
people or battles, need to be highlighted. Bar charts are used where additional
data need to be shown, for instance using the color of the bar to distinguish
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between different processes. Gantt charts are used to display dependencies
in the process on the timeline.

FIGURE 11-2 Another great example of the timeline is at the Impe-
rial War Museum in London, in the bunker—this timeline runs from
bottom to top, and interactively allows one to drill down into greater
detail of events.

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel No ‘
PerformancePoint No

Reporting Services No

®
Power View No .
®

Silverlight/HTML5 N/A

LINE CHARTS

Line charts are a very simple way of showing a value by positioning data points
on the vertical axis and drawing a line through the various points. If you plot
different data points this way, the various lines are called series. The relative
positioning of these lines enables you to easily make additional comparisons,
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as shown in Figure 11-3. This early example of a line chart by William Playfair
shows a classic use of a line chart—comparing imports and exports over time,
with the area of the chart between the lines being an important additional
data point. Because the imports are additive over time, the overall area enables
you to compare whether for the period as a whole, England has imported or
exported more goods.
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Prbiishad s the et dibects, 149 Mgw 108 by TS awnalpt 358, Serand, Eandios .
FIGURE 11-3 An example of an early line chart by William Playfair

Line charts are one of the most used and most useful chart types. They are
present in almost every reporting tool, and they are used almost exclusively
for showing changes over time. You must take care not to casually interpolate
data between data points if the chart data is not contiguous. As an example,
let's consider a store that trades Monday to Saturday, and is closed on Sundays.
If a chart for the month included Sundays on the axis, it would be misleading
to draw a line from the sales value on Saturday to the sales value on Monday
via Sunday, because the chart would then show a sales value for a day that
the store was closed.

The area chart version of the line chart simply shades in the gaps between
various lines on the chart. However, note that many of the challenges inherent
in attempting to judge area are present in this type of chart.
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EASE OF DEVELOPMENT

REPORTING TOOL PREDEFINED CHARTTYPE  EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes .
Power View Yes .
Reporting Services Yes .
Silverlight/HTML5 N/A .
BAR AND COLUMN CHARTS

Bar and column charts, as shown in Figure 11-4, are simply two versions of the
same chart rotated 90 degrees. In a column chart the date is on the bottom
axis. The additional series on the bar chart replaces the value used for the
height on the column chart. However, the two charts are used very differently
when it comes to temporal analysis. A bar chart uses the length of the bar
to show a start and end date, with the position of the bar being the discrete
item, whereas a column chart uses the length of the column to show a value.
For temporal analysis, the date always runs from left to right. Some additional
work is required in all the Microsoft tools to show the bar chart in the cor-
rect manner, as it has really been implemented as a column chart rotated 90
degrees. Figure 11-4 shows an example.

Ai seress H There are many addi-
as i tional ways of add-

3 Seriesa ing data to bar and
- 1 column charts, such
s series3 as using stacks and

1 ] groups. These meth-
03 seres2 | ods are discussed in

o

\0\\“” \QN\& \@\Q &\@ &\0\ N Chapter 12.

A B ,\’Q@ '\90 '19@ 2000 2002 2004 2006 2008 2010 2012 2014

FIGURE 11-4 Bar and column charts are often confused, but the distinction is simple. Bars run from
left to right, and columns from bottom to top.

Both types of charts rely on the human eye being able to follow a straight

line and make comparisons. It is always a good idea to add background lines
to aid this process.
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Ease of Development

REPORTING TOOL PREDEFINED CHARTTYPE  EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes .
Power View Yes .
Reporting Services Yes .
Silverlight/HTML5 N/A .
COMBINED CHARTING

Using a line chart in combination with a column chart is one of the most pow-
erful visualization techniques because it can be used either to show additional
or derived data points, such as profit margin as a percentage against sales
value or profit value, or it can be used to show a trend, such as a three-month
moving average. Choice of color in this combined form is very important; if
you have used multiple series that are differentiated by color, making sure
that the line and the chart for matched series have similar colors is essential.
Using different shades of the same color ensures that contrast is maintained
between the line and the chart while still keeping the relationship clear. An
example of using different shades of red and blue to match Sales Amount and
Gross Profit to their moving averages is shown in Figure 11-5.

Sales Amount  Gross Profit

56 000 000.00

$5 000 000.00

54 000 000.00

$3 000 000.00

$2.000000.00 - Values
[ Sales Amount

$1000000.00 - BN Gross Profit

Moving Average

50.00

Moving Average

April 2007
May 2007
June 2007
July 2007

January 2007
February 2007
March 2007
August 2007
September 2007
October 2007
Movember 2007
December 2007

Q1 CyY 2007 Q2 CY 2007 Q3 CY 2007

Q4 CY 2007

Date.Calendar =7

FIGURE 11-5 Using matched colors to show relationships between series
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Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes .
Power View No .
Reporting Services Yes .
Silverlight/HTML5 N/A .

SCATTER PLOTS AND BUBBLE CHARTS

A scatter plot is a chart of points, graphed on an x and y (horizontal and verti-
cal) axis. For static temporal analysis, the horizontal axis will be always be the
time period of the chart.

A bubble chart is a refinement of the scatter plot. The horizontal position is
still time, but in addition to using position on the vertical axis to represent a
data point, the size of the bubble, its color, and, in some tools, its shape can
be used to represent data points.

Bubble charts have been used with great effect as animated tools. Rather than
showing time on the horizontal axis, another data point can be represented
on the horizontal axis, and the changes over time are shown by changing the
various values. The animation draws attention, as the bubbles grow or shrink,
and move around on the plot. However, it is vital that the animation can be
paused, and that the position on the timeline is shown, as shown in Figure 11-6.

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes ‘
Power View No .
Reporting Services Yes .
Silverlight/HTML5 N/A ‘
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L

15

1M

FIGURE 11-6 A PowervView bubble chart

TILING

Tiles are a series of similar charts, typically with one background filter applied
to the charts in a series. In the context of temporal analysis, the background
filter would be a discrete set of points in time, for example years or months.
This is a technique that can be applied in Reporting Services with some
amount of ease, by embedding a chart in a matrix, and PerformancePoint
has the capability of doing this specifically for pie charts (the only possible
advantage of having pie charts in PerformancePoint). However, the tool that
truly shines with tiling is Power View, in which you simply drag a value to the
Tile field to yield an exceptionally powerful visualization. The drawbacks of
tiling are, of course, that much more screen real estate is needed when charts

lan 3005
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L
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2000 =00 000 3500 &0 200
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are repeated, and thus the charts themselves often end up smaller.
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Types of Temporal Analysis Visualization

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel No .
PerformancePoint No
Power View Yes .
Reporting Services No .
Silverlight/HTML5 N/A .
ANIMATION

Animation in cinematic effects, for instance time-lapse filming, has always been
an exceptional way to show how things change over time. Animation has only
recently been used to good effect in the visualization field.

Many business intelligence (Bl) tools have used animation to show transitions;
it's a nice visual effect, but it doesn’t add any value or informational content.
Instead, using animation to show changes over time is an effective use of
the tool. There are several different ways of showing changes over time. The
most popular and information-dense method is in a scatter or bubble plot,
in which the x- and y-axes, the bubble size, and the bubble color can be used
to show dimension values or metrics. A visualization with these criteria is five-
dimensional (x-axis, y-axis, the size of the bubble, the color of the bubble, and
the animated changes)—very informationally dense.

A further enhancement is to combine tiling and animation, which allows for
a better use of screen real estate. When you combine tiling and animation,
you only show a few tiles and move them along to illustrate the change over
time. You will see how to do this in the section “A Data-Driven Timeline Using
Reporting Services” later in this chapter.

Ease of Development

REPORTING TOOL PREDEFINED CHARTTYPE  EASE OF DEVELOPMENT
Excel No .
PerformancePoint No .
Power View Yes .
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REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Reporting Services No .
Silverlight/HTML5 N/A .

TOOL CHOICES, WITH EXAMPLES

Temporal analysis is one place where all the Microsoft tools have strengths.
However, PerformancePoint is the most limited, and Power View's sole out-
standing feature is animation.

PERFORMANCEPOINT SERVICES (PPS)

PerformancePoint supports column and line charts. When numeric values are
combined with percentages, PerformancePoint automatically sets the chart
type to a combined chart. Scatter plots, timelines, and animations are not
supported at all.

The lack of a capability to combine line and column charts gratuitously is a
serious hindrance, but PerformancePoint has another strength in temporal
analysis in its internal awareness of the current date, and the ability to apply a
formula to the date. The language used for this is called STP, short for Simple
Time Protocol. After you have mapped a time dimension, STP allows for the
addressing of dates. These will each be implemented either as connection
formula or as formulas in a time intelligence filter.

Table 11-1 includes example formulae.

TABLE 11-1 STP Examples

TO DISPLAY FORMULA RESULT

Yesterday day-1 The previous day relative to the cur-
rent date.

Tomorrow day+1 The next day relative to the current
date.

The current quar- quarter, day A set of time periods consisting of

ter and today the current day and current quarter.

Last 10 days day:day-9 A 10-day range including today.

Last 10 days day-1:day-10 A 10-day range NOT including today.

(excluding today)
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TO DISPLAY

Same day last
year

Same month last
year

Same range of
a period of six
months last year

Same range of
months to date
for last year

Year to date

Year to date (by
month)

Year to date (by
day)

Parallel year to
date

FORMULA

(year-1) .day

(year-1) .month

year-1) .
month-5) :
vear-1).
month)

(year-1).
firstmonth:
(year-1) .month

yeartodate

yeartodate.
fullmonth

yeartodate.
fullday

yeartodate-1

TIMELINES

Tool Choices, with Examples

RESULT

Current date (month and day) for
last year. For example, if the current
date were December 10, 2010, then
(year-1) .day would show informa-
tion for December 10, 2009.

Current month for last year. For
example, if the current month were
December, 2010, then (year-1)
.month would show information for
December, 2009.

From 18 months ago to one year
ago. For example, if the current
month were December 2010, then
(year-1) . (month-5): (year-1)
.month would show information for
the time period ranging from June
2009 to December 2009.

From the first month of last year up
to and including the month parallel
to the current month this year.

A single time period representing
the aggregation of values from the
beginning of the year up to and
including the last completed period.
The period corresponds to the most
specific time period defined for the
data source.

A single time period representing
the aggregation of values from the
beginning of the year up to and
including the last completed month.

A single time period representing
the aggregation of values from the
beginning of the year up to and
including the last completed day.

The aggregation of the same set of
default time periods completed in
the current year except for the prior
year.

Although all the examples in Table 11-1 are lowercase, STP is not case sensitive,
and you may find that casing the formula elements makes them easier to read.
For instance, instead of year, put Year, and use FirstMonth instead of firstmonth.
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Examples of PerformancePoint column, line, and combined charts are included
in Figures 11-7, 11-8, and 11-9.

Store Comparison ~
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FIGURE 11-7 A PerfomancePoint stacked chart showing a snapshot
Sales chart -
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3.0M
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FIGURE 11-8 A PerformancePoint line chart
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200K 10%
0K 0%
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FIGURE 11-9 A PerformancePoint combined chart
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The combination of a Time Intelligence filter using STP formulae and a com-
bined line and column chart is very powerful. In Figures 11-10 and 11-11 you
can see how selecting a time period in the drop-down enables you to change
the connected graph

Time: ILast 6 Years -I

SALESLINEGRAPHAVG

1,000K

BOOK

600K

400K

200K

oK

50%
40%

30%

20%
J -
| S "

2006 2007 2008 2009 2010 2011 2012

FIGURE 11-10 A PerformancePoint chart filtered by an STP formula

Time: ILast 12 Months -I

SALESLINEGRAPHAVG

120K
100K
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il s &
Tk NNHEL il

2011 Decem... 2012 Februa.. 2012 April 2012 June 2012 August 2012 October 2012 Decem...

2012 January 2012 March 2012 May 2012 July 2012 Septem.. 2012 Novem

[l TergetAva Monthly Sales
[l 2vaMonthlySales
Target GM Percentage

GMPercentage

35%
30%
25%
20%
15%
10%
5%

0%

FIGURE 11-11 The same PerformancePoint chart filtered by a different formula

SQL SERVER REPORTING SERVICES (SSRS)

[l TargetAvgMonthly 5

[l AvgManthlySales
Target GM Percentags
GMPercentage

SQL Server Reporting Services (SSRS) enables you to have finely detailed control
over the individual elements in the charts being displayed. SSRS supports line
charts, column charts, combined line and column charts, bar charts, scatter
plots, and—with a bit of ingenuity—timelines. The only visualization missing
is the animation component.

Examples of SSRS column, line, and combined charts are shown in Figures
11-12, 11-13, and 11-14.
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FIGURE 11-12 A column chart in Reporting Services
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FIGURE 11-13 Aline chart in Reporting Services
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FIGURE 11-14 A combined chart in Reporting Services
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There are some issues with the default representation shown in Figure 11-14:
notably that the gaps in the dates have been skipped, and the data set looks

continuous when it is in fact not. This is a feature of SSRS to watch

for.

SSRS supports scatter plots natively, as illustrated in Figure 11-15. The default
is to use different shapes for the markers, which is a nonstandard way of treat-
ing scatter plots. Some work with expressions is required to show the labels

on the data points themselves.

Average Hours worked vs Unemployment
10 ]
A .
A
8 * &
+
+
H L] .
fo , -
2 . x
i *
:E; n
2
0
1,488 1,588 1,688 1,788 1,888
Average hours worked

® CrechRepublic

Australl

Finlend
France
Ieeland
Isroel

Italy
Luxembourg
New Zealand
Swtzerland

FIGURE 11-15 A scatter chart in Reporting Services

A traditional bar chart is shown in Figure 11-16, and the slight modification to

the chart to show as a timeline is shown in Figure 11-17.

‘GDP Per Capita

W vetric Value

South Africa

Country

Canada

$0 $50,000 $100,000 $150,000 $200,000 $250.000
GDP Per Capita

FIGURE 11-16 A bar chart in Reporting Services

Data Collection Period

BN Date Number
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Date

Country

FIGURE 11-17 ATimeline in Reporting Services
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EXCEL

Excel’s repertoire of line, column and scatter charts is very similar to SSRS when
it comes to temporal charts. Although the timeline capabilities are missing,
Excel has a very important addition known as trendlines, which are statistical
extrapolations of the trend of the chart series to date.

Examples of Excel column, line, and combined charts are shown in Figures
11-18, 11-19, and 11-20.

Reservevalue

520000 000
$18000 000
516000 000
514000 000
512000 000
$10000 000 ™MD
SE000 000
$6000 000 0L
54000 000 2012
52000 000 .
. i = e —
Australia + New North East Asia South Asia South East Asia
Zealand
Africa Asia + Pacific Europe
Regions -Y

FIGURE 11-18 An Excel column graph
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$1000 Lstin America +Carbbean

$500 = North America
5
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FIGURE 11-19 An Excel line graph
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FIGURE 11-20 An Excel combined graph
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x

Czech Republic
Estonia
France

Germany

The setup screen for the trendline is shown in Figure 11-21, and the resultant
chart is shown in Figure 22.

Trendlines can be calculated by various methods:

Exponential: Showing a curved ling, this trendline is useful
when data values rise or fall at constantly increasing rates.

Linear: Use this type of trendline to create a best-fit straight
line for simple linear data sets. A linear trendline usually shows
that something is increasing or decreasing at a steady rate.

Logarithmic: A best-fit curved line, this trendline is useful
when the rate of change in the data increases or decreases
quickly and then levels out.

Polynomial: This trendline is useful when your data fluctuates
as happens, for example, when you analyze gains and losses
over a large data set.

Power: Showing a curved line, this trendline is useful for data
sets that compare measurements that increase at a specific
rate.

Moving average: This trendline evens out fluctuations in
data to show a pattern or trend more clearly. A moving aver-
age uses a specific number of data points (set by the Period
option), averages them, and uses the average value as a point
in the line
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FIGURE 11-22 A column chart with trendlines

You have to add each trendline individually by right-clicking the series and
choosing Add Trendline.

POWER VIEW

Power View has been designed for an interactive experience, and this truly
makes it powerful for showing changes over time. The standard options for
column, line, and bar graphs are all available in Power View. In addition, Power
View enables both tiling and animation over time—truly a broad reach of
visualization. The counterpoint to this, which is similar to PerformancePoint, is
that there are limited customization options. Indeed, in terms of customizing
how different components interact with each other, Power View has even
fewer options than PerformancePoint.

In Figure 11-23, you can see a combination of bar, column, and line charts that
are being filtered by a single slicer. The time required to build a visualization
like this is much less than PerformancePoint, SSRS, or even Excel, as the con-
nections are all built behind the scene.
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FIGURE 11-23 A Power View analysis page

You experience the power of Power View (forgive the pun!) when you apply the
newer features. For one thing, tiling (@automatically repeating the same graph
and filtering by a value, which is possible in SSRS, and is exceptionally hard
work in PerformancePoint and Excel) is performed simply by dragging the tiled
value into a box and having the tiles show up automatically. For a comparison
over a discrete set of time values—for instance, months of the year—tiling is
a great way to get a snapshot comparison, as shown in Figure 11-24.
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FIGURE 11-24 Power View tiled charts

Power View also has an animated scatter plot feature. This feature can’t be
used in combination with tiling, but is as easy to implement. Simply create
a scatter plot chart and drag your date field to the Play Axis. The Play Axis
is a slider along the bottom of the chart which can be used to set a point
in time, or animate over the data points. Figure 11-25 shows a basic scatter
plot, and Figure 11-26 shows—as much as is possible in a static image—the
animation effects available. It is interesting to note how Power View shows
the track of a particular data series over time when it is clicked upon—a
very useful effect.
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FIGURE 11-25 A scatter plot with the animated Play Axis at the bottom
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FIGURE 11-26 A Play Axis tracing the positions and sizes of the bubbles
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IMPLEMENTATION EXAMPLES

The implementation examples in this section use the OECDPopulation
PowerPivot model available from this book’s web page (www.wiley.com/go/
visualintelligence), and called OECDPopulationStats.x1sx. Building the
model is covered briefly in the next section, but refer to Chapters 5 and 6 for
more details.

POWER VIEW ANIMATED SCATTER PLOT

Power View'’s best feature is the animated scatter plot. With a focus on inter-
action in general, the ability to drag a slider to animate changes in time (or
just let it play), this visualization is Power View’s raison d’etre. In this section
you learn how to implement it.

Building a Model to Support Power View

Please see Chapters 5 and 6 for an introduction to building a PowerPivot
workbook. This section requires at least Excel 2010 for the PowerPivot pieces,
and Excel 2013 for Power View.

Power View requires a PowerPivot (or tabular) model to support the anima-
tion. You will need to set up a date table to allow the animations to work
correctly. Create a connection to the VI_UNData database, and make sure you
have imported the DimDate view, and the DimCountry, DimOECDStatistic,
FactOECDNationalReserve, and FactOECDPopulation tables. Note that the
DimDate view is near the bottom, and don’t choose the DimDate table. Your
sheet should look similar to Figure 11-27.

You need to set up the relationships to the DimDate view by first clicking the
diagram button in the bottom right, and then creating relationships from the
two fact tables to the DimDate, using DimDatelD. You need to click on the
DimDatelD field on the fact table, and dragging it onto the DatelD field on
DimDate. Your diagram should look like Figure 11-28.

Right-click DimDate, and choose Go To which will take you to the table
designer. In the Ribbon at the top, choose the Design tab and click the Mark
as Date Table button, as in Figure 11-29.
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FIGURE 11-27 Initial model setup
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FIGURE 11-28 The PowerPivot diagram designer
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Home Design Advanced
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FIGURE 11-29 Marking a table as a date table

Click OK in the next window. You need to fix up the sorting of the Month
names by selecting the Month name column, and clicking Sort by Column on
the Ribbon’s Home tab. Choose MonthNumber, as in Figure 11-30.

= ‘gg Data Type: Text * 4l wr 3 AutoSum + [
e (s 0 | TR |
=9 Format : Text = J Create KPI
Paste Get External Refresh  PivotTable 5 3.0 .00 s Clear All| Sort by Find
= Data~ - A % » T 3% Ze Filters |Column~ A\
Clipboard Formatting Sort and Filter Find Calculations
[Monthiame] v| |January
PYinvonth B3| DayOfvear E| WeekOfvear K| weekofMonth E| Mo J= = IMonthName [+]
1 Panuary
1 Panuary
= Select the column to be sorted and the column by which it is sorted (for example, sort the month
Ll name by the month number). Click the link below to learn how to sert by a column from a different 1 panuary
table. 1 Panuary
Sort By 1 Panuary
1 Panua
=i Column Column 3
1 pPanuary
— || [MorthName A Wl onth Humber v
1 Panuary
1 panuary
— | Howtosert Jurnn from o different table? oK
low to sort by @ column from a differe: e ncel |
lannans

FIGURE 11-30 Sort by columns

Repeat the process for MonthNameFull.

Next, you need to set the row identifier. The row identifier is similar to the
primary key in SQL Server, and is a number that uniquely identifies each row.
Start by enabling the advanced tab. This option is found under the file menu,
and is called Switch to Advanced Mode. Change to the Advanced tab, click
Table behavior, then select OECDPopulationID in the drop-down box for the
row identifier. Click the OK button.

Your final step is to create some measures that you are going to use in the
scatter plot. You need to create a measure for each dimension value you are
going to analyze. The three to analyze are Average Hours Actually Worked,
GDP per Capita, and GDP per Hour Worked.
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Create each of these on the FactOECDPopulation table, and use the follow-
ing formulae:

AvgHours : =CALCULATE (
AVERAGE (FactOECDPopulation[Value])
, DIimOECDStatistic[Metric] = "Average hours actually worked"

)

GDPPerHour : =CALCULATE (

AVERAGE (FactOECDPopulation[Value]l)

, DimOECDStatistic[Metric] = "GDP per hour worked"
)

GDPPerCapita:=CALCULATE (

AVERAGE (FactOECDPopulation[Value])
, DimOECDStatistic[Metric]
)

= "GDP per capita"

You will do this by right-clicking Add Column. Rename the column to
AvgHours. Paste the formula, starting with the equal sign, into the formula
bar making sure to keep all the text of the formula on one line.

Save your workbook. Now that you have a Power View model, you are
going to build out the animated scatter plot. Start by going back to Excel
and clicking Power View on the Insert tab. On the new sheet that is cre-
ated, drag GDPPerHour, AvgHours, and GDPPerCapita (in that order) from
FactOECDPopulation in the field choice tab on the right to the value box, as
shown in Figure 11-31.

Power View Fields x
scmve | aun

A DimCountry
[ Dimbiaste
3 DimOECDStatistic
[T FaclOECDNationalReserve
4[T] FactOFCDPopulation
E Adive
7| @ AvgHours
CreateDate
¥ DimCountryn

a8 175040 2805448

Drag fields between areas below:
TEBY

FIELDS
GDFFertiour -

AvgHours -
GDPPerCapita -

FIGURE 11-31 Dragging fields to the value box
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Power View Fields

ACTIVE ALL

4T DimDate
= Date
[7]= patep
[ 1= patesk
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[71x weekorvear
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TILE BY

X X VALUE
GDPPerHour
I Y VALUE
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pagaris
GDPPerCapita
DETAILS
GEO Region

COLOR

PLAY AXIS

=lDate

WERTICAL MULTIPLES

FIGURE 11-32 Power View

field choices

Change the chart type to a scatter plot (you do this in the Design tab,
under Other Chart). Resize the chart to fill the screen. Drag GeoRegion from
DimCountry to the Details box on the right side, and drag Date from DimDate
to the Play Axis box (see Figure 11-32).

The result is an animated scatter chart, which you can play; alternatively,
you can drag the slider to see data at a point in time. If you click a particular
data item, you see the history for that item. Figure 11-33 shows an animated
bubble chart.

2300
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1700 4

1600
15 20 25 30 35 10 a5 50
2000 2002 2004 2006 2008 2010

FIGURE 11-33 A Power View bubble chart

COMBINING LINES AND COLUMNS IN EXCEL

In this section, you are going to track the relationship of Gross Domestic
Product to population size over time. This example uses Excel 2013, which has
a combined chart type that makes this process easier, but in earlier versions
of Excel it is easy enough to simply change one of the chart series types to a
line chart to create a combination chart.

Switch to Sheet 1, then start by clicking the Pivot Chart button on the Insert
Ribbon, as shown in Figure 11-34.
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FIGURE 11-34 Excel Ribbon interface to add a pivot chart

Choose Existing Worksheet and Use an External Data
Source. Click Choose Connection, as shown in Figure 11-35.

The choice of a connection is a bit different between Excel
2013 and earlier versions. In the earlier versions, you select
PowerPivot as the data source, but in Excel 2013 you must
choose Tables and then select Tables in Workbook Data
Model, as shown in Figure 11-36.

(s o, )
Select a Connection or Table

Connections | Tables

This Workbook Data Model
Tables in Workbook Data Model
5 Table(s)

SglServer sql2012 VI_UNData
DimCountry
[Blank]

DimDate
[Blank]

DimOECDStatistic
[Blank]
FactOECDPopulation
[Blank]

FactUNData

[Blank]

I8 S I

FIGURE 11-36 Choosing a connection in Excel 2013
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At this point, you see an empty pivot chart on the left and the PivotChart
Fields pane is on the right, but you need to add the appropriate fields to the
chart. Start by adding the Value field from the FactOECDPopulation table
to the Values block, and Metric from DimOECDStatistics to the legend, and
YearName from DimDate to the Axis, as shown in Figure 11-37.

A E C D E F G H
1 . .
,  Sumofvalue PivotChart Fields M
3 | 14000000 ACTIVE ~ ALL
4 | 12000000 Metre T Ch fields to add t t: g
. - oose fields to add to report: -

5 10000000 [ IIHD:ED)(FDI Restrictiveness
6 = B UL DStatistic o
7 8000000 E] Statistics
8 6000000 = lZ5 More Fields
9 | 4000000 2010 FDI Restrictiveness Active
10 Index vs. 2009 FDI Stock Area

2000000
11 | | Category

N} I
12 o : | Metric e
2000 2005 2008 2009 2010 2011

13 | -2000000

Drag fields between areas below:
14| [YearName ~

15 Y FILTERS [ LEGEND [SERIES)
16

17
18
19
20
21
22
23
24
25
26
27

a0

Metric -

fiE AXIS (CATEG... |2 VALUES

YearMarme hd Sum of Value ~

FIGURE 11-37 An Excel pivot chart

At this point, the chart isn't showing anything meaningful for analysis, just a
selection of the metrics. Start narrowing down the selection by clicking Metrics
in the pivot chart and selecting Gross Domestic Product and Population Levels.
This restricts your data set to the values you want to compare. However, to
compare them you need to format them to show a line and a column, and
you need to set up secondary axes. In Excel 2010 and earlier, you do this by
changing the chart series type individually, but in Excel 2013 if you right-click
anywhere on the chart and select Change Chart Type, you are presented with
the new chart selector window, as shown in Figure 11-38.

Set the chart type to Combo, and select Secondary Axis for Population levels.
Click OK.
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Series Name Chart Type Secondary Axis
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FIGURE 11-38 Changing a pivot chart type

This chart is a great showcase of one of the biggest fallacies in temporal analy-
sis—points on the axis that have no data are hidden (for example Monday
being followed by Wednesday because Tuesday had no data), thus altering
the slope of the curve.

To fix this issue, you need to make several changes: Show the missing data
points, limit the chart to the relevant dates, and add a trendline to interpolate
the missing years.

To add the missing data points, right-click the chart area, and click PivotChart
Options. Choose the Display tab, select the Show Items with No Data on Axis
Fields option, and then click OK. All the years are now displayed, and you filter
them by clicking YearName and choosing the years 2000 through 2012. The
gross domestic product series is showing correctly as columns, but you need
to add markers for the line chart to show noncontiguous values. Right-click the
line and choose Format Data Series. If you're using Excel 2013, you should see
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Format Data Series X

SERIES OPTIONS ¥
SOl

~4LINE ' MARKER -
» MARKER OPTIONS
b FILL
4 BORDER
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Gradient line
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Color o~
Transparency 0%
Width 075pt 1
Compound type =-
Dash type mE

FIGURE 11-39 The Format
Data Series pane in Excel
2013

a pane like the one in Figure 11-39; in earlier versions of Excel, you see pop-up
window. Click the Paint icon, then choose Marker, and choose a series marker
in Marker options—the default Square and size 5 will work nicely—and show
the values of Population levels on the chart.

The final piece to this chart is showing interpolated values. This is where Excel
truly shines over the other tools. Right-click on the line chart, and click Add
Trendline—all the default values are fine (although you may want to play with
the forecast feature!). Click OK. You see the final chart shown in Figure 11-40.
You would, of course, finish off by formatting the axes appropriately.

Region *
Sum of Value
50000 4050000
45000
4000000
40000
35000 3950000
30000 .- 3500000 | Metric T
25000 e mmmm Gross domestic product
20000 3850000 === Population levels
2
Linear [Population levels)
15000 3800000
10000
3750000
5000
U] 3700000
2005 2006 007 2008 2009 2010 2011
wo ¥

FIGURE 11-40 An interpolated population chart

A DRILLABLE LINE CHART IN PPS

In PerformancePoint, set up a data connection as described in Chapter 7,
making sure to set up the time dimension correctly. You use the OECD_Data
model that you setup in Chapter 7, and create an analytic chart. Right-click
the library and click New > Report. Choose Analytic Chart and then choose
the data source you created. In the chart design screen, drag the YMD hier-
archy from DimDate into the Bottom Axis column. Drag ReserveValue from
Measures into the series. Finally, right-click the chart and select Report Type >
Line Chart with Markers.

To choose the appropriate data, click the All value on the bottom axis and
then right-click next to it so you can select Filter > Filter Empty Axis Items.
At this point, you see a chart such as the one in Figure 11-41.
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FIGURE 11-41 A PerformancePoint analytic chart

Once deployed, this chart is automatically drillable by clicking on the year to
drill down to the months. You can create additional time series by using time
intelligence filters. In order to make it interactive with the other components
of PerformancePoint you need to add other dimensions to the background.

A DATA-DRIVEN TIMELINE USING SSRS AND DATA BARS

SSRS can do all the visualizations that you have worked with so far this chapter
barring the animation, but it also has the capability of doing a timeline. This
isn’t a standard visualization in SSRS, but it is relatively easy to do. You use
Report Builder to build the report, as described in Chapter 8. Start by creating
a data source connection to the OECD_Data tabular cube in Report Builder
and then creating a new data set.

To do so, open Report Builder and you will see the Getting Started Wizard.
Click on Chart Wizard, then click Next on the following screen. Click New to
create a new data source, then choose Microsoft SQL Server Analysis Services
from the Select connection type drop-down, and enter rsds_OECDDatain the
Name text box (this could be any name).

Click the Build... button. If you are using a local and unnamed Analysis Services
instance, you can just enter “.” in the Server name box, otherwise enter the
server you are connecting to. Finish off by choosing OECD_Data for the data-
base name, and clicking OK. Click OK again and then click Next to create the

data set.
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In this data set, filter by the GDP per Capita metric, and add the YMD hierar-
chy, the Country Name hierarchy, and the MetricValue measure to the design
surface, as shown in Figure 11-42. Add the DateSK column—this is an incre-
menting column that starts at 1 for the first date and has no gaps. It's ideal
for calculating distances on a chart.

Query Designer ) _|_|- [m] ﬁl
IV Edit as Text [ tmpart..
’i Model I Dimension I Hierarchy | Qperator Filter Expression
] Metadata | DimOECDStatistic E Metric Equal {GDP per capita}
MR G <5elect dimensions
<B)l= =l al | o
= KAl =]
]g: DimCauntny =1 CountryMame VearMame Monthiame I Date I Datesk | hMetricvalue | &
= [gj DimDate South Africa 2000 January 200, 15263 6639.685
Date South Africa 2005 January 200, 20090 8653.708
Datell
Datesk South Africa 2005 January 200, 21185 10452737
Day Sauth Africa 2009 January 200... 21551 10237.994
Dayorveck Sauth Af 2010 il 201, 21916 10437.563
DayOfVear oLl rica anuary B
DaySuffix Australia 2000 January 200, 18263 27968.3674
DOWIntonth Australia 2005 January 00.. 20090 3438191761
HolidayText
TsPublicHoliday Sustralia 2008 January 200, 21135 3596436885
Monthhlame lﬂ Australia 2009 January 200, 21551 39904,35639
1 | [ L4 Australia 2010 January 201., 21916 40790,00007
Caloulated Members Mew Zealand 2000 January 200.. 18263 21035.92835
Mews Zealand 2005 January 200... 20090 25215.92334
Mews Zealand 2008 January 200.. 21135 29076.94574
Mew Zealand 2009 January 200, 21551 29386,15861
Mew Zealand 2010 January 201., 21916 29710,85119
China 2000 January 200, 15263 2377.754 ;I

Help | oK | Cancel

FIGURE 11-42 The Reporting services data set designer

This data set is going to be too large to work with easily, so filter it just for
South Africa and Canada. You do this by dragging CountryName onto the fil-
ter pane at the top on the right, and then choosing South Africa and Canada
from the drop-down. Click OK twice to close the designer when you're done.

You're just working on the chart, so remove the titleand footer from the report.
You remove the title by clicking on it, and then hitting the Delete key, and
you remove the footer by right clicking on it and choosing Remove footer.

Click the Chart option on the Insert tab, choose Chart Wizard, and in the
window that displays select the data set you just created. Click next. Choose
Bar, click Next, and then enter CountryName into the Categories and DateSK
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into the values column. Click the arrow next to the DateSK and choose Max
as the aggregation value.

On the next screen choose the Generic style and then click Finish.

When the chart appears on the report design surface, drag the bottom-right
corner to make the chart big enough to show all the values and then right-
click the chart and click Change Chart Type. Scroll to the bottom to find the
Range category. Choose the Range Bar chart type (it is fourth from the left).

Click the Low value that appears on the right side, and change it to use the
DateSK field and to aggregate as Min, as shown in Figure 11-43.
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Country Name E ' =] Date

[Max(Datesk)] -
[Count(Datesk)] -

Country Name D
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Country Name C

Country Name B ]
Country e A I

Fields »
= Agyregate 3

B Expression...

L] Category Groups

[ Countrybame -

T series Groups =+

0 20 40 60 80
Axis Title

Court
CourkDistinct
StDev
StDevP

var

varP

First

Last

Previous

Aggregete

FIGURE 11-43 Setting the DateSK field to aggregate as Min

Format the chart by right-clicking near the vertical axis (around the
CountryName labels). The words CountryName are repeated down the left
hand side, next to the words Axis title, and you need to click between two
of the lines containing CountryName. Then choose Vertical Axis Properties.
Set the interval to 1 from Auto to show all the countries. Set the Axis title at
the same time.

Next, right-click the bottom axis and select Horizontal Axis Properties. Deselect
the Always Include Zero button. Set the minimum value to 18232 (This is the
value of the first key in the data set, minus 30, to set the chart to display data
points prior to the start of the data set), and the maximum to 22281 (this is
the value of the last key in the data set), set the interval to 12, and then set
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Reporting Services
automatically con-
verts the axis display
to a date format when
an interval type that
corresponds to a date
is chosen.

the interval type to Months. Set the Axis title at the same time. On the same
screen there is a text box for the Axis title, which will replace the words “Axis
title” displayed previously. Make the axis title Country.

Run the report by clicking the Execute button and you see a display similar
to Figure 11-44.

Data Collection Period

111950 1771951 1MA952  1MM853 111954 1MM8SS  1MM958 111957  1/1i1958 111958  1/1/1980
Date

B Date SK

Country

FIGURE 11-44 Running the report

It's immediately apparent that the dates are wrong. This is because the data
set uses 1950/01/01 as the base date, and a date type in SSRS is based upon
a date starting in 1900/01/01. If you create a new calculated field in which you
add 18262 to the DateSK and then add 18262 to the minimum and maximum
values, you get a chart such as that shown in Figure 11-45, which shows an
accurate timeline for when data was collected for South Africa and Canada:

Data Collection Period

1172000 12007 112002 17172003 11/2004 1172005 V12008 1/1/2007  1/1/2008 1172008 17172010
Date

BN Date Number

Courtry

FIGURE 11-45 Date ranges displayed in SSRS

SUMMARY

In this chapter you learned about using visualizations to present data that
changes over time, and the pitfalls to avoid. The different tools in the Microsoft
stack are all good at displaying temporal data, but for different purposes:
PerformancePoint is good with custom date ranges, Power View has an ani-
mated bubble chart, Excel has trendline functionality, and Reporting Services
can display timelines with ease.
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CHAPTER 12

Comparison Visuals

Using a visualization to compare two or more objects either at a point in time
or over a period is one of the oldest forms of visualization. In Chapter 11, a
treatment of comparisons over time has been done, so this chapter focuses
on point-in-time comparisons.

Comparing items of data and deciding which is better is one of the most
common actions people take. This may take the form of ranking: for instance
determining which of your stores are in the top 10% and which stores are in
the bottom 10% by sales (or gross profit) allows you to determine the appropri-
ate remedial action for the poorly performing stores, and apply what's been
learned by the best 10% to your other stores.

Another comparison is comparing actuals against targets: For instance, while a
store may be in the top 10% by sales, it could well have not achieved a target
set for the period.

In this chapter you learn about several methods for comparing values visually:
heatmaps (also called chloropleths), traditional bar charts, and pie charts, as
well as bullet graphs, radar graphs, and matrices.

OVERVIEW OF POINT-IN-TIME
COMPARISONS

The effect used to show point-in-time comparisons can take one or a combina-
tion of the following forms:

Change in color (heatmaps, chloropleth, indicators)

Change in width (bar charts)
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Change in height (column charts, prism charts)
Change in position (scatter plots)

Change in area (bubble charts, tree maps)
Change in angular width (pie charts, donut charts)
Change in length (radar charts)

Combinations of these formats to add data—for instance, color to show a
change, and size of a bubble to show the absolute value—are very common.

PROBLEMS WITH POINT-IN-TIME COMPARISONS

The most common problem with comparison visualizations in popular
media is that, despite being a snapshot of the comparison at a point in
time, the time period is not listed. This can lead to confusion later on when
the comparison has changed.

Figure 12-1 shows an example from VizWorld (http: //www.vizworld.
com/2009/11/bad-infographic-mapping-emissions-country/) that
compares emissions. It has some of the problems mentioned in Chapter 2
with regard to the area of the bubbles (i.e, that the radius rather than the
area has been used, and it hasn't been labelled).

United
States
7,098

FIGURE 12-1 A comparison visual with several problems
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PROBLEMS WITH CHLOROPLETHS

A chloropleth is a heatmap with the shapes of countries or states instead of
blocks. Showing chloropleths using non-normalized numbers, for instance
gross domestic product (GDP) instead of GDP per capita, often gives a
misleading impression, showing a map of the population more than the
figure being chosen. Figure 12-2 shows an example of this from the popular
cartoon XKCD (http://xkcd.com/1138/).

PET PEEVE #208:
GEOGRAPAIC PROFIE MAPS WHICH PRE
BRSICALLY JUST FORULATION MAPS

FIGURE 12-2 XKCD showing the problem with heatmaps

EXPLAINING PERSPECTIVE AND
PERCEIVING COMPARISONS

How you perceive the difference between two objects is dependent on a
variety of factors—the difficulty with using area as a comparison method is
covered in Chapter 2, and the challenges of using 3D is covered in Chapter
1. Other factors include their relative positioning and ordering—putting two
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slices of a pie chart with similar but not identical values opposite each other
can be hard to read. As you learned in Chapter 2, background images can
also distort comparisons.

PIE CHARTS VERSUS BAR CHARTS

People commonly use pie charts as a Value
comparison visual. However, you need to
carefully think before using a pie chart.
Figure 12-3 shows a pie chart. Look care-
fully. Is Slice B or Slice D bigger?

It’s fairly difficult to determine which slice
is larger. While, as shown later, ordering
the pie chart by value will assist in this
comparison, there are better methods.
Compare Figure 12-3 to Figure 12-4, a col-
umn chart of the same values.

m5ice A w5liceB wShiceC wSliceD mSliceE wShceF

In Figure 12-4, it's much easier to deter- FIGURE 12-3 An Excel pie chart with
mine which column is larger, and it’s also similar-sized slices
easier to tell the absolute values.

Value

5

20

15

; I I
0

Sice A Slice B Slice C Slice D Slice E Slice F

wn

FIGURE 12-4 An Excel column chart with the same values
Another option is a stacked column. With a stacked column, as with a pie chart,

it aids perception greatly to order the numbers by value. You can see by this
by comparing the pie chart in Figure 12-5 with the stacked chart in Figure 12-6.

www.it-ebooks.info


http://www.it-ebooks.info/

COMPARISON VISUALS
Explaining Perspective and Perceiving Comparisons

Value

q

Sum of Yalue

160

140

120

mShice A wSliceE wSEceF wSkceC wSiceD mSiceB Total

FIGURE 12-5 A pie chart ordered by value FIGURE 12-6 Astacked chart

It's easier to see the total value in the stacked chart, but that comes at the
expense of the ease of comparing the individual items (although that’s still pos-
sible). Also, comparing individual items to the total value is now easier. Which
of these charts you choose depends on the message you are trying to convey.

EASE OF DEVELOPMENT

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes .
Power View Yes .
Reporting Services Yes .
Silverlight/HTML5 N/A .
BULLET CHARTS

Bullet charts have been popularized by Stephen Few, and are an excellent
way of having multiple comparison points. Chapter 16 deals with them
more extensively, but this chapter includes an implementation in Reporting
Services (SSRS).
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mSlice B
mSlice D

Slice C
mlice F
mSlice E

mSlice A

Ordering values by
magnitude is always
agood idea for
legibility.
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Figure 12-7 shows a basic example of a bullet chart.

Title Sales Amount Sales Quota
European Sales Manager $98,323 $117.000

North American Sales Manager $249,400 $271,000

Pacific Sales Manager $26,580 $33,000 _—

FIGURE 12-7 Abullet graph in SSRS

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel No
PerformancePoint No .
Power View No .
Reporting Services No .
Silverlight/HTML5 N/A
RADAR CHARTS

A radar chart is a way of comparing data along multiple axes. In a radar chart,
each point is represented as a distance from the center. The order and choice of
data points is quite important in this type of graph, as adjacent nodes should
be related in some manner, and the slope of the graph has meaning. In the
chart of education ratings for the Scandinavian countries shown in Figure 12-8,
the ratings for men and women have been chosen to be opposite each other,
allowing for each comparison, and science was picked to be between math
and reading, as science ability can be considered highly influenced by ability
in math and reading.

The high slope for women up to science versus the flat one for men is an
interesting contrast.
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Statistics -1 Regions <1 YD T
Metrich'alueivg

Mean scores on the
mathematics scalke in

PISA 2009 women
30
560
540

Mean scores on the
reading scale in PISA

Mean scores on the
science scalein PISA

2009: men 2009 women CountryMame ¥
g Denmark
g Finland
—a— Norway
Mean scores on the IMean scores on the Sweden
science scale in PISA reading scale in PISA
2009 men 2003 women
Mean scores on the
mathematics scalke in
PISA 2009 men
Metric
FIGURE 12-8 Aradar graph of Scandinavian education scores
Ease of Development
REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint No .
Power View No .
Reporting Services Yes .
Silverlight/HTML5 N/A
MATRICES

A matrix of different comparisons is a very common visualization. A com-
mon use for them is on online shopping portals, such as the one from HTC
in Figure 12-9.

www.it-ebooks.info

233


http://www.it-ebooks.info/

234 VISUAL ANALYTICS IN PRACTICE

Specifications [}
Highlights |
HTC One SV HTC Desire SV HTC Desire X
Size -
128 x 86.0 x 0.20 mm 120.74 x87.0 x 10.7 mm 118.5x062.3 x 0.2 mm (4.67 x
2.45 x 0.37 inches)
Weight »
Display -
4.2-inch super LCD-2 touch 4_2-inch super LCD2 touch screen 4-inch super LCD
screen with Coming® Gorilla®
Glass 2
Screen *
CPU speed -
Qualcomm® 54 1.2 GHz, Dual- Quslcomm® 54 1 GHz, Dual-core 1 GHz, Duslcore
sore
Platform Android .
SIM card type »
Memory -
Total storage : 8 GB, available Total storage : 4 GE, available Total storage: 4 GB, available
capacity varies: capacity varies: capacity varies
RAM:1 GB DDR2 RAM : 768 MB Expansion Card Slot supports.
) i microTM SD memory card for
Expansion Card Slot supports Espansion Card Slot supports addifional storage (oard not
micro™ 5D memory card for microTM SD memeory card for included)
additional storsge {card not additionsl storsge {card not
included) included) RAM: 768 MB

FIGURE 12-9 HTC comparing models of phones

Another form of matrix comparison is the bus matrix used in the Data
Warehouse design, shown in Figure 12-10. By listing the dimensions along
the top and the fact tables down the side, you can make an estimation of
the difficulty of development of each area based upon the order in which
they're done.
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'b‘oz} \5"2} & & Sy
Facts/Dimensions _g,\o“:, S SUS g“&& % \><‘“<qu°°’§ EYA ) ZQ“JP
e S S b"c‘ @é ,;-9& o ﬁ& \29& S ﬁ& p‘t’z SOS S §&‘ é%‘ . \bc‘*
ST SSRGS G S S

Invoice XX [ X[ X[ X X X X

Invoice Line Item XX | X|X| X X X X | X

InvoiceTender XX [ X[ X[ X XX | X X X

Return XX | X|X| X X | X X X X

Return Line [tem XX | X | X | X X | X | X X | X

Exchange X X X X

Till Open X | X X [ X X

Till Open User XX | X X[ X X

User Change XXX X XX

Day End Recon XX | X X X X

Till Close XX | X X | X X X X

FIGURE 12-10 A bus matrix

PerformancePoint has an analytic grid, Excel has a pivot table, and SQL Server

Reporting Services (SSRS) has a matrix for creating these comparison tables.

PerformancePoint’s analytic grid is shown in Figure 12-11.

DimCountry Regions Mean scores... Mean scores... Mean scores... Mean scores... Mean scores... Mean scores... Mean score ... Expenditure...

=l Asia + Pacific 486.6788355 480.22512625 491.924246 498.81417825 "|Mean srores on the science scale in PISA 2009; men‘ 75 13486.34791
[# Australia + Mew Zeal... 521,257136 512,413167 527.8930355 531.437763 497.334269 538.5145 517.890327 12784.503875
[+ Morth East Asia 533.554451 524.13089 533.786862 545.447412 501.022974 539.934752 519.85773 14890.03598
[ South East Asia 370.646619 371,943281 378.124051 386,933775 383.272307 419,801983 401,705191

=l Europe 500,24016836 48931279244 498,47459548 499,33233656 470.32487992 511,73701368 493.273586473684 13368.6117674286
[ Central Europe 492,839797333333 485,913392 497.74769 503,9896165 464.320704833333 510.620712166667 490.947979333333 7550.1334078
#l Eastern Eurcpe 468,91121 466.732419 476.746896 479.820981 436.875505 481,522416 459,395959
H Western Europe 504.447456388889 491.700391111111 499.923991722222 498.863874111111 474.184570222222 513.787702944445 4959972164 15186.8862548125

= Latin America + Cari... 416.930844666667 400,228196  426.071153333333 419.817264 415.921136333333 441.127491666667 428.796609333333 71663860415
[+ Meso America 425.412094 411.76969 419.169678 412.724955 412.653217 437.578505 425.26531 7503.772083
# Seuth America 412,69022 394457449 429,521891 423.3634185 417555096 442,901985 430,562259 6829

= North America 532.700246 520.832034 531.011766 526,367631 507.182212 541,527242 524.241845 20903.35796
= Morth America 532.700246 520.832034 531.011766 526.367631 507.182212 541,527242 524241845 20903.35796

Canada 532.700246 520.832034 531.011766 526,367631 507.182212 541,527242 524.241845 20903.35796

FIGURE 12-11 A PerformancePoint analytic grid
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Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE
Excel Yes
PerformancePoint Yes
PowerView Yes
Reporting Services Yes
Silverlight/HTML5 N/A
CUSTOM COMPARISONS

A custom comparison can take several forms. You

EASE OF DEVELOPMENT

can format the various

charts in Excel and Reporting Services to a level that the chart is essentially

a custom type.

For instance, Figure 12-12 is an example of a Christmas tree comparison.

T

-

-
Regions ¥ Statistics 1
Cenmark Finland
-150 -100 -30 0 0 100 150
Walues
YD m Denmark
.

FIGURE 12-12 A bar chart as a Christmas tree comparison
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Bullet graphs such as the one shown in Figure 12-13 are a custom comparison
in Excel. This graph was developed by superimposing two bar graphs with a
transparent background and a colored shape with a gradient.

A B C E FGHI JKLMNOPQRSTUVWXY
1
2 Statistics Unemployment rates: total
3
4 MetricValueAvg Target
5 2011 2012
3 Brazil 570 5 _— 3
7 Russian Federation 6.60 3 _— A
g South Africa 24.90 18 ﬁ N
a Japan 460 4/ : -
10 Canada 7.40 7_— -
11 |chile 7.0 7 |

-
=)

FIGURE 12-13 Abullet graph in Excel

Other custom visualizations include filled-up shelves shown in Figure 1-3 in
Chapter 1, or the animated building in Figure 2-21 in Chapter 2. The animated
buildings are essentially just prettified columns in a column graph.

Another custom visualization is the prism map also shown in Chapter 1.

TOOL CHOICES, WITH EXAMPLES

The Microsoft toolset is relatively good with comparison visualizations, and
works well across the toolset. The only large gap is an automatically gener-
ated heatmap. While Excel can be used to generate a heatmap of sorts, it is
far from use friendly. The InfoVis toolkit is discussed later in this chapter to
show you what these heatmaps look like.

PERFORMANCEPOINT SERVICES

PerformancePoint is very good with the basic comparison visualizations. It has
column charts, scorecards (the indicators covered in Chapter 13 are a form of
comparison visual), and an analytic grid. It is, however, limited in that further
customization is not possible. The interactivity of being able to slice your vari-
ous comparisons by a scorecard—as shown in Figure 12-14—makes up for this
in large part by making the experience of filtering the comparisons very easy.
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FIGURE 12-14 A PerformancePoint dashboard

SSRS

Reporting Services allows for great and finely detailed control over the indi-
vidual elements in the charts being displayed. It enables you to easily create
embedded charts (such as bullet charts) in table matrices. An example of
embedding a bar chart in a matrix is shown in Figure 12-15.

This repeating (or tiling) of a chart is one of Reporting Services’ greater
strengths for comparing values.

EXCEL

Excel’s greatest strength is in the level of control you have over a visualiza-
tion’s exact look. For instance, the pie charts shown in Figures 12-4 and 12-6
can have the individual slices pulled out to highlight items you are interested
in, as shown in Figure 12-16, as well as a great deal of customization of how
the labels are shown.
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Il Czech Republic
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0 2000 4000 6000 8000
Il Czech Republic
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FIGURE 12-15 Comparisons in Reporting Services
D 3 F G H I 1 K L =]
Format Data Label M Do not mix the
LABEL OPTIONS ¥ | TEXT OPTIONS data label display as
. I A
SO @ M done in Figure 12-16!
Rather, choose a
“ LABEL OPTIONS display that fits the
tael Cantains data you have—data
L geries Name labels outside the

Eategery lame slice are often a good

Wal .
24 [ e choice for smaller
Bercentage .
slices.
) Show Leader Lines
[ ] Legend key
Separator [New Line] =

Reset Label Text

Label Position

mShiceA wSliceE =SiceF SiceC mShceD wShiceB

() Center

() Inside End
(® Qutside End
) BestFit

Data Label Series

Clope Current Label @

FIGURE 12-16 An exploded Excel pie chart
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Getting the slicers
set up along the top
simply requires set-
ting the number of
columns in the slicer
settings. You would
do this by clicking on
the slicer, and choos-
ing Position and
Layout in the pane on
the right hand side,
and changing the
number of columns in
the text box.

VISUAL ANALYTICS IN PRACTICE

Another strength of using Excel is conditional formatting, which is used to
create heatmaps, as well as the data bars. You can read more about heatmaps
in Chapter 16, but an example of one is shown in Figure 12-17.

| subject )
Education Energy andtra..  Environment Glabalisation Labour Populationand...  Prices Production and... | Seience and te...
Category %
| [ outeomes Energyprod.. | Energyrequi.. | Transport airandland | WaterandN.. | FDiandbala.. | Trade Employment...  Unemploym... =
Area i
| | Educationat... || Enjoyment o... || How manyst... || gyprod.. | Oil prices Oil production  Electricity ge.. | Energyinten.. =]
GEORegion T  MetricvalueAvg Colum ¥
—_— Mean Mo Fopation opd2564 dilererce of
Asia+ Pacific womson sonon Mean  MeIn  Men  Mein  SpedISEL Mpublon wHhupeer belween  interrstion
. the the momson momon xoreion woreson  withbslow apsd25C4 mcondsy gudets  almubents
Masnxor muramuc Mehemac the resgirg tharesding thexMNce thexclerce tppar  Wah  Erdpom.  woresd  on
- inrsdicg smalein xalein  malein  malin  smlein  wmlin  smcorday tatisy  moonday uptod)  pmdution
Latin amer... partormarc FISAZ00S: PISAZ00S! FISAZO0S: MEAZ009) PISA2008: PISAZ00S: lvelol  ewelc!  romerian minae  mwar
N Row tabels < e men  womsn  men  womsn  men  women  eduation edustion lealol  and tartiary-
North e | o w e e e T e
africa | Betgium 506 526 08 s 01 m 510 ) n ” L] z
|
Caech Republic wm s 50 s 03 e o [EEEN - :
=
Yeamame | nmark ws s s08 T s08 " n « » B
2008 2| | estonia 536 500 527 £ - s [EE » B s 1
(aos |[] |reiand » ” b e 8
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1953 Ireland 5 51 a3 s07 503 ar 515 » ] “
e el o [Mwee e el e ows ow » [
taly s w0 s s 30 ase s10 “ “ “ 1
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FIGURE 12-17 A heatmap in Excel

HEATMAPS AND COLUMNS

In Figure 12-17, the columns were set up individually with conditional
formatting, as the numbers in the different columns are not comparable.
Grand totals were also removed for this reason.

POWER VIEW

Power View is a good tool for interactive comparison visualizations. The auto-
matic linking of column and bar charts on the same page is very useful. Just
as with PerformancePoint, though, the level of control over the visualization
is very limited. Figure 12-18 shows an example of a dashboard with a slicer, a
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table of data, and column and bar charts interacting with each other. Active
regions are shown in blue, and inactive in a grey-blue.

GEQ Regicn GEQ Subregion - — A
W Europe W Central Europe Value by CountryName

Eastern Europe
Western Europe
Czech Republic

ungeny -

CountryName  Metric MetricValueAvg &
Hungary Met migration rate 159 Poland
Hungary Muclear power plants connected to the grid 4.00
Hungary Cantribution of renewables to energy supply 572 Slovenia
Hungary Crude cil import prices 26.22
Hungary MNuclear electricity generaticn 29.75
Hungary CO2 emissicns from fuel combustion 52.75 Turkey
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FIGURE 12-18 A Power View dashboard

HTML5

Working in HTMLS5 gives you the ability to build your own visualizations.
The prism map referenced earlier is one example, but all the other examples
previously listed are possible—with an additional amount of work, of course.
Figure 12-19 shows a heatmap chart built using the InfoVis toolkit. InfoVis is an
open source HTMLS5 library available at http://philogb.github.com/jit/.
The chart in the figure is based on countries for which we have both National
Reserves and GDP per capita in 2009.
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Regions by National Reserve and GDP per capita

North America

Switzerland ey Denmark

Germany Norway,

Sweden Netheriands

Latin America +
Cagihfigan

Austria

FIGURE 12-19 A heatmap built in InfoVis

IMPLEMENTATION EXAMPLES

The implementation examples in this section use the OECD_Data model, so
be sure you have downloaded those from this book’s web page on Wiley.com.

PERFORMANCEPOINT: COLUMN GRAPHS

PerformancePoint is the easiest tool to set up. To create the column chart
for this example, create a data source, as explained in Chapter 7, right-click
your PerformancePoint content list, and then create a new report. Choose
Analytic Chart from the window that appears and finish off by choosing your
data source. At this point you should see the Dashboard Designer window
like the one in Figure 12-20.
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T D Untitled - Dashboard Designer = x
Home | Eait Create )
%ocut | Ry flAddlsts | 5F Properties X Delete | [ Compare ltem g
> X ) =
3 Col Remove Permissions Gl waliclate Trem
P tb ® - Inport
Eems (2 Refresh | = pename [ Mark Differences | Ttems
Clipboard Workspace Item Changes Import
Workspace Browser «|[Tpetn | quen | prepertes | Details »
Untitled Workspace = ‘Al Measure Groups, [
4 i (€ New Report 3 (e o) =
= (£ Data Connections T Messures
|| dsoECD 122 Dimensions
= [ PerformancePoint Content 2% Named Sets
Drag measures, dimensions, or named sets to the
Series and Bottom Axis to lay out the report.
Series Bottom Axis Background
Connected ko: hbtp: fgs-me600/

FIGURE 12-20 Dashboard designer

Drag MetricValueAvg to the Background, DimDate > YMD to the background,
DimCountryRegions > Regions to the Bottom Axis, and DimOECDStatistics >
Statistics to the Series. You will find these by drilling down on Measures and
Dimensions on the right-hand pane. Click the drop-down arrow next to
DimDate and select 2009. Click the drop-down arrow next to Statistics and
choose Foreign Population > Foreign-born Nationals > Foreign-born popula-
tion. Finally, click the All member on the bottom axis to show the data at the
region level. You should see a chart similar to Figure 12-21.

80

Asia + Pacific

Il Foreign population
[l Foreign-born nationals
[l Foreign-born population

North America

Latin America + Car..

FIGURE 12-21 A PerformacePoint analytic chart
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EXCEL: MULTIPLE AXES AND SCALE BREAKS

The implementation examples in this section use the OECDPopulation
PowerPivot model available from this book’s web page, and called
OECDPopulationStats.xlsx.

Sometimes it is difficult to show comparison for data—for instance, comparing
the GDP per capita to the National Reserve value, as they are substantially dif-
ferent values, or comparing two countries that are very different. For instance,
the chart shown in Figure 12-22 has these two measures for Switzerland and
for Estonia, and Estonia’s Reserve value is barely visible:

Statistics < YMD T

Metricvaluefvg LatestReservetalue
200000

180000
160000
140000
120000
100000

“Walues

80000 W MetricValueAvg

60000 m LatestReserveValue
40000
0

Estonia Switzerland

Central Europe Western Europe

Europe

Regions 'Y

FIGURE 12-22 An Excel chart with difficult-to-read figures

MULTIPLE AXES VERSUS SCALE BREAKS

When two or more axes are shown together on a chart, the chart is said to
have multiple axes. These will be shown on each side of the chart, and the
series on the chart will be associated with one or the other of the scales.

A scale break is shown when, for example, only sections of a scale are
shown on the chart. For instance, a chart might only display values from
0-100 and 90000-100000. This enables a comparison of figures that are
different in scale.
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Open OECDPopulationStats.xlsx. Switch to sheet 1, then start by clicking
the Pivot Chart button on the Insert Ribbon, as shown in Figure 12-23.

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW LOAD TEST POWERPIVOT TEAM
C F T2 Shapes - =y - =-%- E ]: E H = Q’Dé
E? r:l (] T Smartart [H 1 E? W~ A i ' A e [ T o
PivotTable Recornmended Table  Pictures Online Appsfor  Recommended ) Power Line Celumn  Win/ Slicer Timeline Hyperlink
PivotTables Pictures @+ Screenshot™  office - Charts vl View Loss
Tables Tustrations Apps Charts 15 PivotChart tlines Filter Links
m oo .
- £ W PivotChart & PivotTable
(B ¢ % | Protchoe L
A B C D E F G H I J K L p  Use PivotCharts to graphically

1 | summarize data and explore
,—- complicated data.
2

FIGURE 12-23 Excel Ribbon interface to add a pivot chart

Choose Existing Worksheet and Use an External Data Source. Click Choose
Connection, as shown in Figure 12-24.

The choice of a connection is a bit different between Excel
2013 and earlier versions. In the earlier versions, you select
PowerPivot as the data source, but in Excel 2013 you must
choose Tables, and then select Tables in Workbook Data
Model, as shown in Figure 12-25.

oo N

Choose the data that you want to analyze

(") Select a table or range

Table/Range: ‘ ﬁ

Choose Connection...

Connection name:

Choose where you want the PivotChart to be placed
7) New Waorksheet
Existing Worksheet
Location: | Sheet3!SAS1 E

)
Select a Connection or Table

Connections | Iables

Show:

Choose whether you want to analyze multiple tables

D Add this data to the Data Model

-

This Workbook Data Model
Tables in Workbook Data Model
5 Table(s}

SglServer sql2012 VI_UNData
DimCountry
[Blank]

DimDate
[Blank]

DimOECDStatistic
[Blank]
FactOECDPopulation
[Blank]

FactUNData

[Blank]

FIGURE 12-24 Choosing a connection for a pivot
chart

IS 1 S

FIGURE 12-25 Choosing your workbook model
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Format Axis X%

AXISOPTIONS ¥  TEXT OPTIOMS
P
SH O = M

b AXIS OPTIONS
b TICK MARKS
b LABELS
4 NUMBER
Category
Currency ~|@
Decimal places: | 0
Symbol:
§ English (United States) -
Hegative numbers:

51234
41234

4-1234
4-1234

Farmat Cade ©
[55-409# ##0 Add

Linked to source

FIGURE 12-26 Formatting
a number in Excel

AXISOPTIONS ¥  TEXT OPTIOMS
P
O O omE ol

4 AXIS OPTIONS

Bounds

Minimum 10 Dyta

Wadirmurn 106 Autn

Units

Major 100 Auto

Winer 100 futo
Horizantal ais crasses
® Autprnatic
sz value 10
Maxirmum axds value

Display units None -

| Logarithmic scale  Base | 10

Values in reverse order

> TICK MARKS
b LABELS
4 NUMBER
Categary
Currency ~|a
Decimsl places: | 0
Symbol:
§ English (United States) -
Megative numbers:

41234
41234

41234
4-1234

Format Cade ©
[55- 4041 ##0 Ldd

Linked to source

FIGURE 12-27 Formatting
the secondary axis in Excel

At this point, you see an empty pivot chart on the left and the PivotChart
Fields pane is on the right, but you need to add the appropriate fields to the
chart. Drag MetricValueAvg and LatestReserveValue to the Values field in the
right-hand pane.

Next, drag the DimOECDStatistics > Statistics Hierarchy onto the Filter pane.
Click the arrow next to the word Statistics on the chart, and drill down to
Production and Income > Production > Size of GDP > GDP per Capita, and
then click OK.

Drag DimDate > YMD onto Filters, click on the arrow next to the word YMD,
select 2011, then press OK.

Drag DimCountry > Regions to the Axis field on the right-hand pane. Click
the arrow next to the word Regions on the chart, then click Select multiple
items. Untick the All check box, and then tick Europe > Central Europe >
Estonia and Europe > Western Europe > Switzerland.

Right-click on the word Europe that appears on the bottom of the chart, then
click Expand/Collapse, and then Expand to CountryName. This will finish the
chart shown at the beginning of this section.

For the first problem, you can put the one series onto a second axis by right-
clicking the series and then selecting Format Data Series. On the screen that
displays, set the axis to Secondary. Notice that some of your data has disap-
peared. To fix this, change the Gap Width to 400% and then go to the other
series and change the Gap Width to 100%. The widths of the two series changes
so that they can always be seen.

Next, right-click the right axis, choose Format Axis, and then change to the Axis
Options tab in the Format Axis pane. Change the Number format to Currency,
check that the correct currency (USS$) is chosen, and set the Decimal places to
0. Your setup screen should look like Figure 12-26.

Now, do the same for the axis on the left. In this case, there is one addi-
tional setting you want to set—check the box next to Logarithmic Scale. (See
Figure 12-27.)

The Logarithmic Scale option sets your axis to show in multiples of 10, which
nicely compresses the data values. It requires some skill on the part of the
reader to know that the values on the two axes scale differently, so be careful
when using this technique.

The chart is as shown in Figure 12-28, but you still have to apply formatting
to make it readable.
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Having two axes enables you to show different scales, but it does mean that
your reader needs to pay attention to the scales when reading the visualiza-
tion. Figure 12-29 shows how the relationships change when using data for all
of Europe. The left axis stays the same, but the values on the right axis do not.

0 1
Statistics .! D v!
|LatestReserveivalue Metricialuetyg |
51000 000 560 000
5100 000 550 000
$10 000 540 000
$1000 L —
Walues
M LatestReserveValue
5100 520000  wMetricValuetive
510 $10 000
51 50
Estonia Switzerland
Central Europe Western Europe
Europe
Regions -!
o J
FIGURE 12-28 Two axes superimposed
s e ]
Statistics -! D -!
|LatestReservesalue Metricvaluetvg |
51000 00D $100 000
590 000
100 000
5 SB0 000
$10 000 70000
$60 000
$1000 550 000
540000
5100 $30000 Walues
M LatestReserveValue
520 000
510 m MetricValusAvg
510 000
51 50
@ =T m o = T ¥ 8T T g = B ™ = ]
SEREs Y FEEEEEEEREESITIRERGE
2zS5¢egz2 2B czg:itEfzr® 2gEEv s
R w <=8 F = 39 == E2=2¢ @ g
= 5 5 =
T o 2 “
)
Central EuropeEastern Europe Western Europe
Europe
Regions -!
[ )

FIGURE 12-29 A change in only one axis
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FIVOTCHART TOOLS

AMALYZE

!
Clear  Mowve

- Chart
Actions

DESIGM

i

& Sets v

FORMAT
- sure to add the YMD hierarchy to the filters section, filter

& =5 [E 1y erarehy :
Fields, lerns, | OLAP Relationships | Field  Field for 2011, add the Regions hierarchy to the Axis category,

Cz

Tools =

This is of course not a scale break, which you may be familiar with from
Reporting Services (which has it as a built-in option).

There are some (relatively tricky) ways of getting scale breaks to work in Excel:
The one you are going to work through now is reliant on being able to create
custom measures. This is a feature specific to Excel 2013—in Excel 2007 and
2010 you need to download a tool called OLAPPivotTableExtensions from
http://olappivottableextend.codeplex.com/. You will be continuing to
use the same pivot table you used in the previous example.

OTHER SCALE BREAK TRICKS

Jon Peltier has some great alternative tricks to building a scale break, which
are based on the data residing within Excel and not a cube. He calls them
Panel Charts, and you can read more about them at http: //peltiertech.
com/Excel/ChartsHowTo/PanelUnevenScales.html.

Start by removing your current measures from the pivot
table. Alternatively, if you are creating a new chart, make

WETBIREE - and filter for Switzerland and Estonia.

Offline OLAP...
U — Next, choose the appropriate scale break values. Given how

ML Calculated Member..,

low the value for Estonia is, you can set the upper scale

Manage Calculations.. break to 2000. You will do this by going to OLAP Tools on
FIGURE 12-30 Adding an MDX Calculated Measure the Ribbon'’s Analyze tab and choosing MDX Calculated

Measure, as shown Figure 12-30.

As shown in Figure 12-31, call your new measure LowerReserve and put it in
the FactOECDNationalReserve measure group. Use the following code—all it
does is set any value higher than 2000 to 2000.

CASE WHEN [Measures].[LatestReservevValue] > 2000 THEN 2000 ELSE
[Measures] . [LatestReserveValue] END

Add this measure to your pivot table by dragging the field name from the
right-hand pane onto your pivot table. Now right-click the axis on the right
side and choose format Axis. Set the number format to currency, and set the
maximum to 4000. Because you are splitting the axis in two, this setting is
always double the maximum value for the lower reserve.
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Mame: |lowerReseNe

Folder: I

Fields and Items | Functions FADH: Measure Group

CASE WHEMN [Measures][LatestReservevalue] » 2000 THEM 2000 ELSE
[Measures][LatestReservevalug] END

Show flelds: |40 =l
4

[l £ FactOECDNationalReserve
LatestReservevalue

Reservewalue

[ X FactOECDPopulation
Dienmark
Finland
LowverReserie
Metricialue
Metrichaluedug
Metricialuehax

UpperResere

=l [ bimCountry
Regions j

Irsert: Test MDX
Cancel
7]

4

FIGURE 12-31 Calculated measure text

Next, create a new measure called UpperReserve in exactly the same manner
as LowerReserve. This value instead has a lower limit. Setting this lower limit
is crucial—any chart item with a value between the upper end of the Lower
value (2000) and the lower end of the Upper value disappears off the chart. In
this case, with just two values, you can be fairly arbitrary, and 150000 works.
Use the following code:

CASE WHEN [Measures].[LatestReserveValue] > 150000 THEN
[Measures] . [LatestReserveValue] ELSE NULL END

The difference here is that the value at the bottom end is getting removed from
the chart. Add Upper Reserve to the chart and switch it to the secondary axis.

The trick is to set the minimum and maximum bounds of the axis so that it
appears above the other chart items. In this case, set the maximum to 200000
and the minimum to -228571 (200000 plus an offset value of 1 seventh—you
often need to tweak this offset).

Your chart should currently look like Figure 12-32.
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-5228 571

Switzerland
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FIGURE 12-32 The chart with double scales
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Bounds
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MNane -
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FIGURE 12-33 Removing labels
from a chart

It isn't immediately apparent that what we are
doing is a type of scale break technique. To
make that more evident, first hide both axis
titles and add data labels. You can do this by
right-clicking each axis, choosing Format Axis,
and then setting the Label Position to None,
as shown in Figure 12-33.

Add data labels by right-clicking an axis and
choosing Add Data Label. After you've added
the labels, right-click and choose Format Data
Label, set the number format, and also set the
position to Inside End, as in Figure 12-34.

After that, change the font in the Home Ribbon
where you’d normally do it. The final step is
to set a gradient to show that the two series
are related. Using one stop at 15% away and
keeping to the very distinct colors illustrates
that the two sections can’t be compared.
Figure 12-35 shows the gradient setup.
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LABEL OPTIONS ¥  TEXT ORTIONS SERIES OPTIONS
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FIGURE 12-34 Changing label FIGURE 12-35 Setting gradient
position stops

Obviously, you need to do this twice—once for each series—and your final
chart should like the one shown in Figure 12-36.

To get back to the Axis options (for instance, if you change the selection of
countries and need to adjust the axis maximum and minimum), you have to
go through the chart format area because you have hidden the axis. (See
Figure 12-37)
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Format Chart Area %
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FIGURE 12-36 A chart with scale breaks

Adding all the countries of Europe creates a rather messy chart. You can tidy it
up by clicking the individual $2000 labels and deleting them. There is still data
missing, and to bring that missing data onto the chart, you need to change
the lower value for the upper reserve. This approach requires some manual
effort to get these values set to 100% correctly.

SLICERS AND NUMBERS TABLES

You can dynamically set the scale break values if you have a numbers table
in your cube, use that numbers table as the data source for your slicer, and
then use that numbers table as your limit. This qualifies as an advanced
topic—more information can be found at http://markgstacey.net.

EXCEL: RADAR CHARTS

Excel radar charts are very easy to set up. From a new sheet, click Insert >
Pivot chart. Select the external data connection option, and choose the con-
nection to OECD_Data. If you need assistance, refer to Chapter 5.
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On your new pivot chart, add MetricValueAvg to the values and drag
DimDate > YMD to the filters. Add DimCountry > Regions to the Series, and
DimOECDStatistic > Statistics to the Axis.

On the pivot chart, click the drop-down arrow next to YMD and select 2011. Then
click the drop-down arrow next to Statistics and uncheck the Select All box.

Navigate to Globalisation > Trade > and select International Trade in Services
and International Trade in Goods and click OK.

Right-click Globalisation on the chart, choose Expand/Collapse, and then
choose Expand to Metric.

Your chart should look like Figure 12-38.

wo Y

Metricvalueivg

700
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400
Regions -

300 .
m Africa
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200
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I I I I I I m North America
. - i Al ___
Exportsofgoods  Imports of goods Trade balance Exports ofsenvices  Imports of services  Services trade
exports of goods balance: exports of
-100 minus imports of services minus
goods imports of services
International trade in goods International trade in services
Trade
Globalisation
Statistics Y

FIGURE 12-38 The basic chart before converting to a radar chart

To convert this to a radar chart, right-click the chart, choose Change Chart
Type, and then pick Radar chart from the list of charts, and click OK. Your chart
changes, as shown in Figure 12-39.

This chart is one that works better as a column chart. Give careful thought
before using radar charts.
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FIGURE 12-39 Aradar chart

SSRS: A BULLET CHART

Reporting Services has a chart very closely related to the bullet chart—the
gauge chart—which you use to create the bullet chart.

Start by creating a data source connecting to the OECD tabular model, and
then create a new data set, and call it dsOECD. Pull the MetricValueAvg mea-
sure onto the design surface, drag DimOECDStatistics > Statistics onto the
parameters, and select the Production and Income > Productivity > Size of
GDP > GDP per hour worked metric. Check the parameter box.

Now drag DimDate > YMD onto the design surface, and choose 2011. Drag
DimCountry > Regions > CountryName onto the design surface.

Your design surface should look like the one shown in Figure 12-40.

The next step is to set a target, so you need to create a calculated measure. In
this case, you are going to create two measures: one target being the best GDP
per hour worked across the planet, and another one for the best GDP for the Sub
Region. To create a calculated measure, right-click in the box in the lower-left
corner, and choose New Calculated Member. Your code will be the following:

CASE WHEN [Measures].[MetricValueAVG] = NULL THEN NULL ELSE
MAX( [Measures].[MetricValueMax], [DimCountry].[Regions].[All])
END

And the screen should look like Figure 12-41.

www.it-ebooks.info


http://www.it-ebooks.info/

5} Edit as Text 5 Import...

HagrEExmal w

COMPARISON VISUALS
Implementation Examples

Iﬁ Model

(]

(2 Metadata |

Measure Group:

<All>

= | DimCountry

Adtive
CountryCode
CountryName
CountrySourceKey
CreateDate
Developed
GEOID

GEQ Region
GEO Subregion
150 2 Code
1SO 3 Code
LoadDate
Sovereign

UN Code

m

Calculated Members

Dimension Hierarchy Operator Filter Expression

DimOECDStatistic 4, Statistics Equal {GDP per hour worked }

DimDate A YMD Equal {2011}

<Select dimension>

Metric CountryName MetricValuevg -

..... GI DFpEr hnuiwnlked Australia 48.6

GDP per hour worked  Austria 514

GDP per hour worked  Belgium 59.2

GDP per hour worked  Canada 46.2 3

GDP per hour worked  Chile 209 1

GDP per hour worked Czech Republic 306

GDP per hour worked  Denmark 532

GDP per hour worked  Estonia 259

GDP per hour worked  Finland 491

GDP per hour worked  France 577

GDP per hour worked ~ Germany 55.3

GDP per hour worked  Greece 339

GDP per hour worked  Hungary 263

GDP per hour warked  Iceland 396

GDP per hour worked  Ireland 66.4

GDP per hour worked  Israel 338

FIGURE 12-40 A dataset query window for Analysis Services
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FIGURE 12-41 Adding a calculated member
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Create another new calculated member, and use the following formula:

CASE WHEN [Measures].[MetricValueAvg] =

MAX (

{ ([DimCountry] . [Regions] .CurrentMember.Parent) .Children}
, [Measures] . [MetricValueMax]

)
END

Your screen should look like the one in Figure 12-42.
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FIGURE 12-42 Calculated column

Hierarchy
24, Statistics

s, ¥YMD

CountryName
ustralia

New Zealand
Japan

Czech Republic
Estonia

Hungary

Poland

Slovenia

Turkey

Russian Federation
Austria

Belgium

Denmark

Finland

France

Germany

Operator
Equal
Equal

MetricValueAvg
486
3
398
306
259
%38
262
359
81
2
514
592
53.2
191
577
553

NULL THEN NULL ELSE

Filter Expression Param...
{ GDP per hour worked |
{2011}

WorldBestGDP  SubRegionBestGDP -

815 486

815 486

815 398

815 359 L

815 359 i

815 359

815 359

815 359

815 359

815 22

815 815

815 815

815 815

815 815

815 815

815 815

You now have two target values to use for the bullet graph. Click OK twice
and then remove the footer and the title on the report.

In the Insert tab, click Matrix > Matrix Wizard. Choose the dsOECD dataset
you just created. Add Country Name to the Row group, and MetricValueAvg to
the values, and click Next. Uncheck Show Subtotals and Grand Totals on the
next screen and click Next. Finally, choose the generic style and click Finish.

On the table that appears, right-click the Metric value column, and choose
Insert Columns > Right. Click the new cell that appears, parallel to the Country
Name, and from the Ribbon choose Insert > Gauge. Click the cell again to
make the gauge choice screen in Figure 12-43 appear, choose the linear bar,

and then click OK.
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S 3 - 4 - § - § 7 e
! ISeledGaugeT
Metric Value

Radial Radial

Sum(Metr\cVaI

Sum(MetricVa

| Row Groups

ZountryName

Co ][ o ]
ﬂ

FIGURE 12-43 Inserting a gauge chart

Enlarge the row and column to make working easier, as shown in Figure 12-44.

Country Name  Metric Value
[Country ] [ icV:

A

I i i O I
20% 40% 60% 80% 100")5 (Unspecified) CountryNeme

[Sum(MetricVa WorldBestGDP
SubRegionRestGDP

.| Expression...

FIGURE 12-44 Formatting the gauge chart

Right-click the gauge and choose Gauge Properties.
Select Back Fill and set it to solid and white. Click
the gauge, click the arrow next to Unspecified below Eq

LinearPoint1, and set it to MetricValueAvg. E K Delete Gauge

G vl 60%  80%  100%
Repeat the process for LinearPoint2, and set it to | [ P |
WorldBestGDP. To add another point, select the first 2:3 ;::;j
pointer on the graph, and then right-click just next A @
to it on the white space, as shown in Figure 12-45. Add Indicster

Add Label

Set the third pointer to SubRegionBestGDP. Your Ef| Gouge Properties...
GDP values are not percentages, so right-click the FIGURE 12-45 Adding a pointer to a gauge chart
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scale, IOW the numbers along the bottom of the gauge, and choose Scale

Properties. Select the Number tab, as shown in Figure 12-46, and choose
Number in the Category list.

Linear Scale Properties Zl
General
Set number formatting options.

Action
Layaut Categorny:

[ =fault Sl
Labels 12345

Currency
Font Percentage

Scientific I use regional formatting

Decimal places:
Maijor Tick Marks

I use 1000 separatar []
Minor Tick Marks

" showwaluesin:  [Thousands b
Fill

™ Showrzera as: - e
Border

Megative numbers:

Shadaw

Current regional settings: English (South Africa)

eio | Cancel_|

FIGURE 12-46 Formatting the numbers for the chart

A few final steps are all you have left to do. The background ranges are not
relevant in this case—they are useful when percentages are being used. Delete
each of the ranges (see Figure 12-47).

X Delete Range

| L O Gauge Panel 3

%'  Range Properties...

FIGURE 12-47 Deleting the background for the range
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Now you have just some formatting to finish. For the LinearPointer1, click the
arrow and choose Pointer Options. Change the width percentage to 25%, as
shown in Figure 12-48.

Linear Pointer Properties _ 5]

Pointer Dptions 5
Set pointer's type, style and placement options.
Action
Painter Fil Walue:
Printer Border hsum[MEt”wa'“A"g]] [~ il
Shadow

Paointer type and style options

Pointer type:

Ea—

Bar start:

ISca\eStar’t | A |

Placement and size options

Placement (relative to scale]: Distance from scale [percent]:

|Cr055 jil |n :’il
Width [percent]:
[ 3 |

FIGURE 12-48 Setting the size of the pointer

Next, select the Pointer Fill tab and change the fill to solid black. Click OK, and
get to the same settings for LinearPointer2. Change the width to 5% and the
length to 80%, as shown in Figure 12-49.

Change to the Pointer Fill tab, and change the color to solid orange.

Repeat the process a third time for LinearPointer3; set the width to 5% and the
length to 80%. Switch to the Pointer Fill tab, and set the color to solid blue.
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Linear Pointer Properties 5[
Painter Options ) )
Set pointer's type, style and placement options.
Action
Painter Fil Walue:
Painter Barder I[SumnNorldBestGDP]] ﬂ il
Shadaw
Pointer type and style options
Pointer type:
IMarker | A |
Marker style:
IRectang\e - ;3 |
Placement and size options
Placement (relative to scale]: Distance from scale [percent]:
ICross | A | Iﬂ :l P23
Width [percent]: Length [percent]:
B = & [ H £

FIGURE 12-49 Formatting the pointer

To finish off, shrink the row that the bullet graph is embedded in, and run the
report. Your report should look similar to the one in Figure 12-50.

REPORT FORMATTING

There are many things that you should do to this report to aid readability—
modify color choice, change the numbers on the scale to be legible, use
tick marks instead of numbers, or change the borders on the bullet graphs.
These formatting modifications would all be additional to the basics of
building a bullet chart. Also, instead of just purely ordering alphabetically,
ordering by region would enable much better comparisons.
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Country Name

Australia
Austria
Belgium
Canada
Chile
Czech Republic
Denmark
Estonia
Finland
France
Germany
Greece
Hungary
Iceland
Ireland
Israel
[taly
Japan
Luxembourg
Mexico
Metherlands

Mew Zealand

Metric Value
48 6

514

59.2

46.2

34

— ZI
mems— |
— |_ )
— ]
— |
——— 1
— |
— 1
———— ]
—
—_— fl
=1 :|
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.JD Current report server http: ffmgs-mee00fReportServer_SQL2012

FIGURE 12-50 A bullet chart

HTML5

For your HTML5 visualization, you are going to implement the treemap visu-
alization shown earlier in this chapter under the HTML5 examples. Although
you would typically use the C# web service from Chapter 9 to return the JSON
required, in this section you find out how to use SQL Server stored procedures
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to create the JSON. You copy it manually, but it could just as easily be used
to supply server-side code to create the JSON.

You will need the files available from this book’s page on Wiley.com called
Chapterl2_Treemap.js. All the editing can happen in any text editor, such
as Notepad++.

You will need the following:

Base.css
Excanvas.js
Jit.Jjs
Treemap.css
Treemap.html

Treemap.js
Treemap.html simply references the appropriate JavaScript files.

Treemap.js contains the active code. The first section is the function init (),
which is fired when the page is open. The code var json={} is the data
piece—you will paste the code you get from SQL over the {}.

The next call is to initialize the treemap object:

var tm = new $jit.TM.Squarified({
//where to inject the visualization
injectInto: 'infovis',
//parent box title heights
titleHeight: 15,
//enable animations
animate: animate,
//box offsets

offset: 1,
//Attach left and right click events
Events: {

enable: true,
onClick: function(node) {
if (node) tm.enter (node)

7

}
onRightClick: function() {
tm.out () ;
}
¥
duration: 1000,
//Enable tips
Tips: {
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enable: true,

//add positioning offsets

offsetX: 20,

offsetyY: 20,

//implement the onShow method to

//add content to the tooltip when a node

//1is hovered

onShow: function(tip, node, isLeaf, domElement) {

}
iy

var html = "<div class=\"tip-title\">" + node.name
+ "</div><div class=\"tip-text\">";
var data = node.data;
if (data.playcount) {
html += "play count: " + data.playcount;
}
if (data.image) {
html += "<img src=\""+ data.image +"\" class=\"album\"
}
tip.innerHTML = html;

//Add the name of the node in the correponding label
//This method is called once, on label creation.
onCreateLabel: function(domElement, node) {

}
1)

domElement . innerHTML = node.name;

var style = domElement.style;

style.display = '';

style.border = 'lpx solid transparent';

domElement .onmouseover = function() {
style.border = 'lpx solid #9FDA4FF';

Y

domElement .onmouseout = function() {
style.border = 'lpx solid transparent';

Y
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/>";

The parameters are the name of the div to insert the visualization into, the
height, the title, whether or not to animate transitions, and how to enable left-
and right-clicks. All of these settings are available from the InfoVis examples
at http://philogb.github.com/jit/static/v20/Jit/Examples/Treemap/
examplel.html.

It's a two-step process to generate the JSON you will paste in. The first step
is a function that creates the individual child nodes, as follows:

ALTER FUNCTION dbo.fn_JSONCountryTree (@RegionName varchar (255)

RETURNS varchar (max)

AS
BEGIN
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DECLARE @Qreturn varchar (max) = ''

DECLARE @tbl Table(CountryName varchar (255), JSON varchar (max),
FullJSON varchar (max))

INSERT INTO @tbl (CountryName, JSON)

select
countryname,
CASE WHEN ROW_NUMBER() over (order by countryname) = 1 THEN '' ELSE ',
' END +
{
"children": [],
"data": {
"GDP Per Capita": "' + CAST( CAST( round(fonr.value /
131.487000,0) as int) as varchar(10)) + v,
"$Scolor": "' + CASE CAST( ROUND( (FOP.Value -

17311.929220) / 7248.925672000,0) + 1 as int)
WHEN 1 THEN '#A50026'
WHEN 2 THEN '#D73027'
WHEN 3 THEN '#F46D43'
WHEN 4 THEN '#FDAE61'
WHEN 5 THEN '#FEEO8B'
WHEN 6 THEN '#FFFFBF'
WHEN 7 THEN '#A6D96A'
WHEN 8 THEN '#66BD63'
WHEN 9 THEN '#66BD63'
WHEN 10 THEN '#1A9850'
WHEN 11 THEN '#006837'
END +'",
"image": "",
"Sarea": ' + CAST( CAST( round(fonr.value / 131.487000,0)
as int) as varchar(10)) + !
I
"id": "' + dc.CountryName + '",
"name": "' + dc.CountryName + '"

1

FROM DBO.FactOECDNationalReserve FONR
INNER JOIN

dbo.DimCountry DC

on FONR.DimCountryID = dc.CountryID
INNER JOIN dbo.FactOECDPopulation FOP
on DC.CountryID = FOP.DimCountryID
and fop.DimDateID = 20110101

and FOP.DimOECDStatisticID = 197

and FOP.value is not null

where fonr.DimDateID = 20110901
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and [geo region] = @RegionName

--and CountryName = 'Austria'
order by CountryName asc

UPDATE @tbl
SET @return = @return+json, FullJSON = @return

RETURN @return
END

go
In this code, the function takes a template JSON in the following format:

"{
"children": [],
"data": {
"GDP Per Capita": "56"
"Scolor": "#FDAE61",
"image": "",
"Sarea": 56

3

and uses values for the GDP per Capita and National Reserve to set the color
and area. A case statement for 11 ranges of color is set up to set the color.
There is also a chunk of code that appends each of the individual countries
JSON to the @return variable. The RowNumber () call adds a comma to each
entry except the first.

The following is the stored procedure that uses this function:

ALTER PROC TreeMapByRegion
as

DECLARE @return varchar (max) = ''

DECLARE @tbl Table(RegionName varchar (255), JSON varchar (max),
FUllJson varchar (max))

INSERT INTO @tbl (RegionName, JSON)

select [GEO Region] ,

CASE WHEN ROW_NUMBER () over (order by [GEO Region]) = 1 THEN "'
ELSE ',' END +
Bt

"children": [' +
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dbo.fn_JSONCountryTree( [gEO rEGION]) + ' 1,

"data": {
"GDP Per Capita": ' + cast( SUM(ROUND (FONR.Value /
131.487000,0)) as varchar(100)) + ',
"Sarea": ' + cast( SUM(ROUND(FONR.Value / 131.487000,0)) as

varchar (100)) + !
Y,
"id": "'+[GEO Region]+'",
"name": "'+[GEO Region]+'"

3

FROM DBO.FactOECDNationalReserve FONR
INNER JOIN
dbo.DimCountry DC
on FONR.DimCountryID = dc.CountryID
INNER JOIN dbo.FactOECDPopulation FOP
on DC.CountryID = FOP.DimCountryID
and fop.DimDateID = 20110101
and FOP.DimOECDStatisticID = 197
and FOP.value is not null

where fonr.DimDateID = 20110901
GROUP BY [GEO Region]
UPDATE @tbl

SET @return = @return + JSON,
FUlldson = @return

SET @return = '{
"children": [' + @return + ' ],
"data": {},
"id": "root",
"name": "Regions by National Reserve and GDP per capita"

3

select @return

GO

This code calls the previous function for each region, and inserts the result
into a table variable using a JSON template. It then uses the same variable
appending logic to put all the regions together into a single string, and adds
the outside wrappers of the JSON format for the treemaps.

To finish off the work, simply paste the results of this query into Treemap.
js where the var json = {} is. Double check to be sure the semicolon is
after the last brace!
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SUMMARY

In this chapter you learned about comparisons using visualizations. For the
most part, all the Microsoft tools are good at this, and you have seen how
to use them effectively. You have also learned more on using the treemap
visualization introduced in Chapter 9.

www.it-ebooks.info

267


http://www.it-ebooks.info/

www.it-ebooks.info


http://www.it-ebooks.info/

CHAPTER 13

Slice and Dice:
Ad Hoc Analytics

The term slice and dice has been a synonym for business intelligence (BI) and
probably predates that term. With the advent of online analytical processing
(OLAP) tools, business users became able to manipulate large data sets, and
apply summaries such as SUM and COUNT across custom groupings in real-
time—this capability is what is known as slice and dice. A better term is really
ad hoc analytics because slice and dice was originally used purely for tabular
data, and later advances mean that more graphical visualizations can also
be interrogated in the same manner. In this chapter, you will learn about the
different types of ad hoc analysis and explore the value of each of the tools.

OLAP

OLAP stands for online analytic processing to distinguish it from online
transaction processing (OLTP) and batch based analysis. The term was first
coined by Edgar F. Codd in 1993. Microsoft joined the market in 1998 with
Analysis Services and today has the biggest market share in OLAP. Later
technologies, such as the column-store database used in PowerPivot and
Analysis Services Tabular are not OLAP, but are presented in a very similar
way to front-end tools to maintain backward compatibility.
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EXPLANATION OF TERMS

The field of ad hoc analytics is vast and murky, with different vendors per-
petuating their own terminology. Microsoft, as always, does the same, and it
is important to understand the different way the tools are defined.

First, ad hoc analytics needs to be differentiated from the way the term analyt-
ics is used in general. The term is often used as a synonym for predictive ana-
lytics, statistical analysis, or machine learning. These fields (to some extent one
and the same) are all based around the concept that an analysis is being done
mathematically and probabilistically—far outside the scope of this chapter.

Instead, ad hoc analytics is the analysis by a person of a data set, by dynami-
cally applying filters, grouping, and aggregations until a result is discovered.
This process, as mentioned, is also called slice and dice, and (outside the
Microsoft space) is called data mining as well. Data mining in that context is
analyzing data to derive value. However, Microsoft has a tool as part of its
Analysis Services called Data Mining Extensions and a language DMX, which
are in fact a statistical toolset. This distinction is important as it can lead to
some confusion!

Some other important terms that are often confused are covered next.

SELF-SERVICE BI

Self-service Bl is another one of those hot industry topics with confusion
attached.

In the first definition, self-service Bl simply refers to the ad hoc analytic capa-
bility described in the preceding section. Data has been prepared, possibly in
a data warehouse, loaded into a Bl tool, perhaps OLAP or not, and then the
business users are allowed to interact with the data in this controlled manner.

At the other end of the spectrum is the self-service user who is gathering his
own data and then building his own reports. Typically, as seen in Figure 13-1,
this is easy enough when a single source of data (such as an ERP system) is
available, but this becomes much more difficult after multiple sources of data
are required to be combined, such as a CRM and an ERP system, with the pos-
sibility of duplication and data mismatches.
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SSBI

Extract Data
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FIGURE 13-1 Self-service Bl lifecycles

As with everything in life, the best approach is often a middle-ground: allow-
ing a Business Intelligence Competency Center (BICC) to do the large part of
combining data and then opening the door to business departments to use the
centralized data sources, but also to expand and integrate their own sources.

THE PLACE OF POWERPIVOT

A common misconception is that PowerPivot is a visualization tool. Aside
from the ever-present table visualization, PowerPivot is not a visualization
tool in the slightest—no graphs or charts are part of the toolset. Instead,
PowerPivot is a data modeling and data integration tool aimed at a business
user. Incorporating Microsoft’s xVelocity engine, an in-memory column-store
analytic database at its heart, and a new functional language called DAX (for
Data Analysis Expressions). Where PowerPivot sits is as a bridge between users
and IT. Business users can create their own analyses, combining data from the
corporate data warehouse as well as their own formulae and possibly external
data sources. They can start sharing these analyses with their team by publish-
ing to a collaboration portal built in SharePoint and using PowerPivot services
to do the calculations. The final step in an enterprise Bl scenario is when the
business has decided that this analytic workbook is business-critical—which
decision is often driven by usage metrics on the workbook in questions—and
IT is asked to take it over. At this point, the workbook is imported into Analysis
Services using Visual Studio, optimized using such techniques as partitioning,
role-based security suiting the data within the workbook, and then deployed
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to a production server and monitored on an ongoing basis. Figure 13-2 shows
a typical example of such an environment.

Bl Environmant

i wgﬁﬂ T @]|| ¢

£ S S = = — SQL Server
117 ol |||>9

é- Mic h< -

: SharePoint

\>j
)

ndividual

(L
e’

/
\

/

FIGURE 13-2 Bl environments using Microsoft tools

PowerPivot thus sits as the glue holding many of the visualization tools
together.

BISM

Microsoft talks about the Business Intelligence Semantic Layer (BISM) as the
common term across the OLAP and column-store worlds. The semantic
layers serve as a single common point to store calculations and business
terms—this means that when a calculation changes due to changing
accounting regulations or other reasons, it can be changed in a single
central location rather than having to edit every report and dashboard
containing the calculation.

DEFINITIONS

There are several terms in general use as verbs when doing ad hoc analyt-
ics—each of these will be covered in the section ahead—these terms are
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used throughout the book, and indeed the industry, so this will be a useful
section. The terms are:

Pivot

Drill down (Drill up is the reverse)

Drill through

Drill across (not to be confused with cross drill)

Slice

Pivoting

Excel popularized the pivot table, an indispensable tool for any analysis.
Pivoting refers to the ability to drag any field into rows or the columns, and
then view the data aggregated across those fields. Figure 13-3 shows a typical
Excel pivot table and pivot chart beside each other.

Sum of ReserveValue Column Labels | ~
Sum of Reservelfalue
#2011 #2012
$25000 000.00
T
EowLabely 520000 000.00
# Africa S 110813.40 S 199625.20
# Asia + Pacific $ 12599193.50 $20683787.90 31500000000 LT J—--
# Europe $ 401365200 $ 731969558 Slonthiame -
4 latin America + Caribbean § 135941520 $ 2790649.60 510000 000.00 Date e
2011
Grand Total $ 18083 075.00 $30993758.28 "

55000 000.00

. _ II =il

Africa Asia + Pacific  Europe  Latin America
+ Caribbean

m 2012

GEQ Region vY GEQ Subregion = CountryMame -

FIGURE 13-3 Apivot chart in Excel

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel Yes '

PerformancePoint Yes .

Power View Yes .

Reporting Services No .

Silverlight/HTML5 N/A
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Drill-down

A drill down requires a hierarchy, a predefined relationship between data
values. The hierarchy that will always appear in any Bl analysis (with many
different versions) is the date hierarchy. In the most common date hierarchy,
the calendar date will be defined as Year-Month-Day, with the drill down
corresponding to that. Drill downs are most commonly shown with a “+” to
allow drilling down. The inverse of a drill down is a drill up, which will col-
lapse the expanded drill down, and this is most commonly shown with a “-".
PerformancePoint analytic charts are an exception—drill down is achieved
by clicking the dimension member name, and drill up requires a right-click.

Figure 13-4 shows a drill down in Excel.

A B C D E F G H
1
2 ReserveValue Column Labels | ~
3 Row Labels LT #2011 2012
4 = Africa 3 110813 $ 199625
5 =l Asia + Pacific s 12599194 520683 788
[ #Haustralia+ New Zealand & 157106 5 274520
T #INorth East &sia s 11438042 518524455
8 H5outh Asia g 725038 5 1396468
9 H5outh East Asia g 273007 5 438345
10 #Europe H 4013653 5 7319696
11 # Latin America + Caribbean & 1350415 § 2790650
12 Grand Total S 18083075 530993758
13
14 Reservevalue
13 520000 000
16 $18000 000
516000 000
1 514000 000
18 512000 000
13 510000 000
$8000 000 MDD -
20 56000 000 m2011
21 54000 000
$2000 000 I m 2012
z oo —_ 1 |
23 Australia+  NerthEast  SouthAsia  South East
24 New Zealand Asia Asia
25 Africa Asia + Pacific Europe Latin America
75 + Caribbean
27 Regions T

vobg
-3

FIGURE 13-4 Dirilling down on a pivot table and linked pivot chart
The display of the undrilled values next to the drilled values is by contrast to

PerformancePoint, which replaces the values with the drilled-down ones (as
you will see later in this chapter).
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Ease of Development

REPORTING TOOL PREDEFINED CHARTTYPE  EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes .
Power View Yes .
Reporting Services Yes .
Silverlight/HTML5 N/A
Drill through

Drill through, although often confused with drill down, is distinct in that it
often opens up a completely new visualization. This is a great technique for
when you need to display information in a completely different format—for
instance, you are looking at a management summary and you need to view the
transaction detail. Excel provides a default drill-through action, which shows
the detail from the underlying table—this is provided by double-clicking the
data point you need to analyze further. A new sheet will be created with all the
lines that contribute to the number you clicked, as you can see in Figure 13-5.

A B C
1 |Data returned for Reservel/alue, Asia + Pacific - South Asia, 2|J11 (First 1000 rows),

[$FactOECDNationalReserve].[OECDNationalReservelD] B [$FactOECDNationalReservel].[Active] Bl [$FactOECDNationalReserve].[Value] B
352 i 182375

353 1 183700
354 1 181633
355 1 177330

o m o m wom

FIGURE 13-5 A table of data displayed by Excel after a drill through

Reporting Services gives you much finer-grained control of drill through,
allowing you to specify other reports or even URLs and JavaScript commands.

ANALYSIS SERVICES

Analysis Services in multidimensional mode allows for a large variety of
drill-through actions to be defined on the cube, specifying which columns
should be returned or sent to a report. Excel, Reporting Services, and
PerformancePoint all support these actions, but they are not available in
tabular mode SSAS and PowerPivot.
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GDP per hour

[ Asia + Padfic

= Eurape
[ Central Europe
=l Eastern Europe

Russian Federation

@ Western Europe
=i Latin America + Caribbean

&1 Meso America

2 South America

& North America

GDP Per hour
40.43
44.88
28.25
21.26
21.26
5173
19.13
18.23
20.03

45.59
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Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel Yes .

PerformancePoint No

Power View No .

Reporting Services Yes .

Silverlight/HTML5 N/A

Drill across

A drill across is done by clicking one component on your screen and having
another component update according to your selection. This is distinguished
from the traditional filters and the slicers we will discuss next because the
drill-across item contains data—for instance, clicking a line in a scorecard that
has a red indicator and having the chart alongside update automatically is a
drill-across. An example of a drill-across is shown in Figure 13-6.

Value Added by Activity -
Target 2

48.60 @ -17%
8L50 (7 -45%
35.90 () -21%

22.00 @ 3%
200 @ 3%
8150 (7 -37%
20,90 (@ -8% "
19.75 (@ 8%
20,90 @ 4%
46.20 @ 1% 5

0

W "alueaddedin agriculture

Wl valueadded infinancal interme.
[l Value addedinindustry

[ "Value added inwhalesale and r...
Il Value added in construction

[l Value added inother servios act

2001 2003

FIGURE 13-6 Drilling across from a PerformancePoint scorecard to an analytic chart

www.it-ebooks.info


http://www.it-ebooks.info/

SLICE AND DICE: AD HOC ANALYTICS 277
Explanation of Terms
Ease of Development
REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel No .
PerformancePoint Yes .
Power View Yes .
Reporting Services No .
Silverlight/HTML5 N/A
Slicing and Slicers
A slicer is very similar in concept to a drill across, except that the slicer doesn’t
contain any information. It is a new way of showing a multiselect filter. One
innovation is that slicers change color depending on whether data is contained
within the data set. Figure 13-7 shows a slicer in Excel: It is easily apparent
that although North America and Latin America are not selected, they do
contain data that could be used if they were selected; Polar and West Asia
do not contain data.
ReserveValue Column Labels | - GEO Region B GEO Subregion * CountryMName A8
Row Labels -T| #2011 +2012
 Africa s 110813 § 199625 [ Africa ]; [ Central Europe ] b [ South &frica ]i
= Asia + Pacific s 12599194 520683 788 [ Asia+ Pacific ] [ Eastern ELrope ] [ Australia ]
Haustralia + New Zealand 5 157106 S 274520 =
- [ Europe ] [ Western Europe ] [ Mew Zealand ]
Hhorth East Asia 5 114358042 518524455
Ssouth Asia g 735038 % 139 468 Latin America + Carl... Meso America
#South East Asia 4 279007 & 488345 Maorth &merica South &merica
*Europe S 4013653 % 7319696 =
Grand Total $ 16723660 $28203109 Polar r Marth america
tlact faia :I Cantral Afrira bt W
520000 000
516000 000 .
510000 000 D -
56000 000 m20m
$2000 000 .
T - e
Australia + New North East Asia South Asia South East Asia
Zedland &
Regions +T Finland ;I

FIGURE 13-7 Slicers operating in conjunction with a pivot table and chart
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Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel Yes .

PerformancePoint No .

Power View Yes .

Reporting Services No .

Silverlight/HTML5 N/A

TOOL CHOICES WITH EXAMPLES

Ad hoc analysis is an area where the Microsoft tools diverge quite sharply.
Reporting Services is not designed for this at all, and PerformancePoint shines
on guided analysis. Excel, including PowerPivot and Power View, is truly the
best tool for unguided analysis and data discovery.

PERFORMANCEPOINT: ANALYTIC CHARTS

PerformancePoint is great for guided analysis when known conditions are
exceeded or not met, for instance when a particular store does not meet a
sales target, or an item is overstocked and some further analysis is required.
The ability to drill down to the particular store and then do an analysis on
how many salespeople are allocated to that store or break down the stores
sales by product is one of the key strengths of PerformancePoint. Figure 13-8
shows an analytic chart that drills across to the UK sales figures and drills down
to the months for 2007.

Right-clicking October 2007 brings up a context menu that enables us to do
a Decomposition Tree and determine what figures make up that low sales
figure in October. As you can see in Figure 13-9, a large amount of additional
information can be gleaned from the Decomposition Tree.
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Sales Filtered Sales Chart
Actual Target 800K 0%
2 sales s41,993,730  $37,415,000 @ 12% Sales Amount
N See 255,
=1 Europe 59,015,796  $9,376,000 () 4% Dril Dowin
. 500K
& France s3,400,129 52,940,000 @ 16% Drill Doven To 3
0%
= Germany §2,157,272 51,294,000 @ 67% Dril Up
[@United Kingdom ~ §3,458,394 55,142,000 ¢ -33% 00k Shouw Only 155
e ® [l slesAmount
@North America  £29,096,719  $27,172,000 @ 7%
Select Measures. . ~ Gross Profit Margin
@ Pacific 3,881,215 £867,000 (@ 346% 10%
Switch to "October 2007"
200K i)
Decomposition Tree
5%
Show Details
13 S0
January 2007 March 2007 May 2007 July 2007 September 2007 sok
February 2007 April 2007 June 2007 August 2007 Filter »
Pivot
Show Information Bar

FIGURE 13-8 Opening a Decomposition Tree from an analytic chart

Sales Amount Category - Isuh:ateqory | {Pmduct ™ {Date -
Mountain-500 Black, 52 %
$539.99
0.6% of "Mountain Bikes"
0.2% of "October 2007"

I
18K Mountain-200 Bankdp-ofd
—— Expand To | Show Properties
18K Mountain-200
e Class: Low
15K Mountain-200
— Color: Black
9,180 Mountain-20 Days to Manufacture: 4
ey
9,180 Mountain-20 Dealer Price: 323.994
— .
7,424 Mountain-20 End Date: Active

232K Bikes R - List Price: 535.95

88K _Mountain Bikes 2,308 Mountain-40

Model Mame: Mountain-500

— 19K Companents — .
272K October 2007 72K Touring Bikes 1,465 Mountain-50 Reorder Point: 75
11K Accessories — .
M 72K Road Bikes 1,356 Mountain-50 Safety Stock Level: 100
9,461 Clothing [} Size: 52
1,356 Mountain-50 )
i Size Range: 48-52 CM
923 Mountain-400- Standard Cost: 254.5757
[}

864 Mountain-500
769 Mountain-400-
[

540 Mountain-500

I
540 Mountain-500 ¢

Start Date: July 1, 2007
Status: Current

Style: Unisex

Subcategory: Mountain Bikes

Weight: 28.68

FIGURE 13-9 A PerformancePoint Decomposition Tree
The analytic chart can also be rearranged significantly to view alternate rollups.

In Figure 13-10, | have drilled to November 2007 and filtered for the bottom
10 mountain bikes by Sales Amount. Immediately apparent is that although
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we have a spread of low-selling bikes, the Mountain-400 W Silver is a very
profitable bike, so when talking to the store about doing a promotion, that is
most likely the bike to focus on first.

Sales Davhboard : Sales | Reseler Saks

Froduct Category: AN Products ¥

oate formube: [Curvent vear =

Sales Flltered Sales Chart
Aczusl Torget L0 50%
sales s AL @ un L
Surase ST S [ % -
2200
B France £,400128  52.990,000 @ 16%
woemery s L4000 @ 6% 000

Buntedkngem  $450,384 SS4LU00 g 3%
wlorhArerka  £20,006,718 322,172,000 @ 7%
pree. SeeL26  ST00 @ N

I Ssles Amosnt
WH - Gross Profitmgs

. ——
¥ Mounlsn 300 Siver.  Mounksin$00 Black~.  Mourkain-500 Black.,  Musstain-500 Siver.  Mounkein-500 Slver.,
Sih. o HOUEAINS00 Biack..

FIGURE 13-10 Additional analysis within PerformancePoint

One key factor to always remember with PerformancePoint analytic charts is
that they are dependent on having well-designed hierarchies to create a rich
visualization environment.

PERFORMANCEPOINT: DRILL ACROSS

PerformancePoint has an exceptional strength in that it allows for drill across
to non-PerformancePoint components that are on the same dashboard.

A great example is combining GIS visualizations from SQL Server Reporting
Services (SSRS) and filtering them by the PerformancePoint scorecard on the
same page, as shown in Figure 13-11.

Progress
Actual Target
Al 3782.65 [¢)
@EasternCape | 59463 929.17 (7 -36%
@Free State 32208 929.17 @ 65%
[ Gauteng 15779 929.17 @ 83%

520,17 929.17 @ 0%
i 31526 929.17 {fp 6%

@ Mpumalanga 23155 929.17 df 15%
@ North West 26578 929.17 @ 7%
@Northern Cape 440.53  929.17 @ -53%
@Western Cape  525.85  929.17 () 3%

Pretoria
[u]

FIGURE 13-11 Combining PerformancePoint and Reporting Services
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This cross-filtering works only from a PerformancePoint scorecard, not the
analytic chart. It can, however, be used to filter an analytic chart by a scorecard.

EXCEL PIVOT TABLES

Excel pivot charts are by far the most widely known of the slice and dice tools,
and they have a flexibility that none of the other Microsoft tools do. Excel
pivots can be created against any data contained within Excel, but they do
work much better when they have a solid data model to work from.

The pivot tables can be built up manually, but it is a lot more work because
each level has to be added individually, and the subtotals removed. An example
of such a pivot is shown in Figure 13-12.

There are other benefits to putting the data into a model first: centrally con-
trolling the structure is the first benefit, the additional calculation power of
DAX becomes available, and the data volumes that can be handled increase
exponentially. The improved interface is shown in Figure 13-13.

Finally, when Excel pivots are deployed to Excel Services in SharePoint, they
can be connected to PerformancePoint scorecards—the scorecard row values
connect up to the slicers and change their values.

A B C D El~

1 FivatTable Fields v
2 sum of Reservevalue Column Labels = X

Choose fields to add to report: A
3 +2011 +2012
4 /| GEO Region
5 Row Labels = /| GEO Subregion
4 = Africa § 11081340 § 19962520 7| CountryMame
7 + Asia + Pacific S 12599193.50 S 20 683 787.90 | YearMame
8 + Europe S 401365290 S 7319695.58 +| MonthName
9 # latin America+ Caribbean § 1359415.20 $ 2790 649.60 /| Date
10 + North America [ 166 852.60 | $  300560.90 I | ReserveYalue
11|  Grand Total $ 1824992760 $31303319.18 MIORE TABLES..
12
13

Dirag fields between areas belows:
14
15 FILTERS COLUMME
18 WearMame hd
17 tonthMarne =
18 Date -
18
20
71 ROMYS I OWALLES
22 GEC Region Sum of Resenv., ™
23 GED Subregi., *
24 CountryMame *

=
w

e

FIGURE 13-12 Editing a pivot table
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Show fields: | FactOECDM.. ~ -

4 X FactOECDNationalReserve -
| ReserveValue

4 [5] DimCountry

> || Regions

b [ More Fields
4 D DimDate

b [v] YMD

[ [ More Fields

4[5 FactQECDNstionalReserve
Active

Drag fields between areas belows

FILTERS COLUMNE
YD -
ROWS ZVALUES
Regions M Reservelalue =
Defer Layout Update

FIGURE 13-13 The Pivot-
Table Fields task pane, where
fields are added to the table
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SSRS DRILL DOWN AND DRILL THROUGH

Reporting Services has the capability of doing both drill down and drill through.
Each one of these has to be built in manually—the drill down is not particularly
complex, but the drill through does require some work. Figure 13-14 shows
the drill down enabled.

S
Total  Tetal  Total  Tol
$27885.10 $3,193457.20  $999249.57  §343 46350 4276640
$27F99.40 $3194457.00 98347913 §341846.40  B4226180
$27 419.40 $311012210 $1004709.08 §33408180 $41,141.40
$27809.50 $3101117.20 $1026214.63 33402350  $400693.30
$110,813.40 $12599,193.50 $4,013652.90 $1,369 41520 $166,852.60
$199,525 20 §20583 787,50 §7, 31969558 $2,790 64960 $309,560.90
$310,438 60 53328295140 $11, 333348 48 $4,150064.80  $476,413.80

FIGURE 13-14 A Reporting Services matrix with drill down enabled

Figure 13-15 shows the setup screen for creating an action. Individual fields
within the report table get passed to the report that is linked to, which gives
a great deal of control over how the action works to the report designer.

Text Box Properties | x|
General
Change action options.
Number
Alignment Enable as an action:
o
Font Mo
% Goto report
Border
" Go to bookmark
Fill
!  Goto URL
Wisibility

Specify 3 report:

IfDrlIIuown B | Browse.. |

Use these parameters to run the report

Add | Delete |

Interactive Sorting

Mame |Va|ue |Om\t |
foat = 2] £

s | e |

FIGURE 13-15 Configuring drill through in Reporting Services
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POWER VIEW
Power View is a data exploration tool, embedded within both Excel 2013 and

SharePoint (installed from SQL).

Obviously, as a data exploration tool, it is squarely aimed at slice and dice
analytics. It does require a data model to create these interactive dashboards.

Power View has a few key benefits over the other tools:

Automatically connected slicers
Integrated graphics (for instance, pictures of products)
Tiled views
Animations
Integrated maps
Although they are great features and very welcome, Power View's great dis-

advantage is that it is impossible to integrate with the other tools. It is purely
a standalone tool.

Figure 13-16 shows slicing by region and drill across by selecting specific
months, as well as a tiled view of products.

SuntT rand, and MonthNarr Region
OHNSON'S ENTHERIC MAYBELLINE tastern Cape
0.3M Free state
= Gauteng
0.2M Limpopo
g Mpumalanga
“01M II Nata
. . Nnebtnrn £
oM 100K
UMM SALLY YARDLEY 1 Il PercyoY
03M 80K W ProfitMargir
T 02M ©O60K
< 0am I I I I I Aok
oM I 20K

Apr May Jun Jul  Apr May Jun Jul  Apr May Jun Jul | 0K

FIGURE 13-16 A Power View report sliced by specific months
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In Figure 13-17, tiles with product images are used to slice the sales amounts
in the column graph below:

mb_l‘dgi._, 7 e

BEAUTY

=
X o

AmountTY by MonthName
700
6500

500

400
300
200
100
Apr May Jun Jul

0

FIGURE 13-17 A tiled view in Power View

IMPLEMENTATION EXAMPLES

The implementation examples all use the OECD_Data model, so be sure you
have downloaded them from this book’s web page on Wrox.com.

SSRS: DYNAMIC MEASURES

Although Reporting Services isn't as dynamic as the other tools by default, it
is an exceptionally powerful toolset, and some measure of ad hoc analytics
can be enabled by using expressions.

For the purposes of this exercise, we will build the report by pulling in all the
data we require and then use expressions to choose which items to use. You
can also create dynamic queries, which will often perform much better.

Start by creating a new report in Report Builder and connecting to the OECD_
Data tabular model. Create a new data set named dsOECD and pull the fol-
lowing fields onto the design surface:

Measures > Reserve Value
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Measure > MetricValueAvg
Measure > MetricValueMax
Measure > MetricValue
DimCountry > Regions
DimDate > YMD

DimOECDStatistic > Statistics

Your query designer should look similar to Figure 13-18.

=gl
Dedwier G| %P PE[EX® & 1 n[E]
T =] [ ey = T T
B ]
[y
e o
3 o
& s e e e I o e e T e e e |
" L3 PR Bt 0| heoy 000 Enerpy. fergys toee Towl s Southem Aics S Afica il s 158 154
iy Reservealiue 2000 hewary 000 Enerr. Enermye. o Toalo  dalee Fodfic  Austnlie Ne.  Austals i Y s me
WAooy W00 Ewm teme. e Tol. Alve P AutmlneMe.  NewZend il f w e
W mewy 900 Eneidy. temvo. . Tl AlbeRoRc Memntatas  Crin o 106 1064 e
000 meoy M0 Enegy. targyp. far Tomi_  Aivefanc  Nomnfitass | hipin i wsa s uss
000 meay N0 g Dagype (. Temio A fne Somas e i 2ea sk i
000 meay N0 gy Dargype (. Temio  Avefanc  Soumfutam  comsa | fun B xa nex
000 mmay 00 Energy. fermpe . Tow. fumpe  Cenumfurope  CoranRepubdc g s ) nr
W0 ey N0 gy bewp. Gen Tobl. fwope  Cealfucpe  Esiona il 12 1 n
W0 ey N0 ey bargyp fen. Toi_ fuspe  Conifupe  Hungy i) 1w s s
W hewy W00 Enegy. foergrp foee. Tow Euope  Conbalfuope | Poand it e ns ns
W0 meoty 00 Enemy. tevp. Ewe. Toml. fwepe  Cenitwope  Simens o N 1 1
W0 meoy 00 Enemy. tevo. Ewe. Toml. fwepr  Ceitwope  Tumey un 3 53 53
W0 meowy 00 Eem tve. e Totl. fwope  EwwmEwose  busanfest.  fuil o o ”m
W00 meowy 00 Eem. teve. e Tobl. fwepe  Wetemtwoos  Aut i s 0 i
W00 Aoy 00 Eemy. temo. e Totl. twope  Wetemtwops  bdigum i 81 i) v |
| || |

FIGURE 13-18 The Report Builder query design screen for Analysis Services

Next, create three new parameters: Measure, X-Axis, and Y-Axis. Use XAxis and
YAxis for the actual name, and use X-Axis and Y-Axis for the prompt. For the
Measure parameter, add the Available Values shown in Table 13-1. The Value
fields are going to match the cube fields exactly so that this report can be
used with PerformancePoint later. Set the default to ReserveValue.

TABLE 13-1 Measure Values

LABEL VALUE

Reserve Value ReserveValue
Metric Value Avg MetricValueAvg
Metric Value Max MetricValueMax
Metric Value MetricValue

For the X-Axis and Y-Axis parameters, use the values Table 13-2. Set the X-Axis
default to Year and the Y-Axis default to GeoRegion.
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TABLE 13-2 Measure Values

LABEL VALUE

Year Year

Month Month

Date Date

Subject Subject
Category Category
Area Area

Metric Metric

Region GeoRegion
Subregion GeoSubregion
Country CountryName

This sets up the basics for the report. Next, you create the dynamic fields that
will use the parameters. Right-click dsOECD and click Add Calculated Field.
Call the new field Measure and then put the following expression into the
expression box (as you can see in Figure 13-19).

Dataset Properties Lll

Query T x|

Change query &
Set expression far Value
N =switch(

Options Add | Delete Parameters!MeasureNalue = "Reservevalue”, Fields Reservevalue Value
] ParametersiMeasureValue = "MetricWaluedug”, Fields!MetricvalueAvg. Value

Filters Field Name

Parameters!Measure.value

hMonthhame

Parameters vearname Parameters!MeasureValue = "Reservevalue®, Fields!Metricvalue value

"MetricWalueMax", Fields!MetricvalueMax.value

Calegory -
Subject W
W - Buitin Fisids

Farameters

IA”“— - Fields [dsOECD)
- Datassts

Reservetalue Wariables
Operators

lm Common Functions

M etricy'alue g
Help
CountryMame

Mo constants are available for this
propety.

Cancel
A

IMetr\cVaIueMax |<?5(ml wersion="10" encoding="utf-§"

IMeasure I«Exprn

@

Help oK | Cancel

FIGURE 13-19 The calculated measure expression
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=switch(

Parameters!Measure.Value = "ReserveValue",
Fields!ReserveValue.Value

,Parameters!Measure.Value = "MetricValueAvg",
Fields!MetricValueAvg.Value

, Parameters!Measure.Value = "MetricValueMax",
Fields!MetricValueMax.Value

,Parameters!Measure.Value = "ReserveValue",

Fields!MetricValue.Value

This piece of code sets the value of the Measure field to the value of the field
chosen by the user. Next, we will do the same for the X-Axis and Y-Axis fields.
Create two new calculated fields called XAxis and YAxis. The code for the
X-Axis is shown in the following snippet:

=switch(
Parameters!XAxis.Value = "Year", Fields!YearName.Value
,Parameters!XAxis.Value = "Month", Fields!MonthName.Value
,Parameters!XAxis.Value = "Date", Fields!Date.Value
,Parameters!XAxis.Value = "Subject", Fields!Subject.Value
,Parameters!XAxis.Value = "Category", Fields!Category.Value
,Parameters!XAxis.Value = "Area", Fields!Area.Value
,Parameters!XAxis.Value = "Metric", Fields!Metric.Value
,Parameters!XAxis.Value = "GeoRegion", Fields!GEO_Region.Value
,Parameters!XAxis.Value = "GeoSubregion",

Fields!GEO_Subregion.Value

,Parameters!XAxis.Value = "CountryName",

Fields!CountryName.Value

The code for the YAxis is very similar, as you can see:

=switch(
Parameters!YAxis.Value = "Year", Fields!YearName.Value
,Parameters!YAxis.Value = "Month", Fields!MonthName.Value
,Parameters!YAxis.Value = "Date", Fields!Date.Value
,Parameters!YAxis.Value = "Subject", Fields!Subject.Value
,Parameters!YAxis.Value = "Category", Fields!Category.Value
,Parameters!YAxis.Value = "Area", Fields!Area.Value
,Parameters!YAxis.Value = "Metric", Fields!Metric.Value Value
,Parameters!YAxis.Value = "GeoRegion",Fields!GEO_Region.Value
,Parameters!YAxis.Value = "GeoSubregion",
Fields!GEO Subreglon Value
,Parameters!YAxis.Value = "CountryName",

Fields!CountryName.Value

Now finish by adding a new column chart, using the fields as shown in
Figure 13-20.

www.it-ebooks.info

287


http://www.it-ebooks.info/

288 VISUAL ANALYTICS IN PRACTICE

Arrange chart fields

Add data fields to the chart. For most chart types, a field in the Categories list is displayed on the x-axis. A field in the Values list shows
aggregated data on the y-axis. A field in the Series list creates a new series in the chart.

Available fields [ series
GEO_Region XAxis
GEO_Subregion

CountryMame

YearName

MaonthName

Date

Subject

Category

Area

Metric

Metricvalue

MetricValueAvg E Categories ¥ values
MetricValuchlax YAxis Sum(Measure] -
ReserveValue

Xhxis

YAxis

Measure

<Back || Net: | | Cancel

FIGURE 13-20 Laying out the chart

Choose the generic template, click Finish, and run the report to see a report
such as the one shown in Figure 13-21.

Messure [Rezervevalue =] Ry [rear |
Yaxis  [region -]
——
Chart Title
5000000000 — . Africa
I Asia + Pacific
B Europe
M Lotin America + Caribbean
N Morth America
4000000000
3000000000 |
Y
3
2000000000 —
1000000000
0 v v v T v - '
2000 2005 2008 2008 2010 2011 2012
Axis Title

FIGURE 13-21 Achartin Reporting Services
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There are some very obvious limitations with this report—years are rolled up
months as opposed to the last value for the year, the formatting is not cor-
rect—but the obvious first issue is that the report is exceptionally slow and it
will always return all the data. To rectify these problems, go back to the data
set; add the Regions, YMD, and Statistics hierarchies to the filter; and click the
Parameterize button, as shown in Figure 13-22.

Query Designer E —[a] x|
ek asText [Fimport.., | 33 3 R XxBatow
(3 Model .. | | pimension [ Hierarchy [ operator [ Fitter Expressian [ Parameters |
\g Metadata | DimCountry Equal O Ird
e DimDate Equal tomn amoy I
<Al || | pimoEcDstatistic A, statistics Equal N v
3 Magel <Select dimension>
al Measures
= ks
|2 pimCountry
15 Dimbate VearName | MonthMame | Date | Subject | Category | Area | Metric | GEORegion | GEG subregion | i’
19} DImOECDStatistic 2011  January 201L. Energy.. Energyr. = Nuc. Nuce. & Africa Southern Africa | §
1 FactGECDRationalReserve 2011 Januany 2011. Energy. Energyr. Nuc. Muce. Asia+ Pacific | Morth Eastésia | C
|2 FactoECDPopulation
2011 January 2011, Energy.. Energyr.. Nud. MNuce. Asia+ Pacdfic  MorhEastAsia K
2011 January 2011, Energy.. Energyr. Nud. MNude. Asia+ Pacfic  South Asia I
2011 January 2011, Energy.. Energyr. Nud. Nude. Europe Central Europe ©
2011 January 2011. Energy.. Energyr. hud.. Mucle.. Europe Central Europe F
2011 January 2011. Energy.. Energyr. hud.. Mucle. Europe Central Europe S
2011 January 2011. Energy.. Energyr.. Kud.. MNucle. Europe Eastern Europe | R
2011 January 2011. Energy.. Energyr.. Hud. MNucle. Europe Western Europe | B
2011 January 2011. Energy.. Energyr. Nud. MNucle.. Europe western Europe | F
R 2011 January 2011. Energy.. Energyr.. hud.. MNucle. Europe Western Europe | F
2011 January 2011. Energy.. Energyr.. hud. MNuce. Europe Western Europe | G
2011 January 2011, Energy.. Energyr. Nud. MNuce. Europe Western Europe | I
2011 January 2011, Energy.. Energyr. Nud. MNuce. Europe Western Europe | §
2011 January 2011. Energy.. Energyr.. Nud. MNuce. Europe Western Europe | §
Help ok Cancel

FIGURE 13-22 The Query designer

This process enables you to parameterize the query and will serve as a basis
for connecting PerformancePoint to Reporting Services.

To finish this exercise, you will make the chart title dynamic and label the
axes correctly.

Start by right-clicking the Axis Title running along the left of the chart, and
clicking Axis Title Properties. Click the Fx button next to the chart title; then
replace the wording with Parameters!YAxis.Label, as shown in Figure 13-23.
The default, if you choose from the parameters at the bottom, will be Value,
but generally speaking, Labels will be more user-friendly.
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Assuming that the
rollups will always be
a SUM is dangerous,
and in this example,
there are indeed
measures that are
MAX and AVG. In a
complete solution,
the rollups will also
be dynamic.

PerformancePoint
can handle both
Native mode

and SharePoint
Integrated mode
reports from
Reporting Services.
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(s 1306
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FIGURE 13-23 Changing the Y axis label

Repeat this for the XAxis and for the Chart title, using ="SuM of " +

Parameters!Measure.Value

Format the axis to have thousands separators as well, and the chart will appear
as in Figure 13-24 when run.

SUM of ReserveValue

25,000,000 W Africa
Asia + Pacific

20,000,000 BN Europe
c 15.000.000 I Latin America + Caribbean
) o North America
& 10.000.000

5,000,000 I
0+ L

2011 2012

fear

FIGURE 13-24 A better formatted SSRS chart

INTEGRATING PPS AND SSRS ON A SINGLE PAGE

One of the strongest uses for PerformancePoint is combining PerformancePoint
content with Reporting Services or Excel Services content and having them
interact. In this exercise, you will create a Date Filter, a scorecard showing val-
ues for average hours actually worked by region, and then embed the report
created in the previous section. You will also set up the scorecard such that
the region changes the region in the report. The date filter will allow your
user to select a date on a calendar, and will display all the months of that
year on the report.
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Start by opening up Dashboard Designer. If you have not used Dashboard
Designer before, you will open it up from the front page of a Business
Intelligence Center in SharePoint, choosing the Create Dashboard tab and
clicking Start using PerformancePoint services to bring up the Run Dashboard
Designer button. Set up the data connection and map the date dimension as
described in Chapter 7. Name the data connection dsOECD.

Right-click the List name (PerformancePoint content). Choose New > Filter
and then Time Intelligence Connection formula. Click OK.

Click Add Data Source; then choose the dsOECD data source. Click Next and
select the Time Intelligence Calendar. Click Finish and name the filter Months
of Year.

Next, select PerformancePoint Content > New > KPI, and call the KPI Average
Hours Worked Per Year. Change the number formats for both actual and
target from Default to Number, and remove the decimal spaces.

For the actual, click 1 (Fixed Values) under Data mappings; then change
the source to dsOECD and click OK. Choose MetricValueAvg under Select A
Measure; then click New Dimension Filter and choose DimOECDStatistic.met-
ric. Click OK, and choose Average Hours Actually Worked by clicking Default
Member (All) and selecting it from the list. Make sure to deselect the default.
Your setup should look like Figure 13-25.

Dimensional Data Source Mapping 5[

Select a measure:

IMetricVa\ueAvg j

Select a dmension:

L+ New Dimension Filker " New Time Inteligence Filter X

Mame | Default
Awersie hours sctuslly worked

Aggregate members by:

IDEFau\t j

™ Use MD¥ tuple farmula

Change Source. .. | OK I Cancel |

4

FIGURE 13-25 Setting up a measure in PerformancePoint Dashboard Designer
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Editor | Properties |

Repeat this process for the target, but also add a dimension filter for
DimCountry.Regions and choose All instead of Default Member (All). Your
setup should look like Figure 13-26.

Dimensional Data Source Mapping 5[

Select a measure:

IMetri:Va\ueAvg

Select a dmension:

¥ New Dimension Fiker G New Time Intellgence Fiter |

Mame

| Default

Aggregate members by:

DimCountry, Regions All
DimOECDSEakistic Metric Awersie hours sctuslly worked

IDaFau\t

r Use MD¥ tuple Formula

Change Source,.. I oK Cancel |

FIGURE 13-26 Adding filters

This process will create a target that is the average of all the countries.

Next, create a new scorecard by choosing “Blank scorecard” from the templates.
Add the KPI to the new scorecard by dragging it onto the design surface, and
add the DimCountries > Regions hierarchy by dragging it onto the KPI name

i« Average Hours

Actual
=) AverageHoursworkedPerYear
Aftica
Asia + Pacific 1,748
Europe 1,716
Latin America + Caribbean 2,192
Morth America 1,724

Palar

West Asia

FIGURE 13-27 Ascorecard in
PerformancePoint

Target

L J
1,750 >
1,750 7y 0%
1,750 (7 -2%
1,750 (@ 25%
1,750 /7 1%
1,750 >
1,750 >

on the scorecard. Call your scorecard Average Hours, and it
should appear as it does in Figure 13-27.

The final step before creating the dashboard is to link to the
Reporting Services report. Right-click the PerformancePoint
content list, choose New > Report, and then choose Reporting
Services.

A setup screen will appear—if you are using Native mode
Reporting Services, put in the server name. If you are running
a named instance, you will need to go to the Reporting Services
Configuration Manager to obtain the name. Once you have set
it up, click the Browse button to choose the report, as shown
in Figure 13-28.
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Report Settings

Server mode: |Report Center j

Server name: Ihttp:ngs—mséUUﬂrepurtserveerLZU12

Browse. . I Select Reporting Services Repork _{mj x|
B - *E =3
Preview
Name

(3 &l Display Folders

Report: [

¥ show taolbar

™ Show parameters

I show docmap |24 Drildown
Zoom: |100 j
Format: [Hrmien =l E Gage
Section: |
Dockap ID: |
Report parameters
HName Value

Cancel

Edit..,

FIGURE 13-28 Integrating Reporting Services into PerformancePoint

Choose the report you created in the previous section; then click OK.

PerformancePoint allows you to override the defaults used for the report, as
you can see in Figure 13-29.

Report parameters r
el Parameter Picker [ =] B3]
Hame Value = 5
<Default Value =

KhAxis <Defaul Yale>
Vizis <Defaul Valus: _
CimCou...  <Defaul Value: Measure Fieserve Yalue hd
DimDate... <Default Yalue= LI <D efault Values

= Fiaserve alis

tetiic Value &vg

Preview Metric Value Max
tetic Value

FIGURE 13-29 Setting SSRS parameters in PerformancePoint

Choose Reserve Value for the measure, Month for XAxis, and Country for YAxis;
and leave the rest. Give your report a name and save it.

Now create the dashboard. Right-click the PerformancePoint content list and
choose New > Dashboard. Use the Header, 2 Columns template. Drag the
Months of Year filter to the top section, the Average Hours scorecard to the
left section, and the report you just created to the right section. Note that
these will be in the Details window on the right!
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Click Average Hours and choose Create Connection from the Ribbon. If you
don't see the Create connection button, change to the Edit tab in the Ribbon
at top. Set Get Values From to Header - (1) Months of Year; then change to the
Values tab and set the source to Member Unique Name. Click the Connection
Formula button and type Year. This will set the filter to the year of the date
selected in the calendar. Finish by clicking OK on both screens.

Repeat the process for the report. Click DynamicMeasures and choose Create
Connection from the Ribbon. Set Get Values From to Header - (1) Months of
Year; then change to the Values tab and set the source to Member Unique
Name. Change the Connect To to DimDateYMD.

Click the Connection Formula button and type Year. Finish by clicking OK on
both screens.

The final step is to link the scorecard to the report. Click DynamicMeasures
and choose Create Connection from the Ribbon. If you can’t see Create
Connection in the Ribbon, change the tab in the Ribbon to Set Get Values
from to Left Column - (1) Average Hours. Switch to the Values tab and set the
source to Member Row: Member Unique Name. Change the Connect To to
DimCountryRegions.

When a row is clicked on in the scorecard, this step will send the underlying
unique name from the cube to the report, and hence filter the report. Give
your dashboard a name. Right-click and deploy to SharePoint. Choose a date
in 2011, as that is the last year for which there is average hourly data available.

TROUBLESHOOTING

This is a fairly complex section, and many people (including the author)
have issues on the first deploy. The error messages can also be misleading,
as an incorrect setup will sometimes lead to an error saying that you do
not have permission to view the data. In order to troubleshoot, remove
the connection to the parameters one by one until you have isolated the
parameter that is the cause. A common cause of this is PPS sending a value
that SSRS does not have in its list, for instance [Measure] being used instead
of [Measures], or the underlying hierarchies not matching.

Clicking Asia/Pacific in the scorecard will show you a chart similar to the one
in Figure 13-30.
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Months of Year:  12/17/2011 -
Average Hours DynamicMeasures
Actual Target 4 4 of1 b Pl 100% =1 Find | Mext - % &
=) AverageHoursWorkedPerYear O
SUM of ReserveValue
 Africa 1,734 O
- 2,500,000 BN Australia
3 Asia + Pacific Sy 1730 0% China
2 000 000 s
.29 =R
@ Europe 1701 173 O 2% & 1500000 B Indonesia
@ Latin America + Caribbean 2,148 1,734 i) 24% 5 Japan
S 1,000,000 N 1ew Zealand
= Morth America 1,702 1,734 () 2%
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1,734
@ Polar © o - - 5~ 5~
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Month

FIGURE 13-30 Anintegrated dashboard

DATES

Reporting Services doesn't handle dates as well as Excel or PPS, and in
order to sort the months correctly, a month number field will be needed.

POWER VIEW: EXPLORING DATA

In order to use Power View, you will need to start by creating a data model.

Open a new Excel workbook and on the PowerPivot tab, click the Manage
button. (See Chapter 5 for enabling PowerPivot if the tab is not visible.) Click
the From Database button, choose SQL Server, and enter the location of your
SQL Server. Choose the VI_UNData database from the drop-down and click
Next. Choose Select From A List Of Tables; select the DimDate, DimCountry,
DimOECDStatistic, FactOECDPopulation, and FactUNData tables; and click
Finish. Rename the Value column to ValueSource. In FactOECDPopulation,
choose the Value field, click the arrow next to Autosum, and choose Average.
Right-click ValueSource and select Hide it from client tools, and then rename
the Average of Value calculated measure to Value. You rename this by editing
in the formula bar everything before the “=".

This satisfies the bare minimum of building the model—in a full implementa-
tion, you would spend some time tidying it up.
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Once you have your model set up, creating a Power View
= report is simple: Go the Insert tab in the Excel Ribbon and
CountyName  Value click Power View. Start by dragging the Value field from
o o e FaceOECDPopulation to the Fields box, Geo Regions from
e L e DimCountry to Tiles, and then CountryName to Fields. You
Japan 10 877 526,06 H H H
e ioromnen will need to resize the chart and should see something
Tetal 49010 856.11 similar to Figure 13-31.
FIGURE 13-31 A tiled Power View report Drag Value from FactOECDPopulation to the whitespace
next to the table, which creates a new table, and change
it to a bar chart. By dragging CountryName to the Axis field, the bar chart will
now become interactive, as seen in Figure 13-32.
Filters «x Power View Fields x
VIEW ACTIVE ALL
4[F DimCountry
Ba (= Adive
sany - [[]& countrycode
CountryMame  Value [z countryip
China 15 037 623.57 [¥]& CountryName
Total 15037 629.57 [[1® countrySourcekey
Australia [l createpate

[]= Developed

e _ Llx ceon
- CountryName: China (MR | L T remcimennien
ndia
Value: 15 037 629.57 Drag fields between areas below:

TILE BY
Indonesia

GEO Region -
Jspan X VALUES
¥ Value -
New Zealand
. . AXIS
oM ™M amM &M M oM 1M 1aM 16M
& CountryName -

LEGEND

FIGURE 13-32 Filtering a Power View report

This chart is still meaningless as it is simply a sum of all the different statistics.
Start by clicking the CHART button on the Filters section, and filtering this
chart to show just the GDP per capita. You will need to drag Metric to the
Filter section and select the metric, as shown in Figure 13-33.
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Filters <« x
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Lsbeur compensation
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FIGURE 13-33 Choosing a metric

Click on the table on the left (The table and not the chart you edited above),
and add a filter to show GDP per hour worked; then add another table below
it by dragging value onto the white space. Add a country name and a filter
to show average hours actually worked. These tables will all then be sliced
by the chart. Each table and chart will be filtered by a different metric value.

Finish by dragging value to the whitespace beneath the chart. You may need
to clear some space, which you can do by selecting the corner of the title text
box, deleting it, and then resizing the main box. Drag Metric onto this new
table; filter by the three metrics GDP per hour worked, GDP per capita, and
Average hours actually worked; and then change it to a column chart. Move
Metric to Legend, and drag YearNumber to the Axis of the chart. This will
give you an interactive dashboard similar to the one in Figure 13-34. Clicking
either of the charts will update the other chart with that selection, as well as
the tables.
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FIGURE 13-34 Aninteractive Power View report

SUMMARY

In this chapter you learned how to build interactive visualizations to support
ad hoc analytics, using all the Microsoft tools. These visualizations are com-
monly more used by power users, but applying predetermined analysis paths
helps guide less experienced users.
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CHAPTER 14

Relationship Analysis

Relationship analysis is a visualization form you are probably more familiar with
than you know. The earliest exposure you would have had to a visualization
of this type would have been a family tree. Understanding how relationships
work, and being able to tell at a glance which of a set of objects is dependent
on another, is an old but growing area. Especially given the advent of social
media, networks are taken to represent influence; for instance, a marketer
may be more inclined to market to people with many followers on twitter
than to those with only a few followers. Being able to analyze this is thus is
a key differentiator. This chapter skips the pieces of heavy lifting that often
sit underneath these analyses. The tools that would be used for this analysis
include graph databases.

VISUALIZING RELATIONSHIPS:
NODES, TREES, AND LEAVES

The two different types of relationship analysis we are going to cover in this
chapter are network graphs, which show items at the same level and how they
interrelate, and hierarchical or tree structures, which show the relationships
from the top down. Trees and hierarchies have technical differences in detail,
but for the purposes of visualization, you can treat them the same. You will
be familiar with the Analysis Services hierarchies already from Chapter 13, so
those types of visualization will be excluded.
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COLORPYRAMID

Figure 14-1 shows one of the very first relationship diagrams (created by
Johann Heinrich Lambert in the 1760s), which illustrates the color rela-
tionships. His “Farbenpyramide” differed fairly substantially from the color
relationships we use today, but it was an influential work.

7

FIGURE 14-1 Farbenpyramide
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Both types of visualizations have various flavors. This chapter covers four of
them, with very different uses.

The network map is used purely to show relationships without any value
attached to the network. This is useful especially in the social media analysis
context, where the connection between items in the network, known as nodes,
is the sole arbiter of value. Other older uses for the network graphs include
the representation of computer networks, telecommunication networks, and
transport networks. In some of the versions of the network graph, direction
is included.

A color wheel, which is a wheel divided into sections with the relationships
shown as lines connecting the sections, has an added dimension in that it
can show the size of a relationship. This is useful when showing, for example,
trade balances.

Tree structures are used to represent top-down hierarchies. Organization
charts and family trees are the most well-known examples of tree structures.

The strategy map visualization, made famous by Robert S. Kaplan and David
P. Norton in their article, “The Balanced Scorecard—Measures That Drive
Performance,” is a very specific version of a tree chart. The implementation
of this tool in Performance Point also lends itself to other uses.

NETWORK MAPS

A network map shows the connections between objects visually—these con-
nections could be physical (as in the case of computer networks or railway
tracks), or they could be more abstract (as in the case of social media networks).

NETWORK GRAPH THEORY

Network graph theory is another of the discoveries by the mathematician
Leonhard Euler, first published in his book, Seven Bridges of Kénigsberg, in
1763. In the problem statement he worked through in this book, there are
seven bridges, and he needed to determine if one could cross each bridge
twice during a walk. A vertex (or node) is called odd if it has an odd number
of arcs (or edges) leading to it, otherwise it is even, and if a network has
more than two odd vertices, it does not have an Euler path—that is, one
cannot walk the path and cross each bridge twice.
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The easiest place to see a network map is at http://inmaps.linkedin.com/.
This tool analyzes your LinkedIn network and gives you a network graph of
your connections. An example of my network is shown in Figure 14-2.

If your network is fairly large, the limitations of network maps at scale are quickly
apparent. As a node is added, performance degrades as a function of the number
of connections of that node rather than as a function of the number of nodes.
The readability of the graph quickly degrades as well. In the zoomed-out view,
the categories blur into one another; when the view is zoomed in, only in the
outskirts of the network graph are the relationships immediately apparent.

Creating data for a network map is relatively straightforward: It is simply a
list of pairs, each pair being the two nodes, and with an edge that is the con-
nection between the nodes. In order to render network graphs, it is worth
considering rendering order. You might assume that drawing all the nodes
first and then connecting them up will work—and indeed it will—but you are
likely to end up with a severely non-optimal layout. Luckily, most tools avail-
able to you handle this fairly well.

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel No .
PerformancePoint No .
Power View No .
Reporting Services No .
Silverlight/HTML5 N/A
COLOR WHEEL

Primarily, a color wheel is a wheel divided up into sections as categories;
secondarily, it shows links between the sections. It’s a similar concept to the
network map, but it's a condensed version. When you build a color wheel, you
will almost certainly have to build it interactively to show only one relationship
at a time, otherwise the lines overlap and look chaotic. A great example of an
interactive version of a color wheel is shown in Figure 14-3.
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= d

FIGURE 14-2 The author’s LinkedIn network
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FRANCE: €107.7 bn
US:€244.8 bn

SPAIN

PORTUGAL

TALY

IRELAND

GREECE

UK:€101.8 bn GERMANY: €42.5 bn

FIGURE 14-3 A color wheel showing trade balances from http://www.bbc
.co.uk/news/business-15748696 (Source: bbc.co.uk © BBC)

Ease of Development

REPORTING TOOL PREDEFINED CHARTTYPE  EASE OF DEVELOPMENT
Excel No .

PerformancePoint No .

Power View No .

Reporting Services No .

Silverlight/HTML5 N/A

Another consideration related to color wheels is not having too many catego-
ries. Representing the entire world in this manner would likely be confusing
and chaotic for end users.
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TREE STRUCTURES: ORGANIZATION CHARTS AND

OTHER HIERARCHIES

RELATIONSHIP ANALYSIS

Visualizing Relationships: Nodes, Trees, and Leaves

Tree structures are used everywhere in our world. The most ubiquitous example
in the corporate world is the organization chart. Figure 14-4 shows a proto-
typical organization chart that was built in Visio.

CED

Exeautive Team

CFO

—

Aoccountant

!—‘_\

Creditor’s clerk

Debtor's derk

FIGURE 14-4 Organization chart built in Visio

Development
Manager

Team Lead

Deweloper

Developer

Tester

Development T eam

A standard drill-down tree structure is another example. This type is exten-
sively covered in the earlier chapters and is excluded from the following Ease

of Development table.
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Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel No
PerformancePoint Yes .
Power View No .
Reporting Services No .
Silverlight/HTML5 N/A .
STRATEGY MAPS

Strategy maps are, in many ways, a refinement of the tree structure. The
hierarchy of an organization’s strategy is shown visually; the key addition is
that each block of the strategy map is dynamically linked to data. Figure 14-5
shows a prototypical strategy map next to a scorecard that it is mapping.

(1)

e eeRes one

@,_
0
0
ol |

s0 000

Motor Vehicle Production

Preproduction| Production Delivery|

Testing Painting ——»{ Loading

Components
Delivered

i

Body Engine

=

Body

Staff Onsite

| ‘ |Wheels

Plant
E
[

| ‘F\tter Spray Mechanic

Delivery Sales

Dealer

FIGURE 14-5 A standard strategy map based on the balanced scorecard is shown on top, and at
the bottom the same tools are used to show a process map
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Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel No .

PerformancePoint Yes .

Power View No .

Reporting Services No .

Silverlight/HTML5 N/A

TOOL CHOICES

Relationship analysis is an area in which the Microsoft stack is especially poor.
PerformancePoint has some native capabilities in the form of Decomposition
Trees and strategy maps, and there is an add-in for Excel, but outside of that,
any relationship analysis must be coded. The techniques necessary to do that
are covered later in this chapter.

PPS DECOMPOSITION TREE

PerformancePoint is great for showing how a particular metric is broken
down—not just by predefined hierarchies, as in the drill-down capabilities,
but also with the Decomposition Tree, which allows for a continual drill down
by alternative hierarchies in a tree format.

You want to know the best part? The Decomposition Tree is available at any
time to you. All you have to do is right-click and choose Decomposition Tree,
as shown in Figure 14-6.

Value Added by Activity
1,000

Value added by acwvity

£]

Drill Dowin
Drill Down To 4
200 = prill Up

Show Only

Remove

Select Measures...
Switch to "MetricValue”

[l Value added by acivity/Metricvalue
400 Switch to "2008"

=15 Decomposition Tree

200 Show Details
Additional Actions 4
o Sort 3

2000 2002 2004 2006 Fiter
2001 2003 2005 2007 Pivot

2012

@  Show Information Bar

FIGURE 14-6 Opening the Decomposition Tree
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The Decomposition Tree displays (like the one shown in Figure 14-7), allowing
your end users to drill down on the various dimensions and see the makeup
of the values they are examining.

Metricvalue |Metric ™ |GEQ Region o |sEO Subregion  + |
‘Western Europe ®
398.389644
77.6% of "Europe”
45.1% of "Value added by acivity
Rank 1 of 3
Expand To = Show Properties.
4 Back
398 Western EUrop Regions
—— -
513 Europe 102 Central Europe
. Cauntryl
75 Asia + Pacific 13 Castern Curope oUTyName
[ ———— [} i Active
EE—— 662 Value added in 34 Latin America ¥ CountryCod
883 Value added b —— 1§ CountryCode
221 Value added ir 21 Africa 22 CountrySourceKey

i %% CreateDate
20 North America

22 Developed
i cromo

2 150 2 Code
2 150 3 Code
¥ LoadDate
¥ sovereign

i un Code

FIGURE 14-7 A PerformancePoint Decomposition Tree

DATA SOURCES

It's important to note that the majority of features in PerformancePoint—
including the Decomposition Tree—only work when PerformancePoint is
connected to an Analysis Services cube or Tabular data model.

EXCEL AND NODEXL

Excel itself does not have any support for network diagrams, but a down-
loadable add-in called NodeXL is available. You can download this tool from
http://nodexl.codeplex.com/.

The NodeXL add-in is an Excel template into which you paste your data. In the
simplest format, you can paste a list of edges and change the widths based on
some value. In Figure 14-8, the edges are trade values between South Africa
and other countries, and the width of the lines is the log of the distance from
the trade value to the minimum trade value.
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FIGURE 14-8 The NodeXL template with data entered

As you add more root nodes (that is, nodes
that are connected to multiple nodes), the lay-
out becomes more important. In Figure 14-9,
Australia’s trade exports have been added.
NodeXL makes working with a large number
of connections fairly easy, as you can click on
a node to highlight what it is connected to.
NodeXL also enables you to drag the node
around to improve the layout.

PERFORMANCEPOINT SERVICES (PPS)
STRATEGY MAPS

PerformancePoint has a great toolset for cus-
tom strategy maps because it can link any data
in PerformancePoint to custom shapes in Visio.
The most common example of this is to imple-
ment a Kaplan and Norton balanced scorecard,
as shown in Figure 14-10.
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FIGURE 14-9 Dragging a node around in NodeXL
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Corporate Strategy Map

Fiscal Year 2007

Financial

Customer
Satisfaction

Achieve Operational Increase Customer Inncwate
Excellence Value

Operational
Excellence

£ A ml

g A Mativated snd Preparsd Workfarcs

£

E Attract T

8 Keep Quality T

@ —

5 o> >
&

FIGURE 14-10 A balanced scorecard in PerformancePoint

More extensive use of this technology is great for visualizing flows such as
manufacturing processes. Because PerformancePoint strategy maps are based
on a user-customizable Visio diagram, almost any process can be visualized.

HTML5 STRUCTURE MAPS

The biggest challenge with the NodeXL tool is that it is embedded only within
Excel. You can build a network map equivalent on the web using the same
libraries that we've been using and you were introduced to in Chapter 9, but
there are also some great online tools. You can see examples at https://
www.google.com/fusiontables/Home/.

The output of the network graph built in Fusion Tables is shown in Figure 14-11.
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FIGURE 14-11 Networks built in Fusion Tables

IMPLEMENTATION EXAMPLES

The implementation examples use the OECD_Data model. You can obtain the
datasets from the Wiley website; see Chapter 3 for information about installing
them in the “Installing the Sample Databases” section.

BUILDING AN ORGANIZATION CHART IN PERFORMANCEPOINT

To create custom visualizations in PerformancePoint, you use the Strategy
map feature, which requires you to first build a scorecard and then create a
Visio document to which you link the key performance indicators (KPIs) in the
scorecard. You can read about creating scorecards in Chapter 10.

In this example, you create custom rollups of OECD (Organization for Economic
Development) statistic metrics and associate them with organizations. The
organizations in this example are going to be our own creation, and this shows
the power of this approach in PerformancePoint. The data points you will
be using will be GDP per hour and Purchasing Price Parity in the Production
category, and Mean score in reading performance in the Education category.

In the PerformancePoint Content section of the Business Intelligence Center
in SharePoint, create a new PerformancePoint KPI in the Items section of the
ListTools tab in the Ribbon. This action launches the Dashboard Designer.

www.it-ebooks.info


http://www.it-ebooks.info/

312 VISUAL ANALYTICS IN PRACTICE

Choose Blank KPI in the Select a KPI Template dialog and click OK. Name the
KPI GDP per hour.

The next step is to create a new data source in Data Connections pointing to
Analysis Services. Name the data source dsOECD. Fill in the SSAS server and
instance name, and then select the OECD_Data database and Model cube.

On the Time tab of the new data connection, set up the time dimension. Select
DimDate.Date under Time Dimension. Choose 2012-01-01 as the reference
member. The Hierarchy level is Day and the Reference Date is 2012-01-01. In
the bottom section, map the Date member level to the Day time aggregation.

On the KPI, click the 1 (Fixed Value) link in the Actual row/Data Mappings
column. Click Change Source, change to the dsOECD data source, and then
click OK.

For the Actual, you are going to use the MetricValueAvg measure. Add a
new Dimension Filter, and choose DimOECDStatistics.Statistics, as shown in
Figure 14-12.

Dimensional Data Source Mapping il

Select a measure:

IMatric\u'aIueAvg d
ol e T iEREER Select Dimension _ o1 x|
{2 Mew Dimension Filter Dimension:

CimDate, Monthiame B .
l:l:Name DimDate, MonthHumber :'

DimDate, Quarter
DimDate, QuarterMamne
DimDate, StandardDate
DimDate., WeekOfMonth
DimDate. WeekOFear
DimDate. Yearhame
CimDate. Yeariumber
DimDate. YMD

& " (s g LimOECDSE atiskic. Active
QarEgate MEMOSISDY! | pimOECDSkatistic. Area

Default DimOECDSkatistic, Category vl
DimOECDSE atistic. Metric

DimOECDStatistic, OECDStatisticID

™ Use MO tuple Formuls

DimOECDStatistic, Subject

FactQECDNationalReserve, Active

FactOECDNationalReserve, DimCountry[D

FactQECDNationalReserve. DimDatelD

FactQECDNationalReserye, OECDNationalReservelD
FactOECDMNationaReserve, Yalue LI

’TI Cancel | Cancel |

A P

FIGURE 14-12 Choosing a dimension to filter by
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Click the default measure and change the selection to GDP per hour, as shown

in Figure 14-13. Be sure to uncheck Default Member (All).

Select Members 3

Select Members
Right click any member to view additional selection options.

E DimQECDStatistic, Statistics

g [= (3]

[ = Education

Energy and kranspartation
Environment

Globalisation

Labour

Paopulation and migration

Prices

Production and income

"Incorne

Economic struckure

Income inequality and poverty
Production

Productivity

®-[ o Labour productivity growth
[ = Labour praductivity levels
o GDP per hour warked

< |

Selected items: 1 Cancel

FIGURE 14-13 Selecting the correct metric

Repeat this process for the target, and replace MetricValueAvg with MetricValueMax

as the target, as shown in Figure 14-14.

Dimensional Data Source Mapping , x|
Select a measure:
IMetricVa\ueMax j
Select a dimension:
bf Mew Dimension Filker G307 Mew Time Intelligence Filker X |
Mame | Default
- DimQECDSE. 5 GDP per hour worked
Aggregate members by:
IDaFau\t j
™ Use MOz tuple Formula
hange Source, .. | oK I Cancel |
4

FIGURE 14-14 Replace MetricValueAvg with MetricValueMax as the target
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Click OK and adjust the target values to 80% for Threshold 2.

Repeat this process for Purchasing Power Parity, which you find under prices,
and Mean score in reading performance, located in education, giving you
three total KPIs. Each one of these filters will filter the values of the measure
to return only the recorded value for that metric.

Create a new blank scorecard by right-clicking PerformancePoint Content
and then selecting New > Scorecard. Add the three KPIs to the scorecard, as
shown in Figure 14-15.

Actual Target
GDP per hour 42 8086865967742 81.5 [) ~47%
Purchasing Power Parity 138, 374052047393 6236.547 0 -95%
Reading Score 456,6730588555556  535.577975 @ -

FIGURE 14-15 A PerformancePoint scorecard

You now have a base scorecard, which you can map to shapes.

To do this mapping, you need a Visio diagram. Launch Visio and create a
new drawing. Choose the flowchart category, and create a cross-functional
flowchart. Drag in three Process items. Name all the items meaningfully, as
in Figure 14-16.

Strategy Map

Education

Froduction

FIGURE 14-16 A cross-functional flowchart in Visio

Save the Visio document and go back to PerformancePoint’s Dashboard
Designer. Create a new report and choose Strategy Map. Choose the scorecard
you just created, and then click Edit Strategy Map in the Ribbon’s Edit tab. You
see a screen you use to import the Visio document (see Figure 14-17).
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FIGURE 14-17 Visio Import screen

Import the Visio file you created earlier and click the top shape. Click the
Connect Shape button and then double-click the Reading Score KPI. The
shape updates with the name. Make sure to click the Target to ensure that it
updates the color as well. You should see the updates shown in Figure 14-18.

Strategy Map Editor iE =10l x|

ER import Visio File {7 Export Visio File | Bl stenal | 21 Connect Shape 3% Disconnect Shape | {21 Resize to Fit |5 Fit for Print

Strategy Map

Education

Production

Connect Shape =]

GDF per hour

Actual Target
42.8086665967742 81,5 O 47

Purchasing Power Parity  138.374082047393  6236.547  dp -98%

Reading Score

4860,673080555556 | 535.67797% . 9%

Connect ¥ Show KPI name in shape text

Close

= Pl L L

FIGURE 14-18 Connecting shapes in Visio
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If you are using a
Google apps account,
you will need to
enable this feature.
Do so by going to
http://support
.google.com/a/
AppName (where
AppNameis the
name of your Google
Apps domain) and
log in. Click on the
Organization & Users
tab at the top, then
Services in the new
tab that appears
below that one. Scroll
down to Fusion Tables
and switch it on. Finish
by clicking the Save
button at the bottom.

TradePartners.xlsx

File View

Showing all rows opfions

Node Column 1|Main Country =]
Node Column 2 | Partner =l
Weight Weight =l

™ Color nodes by column
™ Show link direction between nodes

Get embeddsble code

of 62 nodes

62

?

(]
Polsnd

.
Greeoe

FIGURE 14-19 A network graph
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Close the Connect Shape dialog and click the Apply button. Your strategy map
is ready to be embedded in PerformancePoint dashboards.

BUILDING A NETWORK MAP IN HTML5

For this network map, you use an online tool called Fusion Tables. Visit
https://www.google.com/fusiontables/Home/ and click See My Tables.
You have to have a Google account to use this tool, so create one now if you
don’t have one.

Click Create > More > Fusion Tables (experimental), and then upload the
TradePartners.xlsx workbook you were provided with. Click Next. The
column names are in Row 1; click Next again and then click Finish. You have
imported your data. Click Labs > Network graph.

As the final step, click the drop-down next to Weight and choose the Weight
option. A network graph similar to the one in Figure 14-19 is generated.

Switch to new look | Getlink | | Share | T

Edit Visualize Merge Labs

This visualization is in Labs. Leamn more
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This network graph is built on an HTML5 canvas, and you can easily embed
it in your web pages. Although it doesn’t have the interactivity of NodeXL, it
does give you a very easy way of generating a web-friendly network graph.

COLOR WHEEL IN HTML5

For the color wheel, you are going to use a visualization called Sunburst from
the JavaScript InfoVis Toolkit. You can download the toolkit from http://
philogb.github.com/jit/. This basic example uses the Sunburst trivially.
The code samples include an example of dynamically changing the color and
width of the lines joining the nodes.

The following code samples assume that a JSON structure already has been
setup, in a format like so:

"id": "nodel",

"name": "node 1",

"data": {
"S$angularWidth": 13.00,
"Scolor": "#33a",
"Sheight": 70

I

"adjacencies": [

{

"nodeTo": "node3",
"data": {
"$color": "#ddaacc",

"$linewidth": 4

}

The first piece of the JSON structure specifies the node properties: the Name
and the definition of the node itself—its color, height, and angular width (the
portion of the circle it occupies). Then, in the adjacencies node, the properties
of each joining line are defined. In the preceding example, Node 1 is connected
to Node 3 with a line width of 4 and an HTML code for color.

Each of these properties is then used to represent an item of data. For exam-
ple, each node is a country, the angular width is the gross domestic product
(GDP) of that country, and the width of the line is the size of the exports to
that country. Figure 14-20 shows how it looks.
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CODE SAMPLES

For this example, you
will need to open

the code sample files
in the zip file called
Chapter14.zip, as only
excerpts of the code
are included in this
section, for brevity.

A C# web service

to output this JSON
based on the OECD
data source is dis-
cussed in Chapter 9.


http://www.it-ebooks.info/

318

VISUAL ANALYTICS IN PRACTICE

FIGURE 14-20 The color wheel

The implementation using the InfoVis library is relatively easy. The class is
called Sunburst, and a complete sample is provided separately, and is available
from the Wiley website. The code that is specific to the color wheel (called
Sunburst by InfoVis) is shown.

var json = dpGetDatal();

//end
//init Sunburst

var sb = new $jit.Sunburst ({

//1id container for the visualization
injectInto: 'infovis',

//Change node and edge styles such as

//color, width, lineWidth and edge types

Node: {},

Edge: {},

//Draw canvas text. Can also be

//'HTML' or 'SVG' to draw DOM labels

Label: {},

//Add animations when hovering and clicking nodes
NodeStyles: {},

Events: {},

levelDistance: 190,

// Only used when Label type is 'HTML' or 'SVG'
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// Add text to the labels.
// This method is only triggered on label creation
onCreatelLabel: function(domElement, node){},
// Only used when Label type is 'HTML' or 'SVG'
// Change node styles when labels are placed
// or moved.
onPlaceLabel: function(domElement, node) {}
1)
// load JSON data.
sb.loadJSON (json) ;
// compute positions and plot.
sb.refresh();

First, a JSON object is obtained and then the new object is instantiated. The
outlines given here are the styling for the nodes, the edges, the labels, and
any events. (The events are how the lines are hidden when a node is clicked.)
onCreatelLabel and onPlaceLabel are internal workings and can mostly be
left alone. The library does the rest of the work.

The end result is a graphic that, when it's been clicked, looks like the one in
Figure 14-21.

Note that the log of the trade amounts was used to size the lines.

Brazy

FIGURE 14-21 An InfoVis color wheel
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SUMMARY

Relationship analysis is an area in which the Microsoft toolset falls far short.
Luckily, this is fairly easy to remedy with free add-ins and web software. Each
of the tools covered in this chapter has a different use case, so it is useful to
be familiar with all of them.
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CHAPTER 15

Embedded Visualizations

An embedded visualization, as the name suggests, is a visualization that is
contained within some other content—typically, this table of data will be that
most widely used of visualizations. Indeed, this book has made extensive use
of this approach in the tables contained within every chapter, with indicators
showing the ease of implementation. It is also possible to do these visualiza-
tions within a flow of text or perhaps within an application—but they are much
less common. An example of an indicator embedded within an application

is shown in Figure 15-1.

In this case, the indicators are being used as buttons that can be clicked on

to set a status.

Common uses for embedded visualizations include high-
lighting problems such as highly divergent numbers that
are likely to be a data-capture error, and ranking of various
numbers such as all the stores within a region. Covered
much more extensively in Chapter 10, indicators showing
achievement against a target are another form of embed-
ded visualization. Another great use is the ability to show
multiple small charts, thereby allowing for a great deal of
data to be displayed on a single page.

In this chapter, we will focus on the traditional tabular
embedded visualizations—formatting of the table itself,
embedding charts within cells in a table, and conditional
formatting of cells according to value. You will also read
about indicators and a specific type of embedded chart
called a bullet graph.
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FIGURE 15-1 Visualizations embedded in an
application
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322
A ]
1 |Task Rate
2 |Phase 1- Envisioning  Architect
3 |Phase 2 - Planning Architect
4 |Phase 3 - Development Architect
S5 |Phase 4 - Deployment  Architect

6 |Phase 2 - Planning

7 |Phase 3 - Development
8 |Phase 4 - Deployment
9 |Phase 3 - Development
10 |Phase 4 - Deployment
11 |Total

FIGURE 15-2 An unformatted table

Wom e et W R e

L e e
PR TTRE N,

Tester
Tester
Total

Senior Consultant
Senior Consultant
Senior Consultant

TABULAR DATA: ADDING VISUAL ACUITY

The primary reason to add any sort of visualization to a table to is draw atten-
tion to particular rows, columns, or cells in the table; or alternatively to show
their relationship to other rows, columns, or cells. There are various ways of
doing this—in the old paper chart world, using a highlighter was the only
way, and this translates to the conditional formatting discussed in this chap-
ter. Several other ways of highlighting the relevant data points are those not
always traditionally thought of as visualization techniques—changing the
font of a cell, making it bigger, and using italics or bold is one method; and
adding borders is another. These small changes can make a huge difference
in the reading of a chart.

For this example, | will use a very common scenario—you need to present

a table of costs: to a potential client, your boss for budget approval, or pos-

sibly even at home while you decide on a holiday. In the following example,
| use a fictitious consulting cost for a project, and the
unformatted table is in Figure 15-2.

C D
Cost
83000
176000
83000
44000
42000
126000
84000
72000
144000
864000

A few very basic formatting techniques applied make a
huge difference in legibility: starting by sorting the data
in the order that it will be read—in this case, most likely
the task rather than the rate. Adding some white space
on top and to the left, and adding a border around the
entire cell with data will create the visual impression of
a discrete table rather than a set of data. Changing the
fonts to accentuate the important cells is important—in
this case, the headers along the top and the total value
are the most important, followed by costs and hours,

Hours
a0
80
40
20
40
120
80
40
80
540

and then the descriptions last. Little formatting items
such as setting the currency are vital—without it, would

Task Rate

you have known that these figures were South African

Hours

Phase 1-Envisioning Architect

88 000.00 49| rands and not U.S. dollars?

Phase 2 -Flanning Architect

Phase 2 -Planning Senior Consultant

176 000.00 BD|
42 000.00 40|

Phase 2 - Development | Architect

Phase 3 - Development  Senior Consultant

Phase 3-Development Tester

Adding borders to separate the costs as well as the
phases will finish off the visual touches, as seen in

8E 000.00 40|
126 000.00 120]

Phase 4 -Deployment  Architect
Phase 4-Deployment  Senior Consultant

Phase 4-Deployment  Tester

Figure 15-3.

44 000.00 20|
84 000.00 80|
144 000.00 80|

Total Total

R
R
R
R
R
R 72000.00 40|
R
R
R
R

This is a much more legible chart, with only a couple of
864 000.00 540

touches, but what will make it more readable yet is to
include subtotals—in order to do that, we are going to

FIGURE 15-3 A formatted table of costs
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pivot the table, and then finish touching it up. (You work with pivot tables in
the “Embedding Visualizations in a Pivot Table” section later in this chapter.)
The final result is shown in Figure 15-4.

W om o~ o osw

iy
(=]

FIGURE 15-4 Apivottable

A B C
Architect
Items - | Cost (ex.)
Phase 1-Envisioning R 33 000.00
Fhasze 2 -Flanning R 176 000.00
Phase 3 - Development [ R 22 000.00
Phase 4 -Deployment R 44 000.00
‘Grand Total R 396 00000

D E F G H I J K
Senior
Consultant Tester Total Cost [ex.] |Total Hrs
Hrs Cost (ex.) Hrs Cost(ex.) Hrs
40 R 88 000.00 40
80|R 4200000 40 R 218 000.00 120
40|R 12600000 120 R 7200000 40| R 286000.00 200|
20/|R 2400000 20 R 144000.00 20| R 272000.00 120
180|R 252000.00 240 R 216000.00 120| R 864 000.00 540

Finishing off any table in this manner is essential before even diving into the
rest of the visualization techniques—it is a subtle and yet powerful way of
highlighting the data points you wish your audience to notice.

EMBEDDED CHARTS: SPARKLINES AND BARS

Embedding charts in a table is an excellent way to have a repeating set of
data that can be easily compared—for instance, the growth of product sales
over time or the trades of stocks over time.

In Figure 15-5, a sparkline has been used to show the national reserves of the
BRICSA countries (Brazil, Russia, India, China, and South Africa) for the first 6
months of 2012.

11

B C
ReserveValue Column Labels T
=2012
Row Labels -7 = January

5 227 743.00
5 2113 120.00
5 172 538.00
5 285 334.00
5 28 BO9.70

+ February

5 227 809.00
52142 100.00
5 173523.00
5 299063.00

s

28 877.00

+ March = April + May

§ 234639.00 § 240266.00 5 245500.00
$2148640.00 $2142760.00 52 137670.00
§ 174098.00 § 17448100 5 173936.00
$ 30161100 $ 30828900 5 309003.00
§ 2853310 § 2805040 5 2836470

FIGURE 15-5 Sparklines embedded in a pivot table
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A couple of things are worth mentioning: The sparklines in this format are
good for comparing patterns, and not absolute values—South Africa is just
over 1% of China, and would not even show up on a chart at the same scale.
An additional point is that (as is common with sparklines) the data has been
shown superimposed on the text. Although this is an excellent space saver,
care needs to be taken that the sparkline is still visible. In this case, using a

lighter shade of gray for the text was sufficient.

THE INVENTION OF SPARKLINES

Sparklines were first introduced to the world in Edward Tufte's book, Beautiful
Evidence, with several implementations making their way to the world. Luckily
for us all, he never patented them, and they are now a native feature in Excel.
If the Excel functionality isn't enough for you, more features are available
in the free add-in, “Sparklines for Excel,” at http://sparklines-excel

.blogspot.com/.

Just as with line charts and column charts, columns can be used in sparklines.

Data bars are another visualization to be embedded inside a table, but in this
case they are used to show a single value in the cell rather than summarizing
the values of a series. Their usage on the same data set is shown in Figure 15-6.

A B C D E
1
2 ReserveValue Column Labels -T
3 =12012
4 Row Labels -T| # January + February #March
5 Brazil—— 8 227743.00 |[§ 227808.00 [$ 234639.00
3 Chig s 2113 120.00/ [§2 142 100.00 | (52 148 640.00
7 ndig————— [§ 172938.00 [5 173523.00 [5 174098.00
8 RussiarrFederation [§ 29533400 |§ 299063.00 [§ 30161100
9 Southafdca— |5 28809.70 | 2887700 |§ 28533.10

-
=

FIGURE 15-6 Databars embedded in a pivot table

Sparklines and their variations are good for summarizing values over a series,
and are often better for showing patterns rather than absolute values due to
their extremely compressed nature, whereas data bars are good for showing

absolute values.
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% 240 266.00
52 142 760.00
5 17448100
S 308 289.00

s

28050.40

+ May

% 245509.00
52 137 670.00
& 173 936.00
S 309 003.00

s

28 364.70

+ June

S 245 290.00
52149 840.00
5 175 467.00
S 309 418.00

s

2842110

+July
5248 259.00

5176 415.00
5307 261.00
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Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel Yes .

PerformancePoint No .

Power View No .

Reporting Services Yes

Silverlight/HTML5 N/A

CONDITIONAL FORMATTING

Conditional formatting is very similar to the data bars in an application—it is
used to show the relationship of the value in a particular cell to the value in
other cells by including a visualization in that cell. The value is denoted by
the color in the cell. An oft-applied example in the accountancy world is red
for losses and black for gains, leading to the phrases “in the black” and “in the
red.” Another use is to quickly show relative values by shading them along a
color line—often green to red or blue to red—differing shades denote differ-
ent values, in a similar way to a heat map.

In Figure 15-7, you can see the unemployment rates, with higher numbers
shown in red:

A B C D E F G H _I
1
2 Statistics Unemployment rates: total |-T
3
4 MetricValuefvg Column Labels -
5 Row Labels -T| #2000 +2005 +2008 +2000 +2010 +2011
6| BrEi— 1270 930 730 770 6.30 570
7 RuUssian Federation 10.50  7.60 6.40 8.40 7.50 6.60
8 South Africa
9

FIGURE 15-7 Conditonal formatting on a pivot table

Care in the choice of colors needs to be exercised, however. In the example in
Figure 15-7, red for high unemployment and green for low unemployment are
apt; in other examples, the assumption of red for bad, as people are wont to
do, can be misleading. In Figure 15-8, red has been used for low population,
yet China and India are definitely countries with worse population problems.
Reversing the scale doesn’t help because South Africa has a higher density
population than Russia.
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A B C D E F G H
1
2 Statistics Population levels T
3
4 MetricValueAvg Column Labels -
5 Row Labels -T| = 2000 2005 + 2008 + 2000 +2010 2011
] Brazit— 171 275.90 183 383.20 139 612.80 191 480.60 193 252.60 154 932.70
7 Chima—
a8 Indie— 1053 898.00 :
] RUssian Federation 146 757.50 .20 143 163.10 143 064.10 142 958.20 142 822.50
10 | SouthrAfrica

—
=

FIGURE 15-8 Color can be misleading

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE EASE OF DEVELOPMENT
Excel Yes .
PerformancePoint Yes .
Power View No .
Reporting Services Yes .
Silverlight/HTML5 N/A
INDICATORS

Indicators have been treated fairly extensively in Chapter 10, but they are in
many ways simply a subset of the conditional formatting. Although the color
is contained within a shape (which may have meaning), the color banding is
essentially the same concept as coding the entire cell in a color. The advan-
tage of an indicator is that it is a discrete item, and as such won't distract or
overlay the numeric value.

Commonly, indicators are limited to fewer numbers than conditional formatting,
so a problem with them both is rather more apparent: The numbers that are
being shown have been banded into ranges, and as such you lose precision
when displaying in this manner. As an example, let us consider the data set
showing average hours worked per year—in the conditional formatting cells
for 2011, it is very easy to rank the countries by color alone, but in the indica-
tor set it is much harder. This problem doesn’t disappear with the conditional
formatting—look at cells H11 and C6 in Figure 15-9.
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This banding of data into these buckets is in fact the greatest strength of
indicators. Red icons mean they need immediate action, green icons can be
ignored with safety, and yellow icons need to be investigated. Choosing the
boundaries for these values is thus of utmost importance!

A B
1
2 Statistics Average hours actually worked |-T|
3
4 MetricValueAvg Column Labels >
5 Row Labels <7 #2000
[ Russian Federation 1982.00
7 AUstrabia__ 1775.90
8 AUsTra— 1726.70
9 Belgium-___ "
10 Canada-— 1775.00
11 Chile
12
13
14 Statistics Average hours actually worked |-T|

16 MetricValueAvg Column Labels
17 Row Labels <7 = 2000

18 Russian Federation /)

19| AUstrebia___ P

20 Austris— &

21| Belgium-_ &

22 Canada— (<3

23 chile Q

FIGURE 15-9 Using indicators

Ease of Development

REPORTING TOOL

Excel
PerformancePoint
Power View
Reporting Services

Silverlight/HTML5

BULLET GRAPHS

+ 2005
1990.00
1725.00
1695.50

1739.30
2157.00

+2005

+2008
1997.00
1715.70
1647.90

1728.40
2095.00

+2008

+2009
1973.00
1685.20
1608.00

1699.70
2074.00

+ 2009

+ 2010
1976.00
1686.80
1599.20

1701.90
2 068.00

+ 2010

#2011
1981.00
1692.80
1599.70

1701.90
2 047.00

[

*2011

1982.00 /A 1990.00 /\ 1997.00 /A 1973.00 /\ 1976.00 /\ 1981.00
1775.90 ¢ 1725.00 < 1715.70 <P 1685.20 ¢ 1686.80 » 1692.80
1726.70 € 1695.50 < 1647.90 <p 1608.00 {» 1599.20 < 1599.70
1545.00 ¢ 1565.00 <P 1568.00 <P 1550.00 ¢» 1551.00 <P 1577.00
177500 € 1739.30 <P 1728.40 P 1699.70 { 1701.90 P 1701.90
2263.00 @ 2157.00 @ 2095.00 @ 2074.00 @ 2068.00 @ 2047.00

PREDEFINED CHART TYPE

Yes

Yes

Yes

Yes

N/A

EASE OF DEVELOPMENT

A bullet graph is really two or three embedded bar charts in a single cell,
superimposed upon one another. They are very useful when you need to

show a series of data points against targets or averages. For example, you
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may need to compare the total sales of each store within a region to each
other, as well as to a target that is set for each store, and quite possibly the
store average as well.

BULLET GRAPHS

Bullet graphs are the invention of Stephen Few, and his specification for
what they should look like can be found online at www.perceptualedge.
com/articles/misc/Bullet_Graph_Design_Spec.pdf. As always,
Stephen Few is very fond of monochrome, so you may want to spruce up
the design by using colors rather than gray scale.

The bullet graph in Figure 15-10 shows 2011 unemployment rates (the blue bar
for each country) against a country-specific target (the black line—note that
I made up the target), as well as against the overall target bands (the colored
band at the back). Using a graph spread across the 20 columns in Excel is not
necessary, but does give a nice visual cue to exactly how far the bullet graph
is along the bands.

A B C E FGHI JKLMNOPQRSTUWVWXY
1
2 Statistics Unemployment rates: total
3
4 MetricvalueAvg Target
5 2011 2012
6 Brazil 5.70 5_— §
7 Russian Federation 6.60 6 _— b
8 South Africa 2490 18 |88 | E
9 Japan 460 4/ : o
10 Canada 7.40 ?— A
11 |chile 7.10 7 [

FIGURE 15-10 Using a bullet graph

Ease of Development

REPORTING TOOL PREDEFINED CHART TYPE  EASE OF DEVELOPMENT
Excel No

PerformancePoint No .

Power View No .

Reporting Services No .

Silverlight/HTML5 N/A
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TOOL CHOICES WITH EXAMPLES

Excel, PerformancePoint, and Reporting Services all allow for embedded for-
matting of some description, while Power View does not. Excel is the leader
in this section, with Reporting Services second, and PerformancePoint a long
way behind.

EXCEL

Excel is the most widespread tabular display tool, and as such it has a very
powerful set of visualizations; it is definitely the easiest tool to add embedded
visualizations into. Covering data bars, sparklines, and conditional formatting,
Excel may seem like the first choice in all cases—however there are some
shortcomings.

Excel is great with conditional formatting—as shown in Figure 15-11, it is easy
to add conditional formatting year by year to get a different scale when there
are major data differences.

A B C D E F G H
1
2 Statistics Long-term unemployment |-T|
3
4 MetricValueAvg Column Labels hd
5 Row Labels v | ¥2000 + 2005 +/2008 2009 +2010 42011
[ HAF "-n__‘____,_k_,
7 " 24518388 20.43137933 17.54969967 16.51899733 21.68639133 22.43867733
8 37.98401325 31.48703764 27.62271848 34.52850952 36.86855734
9

11260651  9.610552  7.065269  7.81057 12.014035  13.462977
FIGURE 15-11 Sparklines combined with conditional formatting in a pivot table

However, when using a sparkline on the same graph, it won't dynamically get
new data as they come in. Compare Figure 15-11 to Figure 15-12: the sparklines
have shown up only for the data points we'd selected.

This same issue occurs with the bullet graph you saw earlier: It was made by
superimposing two bar charts on top of one another, and it does not have
the capability of dynamically resizing. Conditional formatting and indicators
both have the capability of being dynamic, so they are great choices. As shown
in Figure 15-13, Excel provides additional settings for applying conditional
formatting.
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A B C D E F G H
1
2 Statistics Long-term unemployment IE‘
3
4 MetricValueAvg Column Labels Iz‘
5 | Row Labels [~ #2000 2005 #2008 2000 #2010 #2011
6 Bafrics~—,_____———
7 | | ®hstere-Pacific , —— 24518388 20.43137933 17.54960067 16.51800733 21.68639133 22.43867733
s | Emmopr—— ——— 35.52100845 37.98401325 31.48703764 27.62271848 34.52800952 36.86855784
[ ECENTratEurops 40.5900986 48.66661367  37.304775 30.28948367 39.4519905 41.61361717
10 WEmsterseurnpe I 4sasi0s 38451531 25183184 2871473 29.926106 32760236
1 B n 33.27003831 34.18618265 29.17578372 26.67312944 33.14359383 35.51344483
12| @ latinAmerica + Caribbean [ 185795 1121335507 1l684510 1579913\ 21351222\ 21038572
13| [®North America | 11260651  9.610553  7.065269  7.81057 12014035  13.462077
14

FIGURE 15-12 Expanding a pivot table does not expand the sparklines automatically

-]

+2009 +2010 #2011

17.54969967 16.51899733 21.68639133 22.43867733
31.48703764 27.62271848 34.52800052 36.86855784
37.804775 30.28948367 39.4519505 41.61861717
35.183184 28.71473  29.926106 32.760236
29.17578372 26.67312944 33.14359383 35.51344483

[7-.065260  7.81057 12014035  13.462977
Apply formatting rule to ...

n Selected cells

& All cells showing "MetricValueAvg” values

‘ O All cells showing "MetricValueAvyg” values for "GEQ Region” and "YearName"

FIGURE 15-13 Conditional formatting settings

SQL SERVER REPORTING SERVICES (SSRS)

Reporting Services is a good choice for embedded visualizations—it is more
work than Excel to generate, however; by embedding the visualization in a

matrix, it will automatically repeat.

It also has a chart type that can easily be used to create bullet charts—the

gauge chart.

Figure 15-14 shows a gauge chart that has been customized to be a bullet graph.

Title Sales Amount Sales Quota

European Sales Manager $98,323 $117,000
North American Sales Manager $249,400 $271,000
Pacific Sales Manager $26,580 $33,000

FIGURE 15-14 A bullet graph in SSRS
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Conditional formatting is also very easy with SSRS, as Figure 15-15 shows.

Title Sales Amount Sales Quota
European Sales Manager * $98,323 $117,000

Morth American Sales Manager @ _ $2?1 ,DUU
Pacific Sales Manager 0_ $33,000 J—

FIGURE 15-15 Adding conditional formatting to an SSRS table

Of course, being cautious with colors is imperative if you don’t want your chart
to end up being a cartoon canvas—use www.colorbrewer.org for a good
selection of colors. As shown in the chart in Figure 15-15, using indicators is
a more subtle and less garish way to show the data points.

Statistic:  Total primary energy supply per capita ™ Year: 2010 ¥

PERFORMANCEPOINT

Metric Scorecard

Although PerformancePoint is not a great embedded

Actual

Target

visualization tool, it is the most capable of the indica- ;|Metr|.cva\ue” o I
[# Asia + Pacific S@E 6 -19%

tor tools with its scorecard component. And with a bit e + o v R

of work, conditional formatting can also be applied. [ Latin America + Carbbean 2 @2 | 2 7%
& North America B e B 0%

An example scorecard with both indicators and condi-

FIGURE 15-16 Conditional formatting in

tional formatting is shown in Figure 15-16. PerformancePoint

IMPLEMENTATION EXAMPLES

The implementation examples all use the OECD_Data model. See Chapters 4
and 5 for creating this data model.

EMBEDDING VISUALIZATIONS ON A PIVOT TABLE

Pivot tables are the most likely place for you to need visualizations; in this sec-
tion you will create a new pivot table, add sparklines, and use conditional for-
matting. Data bars can be added in the same manner as conditional formatting.

Start by creating a connection to the OECD_Data tabular model. Do this in
Excel by going to the Data tab, clicking Connections, and then clicking Add.
(You need to click Browse for more and then New Source if a connection does
not exist already.) Your connection type will be Microsoft SQL Server Analysis

www.it-ebooks.info
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Services, and you will need to enter the name of the server to connect to. If
it is on your local machine, using a dot (“.") to mean “local” will suffice. Finish
by choosing the correct model and clicking OK.

Then on the Insert tab, choose PivotTable. Your screen should look similar to
the one shown in Figure 15-17.

PivotTable Fields MR

Show fields: | (20 - A

PivotTablel

4 X FactOECDMationalReserve -

To build a repart, choose fields fram the PivotTahle LatestResenselalue

Field List Reservelialue

L R Y

4 E FactOECDPopulation
hdetrichalue

hdetrichaluedug
hetrichaluehdas:

u| | =
12 =
13
14
15
16
17
18
1

20
21 ROWS I VALUES

4 [F] DimCountry
3 Regions

b [ More Fields hd

Dirag fields between areas below:

FILTERS COLUMNS

22
23

24 =
4« .| Populaton | .. & 4 3 Defer Layout Update

FIGURE 15-17 Designing a pivot table

Drag FactOECDNationalReserve > LatestReserveValue to the Values box,
DimCountry > Regions to the Rows box, and DimDates > YMD to the Columns
box. Right-click in column A and choose Insert; then right-click in row 1 and
choose Insert to give the table a border. Do some basic formatting, and set
the value fields to use the currency format, as shown in Figure 15-18.

Finish the basic formatting by right-clicking Grand Total. If your pivot table
is in A1, this will be D2—if you have left an empty row and an empty column
surrounding your pivot table, this will be E3. All later cell references assumed
that this cell is in E3 and choose Remove Grand Total. The LatestReserveValue
is using a LastNonEmpty pattern, so it always shows the latest value, and Grand
Total for the rows is simply repeating the 2012 value.
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FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEYWY WIEWY ADD-INE Master Data POWERPTVOT
- —
0 6 Cut Calibri Sl - AN == ®- BwiepTe Accounting - =
P BB Copy - Conditional
aj“  Format Painter IU- HopA- = &= 5= Merge & Center ~ B0+ 05 0 G 0f En”y:‘m'&‘”h"i
Clipbaard 5 Font 5 Alighment 5 F.English (South Africa)
3 English {United States)
ca - F | 278ES.
More Accounting Farmats...
A B C D E F G H I J K
LatestReserveValue Column Labels | ~
Row Labels v #2011 2012 Grand Total
@ africa 2788510 § 2856820 & 28569.20

#dvsia + Pacific 3193457.20 325565030 53 255850.30
999249.87 5110880114 5110820114
349 463.50 & 37746230 § 37746230

42766.40 5 4385630 & 4365630

4612822.07 §4814539.24 $4814539.24

s
H
*Europe H
#Latin America+ Caribhean | &
#Morth &merica 3
Grand Total s

- AE - RN ST R RN

FIGURE 15-18 Formatting currencies in Excel

For sparklines, specifically, the data range is not dynamic, so expand both
2011 and 2012 before inserting them. Right-click 2011 Total and remove it
by unticking Subtotal YearName. Insert another column by right-clicking in
column A and choosing Insert—you will put the sparkline here. In B5, select
Insert and then Line, as shown in Figure 15-19.

HOME INSERT
B B LLEd® o & i 2y

.
= 8 -
PivotTable Recommended Teble | Pictures Online Shopes Smorthet Screenshot | Appsfor  Recommended 1 S~ B

PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS Master Data POWERPIVOT D3tz Mining Team

M e B F R

PwotChat Power  Line Column Win/  Slicer Timelin

PivolTables Pictures  ~ . Office - Chats B L . View Loss
Tables Tlustrations Apps Charts & Reports Sparklines Filters
- . . Line Sparkline
Sparklines are mini charts placed in
N ¥ E 5 . . . W siegde sells, cach representing v rew
S I — of data inyour selection.
2 LatestReservoValus Column Labels =
3 2011 -2012
4 Ruw Laliels - “Seplember  “Ocuber  “Nuvember “Dewember Slanuwary  “February  #March
5| L= atrica § 2700050 § 2741940 § 2769940 § 2700510 & 2000970 § 2007.00 & 20501

FIGURE 15-19 Adding sparklines to a pivot table

Choose the data range: D5 to O5, as 2]
ShOWn in Figure 15_20 Choose the data that you want
Data Range: IDS:OS| @

To finish, you need to expand the spar-
kline to all the rows. In order to know
how many rows to expand to, right-click
Africa, choose Expand/Collapse, and
then Expand Entire Field; then do the
same with Southern Africa, as shown in
Figure 15-21.

Choose where you want the sparklines to be placed

Location Range: |$B$5 @

caneel_|
=

FIGURE 15-20 Sparkline data range
window
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LatestReserveValue Column Labels |~
Calibri -|11 -/ A" o" B0+ g4 o
Row Labels BI=00-4 Len o | *November [ Dece

00 =0

= Africa 940 5 2769940 & 27

| H5outhern &frie Ie JTonoEn. . 3741940 & 2769940 & 20

= Asia + Pacific | BB Cepy 111012210 $3194497.00 %319
#Australia + M Eorrnat Cells... 40850.40 & 3@T7ITI0O& 3%
HNorth East & [% Refresh 'B16220.00 %2904911.00 %2807
#5o0uth Asia ot . 183 700.00 5 181633.00 5 17°

u}
#5outh East A: - £9351.70 & 6922580 & Af
= Europe Filter " 004709.08 $ 983479.13 § 99¢
# Central Eurg] v Subtotal "GEQ Subregion” 17441472 & 17246092 5 16t
*Eastern Euro Expand/Callapze (= Expand i
Hiwlestarn Eun Drill © Drl L b | = i

=Latin America 4 Hi emnrni e = Callapse I
Heso amerig 4 Quick Bxplore ¥Z  Expand Entire Field -
#5outh &meri = Collapse Entire Field it

= North America Collapse to "GEQ Region” ke
HMorth Ameri ) I

owe 3 Collapse to "GEOQ Subregion” 3

Grand Total z

2< PRernove "Regions" Expand to "CountryMame"

ShowHide Fields »
Show Properties in Report ¥
Show Property as Caption 4
Show Properties in Tooltips  »
Additional Actions »

&l

Field Settings...
PivotTable Options,.,
Hide Field List

o [m

Search...
Clear PivotTable Cache

[T OLAP PivatTable Extensions...

FIGURE 15-21 Dirilling down on a pivot table

Finish by clicking the bottom-right corner of the cell with your sparkline in
it and dragging it to the bottom of all your data, as shown in Figure 15-22.
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A B C

1

2 LatestReservevalue Col
a =2
4 Row Labels | =g
5 — T | Africa 3
& = Southern Africa 3
7 South africa g
1 = Asia + Pacific S
7 = Australia + New Zealand &
10 Australia g
11 Mew Zealand g
12 = Morth East Asia 3
13 China g
14 Japan g
15 = South Asia s
16 India 5
17 = South East Asia |3
18 Indanesia g
19 = Europe S
20 =l Central Europe 13
21 Czech Republic g
22 Estonia 5
23 Hungary 3

FIGURE 15-22 Extending a sparkline

Once you have done this, collapse the fields again to get a view similar to that
shown in Figure 15-23.

A ] [ n E [ 6 H 1 1 K M N 0
1
2 LatestReservevalue Column tabels =
2 “zu11 S22
4 Raw Lahels ~ “Septemher  “Octaher “Movemher “December  “lanuary “february  “March = April “IMay “lune “luly “August
5 _ S T Wafrica % 2780850 § 2741940 § 27699.40 § 3768510 § 2880970 ¢ 28BTR00 $ 2853310 § 2805040 § 2I836ATD § 28420 § IBGE9.20
3 S ®asia+Paclic 4 310111720 $3110122.10 $3134437.00 $3193457.20 $3212548.50 $3238383.70 $3241176.70 $323805420 $3250299.60 $323435840 $1082756.80 $175610.00
7 T . ®Europe $ 102621483 $1001709.08 § 98347913 § 999249.87 § 98118912 § 995440.69 $1001446.55 $1016501.27 $1055927.69 $111160L67 $ 79471161 $356876.99
8 i T . ®latnAmenca+ Carbbean § 33402350 § 338UBLED § 341B4640 § I4Y46350 G JAEILID § FAEULE.60 S 396 /I S IGILILU0 S IVIESAL0 G IAAUERL0 S F/YULLI0 5246 FLLUD
9 — T #NorthAmerica H 4069300 § 4114140 § 4225150 $ 4276640 G 4207450 $ 4470400 § 446590 © 4473050 S 45370.30 § 4352260 § 4D0S6.00
10 - Grand Tatal $ 452085833 SASI747378 $45B0773.43 $4MM282207 $4MEE312 $465605270 $4G7S5H45 S460117437 $ATHIRAA0 $4TO2866A7 $23IMON4A1 $779197.99

FIGURE 15-23 Sparklines in a collapsed pivot table

Immediately apparent is the influence of the missing data in August 2012: Not
all countries have submitted and it distorts the sparklines. Fix this by remov-
ing August completely in the Excel filters. Do so by clicking on the arrow next
to the words “Column labels” and then ticking the multiselect tickbox. Find
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August 2012 in the tree, and deselect it. This distorts the sparkline, so when
you click the sparkline, a new context menu appears in the Ribbon, and you
can edit the data, as shown in Figure 15-24.

H - = ChapterlfCostals: - Excel SPARKLIME TOOLS
FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA, REWTEYY WIEW ADD-INS Master Data POWERPTVOT Data Mining Team DESIGM
E E E ]E High Paint First Point = [ sparkline Calor~ E Group
u
; Lows Pait Last Paiint \/\/\ \/\/\ \/\/\ \/\/\ \/\/\ \/\/\ - | B Marker Calor = IT's Ungrou
Edit Line  Column Win/ — E A Tlingroup
Data~ Lass Megative Points Markers e - £ Clear ~
i E Edit Group Location & Data.. Show Style Group
Edit Single Sparkling's Data... fe
Hidden & Empty Cells...
9 ] E F G H I 1 3
2 latestResenvevalue Column Labels |-T
3 =l2011 =2012
Row Labels ~ | ¥ September + October +November *December *January + February + March + April
5 | s Hafrica g 2780850 5 2741940 5 2769340 5 278ES.10 5 2580970 & 3GEFT00 5 2853310 5 28
6 S| ®ssia+Pacific % 310111720 %2110122.10 5219449700 5319345720 $3212548.50 $3238983.70 5324117670 53238

- = —= - A ammrmaaan A amaone mn A e e oan A mmmoman o A mmaane an A mee oaan e A e

FIGURE 15-24 Changing sparkline data fields

T

MISSING DATA

Missing data, such as that in this data set (there are data points missing
in June and July as well), is one of the larger problems with aggregating
large data sets. Using normalized aggregations such as arithmetic means
or metrics such as GDP per capita are often required when doing this sort
of analysis, rather than a pure SUM.

Another way of showing data is conditional formatting—the temptation is
to simply highlight the whole data set and add conditional formatting, but
doing this has a problem: the grand total will always be on one end of the
spectrum, and the smallest point of the data set the other. Comparing the
smallest country’s reserve to that of all the OECD nations is not particularly
helpful unless it's expressed as a percentage.

Instead, you will apply conditional formatting to each level independently.
Start by clicking cell D5, choose conditional formatting in the Home Ribbon,
and choose the Green-White scale, as shown in Figure 15-25.
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FILE HOME IMSERT PAGE LAYOUT FORMIILAS DATE, REWIEWY WIEMWY ADD-TNS Master Data POWERPTWVOT Data Mining Team AMNALYZE DESIGM

S 3 Cut - .| = — =, y "
Calibri Sl s AN T == #r BEPWrap Ted Accounting - r 4 | Normal Bad Good
FR Copy - )
Paste I U =

=55 EMergeacenter - 0 0 539 Cenditional Format s EITIIN ceplanatons . [Input

) B u
~ Format Painter Formatting~ Table -

Clipboard 5 Font & Elignment o Humber o ’_—| Styles
Highlight Cels Rules »
D5 - Feo | 278095 £l
T Top/Bottom Rules >
I ] c o E F G Top/Battom Rules ) K
1
H LatestReservevalue Column Labels -T Data Bars "
3 S2011
4 Row Labels ~ wSeptember  ®October  ®November *December E] Color Scales » ﬁ ﬁ = = = May
5 T @africa (8 27808500 5 2741340 ¢ 2769340 § 2788500 s0.40 ¢ 2
5 T @Asia+Padific 4 3100111720 $311012210 $3134497.00 $3193457.20 Jeon Sets v 5 B S sew sans
7 ——————— . #Europe § 102621483 $1004709.08 § 98347313 § 999249.87 01,27 $108
8 " @latinAmerica+Caribbean 4 33902350 § 33408180 § 34184640 § 343463.50 [0 MewRule.. = & 12| L mom ¢ w
9 " &Northamerica § 4069330 § 4114140 §  A2ISLED § 8276640 [ clearpules , mesn ¢ 4
Lo . Grand Total § 452085833 $4SI747378 $4SEOTIIAD S461262207 ;oo Green - White Color Scale 5
1 Apoly a calor gradient ta a range of
12 cells, The color indicates where
e each cell value falls within that

range.

FIGURE 15-25 Applying conditional formatting to a single cell

A small icon will appear next to the cell you just formatted. Click it and set
it to appear for all cells with the year and region, as shown in Figure 15-26.

Column Labels |-T

Sz2011 =2012
r +September + October +Movember +December '+ lanuary + February
__'2?419.40 4 2769940 § 27808510 % 28809,70 & 2887700

3101117.20 Apply formatting rule to ..,

1026214.83 Selected cells

5
5
1% 334023.50
5
$

All cells showing “LatestReseredalue” values
a0693.30 © wing

4529 858.33 O Al cells showing “LatestReservetalue” values for "GEQ Region” and “MaonthMame”

FIGURE 15-26 Expanding a conditional formatting selection

Next, you will do the same for the level below that: the subregion. In this
case, to differentiate between the levels, you will use a color scale from light
to dark blue. So instead of choosing the same color scale, choose more rules.
Set the rule up, as shown in Figure 15-27, making sure to set it to apply to all
cells with the values Sub Region and Month, and choose two appropriately
spaced blue values.
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New Formatting Rule 21x|

Apply Rule To: |=$D$6 E
 selected cells

sl cells showing "LatestReservedalue” values

& allcells showing “LatestReserveMalue” values for "GEQ Subregion” and "MonthMame™

Select a Rule Type:

= Format all cells based on their walues

+ Farmat anly cells that contain

= Format only top or bottom ranked values

= Format only values that are above or below average
+= Use aformula to determine which cells to format

Editthe Rule Description:

Format all cells based on their values:

Format Style: 3_colar Seale &

Minimum Maximum

Type: Loweest Walue vl Highest Walue -
Walue: |[Lowestvalug] E [Highest walue)
Colon -1 [t g

oK Cance|

FIGURE 15-27 Conditional formatting rules window

Repeat this process at the country level, using yellow and red (you could choose
any color you want, as long as it doesn’t overlap with the existing color sets).
The result is a table looking similar to the one shown in Figure 15-28.

latestReserveValue Column Labels -7
=2011 =2012
Row 1ahels + | #Septemher #0ctoher “Nnvemher  ®Decemher ¥ lanuary #Fehruary #narch =april + May # une #uly
- Cafria $ 27809.50 § 2741940 27G99.40 § 2788510 $ 28809.70 § 2B877.00 § 2853340 $ 2805040 $ 2836470 § 2842110
=Southern Africa '$ 2780950 § 2741040 §  27699.40
sauthafrica § IVEISSD § 2741940 §  27RSY.AD §  I7HESI0

$1092 756.80
. § 102621483 $100470908 § 99347943 § 09924007 § 98418012 $ 00544069 S100444655 $1016501.27 $1055927.60 S1111601.67 S 794 71161
- +uﬁnnmprim+mrihhn:n-p 3302350 5 33:08LBU S 34184640 $ 34946350 $ 63130 $ BUIGHU $ I6 /3L S F6IBV00 S5 I71IESFI0 $ 37496210 § 3/9UL0.30
$
$

. _UAsia + Pacific

~ % North America 5 40693.30 § 4114140 4225150 § 4276640 $ 4267450 § 4473480 § 4465390 $ 4473850 $ 4537930 § 4352360 $ 4385630
. Grand Total $  4529050.3) $4517471.70 $4509773.43 $4612022.07 $4616053.12 $4656952.79 $4675541.45 $4691174.37 $475102039 $4792066.07 $2330904.21

FIGURE 15-28 Multiple conditional formatting rules applied to a pivot table
It is important to note that the conditional formatting is relative to the data

currently visible: drilling down on Europe. (Take note of the change in the
coloring for South Africa, as seen in Figure 15-29.)
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lLatastReserveValue Column Labals .7
—2011 —2012

Row Labels = *September “October “MNovember *December  *January “February “March +April * May “June “July
o " =" Cafrita $ ZIHMSN S 2741940 § P/69UA0 § ZUEESA0 S ZHEOYS0 S ZRESAO0 S ZRSHHI0 S ZHISDAD S ZRARAIO § ZRANLIND S ZBSHUZN
——" =" =Southem Africa $ 2700950 § 2741940 $ 27699.40 § 2700510 $ 2000970 $ 2007700 $ 2051340 $ 2005040 $ 2036470 § 2042110 $ 20569.20

— South Africa S 2780850 $ 2741940 § 27699.40 § 2768510 $ 28809.70 § 2087700 $ 2853310 $ 28050.40 § 2836470 $ 2042110 § 2856920

T EmsiatPaific $1092 756.80
e $ 704711

= cCentral Europe

Czech Republic 5 2566340 § 25960.60 § 2610050 § 2505320 § 2570400 § 2720700 § 2737060 $ 2750130 § 25547.00 § 2561230 § 2545290
Estonia H 13149 % 136.47 $ 13998 § 127§ 13450 § 189.58 % 17868 S 18965 § 18T % 16908 % 1860.2%
Hungary 5 3352230 § 3285600 $ 3050800 § 3171160 § 3158100 § 2997230 § 2977520 $ 2989930 § 2911410 § 2933030 § 29076.40
Poland § €0913.80 § 6127760 § 6006210 § 6046120 § 61063.90 § £1791.00 § 6093370 § 6226520 § 61709.10 § 6348110 § 6435640
Sluvenia 5 554.01 $ 569.65 § 535.04 3 544.67 § 596.30 § 547.14 $ 50558 § 506.17 $ 51189 $ 514.90 % 546.21
Turkey s 5617440 S 5360440 § 5502100 § 5123520 ¢ 4949480 ¢ SOE0L10 $ 5208370 £ 5208570 § 5232080 ¢ 5532550 § 56699.90

S Fastern Furope
Russian Federation

FIGURE 15-29 Changing conditional formatting by drilling down

ADDING CONDITIONAL FORMATTING TO A PPS SCORECARD

PerformancePoint also has conditional formatting, but it is by no means
as intuitive as that in Excel. To do conditional formatting, a custom indica-
tor needs to be created and then conditional formatting enabled on the
scorecard.

Chapter 10 covered the creation of custom indicators in some depth, so
they won't be covered here again.

SUMMARY

Embedding visualizations in applications and in tables is one of the most
powerful ways to use them. The tools available from Microsoft to do this are
quite powerful, and in this chapter you learned the techniques to apply them.
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CHAPTER 16

Other Visualizations

Throughout this book you have learned about visualizations that you can
implement using the Microsoft stack, and how to implement them. In this chap-
ter you learn about other visualizations—many of these are not data-driven;
instead, they are often drawn by artists or handcrafted by other professionals.

TRADITIONAL
INFOGRAPHICS

As discussed at length in Chapter 1, data driven
visualizations and infographics are very different in
function, and they are often different in form as well.
An infographic is typically static—in other words, if
the data changes, the infographic doesn’t update.
Many infographics are simply images rather than
being interactive.

are obligated by insurance policy or
| regulations to adopt recovery plan

qualify for reduced insurance premiums based
on backup and disaster recovery strategy

ik kA EE

BENEFITS OF NEXT-GENERATION BACKUP AND RECOVERY

#5805 EAT(ES

RETURN ON INVESTMENT CUT RESTORE TIMES ON AVERAGE
VER THREE YEARS

An infographic is often used to tell a single story,
with imagery chosen to fit that story. It might have

) ) O"U
numeric values attached to the images. An example 11 3

HOURS
infographic is shown in Figure 16-1.
AVERAGE PAYBACK PERIOD REDUCE BACKUP WINDOWS.

Jeraw

SAVINGS IN TAPE-RELATED
(COSTS OVER 3 YEARS

SAVE |TSTAFF TIME OVER 3 YEARS

FIGURE 16-1 Aninfographic promoting next generation
backup and recovery
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PERIODIC TABLES

Mendelev’s periodic table of the elements was a revolution in understand-
ing of the elements—not just as a visualization, but also because he used
the atomic weight—that is, how many protons were in the atom—as the
underpinning, and isotypes are simply versions of the same element. The
effect of the way Mendelev laid out the table cannot be overstated. As
shown in Figure 16-2, being able to read the group (for example, beryl-
lium and magnesium both in Group 2) across, and the periods (such as
hydrogen and helium being the only two members of Period 1) down was
of enormous value.

Group — 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
| Period

1 2

Llw He

2 4 = 6 7 8 9 10

Be B C N (8] F Ne

3 12 13 14 15 16 17 18

Mg Al Si P 5 Cl Ar

1 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36

Ca Sc Ti W Cr || Mn || Fe || Co Ni Cu || Zn || Ga || Ge || As || Se Br Kr

5 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54

5r Y r Nb Mo Tc Ru Rh Pd Ag cd In sn Sh Te | Xe

6 56 72 73 74 75 76 77 78 79 80 81 82 83 84 a5 86

Ba Hf Ta w Re || Os Ir Pt || Au || Hg Tl Pb Bi Po || At Rn

7 a8 104 || 105 || 106 (| 107 || 108 (| 109 || 110|| 111 ([ 112 || 113 || 114 || 115 || 116 ([ 117 || 118

Ra Rf || Db Sg Bh Hs Mt Ds Rg || Cn || Uut ]| FI |[Uup|| Lv || Uus || Uuo

Lanthanides

Actinides

57 || 58 || 59 || &0 || 61 || 62 || ©3 || 64 || 65 || 66 || 67 || 68 || 69 || 70 || 71
La Ce Pr Nd || Pm || Sm || Eu |[ Gd || Tb Dy || Ho Er || Tm |[ Yb Lu

89 90 91 92 93 94 95 96 97 o8 99 || 100 || 101 || 102 || 103
Ac || Th Pa U Np || Pu || &m || Cm |[ Bk cf Es || Fm || Md || No Lr

FIGURE 16-2 The periodic table of elements

Other forms of this periodic table have been used to illustrate other subject
areas. The periodic table of fonts in Figure 16-3 is a stellar example. This
visualization (including the option to purchase a print) is available here:
www . squidspot.com/Periodic_Table_of_ Typefaces.html.

Perhaps the most intriguing of the periodic table of elements visualizations is
the one at www.visual-literacy.org/periodic_table/periodic_table.
html, which is a periodic table of visualizations. This is shown in Figure 16-4.
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Periodic Tables

Periodic aTable of
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FIGURE 16-3 A periodic table of fonts

A PERIODIC TABLE OF VISUALIZATION METHODS
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FIGURE 16-4 The periodic table of visualizations
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SWIM LANES

Swim lanes, also called cross-functional flow charts in Microsoft Visio, are most
often used to show process flows across different areas (see Figure 16-5). This
flow shows a typical ETL (Extract, Transform, Load) process loading data from
one system into a warehouse, and the data subsequently being used by the
business information (BI) system.

SSBI

Estract Data

Transform Load Present

Single Source

#d-u-a

Multi Source

98-

|

Ideal

FIGURE 16-5 A swim lane illustrating different ETL processes

TRANSPORTATION MAPS

When trains and subways were first put into service, maps of their routes fol-
lowed the same conventions as traditional maps. Shown to scale, there was
often an enormous amount of wasted space on the map, as well as overlap-
ping text when stations were close together. With the launch of the New
York subway, which had more stations than ever before, something new
was needed, and this was the novel concept of showing each station evenly
spaced. That concept, along with color-coding the lines and removing the
background graphics, made this map revolutionary in visualizations of travel
routes. Figure 16-6 shows the original New York subway map. (You can obtain
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Transportation Maps

other New York subways maps through history at http://nycsubway.org/
wiki/Historical Maps.) Figure 16-7 shows a newer version of the subway map.
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FIGURE 16-6 The original NYC subway map
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FIGURE 16-7 A newer NYC subway map
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MIND MAPS

Mind maps are a little outside the traditional visualization arena, but are very
useful for brainstorming and framing your thoughts around a plan. A book’s
contents are easily planned in a mind map, and this book’s original Table of
Contents is shown as a mind map in Figure 16-8. You'll note that the book
has evolved over time!

Using 30 effectivoly
Coscams

it dyramicciagrams com 200011
Vil Piayta DA concmist cominose!| 0770643 viory_ide 0270643
" Charles Joseph Minard

Tha s wisssasasons

(A istory o viesasason |

, 0x236808 Snon ¢
Chooting  veuakeaten - oo bing iiandly patanes

Parl 2. Microsalt's loolsel for |
visualizing data

{Pan 3 : Visual Analytcs in practice |

FIGURE 16-8 Mind maps used for planning this book

VENN DIAGRAM

A Venn diagram is a very simple visualization used in set

theory, which has been widely adopted on the Internet.

Two or three circles, each representing a group, are shown

overlapping each other, with the overlap being the group Intelligence
(or set) of people or things that belong to all those group-
ings overlapping those areas. These circles are not shown
to scale in the most common form of these diagrams.
A widely shared example of a Venn diagram is shown
in Figure 16-9. (It's become quite popular to use Venn
diagrams for humor.)

Geek

Obsession

FIGURE 16-9 A humorous Venn diagram
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CAD DRAWINGS

Computer aided design (CAD) is a massively growing field, especially with the
growth of 3D printing. Originally CAD was commonly used only by engineers
and architects on high-end workstations, but it has penetrated the world of
design very deeply. A CAD drawing is shown in Figure 16-10.
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FIGURE 16-10 Computer aided design—more complex than the average visualization
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3D MODELING

CAD is a form of 3D modeling, but the world of 3D has expanded vastly
beyond just CAD with engineering precision. Games, such as the original
Quake and all of its successors, are an obvious example, but 3D design has
penetrated far further. Figure 16-11 shows an example of a 3D inspection
program designed to run on a tablet computer and used to aid engineers in
inspecting power pylons.

[ Line View | Inspection | Mai e | Line Construction | Clerk of Wark|

mpmroo- ﬂzmzoﬂgonﬂ

FIGURE 16-11 The Orion inspection system developed by Aphelion Software

FUNNELS

Funnels represent any process where the number of items decreases as the
process progresses. They have widely been applied to the sales process—
some leads turn into opportunities, some opportunities turn into negotia-
tions, some negotiations turn into sales. The value in visualizing this as a
funnel is showing the effectiveness of this process as well as showing which
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step has the lowest conversion ratio. If a salesperson has a wide pipeline
in every step except turning negotiations into sales, perhaps he could use
some assistance in closing or needs to attend a course on sales techniques.
Figure 16-12 shows an example of a typical sales funnel. This funnel is built
in Microsoft Reporting Services.
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FIGURE 16-12 Asales funnel developed in SSRS

FLOW DIAGRAMS

The swim lanes discussed earlier in this chapter are a type of flow diagram.
The instance shown in Figure 16-5 was specific to one process, but flow dia-
grams can be very conceptual. The following figures are two different flow
charts: Figure 16-13 is a normal UML (Universal Modelling Language) flowchart,
showing a start, end, and a couple of decision points and processes, whereas
Figure 16-14 is a SharePoint workflow diagram that shows a workflow process.
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Cubing Process Flow
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FIGURE 16-13 A UML data flow
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FIGURE 16-14 A SharePoint workflow in Visio

GEOGRAPHIC INFORMATION
SYSTEM MAPS

Any data containing a latitude and longitude could technically be considered
a Geographic Information System (GIS). The term GIS is typically used for those
systems containing spatial data types and/or mapping capabilities.

On the Microsoft platform, SQL Server has had support for spatial data types
since SQL 2008, and mapping support came along in Reporting Services for
SQL 2008 R2, which included support for Bing Maps. You can see an example
in Figure 16-15.

Further evolution in Office 2013 Power View has enabled people to create
slicker maps directly in Excel (and SharePoint), as shown in Figure 16-16, which
is an election-tracking template provided with Excel 2013.
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Geographic Information System Maps
FIGURE 16-15 A geospatial heatmap, or chloropleth, in SSRS
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FIGURE 16-16 An election-tracking map in Excel

The various types of visualizations that can be done on maps (in other words,
adding visualizations to maps as opposed to the different types of maps)
include the following:
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FIGURE 16-17 A prism map

Chloropleth: The different bounded areas are highlighted by changing
the shading or color to represent a value.

Prism map: Similar to a chloropleth, but in 3D.
Pin map: Pins are shown on a map to highlight areas of interest.

Combined chart maps: Instead of pins, some other chart type, such as a
bar chart or pie chart, is shown to represent a value at that point.

Chloropleth and prism maps are often used for representing values such as
population density or voters, but they are also good for representing sales
or profitability in a state. The reporting services map shown in Figure 16-16
is a chloropleth, and Figure 16-17 shows a prism map. You can also see one
at www.pwinfographics.net.

Pin maps are good for navigation and orientation. Although they are used to
represent data by having a variable number of pins, this is an inefficient use of
space, and pin maps are often unreadable when the volumes become too high.

Showing charts on a map is another usage that is inefficient—especially as
the prevalence is toward pie charts. The charts obscure the map itself, they
are often too small to read easily, and they are often poorly distributed and
obscure one another.
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HEATMAPS

The chloropleth map shown in the previous section is in fact a specialized
type of heatmap in which the size and shape of the individual items are based
upon GIS shapes such as countries or states. A heatmap uses the color of the
item to convey one dimension, and the size to convey another. This has often
been used in stock-market analyses, where size is used to show either market
capitalization, or the size of the investor’s holding, and color has been used to
show the performance of the share. Figure 16-18 is an example of a chloropleth.
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FIGURE 16-18 A heatmap of stock prices

SUMMARY

In this chapter you learned about some other common types of visualizations.
Many of these, such as infographics and periodic tables especially, are likely
to be handcrafted, and so won't be data driven—but they can still be useful
in the decision-making process.
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APPENDIX A

Choosing a
Microsoft Tool

When working in the Microsoft business intelligence toolset, it's important to
realize that you will not standardize on one tool for your visualizations. Each
tool in the tool box has its own purpose, and you will frustrate yourself trying
to make the wrong tool do the job of another—just as it would be frustrating
to try to drive in a nail with a screwdriver. In this appendix, you discover the
strengths and weaknesses of each tool.

STRENGTHS AND WEAKNESSES
OF EACH TOOL

As mentioned in Chapter 2, the Microsoft toolset loosely follows the strategic/
tactical/operational levels, with a tool for each level. However, the correlation is
loose, and with the launch of Power View as an application within SharePoint
and a visualization within Excel, the tactical level has been split into two
categories: PowerPivot in Excel for the data modeling, and Power View for
the visualization. Consequently, the correlation between the toolset and the
levels has become even weaker. This chapter explores the uses of each tool
and shows you how to choose which to use.

PERFORMANCEPOINT

As described in Chapter 3, PerformancePoint Services (PPS) has its antecedents
in the original Business Scorecard Manager. The strongest feature of PPS is
the scorecard building component.
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Many people struggle
with trying to cus-
tomize Analytic Grids
to display datain a
format that can be
customized. Instead,
use scorecards to
gain control over the
display of your data.
Analytic grids are
simply an interactive
component rather
than a high-fidelity
display component.

Rating by Store -C
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CHOOSING A MICROSOFT TOOL

PerformancePoint is directly aimed at the process of looking at a scorecard
and quickly identifying where a problem exists, and then exploring prebuilt
analysis paths to identify root causes of the problem.

A key point about PerformancePoint is that it is ideal for driving analysis from a
monitoring point of view, clicking on a value in a scorecard to change values in
associated charts and grids. It has the ability to have either a PerformancePoint
Analytic Chart or an Excel Services or Reporting Services report embedded
on the same page, and driven by the scorecard. Figure A-1 shows a mixture
of PerformancePoint components, a map created within Reporting Services,
and an Analytic Chart below. Clicking the scorecard updates the map as well
as the chart, and the chart allows for additional drilling down.

[ PEOPLE

. INTERNAL PROCESSES
I FINANCIAL

Il CUSTOMER

Store 1

Store 2 Store 3

— Gauteng

— KZN

August
September

October

april June
March May July

December February August

November January September

FIGURE A-1 PerformancePoint interactive dashboard

PerformancePoint is particularly poorly suited for printing, as the SharePoint
elements, such as navigation and the Ribbon, are typically also printed.

REPORTING SERVICES

Reporting Services is squarely aimed at the high-fidelity reporting audience.
It is more complex to develop than either PerformancePoint or Excel, and is
typically a developer function, even when using Report Builder, but offers a
level of control over the display not allowed in the other tools. A rather com-
plex but exceptionally powerful expression language enables a developer to
do exceptionally powerful conditional formatting.
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CHOOSING A MICROSOFT TOOL

In addition, Reporting Services and Power View are the only two tools that
include mapping capabilities, and Reporting Services allows for much greater
customization of the maps.

Reporting Services is often used where inclusion of specific formatting ele-
ments, such as logos, time of running reports, and so on, are required—for
instance, in a monthly board pack that needs to be printed.

Figure A-2 shows an example Reporting Services front page.

Activity Progress Table

Acions » @ M AT o1 b Bl @ FindMext [100% =l
Key
Target Date
Achieved Milestone
Past Completion Date 1]
.

STP8.1.1 : Upgrading households in informal settlements with access to secure tenure and basic services
ACTB.1.1.1 : Activity 8.1.1.1

201011 201112

Excel/Excel Services
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Milestone Name Target Date

lion and isation of informal in all previnces 2011/03/31 ! |5“ '016
9 confirmed provincial project lists 2011/03/31 ! |1”’ !ﬂ%
Assess exsting projects for i againsi delivery iarget 2011/03/31
Confirm pipeline of new and existing projects 2011/03/31 PO%
Planning, land acquisition and senice provision to 20000 households 2011/03/31 0% -
Planning, land acquisition and senice provision to 100000 households 201203131

FIGURE A-2 Areport showing the progress of initiatives in a government department

EXCEL/EXCEL SERVICES

Excel is and has always been the domain of the analyst—someone who wants
to interact with his data and have a dynamic visualization rather than a static
one. Pivot tables and pivot charts, with slicers, enable a user to build an inter-
active dashboard, and the ability to publish on the web using Excel Services
allows for the sharing of the analysis while preserving the interactivity. The
inclusion of PowerPivot (in Excel 2010) and Power View (in Excel 2013) advances
this interactivity greatly.

Figure A-3 shows an example of an Excel dashboard.
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FIGURE A-3 Aninteractive Excel dashboard including a bullet chart at the bottom

POWER VIEW

Power View is designed for data exploration. You use this tool when you do not
know what question you should be asking, but want to explore and discover
patterns in your data. For developers, it is important to put away your assump-
tions about Report Builder when working with Power View, The approach is
not really to give your users a prebuilt Power View report, but to give them
a model that they can explore on their own—or with PowerPivot—to build a
model and explore it using Power View.

An example of Power View’s killer feature—the animated bubble chart—is
shown in Figure A-4. (The animation doesn't show in the figure here, of course,
but it really is animated!)
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HTML5

80K YARDLEY

50K
40K
30K

20K

Apr 2011 May 2011 Jun 2011 Jul 2011

FIGURE A-4 An animated Bubble chart in Power View

HTML5

HTML5 (using such adjunct technologies as JavaScript and CSS, and librar-
ies such as JQuery and D3) is a developer’s tool and not at all an end-user
technology. HTML5 is used when developing visualizations that are simply
not possible using any of the other tools. A prism map is a good example
and is shown in Figure A-5. An interactive version of this is available at at
http://www.pwinfographics.net.

FIGURE A-5 A prism map shown on a world outline
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MATCHING A VISUALIZATION TO A TOOL

In Table A-1, you can see whether a tool has a visualization type built in, the
ease of development (which can sometimes be achieved even when the visual-
ization is not built in), how customizable the visualization is, and finally, where
appropriate, the location in this book where you can find how to implement
this visualization in that particular tool.

TABLE A-1 The ease of developing Visualizations in each tool

VISUALIZATION

Indicators

Indicators

Indicators

Indicators

Indicators

Scorecards

Scorecards

Scorecards

Scorecards

Scorecards

Timelines

Timelines

Timelines

Timelines

Timelines

Line chart

Line chart

Line chart

Line chart

PREDEFINED EASE OF
TOOL CHARTTYPE DEVELOPMENT CUSTOMIZABLE CHAPTER
PerformancePoint Yes . . 10
Reporting Services Yes .
Excel/Excel Services Yes . . 10
Power View No N/A N/A
HTML5 No . .
PerformancePoint Yes . . 10
Reporting Services No . .
Excel/Excel Services No 10
Power View No N/A N/A
HTML5 No .
PerformancePoint No N/A N/A 1
Reporting Services No . 1
Excel/Excel Services No . 1
Power View No N/A N/A 1
HTML5 No . . 1
PerformancePoint Yes . . 1
Reporting Services Yes . .
Excel/Excel Services Yes . 1
Power View Yes . . 11
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VISUALIZATION

Line chart

Bar chart

Bar chart

Bar chart

Bar chart

Bar chart
Column chart
Column chart
Column chart
Column chart
Column chart
Column & Line
Column & Line
Column & Line
Column & Line
Column & Line
Scatter plot
Scatter plot
Scatter plot
Scatter plot
Scatter plot
Bubble chart
Bubble chart
Bubble chart

Bubble chart

TOOL
HTML5

PerformancePoint

Reporting Services
Excel/Excel Services
Power View

HTML5
PerformancePoint
Reporting Services
Excel/Excel Services
Power View

HTML5
PerformancePoint
Reporting Services
Excel/Excel Services
Power View

HTML5
PerformancePoint
Reporting Services
Excel/Excel Services
Power View

HTML5
PerformancePoint
Reporting Services
Excel/Excel Services

Power View

PREDEFINED
CHART TYPE

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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EASE OF
DEVELOPMENT

N/A

CUSTOMIZABLE

N/A

CHAPTER

11,12

11,12

11,12
11,12
11,12
11,12
11,12
11,12
11,12
11,12
11,12

11,12

1
1
1"
1
1
1"
1

1
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VISUALIZATION

Bubble chart
Pie charts
Pie charts
Pie charts
Pie charts
Pie charts

Scale breaks

Scale breaks
Scale breaks

Scale breaks

Scale breaks

Multiple axes
Multiple axes
Multiple axes
Multiple axes
Multiple axes

Radar charts

Radar charts
Radar charts

Radar charts

Radar charts

Bullet chart
Bullet chart

Bullet chart

Bullet chart
Bullet chart

Pivot table

TOOL
HTML5

PerformancePoint
Reporting Services
Excel/Excel Services
Power View

HTML5

PerformancePoint

Reporting Services
Excel/Excel Services

Power View

HTML5
PerformancePoint
Reporting Services
Excel/Excel Services
Power View

HTML5

PerformancePoint

Reporting Services
Excel/Excel Services

Power View

HTML5

PerformancePoint

Reporting Services
Excel/Excel Services

Power View

HTML5

PerformancePoint

PREDEFINED
CHART TYPE

No

Yes

Yes

Yes

Yes

No

No

Yes

No

No
No

Yes

Yes

Yes

No

No

No

Yes

Yes

No
No

No

Yes

No

No
No

Yes

EASE OF
DEVELOPMENT

zZ
>

/

Z
>

/

N/A

N/A

N/A

N/A
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N/A

N/A

CHAPTER
1

12

12

12

12

12

12

12

12

12

12

12
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VISUALIZATION

Pivot table
Pivot table

Pivot table
Pivot table

Pivot chart
Pivot chart
Pivot chart

Pivot chart

Pivot chart
Drill across
Drill across
Drill across
Drill across
Drill across

Drill through

Drill through
Drill through

Drill through
Drill through

Slicers

Slicers
Slicers
Slicers
Slicers
Histogram

Histogram

TOOL

Reporting Services
Excel/Excel Services

Power View
HTML5

PerformancePoint
Reporting Services
Excel/Excel Services

Power View

HTML5
PerformancePoint
Reporting Services
Excel/Excel Services
Power View

HTML5

PerformancePoint
(using SSAS)

Reporting Services
Excel/Excel Services

Power View
HTML5

PerformancePoint

Reporting Services
Excel/Excel Services
Power View

HTML5
PerformancePoint

Reporting Services

PREDEFINED
CHART TYPE

No

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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VISUALIZATION

Histogram
Histogram
Histogram

Box charts

Box charts
Box charts

Box charts

Box charts
Trend lines
Trend lines
Trend lines

Trend lines

Trend lines

Clustering

Clustering
Clustering

Clustering
Clustering
Decomposition
Tree

Decomposition
Tree

Decomposition
Tree

Decomposition
Tree

Decomposition
Tree

Network map

TOOL

Excel/Excel Services
Power View
HTML5

PerformancePoint

Reporting Services
Excel/Excel Services

Power View

HTML5
PerformancePoint
Reporting Services
Excel/Excel Services

Power View

HTML5

PerformancePoint

Reporting Services
Excel/Excel Services

Power View

HTML5

PerformancePoint

Reporting Services

Excel/Excel Services

Power View

HTML5

PerformancePoint
(using Visio)

PREDEFINED EASE OF
CHARTTYPE DEVELOPMENT

Yes

Yes .
No

No N/A
Yes .
Yes ‘
No N/A
No O
No O
Yes ‘
Yes .
No N/A
No

No N/A
No

No

No N/A
No

Yes .
No .

No N/A
No N/A
No
Yes
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VISUALIZATION

Network map

Network map
Network map

Network map

Color wheel

Color wheel

Color wheel
Color wheel

Color wheel

Tree

Tree

Tree
Tree

Tree

Strategy map

Strategy map
Strategy map
Strategy map
Strategy map

Embedded
charts

Embedded
charts

Embedded
charts

Embedded
charts

Embedded
charts

Conditional
formatting

TOOL

Reporting Services

Excel/Excel Services
Power View
HTML5

PerformancePoint

Reporting Services

Excel/Excel Services
Power View

HTML5

PerformancePoint

Reporting Services

Excel/Excel Services
Power View

HTML5

PerformancePoint
(using Visio)

Reporting Services
Excel/Excel Services
Power View

HTML5

PerformancePoint

Reporting Services

Excel/Excel Services

Power View

HTML5

PerformancePoint

PREDEFINED
CHART TYPE

Yes

Yes

Yes
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EASE OF
DEVELOPMENT

N/A
N/A

N/A

N/A
N/A

N/A

N/A
N/A

N/A
N/A
N/A

N/A

N/A

CUSTOMIZABLE

N/A
N/A

N/A

N/A
N/A

N/A

N/A
N/A

N/A
N/A
N/A

N/A

N/A

CHAPTER
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VISUALIZATION

Conditional
formatting

Conditional
formatting

Conditional
formatting

Conditional
formatting

Maps
Maps

Maps
Maps

Maps

TOOL

Reporting Services

Excel/Excel Services

Power View

HTML5

PerformancePoint

Reporting Services

Excel/Excel Services

Power View

HTML5

PREDEFINED
CHART TYPE

Yes

Yes

No

No

No

Yes

No

Yes

No

EASE OF
DEVELOPMENT

N/A

N/A

N/A
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APPENDIX B

DAX Function Reference

Data Analysis Epressions (DAX), is the language used by both PowerPivot and
the Tabular mode of Analysis Services, and will be of great use during your
data analysis. This appendix contains a function reference.

UPDATED FUNCTION REFERENCE

Microsoft maintains an updated function reference at http://msdn
.microsoft.com/en-us/library/ee634396.aspx.

DATE AND TIME FUNCTIONS

Date and time functions, as listed in Table B-1, allow for the manipulation of
data stored in datetime formats.

TABLE B1 Date and Time Functions

FUNCTION DESCRIPTION

DATE (<year>, <month>, <day>) Returns the specified date in date-
time format.

DATEVALUE (date_text) Converts a date in the form of text to
a date in datetime format.

DAY (<date>) Returns the day of the month, a num-
ber from 1 to 31.

EDATE (<start_date>, <months>) Returns the date that is the indicated
number of months before or after
the start date. Use EDATE to calculate
maturity dates or due dates that fall
on the same day of the month as the
date of issue.
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DAX FUNCTION REFERENCE

FUNCTION

EOMONTH (<start_date>, <months>)

HOUR (<datetime>)

MINUTE (<datetime>)

MONTH (<datetime>)

NOW ()

SECOND (< time>)

TIME (hour, minute, second)

TIMEVALUE (time_text)

TODAY ()

WEEKDAY (<date>, <return_type>)

WEEKNUM (<date>, <return_type>)

YEAR (<date>)

YEARFRAC (<start_date>,
<end_date>, <basis>)

DESCRIPTION

Returns the date, in datetime for-
mat, of the last day of the month,
before or after a specified number
of months. Use EOMONTH to calculate
maturity dates or due dates that fall
on the last day of the month.

Returns the hour as a number from 0
(12:00 A.M.) to 23 (11:00 P.M.).

Returns the minute as a number from
0 to 59, given a date and time value.

Returns the month as a number from
1 (January) to 12 (December).

Returns the current date and time in
datetime format.

Returns the seconds of a time value,
as a number from 0 to 59.

Converts hours, minutes, and seconds
given as numbers to a time in date-
time format.

Converts a time in text format to a
time in datetime format.

Returns the current date.

Returns a number from 1 to 7 identi-
fying the day of the week of a date.
By default the day ranges from 1
(Sunday) to 7 (Saturday).

Returns the week number for the
given date and year according to the
specified convention. The week num-
ber indicates where the week falls
numerically within a year.

Returns the year of a date as a four
digit integer in the range 1900-9999.

Calculates the fraction of the year
represented by the number of whole
days between two dates. Use the
YEARFRAC worksheet function to iden-
tify the proportion of a whole year's
benefits or obligations to assign to a
specific term.
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FILTER FUNCTIONS

DAX FUNCTION REFERENCE

Filter functions, shown in Table B-2, are applied within the Calculate function,
and are used to select from a range of data.

TABLE B-2 Filter Functions

FUNCTION

ALL( <table> | <columnl>,
<column2>,..)

ALLEXCEPT (<table>, <columnl>,

<column2>,..)

ALLNOBLANKROW (<table> |
<column>)

ALLSELECTED ( [<table> |
<column>])

CALCULATE (<expression>,
<filterl>, <filter2>,..)

CALCULATETABLE (<expression>,
<filterl>, <filter2>,..)

DISTINCT (<column>)

EARLIER (<column>, <number>)

EARLIEST (<column>)

FILTER (<table>, <filter>)

FILTERS (<column>)

DESCRIPTION

Returns all the rows in a table, or all
the values in a column, ignoring any
filters that might have been applied.

Removes all context filters in the
table except filters that have been
applied to the specified columns.

From the parent table of a relation-
ship, returns all rows but the blank
row, or all distinct values of a column
but the blank row, and disregards any
context filters that might exist.

Removes context filters from columns
and rows in the current query, while
retaining all other context filters or
explicit filters.

Evaluates an expression in a context
that is modified by the specified
filters.

Evaluates a table expression in a con-
text modified by filters.

Returns a one-column table that
contains the distinct values from the
specified column.

Returns the current value of the spec-
ified column in an outer evaluation
pass of the mentioned column.

Returns the current value of the
specified column in an outer evalua-
tion pass of the mentioned column.
EARLIEST is similar to EARLIER, but it
lets you specify one additional level
of recursion.

Returns a table that represents a sub-
set of another table or expression.

Returns the values that are directly
applied as filters to column.
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FUNCTION DESCRIPTION

HASONEFILTER (<column>) Returns TRUE when the number of
directly filtered values on column is
one; otherwise returns FALSE.

HASONEVALUE (<column>) Returns TRUE when the context for
column has been filtered down to one
distinct value only; otherwise, the
function returns FALSE.

ISCROSSFILTERED (<column>) Returns TRUE when column or another
column in the same or related table is
being filtered.

ISFILTERED (<column>) Returns TRUE when column is being
filtered directly. If there is no filter
on the column or if the filtering hap-
pens because a different column in
the same table or in a related table
is being filtered, then the function
returns FALSE.

INFORMATION FUNCTIONS

Information functions, as shown in Table B-3, return additional information,
such as a data type.

TABLE B-3 Information Functions

FUNCTION DESCRIPTION

CONTAINS (<table>, Returns TRUE if values for all referred
<columnl>, <valuel>, columns exist, or are contained, in
<column2>, <value2>,..) those columns; otherwise, the func-

tion returns FALSE.

ISBLANK (<value>) Checks whether a value is blank, and
returns TRUE or FALSE.

ISERROR (<value>) Checks whether a value is an error,
and returns TRUE or FALSE.

ISLOGICAL (<value>) Checks whether a value is a logical
value (TRUE or FALSE), and returns
TRUE or FALSE.

ISNONTEXT (<value>) Checks whether a value is not text
(blank cells are not text), and returns
TRUE or FALSE.
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FUNCTION

ISNUMBER (<value>)

ISTEXT (<value>)

LOOKUP FUNCTIONS

DAX FUNCTION REFERENCE

DESCRIPTION

Checks whether a value is a number,
and returns TRUE or FALSE.

Checks whether a value is text, and
returns TRUE or FALSE.

Lookup functions, as shown in Table B-4, are used to retrieve values from
other tables for calculated columns, or can be used in calculated measures.

Note that using related tables will improve performance dramatically, and
using calculated measures will offer a processing and size improvement over

calculated columns.

TABLE B-4 Lookup Functions

FUNCTION

LOOKUPVALUE ( <result_column>,
<search_columnl>,
<search_valuel>[,
<search_column2>,
<search_value2>]..)

RELATED (<column>)

RELATEDTABLE (<table>)

VALUES (<column>)

PARENT-CHILD FUNCTIONS

DESCRIPTION

Returns the value in result_col-
umn for the row that meets all criteria
specified by search_column and
search_value. A replacement for
VLOOKUP in Excel, LOOKUPVALUE is
used only when relationships don’t
exist.

Returns a related value from another
table.

Evaluates a table expression in a
context modified by the given filters.
Returns a set of values.

Returns a one-column table that
contains the distinct values from
the specified column including the
Unknown member.

Parent-child functions, shown in Table B-5, are used to implement parent-child
hierarchies in DAX—these hierarchies are often called Ragged hierarchies.
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TABLE B-5 Parent-Child Functions

FUNCTION DESCRIPTION
PATH (<ID_column>, Returns a delimited text string with
<parent_column>) the identifiers of all the parents of the

current identifier, starting with the
oldest and continuing until current.

PATHCONTAINS (<path>, <item>) Returns TRUE if the specified item
exists within the specified path.

PATHITEM (<path>, <position>[, Returns the item at the specified posi-

<type>1) tion from a string resulting from eval-

uation of a PATH function. Positions
are counted from left to right. type is
an optional enumeration that defines
the data type of the result (Text or

Integer).
PATHITEMREVERSE (<path>, Returns the item at the specified posi-
<position>[, <type>]) tion from a string resulting from eval-

uation of a PATH function. Positions
are counted backwards from right to
left.

PATHLENGTH (<path>) Returns the number of parents to the
specified item in a given PATH result,
including self.

LOGICAL FUNCTIONS

Logical functions, shown in Table B-6, are used for comparisons within a
function.

TABLE B-6 Logical Functions

FUNCTION DESCRIPTION

AND (<logicall>, <logical2>) Checks whether both arguments are
TRUE, and returns TRUE if both argu-
ments are TRUE. Otherwise it returns

FALSE.
FALSE () Returns the logical value FALSE.
IF (<logical_test>, Checks if a condition provided as the
<value_if true>, first argument is met. Returns one
<value_if false>) value if the condition is TRUE, and
returns another value if the condition
is FALSE.
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FUNCTION

IFERROR (<value>,
<value_1f error>)

NOT (<logical>)

OR(<logicall>, <logicalZ2>)

SWITCH (<expression>, <valuel>,

<resultl>, <value2>,
<result2>.., <else>)

TRUE ()

TEXT FUNCTIONS

Text functions, as shown in Table B-7, are used for formatting text.

TABLE B-7 Text Functions

FUNCTION

BLANK ()
CONCATENATE (<textl>, <text2>)

EXACT (<textl>,<text2>)

FIND(<find_ text>,
<within_text>,
<start_num>, <NotFoundValue>)

FIXED (<number>, <decimals>,
<no_commas>)

DESCRIPTION

Returns the logical value TRUE.

DESCRIPTION

Returns a blank.

Compares two text strings and
returns TRUE if they are exactly the
same, FALSE otherwise. EXACT is
case-sensitive but ignores formatting
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Evaluates an expression and returns
a specified value if the expression
returns an error; otherwise returns
the value of the expression itself.

Changes FALSE to TRUE, or TRUE to

Checks whether one of the argu-
ments is TRUE to return TRUE. The
function returns FALSE if all argu-
ments are FALSE.

Evaluates an expression against a list
of values and returns one of multiple
possible result expressions. else is
the result if expression doesn't match
any of the value arguments (optional).

Joins two text strings into one text

Returns the starting position of one
text string within another text string.
FIND is case-sensitive. start_num and
NotFoundValue are optional.

Rounds a number to the specified
number of decimals and returns the
result as text. You can specify that the
result be returned with or without
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FUNCTION

FORMAT (<value>,
<format_string>)

LEFT (<text>, <num chars>)

LEN (<text>)

LOWER (< text>)

MID(<text>, <start_num>,
<num_chars>)

REPLACE (<old_text>,
<start_num>, <num _chars>,
<new_text>)

REPT (<text>, <num_ times>)

RIGHT (<text>, <num chars>)

SEARCH (<search_text>,
<within text>, <start_num>,
<NotFoundValue>)

SUBSTITUTE (<text>, <old text>,
<new_text>, <instance_num>)
TRIM (<text>)

UPPER (<text>)

VALUE (<text>)

DESCRIPTION

Converts a value to text according to
the specified format.

Returns the specified number of
characters from the start of a text
string.

Returns the number of characters in a
text string.

Converts all letters in a text string to
lowercase.

Returns a string of characters from
the middle of a text string, given a
starting position and length.

REPLACE replaces part of a text string,
based on the number of characters
you specify, with a different text
string.

Repeats text a given number of times.

RIGHT returns the last character or
characters in a text string, based on
the number of characters you specify.

Returns the number of the charac-
ter at which a specific character or
text string is first found, reading left
to right. SEARCH is case-sensitive.
start_num and NotFoundValue are
optional.

Replaces existing text with new text
in a text string.

Removes all spaces from text except
for single spaces between words.

Converts a text string to all uppercase
letters.

Converts a text string that represents
a humber to a number.

Predefined Numeric Formats for the FORMAT Function

Numeric formats, as shown in Table B-8, are used in the format function for

formatting numbers.
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TABLE B-8 Predefined Numeric Formats

FORMAT SPECIFICATION
"General Number"

"Currency"

"Fixed"

"Standard"

"Percent”

"Scientific"

"Yes/No"

"True/False"

"On/Off"

DESCRIPTION

Displays numbers with no thousand separators.

Displays numbers with thousand separators, if
appropriate; displays two digits to the right of the
decimal separator. Output is based on system locale
settings.

Displays at least one digit to the left and two digits
to the right of the decimal separator.

Displays numbers with thousand separators, at least
one digit to the left and two digits to the right of
the decimal separator.

Displays numbers multiplied by 100 with a percent
sign (%) appended immediately to the right; always
displays two digits to the right of the decimal
separator.

Uses standard scientific notation, providing two sig-
nificant digits.

Displays No if number is 0; otherwise, displays Yes.

Displays False if number is O; otherwise, displays
True.

Displays Off if number is 0; otherwise, displays On.

Predefined Date and Time Formats for the FORMAT Function

Date and time formats, shown in Table B-9, are used in the FORMAT function

for formatting numbers.

TABLE B-9 Predefined Date and Time Formats

FORMAT SPECIFICATION

"General Date"

DESCRIPTION

Displays a date and/or time. For
example, 3/12/2008 11:07:31 AM. Date
display is determined by your applica-
tion's current culture value.

"Long Date" or "Medium Date" Displays a date according to your cur-

"Short Date"

rent culture's long date format. For
example, Wednesday, March 12, 2008.

Displays a date using your current
culture's short date format. For exam-
ple, 3/12/2008.
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FORMAT SPECIFICATION

"Long Time" or "Medium Time"

"Short Time"

STATISTICAL FUNCTIONS

DAX provides basic statistical functions

listed in Table B-10.

TABLE B-10 Statistical Functions

FUNCTION

AVERAGE (<column>)

AVERAGEA (<column>)

AVERAGEX (<table>, <expression>)
COUNT (<column>)

COUNTA (<column>)

COUNTAX (<table>, <expression>)

COUNTBLANK (<column>)

COUNTROWS (< table>)

DESCRIPTION

Displays a time using your current
culture's long time format; typically
includes hours, minutes, seconds. For
example, 11:07:31 AM.

Displays a time using your current
culture's short time format. For exam-
ple, 11:07 AM.

such as means and counts. These are

DESCRIPTION

Returns the average (arithmetic mean)
of all the numbers in a column.

Returns the average (arithmetic mean)
of the values in a column. Handles
text and non-numeric values.

Calculates the average (arithmetic
mean) of a set of expressions evalu-
ated over a table

The COUNT function counts the num-
ber of cells in a column that contain
numbers.

The COUNTA function counts the num-
ber of cells in a column that are not
empty.

The COUNTAX function counts non-

blank results when evaluating the
result of an expression over a table.

Counts the number of blank cells in a
column.

The COUNTROWS function counts the
number of rows in the specified
table, or in a table defined by an
expression.
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FUNCTION

COUNTX (<table>, <expression>)

DISTINCTCOUNT (<column>)

MAX (<column>)

MAXA (<column>)

MAXX (<table>, <expression>)

MIN (<column>)

MINA (<column>)

MINX (<table>, <expression>)

RANK.EQ (<value>, <column>,
<order>)

RANKX (<table>, <expression>,
<value>, <order>, <ties>)

SUM (<column>)

SUMX (<table>, <expression>)

TOPN (<n_value>, <table>,
<orderBy._expression>, <order>)

MATH AND TRIG FUNCTIONS

DAX FUNCTION REFERENCE

DESCRIPTION

Counts the number of rows that con-
tain a number or an expression that
evaluates to a number, when evaluat-
ing an expression over a table.

Counts the number of different cells
in a column of numbers.

Returns the largest numeric value in
a column.

Returns the largest value in a col-
umn. Logical values and blanks are
counted.

Evaluates an expression for each row
of a table and returns the largest
numeric value.

Returns the smallest numeric value
in a column. Ignores logical values
and text.

Returns the smallest value in a col-
umn, including any logical values and
numbers represented as text.

Returns the smallest numeric value
that results from evaluating an
expression for each row of a table.

Returns the ranking of a number in a
list of numbers.

Returns the ranking of a number in
a list of numbers for each row in the
table argument.

Adds all the numbers in a column.

Returns the sum of an expression
evaluated for each row in a table.

Returns the top N rows of the speci-
fied table.

DAX does not provide any of the trigonometry functions such as SIN and
COS—you will need to use SIN tables to do these types of calculations. The
functions DAX does provide are listed in Table B-11.
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TABLE B-11 Math and Trig Functions

FUNCTION

ABS (<number>)

CEILING (<number>,
<significance>)

CURRENCY (<value>)

DIVIDE (<numerator>,
<denominator>,
<alternateresult>)

EXP (<number>)

FACT (<number>)

FLOOR (<number>, <significance>)

INT (<number>)

LN (<number>)

LOG (<number>, <base>)

LOG10 (<number>)

MOD (<number>, <divisor>)

MROUND (<number>, <multiple>)

PI()

POWER (<number>, <power>)

DESCRIPTION

Returns the absolute value of a
number.

Rounds a number up, to the nearest
integer or to the nearest multiple of
significance.

Evaluates the argument and returns
the result as currency data type.

Performs division and returns alter-
nate result or BLANK () on division by
0. Alternateresult (optional) is the
value returned when division by zero
results in an error.

Returns e raised to the power of a
given number. The constant e equals
2.71828182845904, the base of the
natural logarithm.

Returns the factorial of a number,
equal to the series 1¥2*3*..* , ending
in the given number.

Rounds a number down, toward zero,
to the nearest multiple of significance.

Rounds a number down to the near-
est integer.

Returns the natural logarithm of a
number. Natural logarithms are based
on the constant e (2.71828182845904).

Returns the logarithm of a number to
the base you specify.

Returns the base-10 logarithm of a
number.

Returns the remainder after a num-
ber is divided by a divisor. The result
always has the same sign as the
divisor.

Returns a number rounded to the
desired multiple.

Returns the value of Pi,
3.14159265358979, accurate to 15
digits.

Returns the result of a number raised
to a power.
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FUNCTION

QUOTIENT (<numerator>,
<denominator>)

RAND ()

RANDBETWEEN (<bottom>, <top>)
ROUND (<number>, <num_digits>)
ROUNDDOWN (<number>,
<num_digits>)

ROUNDUP (<number>, <num digits>)

SIGN (<number>)

SQRT (<number>)

TRUNC (<number>, <num_digits>)

TIME INTELLIGENCE FUNCTIONS

DAX FUNCTION REFERENCE

DESCRIPTION

Performs division and returns only the
integer portion of the division result.
Use this function when you want to
discard the remainder of division.

Returns a random number greater
than or equal to 0 and less than

1, evenly distributed. The number

that is returned changes each time
the cell containing this function is

recalculated.

Returns a random number between
the numbers you specify.

Rounds a number to the specified
number of digits.

Rounds a number down, toward 0
(zero).

Rounds a number up, away from 0
(zero).

Determines the sign of a number, the
result of a calculation, or a value in

a column. The function returns 1 if
the number is positive, 0 (zero) if the
number is zero, or -1 if the number is
negative.

Returns the square root of a number.

Truncates a number to an integer by
removing the decimal, or fractional,
part of the number.

Time intelligence functions are provided for work with calendar months, and

the functions are listed in Table B-12.

TABLE B-12 Time Intelligence Functions

FUNCTION
CLOSINGBALANCEMONTH (
<expression>, <dates>,
<filter>)

DESCRIPTION

Evaluates the specified expression at
the calendar end of the given month.
The given month is calculated as the
month of the latest date in the dates
argument, after applying all filters.
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FUNCTION

CLOSINGBALANCEQUARTER (
<expression>, <dates>,
<filter>)

CLOSINGBALANCEYEAR (
<expression>, <dates>,
<filter>)

DATEADD (<date_column>,
<number_of_ intervals>,
<interval>)

DATESBETWEEN (<column>,
<start_date>, <end date>

DATESINPERIOD (<date column>,
<start_date>,

<number_of intervals>,
<Iintervals>)

DATESMTD (<dates>)

DATESQTD (<date_column>)

DATESYTD (<date_column> [,
<YE_date>])

ENDOFMONTH (<date_column>)

ENDOFQUARTER (<date_column>)

ENDOFYEAR (<date_column>)

FIRSTDATE (<date_column>)

DESCRIPTION

Evaluates the specified expression at
the calendar end of the given quarter.
The given quarter is calculated as the
quarter of the latest date in the dates
argument, after applying all filters.

Evaluates the specified expression at
the calendar end of the given year.
The given year is calculated as the
year of the latest date in the dates
argument, after applying all filters.

Returns a table that contains a col-
umn of dates, shifted either forward
in time or back in time from the dates
in the specified date column.

Returns a table of dates that can be
found in the specified date column
beginning with the start date and
ending with the end date.

Returns a table of dates that can be
found in the specified date column
beginning with the start date and
continuing for the specified number
of intervals.

Returns a table that contains a col-
umn of the dates for the month to
date.

Returns a table that contains a col-
umn of the dates for the quarter to
date.

Returns a table that contains a col-
umn of the dates for the year to date.
The year_end_date (optional) is a
literal string with a date that defines
the year-end date. The default is
December 31.

Returns the last day of the month in
the specified date column.

Returns the last day of the quarter in
the specified date column.

Returns the last day of the year in the
specified date column.

Returns the first date in the current
context for the specified date column.
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FUNCTION

FIRSTNONBLANK (<column>,
<expression>)

LASTDATE (<date_column>)

LASTNONBLANK (
<date_column>, <expression>)

NEXTDAY (<date_column>)

NEXTMONTH (<date_column>)

NEXTQUARTER (<date_column>)

NEXTYEAR (<date_column>[,
<YE_date>])

OPENINGBALANCEMONTH (
<expression>, <dates>,
<filter>)
OPENINGBALANCEQUARTER (
<expression>, <dates>,
<filter>)
OPENINGBALANCEYEAR (
<expression>, <dates>,
<filter>)
PARALLELPERIOD (<dates>,
<number_of_ intervals>,
<interval>)

PREVIOUSDAY (<date_column>)

PREVIOUSMONTH (<date_column>)

PREVIOUSQUARTER (<date_column>)

DAX FUNCTION REFERENCE

DESCRIPTION

Returns the first value in the column
where the expression is not blank.

Returns the last date in the current
context for the specified date column.

Returns the last value in the column
where the expression is not blank.

Returns the next day date from
date_column.

Returns the set of dates in the next
month from date_column.

Returns the set of dates for the next
quarter from date_column.

Returns the set of dates for the next
year from date_column.

Evaluates the expression at the first
date of the month, in the current
context.

Evaluates the expression at the first
date of the quarter, in the current
context.

Evaluates the expression at the
first date of the year, in the current
context.

Returns a table that contains a col-
umn of dates that represents a period
parallel to the dates in the specified
dates column, in the current context,
with the dates shifted a number of
intervals either forward in time or
back in time.

Returns a table that contains a col-

umn of all dates representing the day
that is previous to the first date in the
dates column, in the current context.

Returns a table that contains a col-
umn of all dates from the previous
month, based on the first date in the
dates column, in the current context.

Returns a table that contains a col-
umn of all dates from the previous
quarter, based on the first date in the
dates column, in the current context.
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FUNCTION

PREVIOUSYEAR (<date_column>)

SAMEPERIODLASTYEAR (<dates>)

STARTOFMONTH (<date_column>)

STARTOFQUARTER (<date_column>)

STARTOFYEAR (<date_column>[,
<YE_date>])

TotalMTD (<expression>, <dates>,
<filter>)
TotalQTD (<expression>, <dates>,
<filter>)
TotalYTD (<expression>, <dates>,

<filter>)

DESCRIPTION

Returns a table that contains a col-
umn of all dates from the previous
year, given the last date in the dates
column, in the current context.

Returns a table that contains a col-
umn of dates shifted one year back in
time from the dates in the specified
dates column, in the current context.

Returns the first day of the month in
the specified date column.

Returns the first day of the quarter in
the specified date column.

Returns the first day of the year in the
specified date column.

Evaluates the specified expression for
the interval that starts at the first day
of the month and ends at the latest
date in the specified dates column,
after applying all filters.

Evaluates the specified expression for
the interval that starts at the first day
of the quarter and ends at the latest
date in the specified dates column,
after applying all filters.

Evaluates the specified expression for
the interval that starts at the first day
of the year and ends at the latest date
in the specified dates column, after
applying all filters.
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3D modeling, 349

3D rendering, 3, 7-8
additional dimension, 9-10
depth, illusion of, 8-9
faux 3D transform, 11
perception and, 15
pitfalls, 15

A

Abadi, Daniel, 41
accessing data, HTMLS5, 151-152
ad hoc analytics, 269-270
add-ins, Excel, 75
AdventureWorks database, 63
AJAX (Asynchronous JavaScript and

XML), 151
analysis, temporal, 13
Analysis Services

database, restoring, 47

drill through, 275

OLAP, 40

partitioning, 40

tabular mode, 41-42

Vertipaq, 42-43

xVelocity, 42
analytic charts

drill down, 176

PerformancePoint, 278-280
analytic databases, benefits, 42
analytics, 270
angle versus height example of

perception, 16-17
animations, 193, 201

scatter plots, Power View, 213-216

apps, 148
area charts, line charts, 196
area of circles, perception and, 17
artistic visualization, 3
versus data visualization, 4-7
AspNetCompatibilityRequirements
attribute, 157
attributes
AspNetCompatibility
Requirements, 157
DataContract, 157
OperationContract, 157
ServiceContract, 157
authentication
double hop problem, 138
Kerberos, 138
Reporting Services, 137
stored credentials, 138-140
automated data, 57
axes
Excel, 244-252
horizontal, temporal analysis, 192

B

bar charts, 4, 193, 197
ease of development, 198
versus pie charts, 230
Power View, 89
Reporting Services, 207
stacked bar chart, 6
PerformancePoint, 204
timelines and, 194-195
Beautiful Evidence (Tufte), 324
behavior properties, tables, 99-100
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Bl (Business Intelligence), 3
RoamBl, 148
self-service model, 72, 270-271

BICC (Business Intelligence Competency

Center)

BIDS (Business Intelligence Development

Studio), 141-144
Report Builder compatibility, 142
Big Data, 61
BISM (Bl Semantic Model), 70, 272
architecture, 71
BISM tabular, 70-71
Power View and, 87,90
BPM (Business Performance
Management), 171
Bricklin, Daniel, 59
BSM (Business Scorecard Manager),
35,37
B-Tree models, 73
bubble charts, 199
color use example, 26
Power View, 200, 218
Play Axis, 213
shape and, 30
building height column chart, 29
bullet charts, 231-232
embedded visualizations, 327-328
Reporting Services, 254-261
Business Intelligence Center
Dashboard Designer, 110-111
Monitor Key Performance, 110-111
Business Scorecard Manager, 171

C

C#
JSON and, 158
web services, 154-155

CAD (Computer Aided Design) drawings,

348
canvas element (HTML5), 149
cards, Power View, 90

cartography, 4
categories, data category property, 100
charts

analytic charts, PerformancePoint,
278-280
area charts, line charts, 196
bar charts, 4, 193, 197
ease of development, 198
Reporting Services, 207
stacked bar chart, 6, 204
bubble, 199
color use example, 26
Power View, 218
bullet, 231-232
embedded visualizations, 327-328
Reporting Services, 254-261
column charts, 193, 197
ease of development, 198
Excel, 208
Reporting Services, 206
combined charts, 193, 198
ease of development, 199
Excel, 209, 218
maps, 354
PerformancePoint, 204
Reporting Services, 206
cross-functional flow charts, 344
line charts, 193, 195
area charts, 196
ease of development, 197
Excel, 208
PerformancePoint, 204, 222-223
Playfair, William, 196
Reporting Services, 206
pie, perception and, 17
Playfair, William, 4
polar, 14
radar, 14, 232
Excel, 252-254
scatterplot, 193, 199
shape example, 30
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temporal analysis, horizontal axis, 192
tiling, 193, 200
Power View, 212
chloropleths, 229, 354-355
GIS maps, 353
circles, area, perception and, 17
cleaning up data model, 97-98
Codd, Edgar F., 269
code
Silverlight, 147
WPF (Windows Presentation
Foundation), 147
XAML (eXtensible Application
Markup Language), 148
color pyramid, 300, 385-386
color use, 15, 23, 25
bubble chart example, 26
color-blind persons, 28
combined charts, 198
divergent values, 27
Excel, 24
geo-spatial use, 27
heat map example, 26
intervals, 25
perception and, color-blind
persons, 28
PerformancePoint, 24
Power View, 24
Reporting Services, 24
RGB (red/gree/blue), 23-24
selecting, 25
color wheel, 301-304
HTMLS5 implementation, 317-319
column chart, 197
building height for perspective, 29
Excel, 208, 210
PerformancePoint, 242-243
Power View, 90
Reporting Services, 206
column charts, 193
ease of development, 198

INDEX

column store databases, benefits, 41-42
column stores, 73
indexes, 74
columns
data model cleanup and, 97-98
renaming, 81
combined charts, 193, 198
color use, 198
ease of development, 199
Excel, 209, 218
maps, 354
PerformancePoint, 204
Reporting Services, 206
comparisons
bullet charts, 231-232
custom, 236-237
Excel, 238-240
HTMLS5, 241
matrices, 233-235
PerformancePoint, 237-238
perspective, 229
pie charts versus bar charts, 230
point-in-time, 227-228
chloropleths, 229
Power View, 240-241
radar charts, 232
Reporting Services, 238
SSRS, 238
stacked bar chart, 230
compression, 73
conditional formatting, 325-326
connections, pivot charts (Excel), 219
context, perception and, 15
copy and paste, data set creation, 62
CPM (Corporate Performance
Management), 171
cross-functional flow charts, 344
Crystal Reports, 36-37
custom comparisons, 236-237
Custom Table filter (PerformancePoint), 122
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D
Dashboard Designer

Business Intelligence Center, 110-111

KPIs, editing, 183
PerformancePoint, 110-111
SSS (Secure Store Service), 108-109
web parts, 127-128

dashboards

connections, PerformancePoint, 128

PerformancePoint, 123-124
strategic views and, 20
vehicular style, 21-22
data access, HTML5, 151-152
data category, 100
data cleansing, 65-66
PowerPivot tables, 80
data discovery, glance-and-go, 23
data exploration
versus glance-and-go, 21-23
tactical views and, 20
data feeds, 60
data mining, 270
Data Mining Extensions, 270
data monitoring, 18
data points, number of, 23
data quality, data sets, 55
data ratings, 55
data sets
AdventureWorks database, 63
automated data, 57
creation, 54
copy and paste, 62
exporting, 62
first set, 63
importing, 62
data feeds, 60
data quality, 55
elements, 54
Excel, 59
formatting, 56, 66
free data, 63

Hadoop, 61
importance, 54
metadata, 55
need for, 53
OLAP models, 60
overview, 53
Report Builder, 142
reports, 60
spreadsheets, 58
when to use, 58
SQL tables, 59-60
tabular models, 60
volume and, 56-57
data sources
PerformancePoint, 110-111
Power View, creating, 91
PowerPivot model creation, 76-77
Reporting Services, 136-137
SQL, creating, 77
data visualization, 3
versus artistic visualization, 4-7
versus infographics, 7
databases. See also AdventureWorks
database
analytic, benefits, 42
column store, benefits, 41-42
Excel
connecting to, 64
importing tables, 65
samples, installation, 46-51
SQL
logins, 50
toolsets, 43
tools, 40
DataContract attribute, 157
data-driven timelines, Reporting
Services, 223

date and time functions (DAX), 369-370

date tables, 215

DAX (Data Analysis Expression), 180, 271

date and time functions, 369-370
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filter functions, 371-372
information functions, 372-373
logical functions, 374-375
lookup functions, 373
math and trig functions, 379-381
parent-child functions, 373-374
statistical functions, 378-379
text functions, 375-376
FORMAT function date and time
formats, 377-378
FORMAT function numeric
formats, 376-377
time intelligence functions, 381-384
decisions
strategic, 18
tactical, 20
Decomposition Tree (PerformancePoint),
307-308
depth, 3D charts, 8-9
detecting relationships, 78
diagrams
flow diagrams, 350-352
Venn diagram, 347
dimensions, 3D, 8-9
additional, 9-10
discrete values, domain values, 29
divergent values, color and, 27
domain values, 29
double hop (authentication), 138
drill across, 276-277
PerformancePoint, 280-281
scorecards, 174
drill down, 274-275
scorecards, 173, 176
SSRS, 282
strategic views, 19
drill through, 275-276
scorecards, 174
SSRS, 282
drillable line chart, PerformancePoint,
222-223

INDEX

E

EffectiveUserName property, 140
election tracking maps, 353
embedded data sources, 136-137
embedded reports, PerformancePoint,
125-126
embedded visualizations, 321
bullet graphs, 327-328
conditional formatting, 325-326
Excel, 329-330
implementations, 331-339
indicators, 326-327
PerformancePoint, 331
Reporting Services, 330-331
sparklines, 323-325
tabular data, 322
EPM (Enterprise Performance
Management), 171
Euler, Leonhard, Seven Bridges of
Kénigsberg, 301
Excel, 3, 44, 59
add-ins, 75
animations, ease of development, 201
axes, multiple, 244-252
bar charts, ease of development, 198
bubble charts, ease of development,
199
color, 24
column charts, 208
ease of development, 198
combined charts, 209, 218
ease of development, 199
comparisons, 238-240
data cleansing, 65-66
data formatting, 66
databases
connecting to, 64
importing tables, 65
embedded visualizations, 329-330
Excel Services, 44
filters, 84
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Excel (continued)
history, 38-39
HTML5 and, 149-150
line charts, 208
ease of development, 197
overview, 69, 359-360
Pivot Charts, 36, 273, 281

embedded visualizations, 331-339

pivot charts, 82-83, 220
connections, 219
formatting, 85
sorting, 85

Power View, add-in, 92

radar charts, 252-254

reasons to use, 46

relationship analysis, 308-309

reports
embedding, 125-126
Power View, 91

scale breaks, 244-252

scatter plots, ease of development,

199
scorecards, 177-179
implementation, 179-182
slicers, 84-85
Table Import wizard, 77
tables, 82
tactical views, 20

tiling charts, ease of development,

201

timelines, ease of development, 195

trendlines
calculation methods, 209
column charts, 210
use cases, 72
verification, prototyping, 67-68
Excel Services, overview, 359-360
exponential method of trendline
calculation, 209
exporting
data from systems, 62
reports, to PowerPoint, 103

expressions
KPIs, 140-141
Reporting Services, 140

F

faux 3D transform, 11
Field List (Power View), 93
Field Well (Power View), 93
filter functions (DAX), 371-372
filters
Excel, 84
PerformancePoint, 121-122, 129
Filters Area (Power View), 93
Flotr2, 149
flow charts, cross-functional, 344
flow diagrams, 350-352
formatting
conditional, embedded
visualizations, 325-326
data sets, 56
Excel, 66
pivot charts, 85
Frankston, Bob, 59
free data, 63
front-end tools
Excel/Excel Services, 44
PerformancePoint, 44
Power View, 44
Reporting Services, 44
SSRS, 44
functions
DAX (Data Analysis Expression)
date and time, 369-370
filter, 371-372

FORMAT function date and time

formats, 377-378
FORMAT function numeric
formats, 376-377
information, 372-373
logical, 374-375
lookup, 373
math and trig, 379-381

www.it-ebooks.info


http://www.it-ebooks.info/

parent-child, 373-374

statistical, 378-379

text, 375-376

time intelligence, 381-384
funnels, 349-350

G

Gantt charts, timelines and, 194-195
geo-spatial color use example, 27
GET service, 157
GIS (Geographic Information System)
maps, 352-353
glance-and-go visualization. See
monitoring
data discovery, 23
versus data exploration, 21-23
interactive elements, 22
goals of visualization, 13-15
graphics, timelines, 194
gray scale, 15
gridlines, perception and, 16

H

Hadoop, 61
heat map color example, 26
heatmaps, 355
hierarchical structures, 299
HOLAP (Hybrid OLAP), 40
horizontal axis in charts, temporal
analysis, 192
HTMLS5, 148-149
canvas element, 149
color wheel implementation, 317-319
comparisons, 241
data access, 151-152
Excel and, 149-150
Flotr2, 149
versus HTML 4, 149
network map implementation,
316-317
sample installation, 152-154

INDEX

structure maps, 310-311
visualization implementation,
261-266
human perception, 15
3D and, 15
angle versus height example, 16-17
area of circles, 17
color, 28
RBG (red/green/blue), 24
context and, 15
gridlines, 16
perspective, 28
bubble chart, 30
building height column chart, 29
pie charts, 17

IIS Manager, 153
illusions, 3D charts, 8-9
Imperial War Museum (London)
timeline, 195
implementation
color wheel, 317-319
embedded visualizations, 331-339
network maps, 316-317
organization chart, 311-316
scorecards, Excel, 179-182
importing
data from systems, 62
tables to Excel, 65, 79
in memory models, PowerPivot, 75
indicators
embedded visualizations, 326-327
PerformancePoint, 187-189
infographics, 341
purpose, 7
versus visualization, 7
information functions (DAX), 372-373
InfoVis, 149-150
installation
databases, samples, 46-51
Power View samples, 103-104
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INDEX

J

jQuery, 151-152

JS library, 160

JSON (JavaScript Object Notation), 151
C# and, 158

K

Kaplan, Robert S., 301
Kerberos
authentication, 138
SSS (Secure Store Service), 109
KPAs (key performance areas), 171
KPIs (key performance indicators), 105
editing, 183
expressions, 140-141
KPAs and, 171
PerformancePoint, 118-120
scorecards and, 172-173

L

Lambert, Johann Heinrich, 300
LANPAR, 59
line charts, 193, 195
area charts, 196
ease of development, 197
Excel, 208
PerformancePoint, 204
PerformancePoint, drillable,
222-223
Playfair, William, 196
Power View, 90
Reporting Services, 206
linear method of trendline calculation,
209
logarithmic method of trendline
calculation, 209
logical functions (DAX), 374-375
lookup functions (DAX), 373
Lotus 1-2-3, 59

M

map-reduce, 61
maps
combined chart maps, 354
election tracking, 353
GIS (Geographic Information System),
352-353
HTMLS5 structure maps, 310-311
mind maps, 347
network maps, 299, 301-302
HTML5 implementation, 316-317
pin, 354
Power View, 90
prism maps, 354
strategy map, 301, 307
PerformancePoint, 309-310
strategy maps, 306
transportation maps, 344-346
matching visualizations to tools, 362-368
math and trig functions (DAX), 379-381
matrices, 232, 234-235
Mattessich, Richard, 59
MDA (Multi-Dimensional Analysis), 40
MDX Quiery filter (PerformancePoint), 121
expressions, 129
Member Selection filter
(PerformancePoint), 121
Mendelev Periodic table of the
elements, 342
metadata, 55
Power View, 98-99
Microsoft
business intelligence toolset, 20, 39
color schemes, 24
history, 35-38
Report Builder 1, 35
Report Builder 2, 35
visualization market and, 35
mind maps, 347
model, clean up, 97-98
MOLAP (Multi-dimensional OLAP), 40
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Monitor Key Performance, 110-111

mortality charts of Florence
Nightingale, 14

moving average method of trendline
calculation, 209

multidimensional models, PowerPivot,
75

multidimensional sources versus tabular,
105-106

N

Named Set filter (PerformancePoint), 121
network maps, 299, 301-302
HTMLS5 implementation, 316-317
Nightingale, Florence, charts on
mortality, 14
NodeXL, relationship analysis, 308-309
Norton, David P., 301
Notepad++ text editor, 159

o

OLAP (Online Analytic Processing), 40
Codd, Edgar F,, 269
HOLAP (Hybrid OLAP), 40
models, 60
MOLAP (Multi-dimensional OLAP), 40
ROLAP (Relational OLAP), 40
operational views, 18-19
report example, 19
Reporting Services, 20
OperationContract attribute, 157
operators, Time Intelligence, 115
organization charts, 305
implementation, 311-316
outliers, 14

P

parent-child functions (DAX), 373-374
partitioning, Analysis Services, 40
patterns, 14

INDEX

perception, 15

3D and, 15
angle versus height example, 16-17
area of circles, 17
color, 28
RBG (red/green/blue), 24
context and, 15
gridlines, 16
perspective, 28
bubble chart, 30
building height column chart, 29
size, 31
pie charts, 17

Performance Management, scorecards

and, 171

PerformancePoint, 37, 44, 331

analytic charts, 278-280
analytic reports, 122-123
animations, ease of development, 201
bar charts, ease of develoment, 198
bubble charts, ease of
development, 199
color, 24
column charts, 242-243
ease of develoment, 198
combined charts, 204
ease of development, 199
comparisons, 237-238
custom indicators, 187-189
Custom Table filter, 122
dashboard connections, 128
Dashboard Designer, 110-111
dashboard filters, 121-122
dashboards, 123-124
strategic views and, 20
data sources, 110-111
Decomposition Tree, 307-308
dimension data, 106
drill across, 280-281
fact (measure) data, 106
filter connections, 122
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PerformancePoint (continued) size, 31
filtering objects, 129 pie charts
history, 38 versus bar charts, 230
KPIs (key performance indicators), perception and, 17
118-120 Power View, 90
line charts, 204 pin maps, 354
drillable, 222-223 Pivot charts (Excel), 36, 82-83, 220
ease of development, 197 connections, 219
MDX Query filter, 121 drilling down, 274
Member Selection filter, 121 Excel, 273, 281
Named Set filter, 121 formatting, 85
organization chart implementation, sorting, 85
311-316 pivoting, 273
overview, 357-358 Play Axis (Power View), 212
reasons to use, 45 Playfair, William, 4, 191
reports, 122-123 line charts, 196
embedding, 125 point-in-time comparisons, 227-228
requirements, 106-108 chloropleths, 229
Run Dashboard Designer button, polar charts, 14
110-111 polynomial method of trendline
samples, installing, 130-131 calculation, 209
scatter plots, ease of development, POST service, 157
199 power method of trendline
scorecards, 120-121, 175-177 calculation, 209
SSS (Secure Store Service), 108-110 Power View, 44, 210, 283-284
stacked bar chart, 204 add-in, 92
STP (Simple Time Protocol), analysis page, 211
202-203, 205 animations, ease of development, 201
strategy maps, 309-310 bar charts, 89
tabular versus multidimensional ease of develompent, 198
sources, 105-106 BISM, 90
tiling charts, ease of development, bubble charts, 200, 218
201 ease of development, 199
Time Intelligence, 112-118 canvas, 93
Time Intelligence Connection cards, 90
Formula filter, 122 color, 24
Time Intelligence filter, 121 column charts, 90
timelines, ease of development, 195 ease of develompent, 198
periodic tables, 342-343 combined charts, ease of
perspective, 28, 229 development, 199
bubble chart, 30 comparisons, 240-241
building height column chart, 29 data sources, creating, 91
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examples, 295-298
Field List, 93
Field Well, 93
Filters Area, 93
Geo-Analysis report, 89
interface, 93
line charts, 90

ease of development, 197
maps, 90
metadata, 98-99
multidimensional model support, 89
overview, 87, 360-361
pie charts, 90
Play Axis, 212
Promotion Evaluation report, 88
reasons to use, 46
Reporting Services and, 87
reports

creating, 94-95

enhancing, 97-98

Excel, 91

exporting to PowerPoint, 103

publishing in SharePoint, 101

saving, 102-103

saving in SharePoint, 102-103

sharing, 100-103
Ribbon, 93
Sales Dashboard report, 88
samples, installing, 103-104
scatter plots, 90, 214-216

ease of development, 199

Play Axis, 213
tables, 89

behavior properties, 99-100
tactical views, 20
tiled charts, 212
tiling charts, ease of development,

201
timelines, ease of development, 195
trellis charts, 90
View Area, 93
visualization options, 89-90

INDEX

PowerPivot
data modeling, 271
data sets and, 60
introduction, 42
in memory models, 75
model creation, 75
data source, 76-77
loading data, 76-77
multidimensional models, 75
OECDPopulation model, 214-217
overview, 69-70
Ribbon, 76
Table Import wizard, 77
tables
building relationships, 79
checking relationships, 79
clean up, 80
importing, 79
relationship detection, 78
tactical views, 20
use cases, 72
PowerPoint, reports, exporting to, 103
PPS (PerformancePoint Services)
scorecards, traffic lights, 182-187
SSRS integration, 290-295
Priestly, Joseph, 191, 194
prism maps, 354
Proclarity, 37
properties, table behavior, 99-100
prototyping, data verification, 67-68
publishing reports, Power View, 101

R

radar charts, 14, 232
Excel, 252-254
RBG (red/green/blue) color, 24
Reference Data Mapping, Time
Intelligence, 112
relationship analysis, 299
color pyramid, 300
color wheel, 301-304, 317-319
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INDEX

relationship analysis (continued)
Excel, 308-309
hierarchical structures, 299
HTMLS5 structure maps, 310-311
network maps, 299, 301-302
NodeXL, 308-309
strategy maps, 306-307
PerformancePoint, 309-310
tree structures, 299, 301
organization charts, 305
PerformancePoint Decomposition
Tree, 307-308
relationships
building, 79
checking, 79
detection, 78
renaming columns, 81
Report Builder, 141-144
BIDS compatibility, 142
data sets, 142
intelligence, expression builder, 142
searches, 143
Reporting Services, 36-37, 39, 44, 205
animations, ease of development,
202
authentication, 137
bar charts, 207
ease of development, 198
bubble charts, ease of development,
199
bullet charts, 254-261
color, 24
column charts, 206
ease of development, 198
combined charts, 206
ease of development, 199
comparisons, 238
connectivity, 135
data set designer, 224
data sources, 136-137
drill down, 282
drill through, 275, 282

embedded reports, 125
embedded visualizations, 330-331
expressions in, 140
line charts, 206
ease of development, 197
Native mode, 133-134
operational views, 20
overview, 358-359
Power View and, 87
reasons to use, 46
samples, installing, 145
scatter plots, 207
ease of development, 199
server, 134
SharePoint Integrated mode, 133-136
tiling charts, ease of development,
201
timelines, 207
data-driven, 223
ease of development, 195

reports, 60

embedded, 125-126
Excel, Power View, 91
operational, 19
PerformancePoint, 122-123
Power View
exporting to PowerPoint, 103
publishing in SharePoint, 101
saving, 102-103
saving in SharePoint, 102-103
sharing, 100-103

Ribbon

Power View, 93
PowerPivot, 76

RoamBI, 148
ROLAP (Relational OLAP), 40

S

samples

HTMLS5, installation, 152-154
PerformancePoint, installing, 130-131
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Power View, installing, 103-104

Report Builder, installing, 145
saving reports, Power View, 102-103
scale breaks, Excel, 244-252
scatterplot, 193, 199

Power View, 90, 214-216

Play Axis, 213

Reporting Services, 207

shape example, 30
scorecards. See also Business Scorecard

Manager

drill across, 174

drill down, 173

drill through, 174

Excel, 177-179

implementation, 179-182

implementation, Excel, 1779-182

KPIs and, 172-173

Performance Management and, 171

PerformancePoint, 120-121, 175-177

PPS (PerformancePoint Services),

traffic lights, 182-187

searches, Report Builder, 143
security

authentication, 137

stored credentials, 138-140
self-service BI, 270-271
Seven Bridges of Kénigsberg (Euler), 301
shape, 28

bubble chart, 30

scatterplot example, 30

size, 31
shared data sources, 136-137
SharePoint

publishing reports, Power View, 101

requirements, 106-108

saving reports, Power View, 101

web page creation, 126-129
sharing reports, Power View, 100-101
Silverlight, 147

animations, ease of development, 202
bar charts, ease of development, 198

INDEX

bubble charts, ease of development,
199
column charts, ease of development,
198
combined charts, ease of
development, 199
future of, 150-151
line charts, ease of development, 197
PerformancePoint, 150
PowerView, 150
scatter plots, ease of development,
199
tiling charts, ease of development, 201
timelines, ease of development, 195
size, shapes, 31
slice and dice, 269. See also ad hoc
analytics
slicers, 277-278
Excel, 84-85
sorting, pivot charts, 85
sparklines
Beautiful Evidence (Tufte), 324
embedded, 323-325
spreadsheets, 58
when to use, 58
SQL Server, 40
data sources, creating, 77
Data Tools, 71
SQL tables, 59-60
SSRS (SQL Server Reporting Services).
See also Reporting Services
comparisons, 238
drill down, 282
drill through, 282
examples, 284-290
PPS integration, 290-295
SSS (Secure Store Service), 108-110
configuration, 109
Kerberos, 109
stacked bar chart, 6
comparison and, 230
PerformancePoint, 204
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INDEX

statistical functions (DAX), 378-379
stored credentials, 138-140
STP (Simple Time Protocol), 202-203
PerformancePoint chart, 205
STPS (Simple Time Period Specification),
112
expressions, 129
strategic decisions, 18
strategic views, 18
data monitoring, 18
drill down and, 19
PerformancePoint dashboards, 20
strategy map, 301, 307
PerformancePoint, 309-310
strategy maps, 306
subway map, 344-346
swim lanes, 344
flow diagrams, 350

T

Table Import wizard (Excel), 77

tables
clean up, 80
columns, renaming, 81
Excel, 82
importing, 79
periodic tables, 342-343
Power View, 89

behavior properties, 99-100

relationship building, 79
relationship checking, 79
relationship detection, 78
SQL tables, 59-60

tabular data, 322

tabular models, 60

tabular sources versus multidimensional,
105-106

tactical decisions, 20

tactical views, 18
data exploration and, 20
Excel and, 20

Power View and, 20
PowerPivot and, 20
temporal analysis, 13, 191-192. See also
timelines
animations, 193, 201
bar charts, 193, 197
bubble charts, 199
charts
combined charts, 198
horizontal axis, 192
line charts, 195-197
column charts, 193, 197
combined charts, 193
line charts, 193, 196-197
scatterplot, 193, 199
tiling, 193, 200
text editors, 159
text functions (DAX), 375-376
FORMAT function date and time
formats, 377-378
FORMAT function numeric formats,
376-377
tiling charts, 193, 200
Power View, 212
Time Intelligence, 112
configuration, 112
expressions, 129
formula examples, 113-114
general conventions, 115
operators, 115
parallel period-to-date, 118
period-to-date formulas, 117
period-to-date functions, 117-118
Reference Data Mapping, 112
STPS (Simple Time Period
Specification), 112
syntax, 115
time periods, 116
Time Intelligence Connection Formula
filter (PerformancePoint), 122
Time Intelligence filter
(PerformancePoint), 121
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time intelligence functions (DAX),
381-384
time series, 4
timelines, 191-192
bar charts and, 194-195
data-driven, Reporting Services, 223
ease of development, 195
Gantt charts and, 194-195
graphics, 194
Imperial War Museum (London), 195
Priestly, Joseph, 194
Reporting Services, 207
toolsets
Excel, 359-360
Excel Services, 359-360
front-end tools, 44
Excel/Excel Services, 44
PerformancePoint, 44
Power View, 44
SSRS, 44
matching visualizations, 362-368
PerformancePoint, 202-205, 357-358
Power View, 360-361
Reporting Services, 358-359
SQL databases, 43
transportation maps, 344-346
tree structures, 299, 301
organization charts, 305
PerformancePoint Decomposition
Tree, 307-308
Treemap.cs class, 159
trellis charts, Power View, 90
trendlines
calculations
exponential, 209
linear, 209
logarithmic, 209
moving average, 209
polynomial, 209
power, 209
Excel, column charts, 210
Tufte, Edward, Beautiful Evidence, 324

INDEX

V)

UML (Universal Modeling Language), 350
User Mapping tab, 50

\'}

values
discrete, domain values, 29
domain values, 29
vehicular-style dashboards, 21-22
Venn diagram, 347
verification, prototyping, 67-68
View Area (Power View), 93
views
operational, 18-19
report example, 19
Reporting Services, 20
strategic, 18
drill down and, 19
PerformancePoint dashboards, 20
tactical, 18
Excel and, 20
Power View and, 20
PowerPivot and, 20
VisiCalc, 59
Visio
cross-functional flow charts, 344
organization chart, 305
visualization
data points, number of, 23
developing, 6
goals, 13-15
versus infographics, 7
matching to tools, 362-368
overview, 3-4
VI_UNData.bak backup file, 47

w

WCF (Windows Communication
Foundation), 155

web part pages (SharePoint), 126-129
Dashboard Designer, 127-128
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400 INDEX

web services, C#, 154-155 X-Y-Z

Windows Store, XAML in applications, 151

wizards, Excel, Table Import, 77

WPF (Windows Presentation
Foundation), 147

XAML (eXtensible Application Markup
Language), 148
Windows Store applications, 151
xVelocity engine, 271
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